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Notices
Copyright Notice
© Keysight Technologies 2014–2024
No part of this manual may be repro-
duced in any form or by any means 
(including electronic storage and 
retrieval or translation into a foreign 
language) without prior agreement and 
written consent from Keysight Technol-
ogies as governed by United States and 
international copyright laws.

Trademark
Bluetooth and the Bluetooth logos are 
trademarks owned by Bluetooth SIG, 
Inc., U.S.A. and licensed to Keysight 
Technologies.

Manual Part Number
U8903-90045

Edition
Edition 9, January 2024

Printed in:
Printed in Malaysia

Published by:
Keysight Technologies 
Bayan Lepas Free Industrial Zone, 
11900 Penang, Malaysia

Technology Licenses 
The hardware and/or software 
described in this document are fur-
nished under a license and may be 
used or copied only in accordance with 
the terms of such license.

Declaration of Conformity
Declarations of Conformity for this 
product and for other Keysight prod-
ucts may be downloaded from the 
Web. Go to http://www.keysight.com/
go/conformity. You can then search by 
product number to find the latest Dec-
laration of Conformity.

U.S. Government Rights
The Software is “commercial computer 
software,” as defined by Federal Acqui-
sition Regulation (“FAR”) 2.101. Pursu-
ant to FAR 12.212 and 27.405-3 and 
Department of Defense FAR Supple-
ment (“DFARS”) 227.7202, the U.S. 
government acquires commercial com-
puter software under the same terms 
by which the software is customarily 
provided to the public. Accordingly, 
Keysight provides the Software to U.S. 
government customers under its stan-
dard commercial license, which is 
embodied in its End User License 
Agreement (EULA), a copy of which can 
be found at http://www.keysight.com/
find/sweula. The license set forth in the 
EULA represents the exclusive authority 
by which the U.S. government may use, 
modify, distribute, or disclose the Soft-
ware. The EULA and the license set 
forth therein, does not require or per-
mit, among other things, that Keysight: 
(1) Furnish technical information 
related to commercial computer soft-
ware or commercial computer software 
documentation that is not customarily 
provided to the public; or (2) Relinquish 
to, or otherwise provide, the govern-
ment rights in excess of these rights 
customarily provided to the public to 
use, modify, reproduce, release, per-
form, display, or disclose commercial 
computer software or commercial com-
puter software documentation. No 
additional government requirements 
beyond those set forth in the EULA 
shall apply, except to the extent that 
those terms, rights, or licenses are 
explicitly required from all providers of 
commercial computer software pursu-
ant to the FAR and the DFARS and are 
set forth specifically in writing else-
where in the EULA. Keysight shall be 
under no obligation to update, revise or 
otherwise modify the Software. With 
respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 
227.7102, the U.S. government 
acquires no greater than Limited Rights 
as defined in FAR 27.401 or DFAR 
227.7103-5 (c), as applicable in any 
technical data.

Warranty
THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED “AS IS,” 
AND IS SUBJECT TO BEING 
CHANGED, WITHOUT NOTICE, IN 
FUTURE EDITIONS. FURTHER, TO THE 
MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DIS-
CLAIMS ALL WARRANTIES, EITHER 
EXPRESS OR IMPLIED, WITH REGARD 
TO THIS MANUAL AND ANY INFORMA-
TION CONTAINED HEREIN, INCLUD-
ING BUT NOT LIMITED TO THE 
IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. KEYSIGHT 
SHALL NOT BE LIABLE FOR ERRORS 
OR FOR INCIDENTAL OR CONSE-
QUENTIAL DAMAGES IN CONNECTION 
WITH THE FURNISHING, USE, OR 
PERFORMANCE OF THIS DOCUMENT 
OR OF ANY INFORMATION CON-
TAINED HEREIN. SHOULD KEYSIGHT 
AND THE USER HAVE A SEPARATE 
WRITTEN AGREEMENT WITH WAR-
RANTY TERMS COVERING THE MATE-
RIAL IN THIS DOCUMENT THAT 
CONFLICT WITH THESE TERMS, THE 
WARRANTY TERMS IN THE SEPARATE 
AGREEMENT SHALL CONTROL.

Safety Information

CAUTION
A CAUTION notice denotes a hazard. It 
calls attention to an operating proce-
dure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until 
the indicated conditions are fully 
understood and met.

WARNING
A WARNING notice denotes a hazard. It 
calls attention to an operating proce-
dure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in personal injury or death. 
Do not proceed beyond a WARNING 
notice until the indicated conditions are 
fully understood and met.
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Safety Symbols

The following symbols on the instrument and in the documentation indicate precautions 
which must be taken to maintain safe operation of the instrument.

Direct current (DC) Alternating current (AC)

Off (mains supply) On (mains supply)

Caution, risk of electric shock
Caution, risk of danger (refer to this manual
for specific Warning or Caution information)

Earth (ground) terminal Frame or chassis (ground) terminal

Protective earth (ground) terminal
Equipment protected throughout by double
insulation or reinforced insulation
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Safety Considerations

Read the information below before using this instrument. 

The following general safety precautions must be observed during all phases of operation, 
service, and repair of this instrument. Failure to comply with these precautions or with 
specific warnings elsewhere in this manual violates safety standards for design, 
manufacture, and intended use of the instrument. Keysight Technologies assumes no 
liability for the customer’s failure to comply with these requirements.

WARNING
– Do not use the device if it is damaged. Before you use the device, inspect the casing. 

Look for cracks or missing plastic. Do not operate the device around explosive gas, 
vapor, or dust.

– Always use the device with the cables provided.

– Observe all markings on the device before establishing any connection.

– Turn off the device and application system power before connecting to the I/O 
terminals.

– When servicing the device, use only the specified replacement parts.

– Do not operate the device with the cover removed or loosened.

– Use only the power adapter provided by the manufacturer to avoid any unexpected 
hazards.

– This equipment is under measurement category as below: 
DO NOT CONNECT THE CABLE TO MAINS.

 
Maximum working voltage: 200 Vp for altitude up to 3000 m 
Maximum transient voltage: 1210 V

– Do not measure more than the rated voltage (as marked on the device).

CAUTION
– If the device is used in a manner not specified by the manufacturer, the device 

protection may be impaired.

– Always use dry cloth to clean the device. Do not use ethyl alcohol or any other volatile 
liquid to clean the device.

– Clean the case with a soft, lint-free, slightly dampened cloth. Do not use detergent, 
volatile liquids, or chemical solvents.

– Do not permit any blockage of the ventilation holes of the device.
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Environmental Conditions

The U8903B is designed for indoor use and in an area with low condensation. The table 
below shows the general environmental requirements for this instrument.

Environmental condition Requirement

Temperature

Operating condition
– 0 °C to 55 °C
Storage condition
– –40 °C to 70 °C

Humidity

Operating condition
– 95% RH up to 40 °C, decreases linearly to 45% RH at 55 °C 

(non-condensing)[a]

Storage condition
– Up to 95% RH at 40 °C (non-condensing)

[a] From 40 °C to 55 °C, the maximum % Relative Humidity follows the line of constant dew point. 

Altitude Up to 3000 m

Pollution degree 2

Installation category II

Measurement category  CAT (none) 200 Vpk max

Overvoltage protection II

WARNING
DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE OR WET ENVIRONMENTS 
Do not operate the instrument around flammable gases or fumes, vapor, or 
wet environments. 
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Regulatory Information

The U8903B complies with the following safety and Electromagnetic Compatibility (EMC) 
standard:

Safety compliance

– IEC 61010-1/EN 61010-1

– Canada: CAN/CSA-C22.2 No. 61010-1-12

– USA: ANSI/UL Std. No. 61010-1

EMC compliance

– IEC 61326-1/EN61326-1

– Canada: ICES/NMB-001

– Australia/New Zealand: AS/NZS CISPR11

NOTE
Refer to Declaration of Conformity for current revisions. Go to http://
www.keysight.com/go/conformity for more information.
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Regulatory Markings

The CE mark is a registered trademark of the 
European Community. This CE mark shows 
that the product complies with all the relevant 
European Legal Directives.
ICES/NMB-001 indicates that this ISM device 
complies with the Canadian ICES-001.
Cet appareil ISM est conforme a la norme 
NMB-001 du Canada.

The CSA mark is a registered trademark of the 
Canadian Standards Association.

This instrument complies with the WEEE 
Directive (2002/96/EC) marking requirement. 
This affixed product label indicates that you 
must not discard this electrical or electronic 
product in domestic household waste.

The RCM mark is a registered trademark of 
the Australian Communications and Media 
Authority.

This symbol is a South Korean Class A EMC 
Declaration. This is a Class A instrument 
suitable for professional use and in 
electromagnetic environment outside of  
the home.

This symbol indicates the time period during 
which no hazardous or toxic substance 
elements are expected to leak or deteriorate 
during normal use. Forty years is the expected 
useful life of the product.
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Waste Electrical and Electronic Equipment (WEEE) Directive 2002/
96/EC

This instrument complies with the WEEE Directive (2002/96/EC) marking requirement. This 
affixed product label indicates that you must not discard this electrical or electronic 
product in domestic household waste. 

Product category:

With reference to the equipment types in the WEEE directive Annex 1, this instrument is 
classified as a “Monitoring and Control Instrument” product.

The affixed product label is as shown below.

Do not dispose in domestic household waste.

To return this unwanted instrument, contact your nearest Keysight Service Center, or visit 
www.keysight.com/environment/product for more information.

Sales and Technical Support

To contact Keysight for sales and technical support, refer to the support links on the 
following Keysight websites:

– www.keysight.com/find/U8903B  
(product-specific information and support, software and  
documentation updates)

– www.keysight.com/find/assist 
(worldwide contact information for repair and service)
8 Keysight U8903B User’s Guide
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1 Getting Started
Introduction

The U8903B is a digital signal processing (DSP)-based audio measurement system with a 
frequency measurement range of 10 Hz to 96 kHz or 1.5 MHz depending on the installed 
option. The U8903B basic configuration has two channels of analog audio generator and 
two channels of analog audio analyzer.

The standard option for the U8903B performance audio analyzer is Option STD. The 
U8903B can be further expanded with additional analog analyzer channels; digital audio 

interfaces like the AES3, SPDIF, and Digital Serial Interface (DSI); and Bluetooth® audio 
option with source and sink interface. Refer to “U8903B Options” on page 37 for more 
information on the available U8903B options.

The U8903B is capable of performing a wide range of audio parameter measurements on 
the analog, digital, and Bluetooth audio interfaces. Up to four measurement functions can 
be performed simultaneously on the analog audio. Measurement functions can be 
performed simultaneously on the analog audio and digital audio interfaces such as analog 
audio + AES3/SPDIF, analog audio + DSI, and AES3/SPDIF + DSI. The Bluetooth audio 
interface provides the U8903B with Bluetooth link capabilities with support for different 
audio profiles and codecs. The U8903B also supports industrial standard instrument 
connectivity such as GPIB, USB, and LAN. In addition, the U8903B is equipped with 
frequency, phase, time, and FFT graph analysis, as well as sweep capability for frequency 
and amplitude.

The U8903B also allows you to create test sequences. Refer to Chapter 7, "Test Sequence 
Application" for more information.

To search for firmware updates for the U8903B, go to the Keysight U8903B firmware 
update Web site at www.keysight.com/find/audioanalyzer_firmware.

LXI Standard 1.4 Compliant Audio Analyzer

The U8903B performance audio analyzer is a LAN eXtension for 
Instrumentation (LXI) Standard 1.4 compliant (Standard Core) 
instrument, developed using LXI Technology. LXI is an instrument 
standard for devices that use the Ethernet (LAN) as their primary 
communication interface.

Hence, it is an easy-to-use instrument especially with the usage of an integrated Web 
browser that provides a convenient way to configure the instrument’s functionality.
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Getting Started 1
Installation and Configuration

Initial inspection

When you receive your U8903B, inspect the unit for any obvious damage such as broken 
terminals or cracks, dents, and scratches on the chassis that may occur during shipment. If 
any damage is found, notify the nearest Keysight Sales Office immediately.

Keep the original packaging in case the U8903B has to be returned to Keysight in the 
future. If you return the U8903B for service, attach a tag identifying the owner and model 
number. Also, include a brief description of the problem.

Ventilation

The U8903B can operate within the temperature range of 0 °C to 55 °C. The U8903B is 
cooled by drawing air through the sides and bottom at the front of the U8903B, and 
exhausting it through the ventilation holes on the sides and top at the rear of the U8903B. 
The U8903B must be installed in a location that allows sufficient space at the top, sides, 
and rear for adequate air circulation.

Rack mounting

The U8903B can be mounted in a standard 19-inch rack. Rackmount kits are available as 
Option 908. Support rails are also required for rack mounting. These are normally supplied 
with the rack and are not included with the rackmount options.

If you are installing an instrument on top of the U8903B, ensure that the instrument does 
not obstruct the ventilation holes at the top of the U8903B. If required, use a filler panel 
above the U8903B to ensure adequate space for air circulation.
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1 Getting Started
Standard Shipped Items

Verify that you have received the following items. If anything is missing or damaged, please 
contact the nearest Keysight Sales Office.

– U8903B Performance Audio Analyzer

– Power cord

– USB cable

– Certificate of Calibration

– Safety Notices

Optional Accessories

The following accessories are available for purchase separately.

Table 1-1 U8903B optional accessories

Option Description

11500A Cable assembly, Type-N (male) to Type-N (male), DC to 6.0 GHZ

U8903A-101 Male BNC to male BNC cable (1.2 m)

U8903A-102 Male BNC to male RCA cable (2 m)

U8903A-103 Male XLR to female XLR cable (2 m)

U8903A-908 Rackmount kit

U8903B-105 Cable, digital serial interface for DSI input and output connection

U8903A-107 Cable, accessory – Male XLR-2 male BNC analyzer, 0.26 m

U8903A-108 Cable, accessory – Female XLR-2 male BNC generator, 0.26 m

U8903A-109 BNC accessory kit
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U8903B Options

Table 1-2 U8903B options

Option Description

U8903B-STD
– 2 channels (analog generator)
– 2 channels (analog analyzer)

U8903B-AN4
– 2 channels (analog generator)
– 4 channels (analog analyzer)

U8903B-AN8
– 2 channels (analog generator)
– 8 channels (analog analyzer)

U8903B-DGT Digital audio card

U8903B-BLU Bluetooth card with 2 RF connectors.

U8903B-BL2
Bluetooth card with 2 RF connectors at a secondary option slot.
This is only applicable when U8903B-AN8 is selected.

N3431A
Wide bandwidth option - 1.5 MHz (fixed perpetual license).
This is only available for channel 1 and channel 2 analog analyzer.

N3432A Perceptual Objective Listening Quality Analysis (POLQA) measurement software (fixed perpetual license).

N3434A
AES3, SPDIF, and DSI digital audio interfaces (fixed perpetual license).  
This option can only be ordered with U8903B-DGT.
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1 Getting Started
Product at a Glance

Front panel

Figure 1-1 U8903B front panel
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Table 1-3 U8903B front panel description 

Item Description

1 LCD display
Provides information on the current function including status indicators, settings, and error 
messages. Refer to “LCD display” on page 42 for more information.

2 Softkeys 1 to 7 Activates the functions displayed on the LCD display next to the respective softkeys.

3 Navigation and CHANNEL/DATA panels
The navigation and CHANNEL/DATA panels consist of the arrow keys, Enter key, knob, and 
channel/data keys. Refer to “Navigation and CHANNEL/DATA Panels” on page 58 for 
more information.

4 Menu key

Displays the available U8903B mode of operation.
– Standard View
– Test Seq App
– HP8903B

5 FUNCTION panel Enables access to the U8903B main functions.

6 Run control panel

Press On/Off to turn on or off signal generation or measurements for the selected generator 
or analyzer channel respectively.
Press On/Off to start or stop the graph generation.
Press On/Off to start or stop the sweep.
Press On/Off to start or stop the test sequence.
Press Stop All to stop all generator and test sequence operations.
Refer to “RUN CONTROL Panel” on page 93 for more information.

7 GRAPH panel
Enables access to the U8903B commonly used graph functions. Refer to “GRAPH Panel” on 
page 67 for more information.
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8 SYSTEM panel
Enables access to the U8903B system functions. Refer to “SYSTEM Panel” on page 77 for 
more information.

9 Headphone jack
The headphone jack can be operated in stereo or mono mode. Refer to “Input 
Configuration (Analog Analyzer)” on page 248 for more information.

10 USB port Allows an external USB flash storage to be connected to the U8903B.

11 Analog analyzer input
Receives analog audio signal using a female XLR input connector for balanced signal and a 
female BNC input connector for unbalanced signal. The input connectors are available for 
each channel.

12 Analog generator output
Outputs analog audio signal using a male XLR output connector for balanced signal and a 
female BNC output connector for unbalanced signal. The output connectors are available for 
each channel.

13 Power key Turns on or off the U8903B.

Table 1-3 U8903B front panel description (continued)

Item Description
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Rear panel

Figure 1-2 U8903B rear panel

1 2 3 8 9 10

11121317 16

5 6 7

1415

4

Table 1-4 U8903B rear panel description 

Item Description

1 Monitor 1
Outputs a scaled signal of the analog analyzer channels 1, 3, 5, and 7 input signals. The 
scaled signal can then be connected to an external amplifier or other measurement 
instruments.

2 Monitor 2
Outputs a scaled signal of the analog analyzer channels 2, 4, 6, and 8 input signals. The 
scaled signal can then be connected to an external amplifier or other measurement 
instruments.

3 Analog analyzer input (channels 3 and 4)

Expandable up to 6 analog input channels. Refer to “U8903B Options” on page 37.
Receives analog audio signal using a female XLR input connector for balanced input and a 
female BNC input connector for unbalanced input. The input connectors are available for each 
channel.

4 Bluetooth RF ports

For all applicable Bluetooth options, refer to “U8903B Options” on page 37.
Receives and transmits audio signal through the RF1 and RF2 connectors. The RF1 connector 
is the default port and the RF2 port can be selected in the U8903B’s GUI. Only one RF port 
can be used at a time.

5 Digital analyzer input and output (AES3)
This is only applicable for option U8903B-DGT.
Receives and outputs digital audio signal using a female XLR input connector and a male XLR 
output connector respectively.

6 Digital analyzer input and output (SPDIF)
This is only applicable for option U8903B-DGT.
Receives and outputs digital audio signal using a TOSLINK input connector and a TOSLINK 
output connector respectively.

7 Sync in
This is only applicable for option U8903B-DGT.
Receives an external sync in clock/frame signal using a female BNC input connector  
(for digital audio only).

8 LAN port Allows the U8903B to be controlled remotely over the LAN interface.
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Figure 1-3 Connect the TOSLINK cable straight into the connector

9 USB port (type B) Allows the U8903B to be controlled remotely over the USB interface.

10 AC power port Connects to an AC line voltage.

11 VGA port Allows an external monitor to be connected to the U8903B.

12 GPIB port
Allows the U8903B to be controlled remotely over the GPIB (General Purpose Interface Bus) 
interface.

13 USB port Allows an external USB flash storage to be connected to the U8903B.

14 Digital analyzer input and output (AES3/SPDIF)
This is only applicable for option U8903B-DGT.
Receives and outputs digital audio signal using a female BNC input connector and a female 
BNC output connector respectively.

15 Digital analyzer input and output (DSI)
This is only applicable for option U8903B-DGT.
Receives and outputs digital audio signals using a 25-pin female D-SUB connector.

16 AUX port
Outputs a variable DC voltage (0.5 V to 5.1 V, up to 100 mA). The AUX port can be used to 
power test devices, as a trigger, or to control external hardware.

17 Trigger in
Receives an external TTL signal using a female BNC input connector for triggering operation. 
Triggering can occur on either the positive or negative edge.

CAUTION
– Connect the TOSLINK cable straight into the TOSLINK connector.

– DO NOT force the cable in or connect at an angle. Failing to do so may cause damage 
to the TOSLINK connector.

Table 1-4 U8903B rear panel description (continued)

Item Description
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LCD display

Figure 1-4 U8903B LCD display
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Table 1-5 U8903B LCD display description 

Item Description

1 Main display

Displays the available U8903B modes and functions.
– AG1/AG2: Analog generator channel 1 or 2.
– AA#: Analog analyzer channel (1, 2, 3, 4, 5, 6, 7, or 8).
– DG1/DG2: Digital generator channel 1 or 2.
– DA1/DA2: Digital analyzer channel 1 or 2.
– BG1/BG2: Bluetooth generator channel 1 or 2.
– BA1/BA2: Bluetooth analyzer channel 1 or 2.

2 Title bar

– Displays the name of the current active menu in the main display.
– Displays the following icons.

–  LAN connected

–  LAN disconnected

–  LAN conncted with error

–  Bluetooth connected

–  Bluetooth disconnected

–  LXI front panel turned on

–  External USB flash storage connected

–  Shift function

–  Remote control mode

–  Front panel keys locked

–  Help mode

–  Warning

–  Fan(s) malfunctioned

–  Memory buffer

3 Softkeys panel Displays a maximum of 7 softkey menu options for the selected panel.

4 Status bar Displays the status of an action such as information, warning, or error messages.

NOTE
Refer to “Display mode” on page 65 for more information on the U8903B display layout.
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Getting Started

Power on the U8903B

Connect one end of the power cord to the U8903B rear panel AC power inlet and the other 
end to an AC voltage source. The U8903B will automatically adjust to the correct line 
voltage in the range of 100 VAC to 240 VAC.

Preset the U8903B

A preset will set the U8903B to a default state. It does not affect the I/O configuration, 
calibration data, system configurations (time, date, model number, and serial number), and 
license information. Refer to “Appendix 19: DSI Input and Output Interface” on page 566 
for more information.

To preset the U8903B, you can perform either one of the following steps.

– Send the *RST, SYSTem:PRESet, SYSTem:PRESet:TYPE, or 
SYSTem:RESet[:MODE] SCPI command from the PC via the USB, GPIB, or  
LAN interface.

– Press  on the SYSTEM panel.

NOTE
For more information on preset, refer to “SYSTEM Panel” on page 77.
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Access the help mode

The U8903B help mode provides you quick access to the operating information by 
displaying the description of all the front panel keys and current softkeys.

To activate or deactivate the U8903B help mode, press  on the  

CHANNEL/DATA panel and  on the SYSTEM panel.

An example of a help mode is shown in Figure 1-5. The help mode icon will appear at the 
top-right of the title bar. Refer to Figure 1-5 for more information on the help mode icon. 
Press the front panel keys or the current menu page softkeys to display the respective 
information.

Figure 1-5 Help mode

NOTE
When the U8903B help mode is activated, the front panel keys will not execute their 
normal functions when pressed.
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Update the U8903B

The U8903B firmware update file can be obtained from the Keysight U8903B firmware 
update website at www.keysight.com/find/audioanalyzer_firmware.

Perform the following procedure to update the U8903B firmware.

1 Save the firmware update files in an external USB flash storage.

2 Connect the external USB flash storage to the U8903B.

3 Press  on the SYSTEM panel.

4 From the System menu page, press the Update softkey. The Update menu page is 
displayed as shown in Figure 1-6.

Figure 1-6 System > Update menu page

5 Press the Load File softkey and the recall menu page is displayed to enable you to select 
the source location.

6 Select the firmware file to be updated, and press the Recall softkey as shown in 
Figure 1-7. Refer to “Recall” on page 95 for more information on the Recall menu page.

Table 1-6 System > Update menu page 

Menu Description

Load File Press the Load File softkey to load the update files. The Recall menu page will be displayed to select the source location. 
Refer to “Recall” on page 95 for more information on the Recall menu page.

EULA Press the EULA softkey to display the U8903B EULA (End User License Agreement) page.
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Figure 1-7 Recall menu page

NOTE
The System menu page is only available in the Standard mode. Refer to “Menu Key” on 
page 60 for more information on the U8903B available modes.

CAUTION
The firmware update process may take 20 minutes to 40 minutes to complete.  
DO NOT power off the U8903B during the firmware update process.
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Perform self-test

Perform the following procedure to run the U8903B self-test.

1 Press  on the SYSTEM panel.

2 From the System menu page, press the Service softkey.

3 From the Service menu page, press the Self-Test softkey. The Self-Test menu page is 
displayed as shown in Figure 1-8.

4 Press the Customize Test softkey to select the desired tests.

5 Press the Run Test softkey to run the slected tests.

Figure 1-8 System > Service > Self-Test menu page

Table 1-7 System > Service > Self-Test menu page

Menu Description

Customize Test
Press the Customize softkey to select or deselect the desired tests.
– LAN Test
– Card Self Test

Run Test Press the Run Test softkey to run the selected tests. 

Clear Result Press the Clear Result softkey to clear the previous self-test results. The self-test results are saved in the system memory.

NOTE
The System menu page is only available in the Standard mode. Refer to “Menu Key” on 
page 60 for more information on the U8903B available modes.
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Add or remove U8903B options

Perform the following procedure to add U8903B options.

1 Press  on the SYSTEM panel.

2 From the System menu page, press the Service softkey.

3 From the Service menu page, press the Options softkey. The Options menu page is 
displayed as shown in Figure 1-9.

Figure 1-9 System > Service > Options menu page

4 Press the Add option softkey, and the Recall menu page is displayed to enable you to 
select the U8903B option file.

5 Select the U8903B option file to be loaded, and press the Recall softkey as shown in 
Figure 1-10.

Table 1-8 System > Service > Options menu page 

Menu Description

Add Option Press the Add Option softkey to load the U8903B option file. The Recall menu page will be displayed to select the  
source location.

Remove Option Press the Remove Option softkey to remove the selected U8903B option.
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Figure 1-10 Recall menu page

Perform the following procedure to remove U8903B options.

1 Select the U8903B option to be removed from the list.

2 Press the Remove Option softkey to remove the U8903B option as shown in Figure 1-9.

NOTE
Restart the U8903B after adding a new U8903B option file.

NOTE
The System menu page is only available in the Standard mode. Refer to “Menu Key” on 
page 60 for more information on the U8903B available modes.
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2 Operation and Features
Test Capabilities

The U8903B is capable of testing a broad range of audio-related devices and components 
for research and development, manufacturing, and quality assurance applications. 
Examples of the products that can be tested are listed follows.

– Multichannel home theater systems

– Audio amplifiers, as a complete product or at the component level

– Portable audio playback devices such as MP3 players

– Speakers (require third-party accessories such as microphones and power amplifiers)

– PC audio cards

– Audio components

– Bluetooth audio devices

The U8903B performs the following two basic functions.

– Audio signal generation

– Audio signal analysis

The U8903B basic configuration has two channels of analog generator and two channels of 
analog analyzer which enables the U8903B to test devices with stereo capability. The 
U8903B is also able to generate and analyze digital and Bluetooth audio interfaces with 
the available options as listed in “U8903B Options” on page 37.
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U8903B Block Diagram

Analog audio interface

Signal generation

A simplified U8903B analog generator block diagram is shown as follows.

Figure 2-1 U8903B analog generator block diagram

The digital signal processing (DSP) generates all the required waveforms, except for square 
wave, digitally. The digital waveform data is streamed realtime into the 24-bit 
digital-to-analog converter (DAC) where it is converted to voltage and sent to the output 
conditioning block to be amplified or attenuated to the required amplitude. Finally, the 
waveform is routed through either the balanced (XLR) or unbalanced (BNC) output signal 
connectors to the unit-under-test (UUT). The output can also be fully floating or have the 
output grounded to the instrument ground. There is also a loopback facility where the 
analog generator can be connected onto the systems internal analog bus and routed to the 
analog analyzer.

ANALOG GENERATOR

DAC FILTER RANGING

ISOLATED GROUND

LOOPBACK

BNC

XLR
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Measurement

A simplified U8903B analog analyzer block diagram is shown as follows.

Figure 2-2 U8903B analog analyzer block diagram

An audio signal can enter the analog analyzer through either the balanced (XLR) or 
unbalanced (BNC) input signal connector. There is also a loopback facility where the 
analog generator can be connected onto the systems internal analog bus and routed to the 
analog analyzer.

From the input connector, the signal passes through the AC/DC coupling circuit. If AC 
coupling is selected, the DC component is blocked and only the AC component of the 
signal passes through. However, if DC coupling is selected, the entire signal  
passes through.

The attenuators, buffer, gain, and common mode rejection (CMR) conditions the signal to 
as close to the full scale of the analog-to-digital converter (ADC) as possible, optimizing 
the measurement dynamic range.

There are two separate ADCs in the analog analyzer. The low bandwidth ADC is designed 
for best performance in the audio bandwidth and beyond. The high bandwidth ADC is 
designed to give high resolution measurements up to 1.5 MHz.

The default input impedance is 100 kΩ for unbalanced signals or 200 kΩ for balanced 
signals. Terminations of 600 Ω or 300 Ω can also be applied. The 600 Ω termination can 
tolerate up to 1.5 W and the 300 Ω termination can tolerate up to 3 W.
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ADCFILTERRANGING
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BNC
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54 Keysight U8903B User’s Guide



Operation and Features 2
Digital audio interface

A simplified U8903B digital audio interface block diagram is shown as follows.

Figure 2-3 U8903B digital generator and analyzer block diagram

Signal generation

The digital generator generates all the required waveforms digitally. The digital waveform 
data is then streamed to the serial audio transmitter for the DSI output, or to the AES 
transmitter for the balanced, unbalanced, and optical output. Finally, the waveform is 
routed through the balanced (XLR), unbalanced (BNC), optical (TOSLINK), or digital serial 
interface (DSI) output signal connectors to the device under test (DUT).

Measurement

A digital audio signal can enter the digital analyzer through the balanced (XLR), 
unbalanced (BNC), optical (TOSLINK), or digital serial interface (DSI) input signal 
connector. For balanced, unbalanced, and optical input, the audio signal then passes 
through the AES receiver. For DSI input, the audio signal then passes through serial audio 
receiver. The audio signal is sent to the digital analyzer. Inside the digital analyzer, the 
digital signal can be optionally passed through a combination of up to five digital filters, 
one each from the low pass, high pass, weighting, deemphasis, and sample rate filter 
groups before sending it to the measurement section.

AES

Serial audio

DIGITAL GENERATOR
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Serial audio

DIGITAL ANALYZER

Serial audio

AES

25-pin female D-SUB connector

BNC
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BNC
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Bluetooth audio interface

A simplified U8903B Bluetooth audio interface block diagram is shown as follows.

Figure 2-4 U8903B Bluetooth generator and analyzer block diagram

Signal generation

The digital signal processing (DSP) generates all the required waveforms digitally. The 
digital waveform data is then streamed to the U8903B Bluetooth module in which the 
audio will be encoded and converted to the RF interface. Finally, the waveform is 
transmitted to the Bluetooth audio devices through the RF1 connector. The RF1 connector 
is the default port and the RF2 port can be selected in the U8903B’s GUI.

Measurement

The audio signal enters the Bluetooth analyzer through the RF1 connector. The audio 
signal then passes through the U8903B Bluetooth module in which the audio will be 
decoded and converted to the digital interface and sent to the Bluetooth analyzer. Inside 
the Bluetooth analyzer, the digital signal can be optionally passed through a combination 
of up to five digital filters, one each from the low pass, high pass, weighting, deemphasis, 
and sample rate filter groups before sending it to the measurement section.
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Bluetooth audio connection examples

An example of a direct U8903B Bluetooth audio connection to DUT using an RF cable is 
shown as follows.

Figure 2-5 Direct U8903B Bluetooth audio connection to DUT example

An example of a wireless U8903B Bluetooth audio connection using an antenna is shown as 
follows.

Figure 2-6 Wireless U8903B Bluetooth audio connection to DUT example

DUT

RF cable

RF cable
DUT

Shielded chamber

Link antenna

CAUTION
Over the air testing shall be conducted in a shielded chamber.
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Navigation and CHANNEL/DATA Panels

The navigation and CHANNEL/DATA panels are used to navigate and set or modify the 
parameter values.

Figure 2-7 Navigation and CHANNEL/DATA panels
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Table 2-1 Navigation and CHANNEL/DATA panels description 

Item Description

1 Knob
Rotate the knob to increase or decrease a numeric value, change a highlighted digit or character, or step through 
lists or items in a row.

2 Arrow keys
Use the arrow keys to highlight or navigate the editable items on the LCD display for editing. In HP8903B mode, 
press the up and down arrow keys to increment/decrement the frequency and amplitude values.

3 Enter key Press  to confirm an entry.

4 Numeric keys

Use the numeric keys to enter alphanumeric data by using the number keys and decimal point, or select the 
channel number.

In DTMF single mode, press  to generate the ‘*’ DTMF tone.
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5 Numeric sign key

Press  to specify a positive or negative value. For a negative value, press  to enter the 

negative sign before a numeric value.

In DTMF single mode, press  to generate the ‘#’ DTMF tone.

6 Shift key Press  prior to pressing a shifted function key. The shifted functions are printed in Blue on top of the 

front panel keys. Refer to “GRAPH Panel” on page 67 and “SYSTEM Panel” on page 77 for more information.

7 Escape key Press  to cancel a selected action.

8 Back space key Press  to delete the character to the left of the cursor.

Table 2-1 Navigation and CHANNEL/DATA panels description (continued)

Item Description
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Menu Key

Press  to display the list of available U8903B main modes of operation. Select the 

desired mode from the drop-down list as shown in Figure 2-8.

Figure 2-8 U8903B mode selection

The U8903B modes are listed as follows.

Table 2-2 U8903B modes description 

Mode Description

Standard View The Standard View mode is the default mode for the U8903B. Refer to “Standard View” on page 61 for more information.

Test Seq App Refer to “Test Sequence Application (Test Seq App)” on page 62 for more information.

HP8903B Refer to “HP8903B” on page 62 for more information.
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Standard View

Press  and select Standard View to access the standard view menu page. In the 

standard view, you can perform signal analysis, graph analysis, sweep function, and system 
configurations. The Standard View mode is the default mode for the U8903B.

Signal analysis

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode. Refer to Chapter 3, “Audio Generator Functions” and Chapter 4, “Audio Analyzer 
Measurement Functions” for more information on the respective configurations.

Graph analysis

Press  on the FUNCTION panel to access the graph analysis mode. Refer to 

Chapter 5, “Graph Analysis” for more information on the graph analysis mode 
configurations.

Sweep function

Press  on the FUNCTION panel to access the U8903B sweep parameter and the 

configurations. Refer to Chapter 6, “Sweep Function” for more information on the sweep 
configurations.

System configurations

Press  on the SYSTEM panel to access the U8903B system configurations. You can 
view the error messages, configure I/O settings, update the U8903B, perform self-tests, 
configure the U8903B settings, configure the HP8903B mode settings, and others. Refer to 
“System” on page 82 for more information on the system configurations.
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Test Sequence Application (Test Seq App)

Press  and select Test Seq App to access the test sequence application mode. The 

test sequence application mode allows you to perform a series of automated 
measurements. Refer to Chapter 7, “Test Sequence Application” for more information.

HP8903B

Press  and select HP8903B to access the HP8903B mode. The HP8903B mode 

emulates the HP8903B audio analyzer behavior. Refer to Chapter 8, “HP8903B” for more 
information.
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FUNCTION Panel

The FUNCTION panel provides quick access to the U8903B main functions.

Table 2-3 FUNCTION panel description 

FUNCTION panel Key Description

Interface Press  to switch between the analog, digital, or Bluetooth 

interface.

Generator|Analyzer
Press  to switch between the generator or analyzer mode.

Refer to Chapter 3, “Audio Generator Functions” and Chapter 4, 
“Audio Analyzer Measurement Functions” for more information.

Graph Press  to access the graph analysis mode.

Refer to Chapter 5, “Graph Analysis” for more information.

Sweep Press  to access the sweep function mode.

Refer to Chapter 6, “Sweep Function” for more information.

Full Screen
Press  to maximize the graph view to the full display size.

This function is only applicable in the graph analysis mode. Refer to 
“Full screen” on page 64 for more information.

Display

Press  to switch among the 2-panel view, 4-panel view, or 

10-panel view in the analyzer and generator mode. 

Press  to switch between the single panel view and 2-panel 

view in the graph analysis mode.
Refer to “Display mode” on page 65 for more information.

Shortcut 1 Customizable shortcut key. Refer to Table 2-20 for more information.

Shortcut 2 Customizable shortcut key. Refer to Table 2-20 for more information.
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Full screen

The full screen graph display is displayed as shown in Figure 2-9. To exit from the full 

screen graph display, press .

Figure 2-9 Full screen graph display

NOTE
The full screen function is only available in the graph analysis mode.
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Display mode

The U8903B allows you to display up to ten panels on the main display in the analyzer and 
generator mode.

Figure 2-10 4-panel view

Figure 2-11 10-panel view
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The U8903B allows you to display up to two panels on the main display in the graph 
analysis mode.

Figure 2-12 Graph analysis mode 2-panel view
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GRAPH Panel

The graph panel provides quick access to the commonly used graph functions. Refer to 
Chapter 5, “Graph Analysis” for more information on the graph analysis mode.

NOTE Some keys have a shifted function printed above the keys. Press  on the CHANNEL/

DATA panel before pressing the desired key with the shifted function.

Table 2-4 GRAPH panel description 

GRAPH panel Key Description

Peak Search

Press  to display the peak search menu page, and place the 

selected marker on the trace point at the maximum Y-axis value for 
the marker trace. Refer to “Peak Search” on page 68 for more 
information.

Marker

Press  to access the marker softkeys that select the current 
and reference markers and turns them on and off.
You may also move the markers, display the marker measurement 
data, and display the section of the graph based on the selected 
marker position.
Refer to “Marker” on page 70 for more information.

Print  
(Shift + Marker)

Press  and  to print the current display to a file. 

Refer to “Save” on page 94 for more information.

Scale
Press  to perform autoscaling to automatically scale the 

display according to the signal, or to autoscale the X-axis or Y-axis. 
Refer to “Scale” on page 74 for more information.

Zoom Press  to magnify a section of the graph. Refer to “Zoom” 
on page 75 for more information.

Edit Zoom 
(Shift + Zoom)

Press  and  to configure the section of the graph 

to be magnified. Refer to “Edit zoom” on page 76 for more 
information.
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Peak Search

The Peak Search menu page allows you to define a specific threshold to determine which 
signals can be considered peaks, excluding the unwanted signals from the search. A peak 
can only qualify as a peak if there is a rising slope before the point and falling slope after 
the point. A minimum can only qualify as a minimum if there is a falling slope before the 
point and rising slope after the point.

Figure 2-13 Peak Search menu page

NOTE
The Peak Search menu page is only available in the graph analysis mode.

Table 2-5 Peak Search menu description 

Menu Description

Max Peak Press the Max Peak softkey to search and move the active marker to the highest peak which is higher than the peak 
threshold value. If the active maker is off, the marker will be turned on before performing the maximum peak operation.

Next Peak Press the Next Peak softkey to search and move the active marker to the next peak which is higher than the peak threshold 
value. If the active maker is off, the marker will be turned on before performing the next peak operation.

Prev Peak Press the Prev Peak softkey to search and move the active marker to the previous peak which is higher than the peak 
threshold value. If the active maker is off, the marker will be turned on before performing the previous peak operation.

Next Min Press the Next Min softkey to search and move the active marker to the previous peak which is lower than the minimum 
threshold value. If the active maker is off, the marker will be turned on before performing the next minimum operation.

Prev Min Press the Prev Min softkey to search and move the active marker to the next peak which is lower than the minimum 
threshold value. If the active maker is off, the marker will be turned on before performing the previous minimum operation.

Threshold Press the Threshold softkey to configure the peak search setting. Refer to “Threshold” on page 69 for more information.
68 Keysight U8903B User’s Guide



Operation and Features 2
Threshold

Figure 2-14 Peak Search > Threshold menu page

Table 2-6 Peak Search > Threshold menu description

Menu Description

Line Visible

Press the Line Visible softkey to enable or disable the threshold line in the graph. The threshold line helps to determine the 
peak and minimum threshold.
– Peak threshold (green line)
– Minimum threshold (orange line)

Peak Thres Press the Peak Thres softkey to set the peak threshold value. A peak has to be higher than the peak threshold value in 
order to be taken into consideration when a peak search is performed.

Min Thres Press the Min Thres softkey to set the minimum threshold value. A minimum has to be lower than the minimum threshold 
value in order to be taken into consideration when a minimum search is performed.
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Marker

The Marker menu page allows you to place a marker on the graph. A marker can be placed 
on a trace to allow the value of the trace at the marker point to be determined precisely. A 
total of up to 8 markers can be placed in the graph. You can also press the numeric keys (1 
to 8) once to switch among the active markers, and press the numeric keys (1 to 8) twice to 
toggle the state of the selected marker.

Figure 2-15 Marker menu page 1

NOTE
The Marker menu page is only available in the graph analysis mode.

Table 2-7 Marker menu description 

Menu Description

Active Marker Press the Active Marker softkey to select the active marker number. The active marker is displayed in green, and the other 
markers are displayed in white. The active marker reference marker is displayed in red.

State Press the State softkey to enable or disable the active marker.

Trace Press the Trace softkey to select the trace number for the active marker.

Ref Mkr

Press the Ref Mkr softkey to select the reference marker number. The reference marker has to be specified to perform the 
delta marker calculations in the marker table.
– OFF
– M1 to M8
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Movement

Press the Movement softkey to select the marker movement type.
– Single 

The active marker will move depending on the speed and direction of the knob being turned.
– Pair 

The active marker will move with the reference marker.
– Bin 

The active marker will move to the next/previous bin or pixel regardless of the speed of the knob.
– Peak 

The active marker will move from peak to peak. This behavior is affected by the peak threshold settings.
– Harmonic 

The active marker will move from harmonic to harmonic. This setting is only useful if the display option is changed to 
Harmonics.

Function

Press the Function softkey to select the marker function type.
– None 

No marker function type is specified.
– Slope 

The slope of the current marker. The beginning point and end point taken into account for the calculation is from the 
previous and subsequent point of the marker.

– PSD 
The total power contained in each of the frequency bins in the band, and then dividing the result by the “effective 
bandwidth”.

Marker -> Press the Marker -> softkey to perform automatic adjustment of the graph left and right values in reference to the current 
marker location. Refer to “Marker ->” on page 72 for more information.

Harmonics Press the Harmonics softkey to place the markers on the harmonic values.  
Refer to “Harmonics” on page 73 for more information.

Rdg at Mkr
Press the Rdg at Mkr softkey to enable or disable the readings at the marker. 
You can choose to have the active marker readings to be at the top left corner of the graph, or at the marker location itself. 
When marker table is enabled, the marker readings at the marker location are automatically hidden.

Table 2-7 Marker menu description (continued)

Menu Description
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Marker ->

The Marker -> menu page allows you to perform automatic adjustment of the graph left 
and right values in reference to the current marker location.

Figure 2-16 Marker > Marker - menu page

Table 2-8 Marker > Marker - menu description

Menu Description

-> Start Press the -> Start softkey to set the left value of the graph to the current marker location. The span is retained so the right 
value of the graph may be changed.

-> Stop Press the -> Stop softkey to set the right value of the graph to the current marker location. The span is retained so the left 
value of the graph may be changed.

-> Center Press the -> Center softkey to set the center value of the graph to the current marker location. The span is retained so the 
left and right values of the graph may be changed.

-> Delta Press the -> Delta softkey to set the left and right values of the graph to the current marker and the reference  
marker location. 

Move to 3 dB Press the Move to 3 dB softkey to place the marker on the nearest –3 dB value data point.

Move to 6 dB Press the Move to 6 dB softkey to place the marker on the nearest –6 dB value data point.
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Harmonics

The Harmonics menu page allows you to place the markers on the harmonic values. The 
graph display option have to be in harmonic display view. All the markers will be used and 
placed in the selected trace.

Figure 2-17 Marker > Harmonics menu page

Table 2-9 Marker > Harmonics menu description

Menu Description

Trace Press the Trace softkey to set the trace number to place the marker.

Enabled Press the Enabled softkey to show or hide the markers.
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Scale

The Scale menu page allows you to perform autoscaling to automatically scale the display 
according to the signal, or to autoscale the X-axis or Y-axis. 

Figure 2-18 Scale menu page

NOTE
The Scale menu page is only available in the graph analysis mode.

Table 2-10 Scale menu description

Menu Description

AutoScale Press the AutoScale softkey to perform autoscaling on the X-axis and Y-axis.

AutoScale X Press the AutoScale X softkey to perform autoscaling on the X-axis by searching for the most optimum scale (left and right 
values) for the X-axis based on the data being displayed in the graph.

AutoScale Y Press the AutoScale Y softkey to perform autoscaling on the Y-axis by searching for the most optimum scale (top and 
bottom values) for the Y-axis based on the data being displayed in the graph.
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Zoom

The U8903B screen is split into two windows in the zoom view. The top window is a normal 
graph window, and the bottom window displays a magnified representation of the traces in 
the top window. The data in the bottom window will be more detailed due to the screen 
resolution difference between both windows. The magnified region is indicated by the 
region surrounded by the red border in the top window.

The magnified graph display is displayed as shown in Figure 2-19.

Figure 2-19 Magnified graph display

NOTE
The zoom view is only available in the graph analysis mode.
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Edit zoom

To display the edit zoom mode in the zoom view, press  on the CHANNEL/DATA 

panel and  on the GRAPH panel. Press the up or down arrow key to modify the 

stepping value and use the left and right arrow keys to move the red border region in the 
top window. To resize the red border region in the top window, rotate the knob.

The edit zoom mode is displayed as shown in Figure 2-20.

Figure 2-20 Edit zoom mode display

To exit the edit zoom mode, press  on the CHANNEL/DATA panel and  on the 

GRAPH panel.

To exit the zoom view, press  on the GRAPH panel.
76 Keysight U8903B User’s Guide



Operation and Features 2
SYSTEM Panel

The SYSTEM panel provides access to some useful system functions.

NOTE Some keys have a shifted function printed above the keys. Press  on the CHANNEL/

DATA panel before pressing the desired key with the shifted function.

Table 2-11 SYSTEM panel description 

SYSTEM panel Key Description

Preset Press  to display the Preset menu page. Refer to “Preset” 

on page 78 for more information.

Utility Press  to display the Utility menu page. Refer to “Utility” 
on page 79 for more information.

Help 
(Shift + Utility)

Press  and  to display the help mode page. Refer 

to “Access the help mode” on page 45 for more information.

System Press  to display the System menu page. Refer to “System” 
on page 82 for more information.

Macro 
(Shift + System) Reserved for future expansion.

Local Press  to switch from remote control mode to local mode. 
The front panel keys are locked in the remote mode. Refer to  
Table 1-5 for more information on the remote control icon.

Lock/Unlock Press  to lock or unlock the front panel keys in the local 
mode. A dialog box will pop-up for confirmation. Refer to Table 1-5 
for more information on the front panel keys locked icon.
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Preset

A preset will set the U8903B to a default state. It does not affect the I/O configuration, 
calibration data, system configurations (time, date, model number, and serial number), and 
license information.

Figure 2-21 Preset menu page

NOTE
The Preset menu page is only available in the Standard View mode. Refer to “Menu Key” on 
page 60 for more information.

Table 2-12 Preset menu description 

Menu Description

(Current mode)

Press the (Current mode) softkey to reset the current mode to its default settings. For example, resetting the analog 
generator will only reset all the generator settings while other modes settings remain unchanged.
– Analog Analyzer 

Resetting the analog analyzer will also reset the analog generator loopback connector.
– Analog Generator 

Resetting the analog generator will not reset the analog generator loopback connector.
– Graph Analysis

Save User State Press the Save User State softkey to save the current user state.

Mode Press the Mode softkey to reset all modes to the default settings without deleting the user-defined files. All running 
operations such as auto query, sweep, and test sequence will be aborted.

To Factory Settings
Press the To Factory Settings softkey to reset the U8903B to the factory default settings, delete all the files saved in the 
internal flash memory (for example, state file, arbitrary waveform, test sequence project files, and so on), and reset the GUI 
state to the Standard View mode. If the HP8903B mode is turned on, the GUI state will remain at the HP8903B mode.

User State Press the User State softkey to reset the U8903B to the previously saved user state.
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Utility

The Utility menu page allows you to save the U8903B state to a file, or recall the U8903B 
state from a file.

For the generator and analyzer mode, the Utility menu page is displayed as shown in 
Figure 2-22.

Figure 2-22 Utility menu page (generator and analyzer mode)

NOTE
The Utility menu page is only available in the Standard View mode. Refer to “Menu Key” on 
page 60 for more information.

Table 2-13 Utility menu description (generator and analyzer mode) 

Menu Description

Save Channel (x)
(x) = current channel 
number

Press the Save Channel (x) softkey to save the current channel state to a file. Refer to “Save” on page 94 for more 
information on the Save menu page.

Save (x)
(x) = current mode

Press the Save (x) softkey to save the current mode state to a file. Refer to “Save” on page 94 for more information on the 
Save menu page.

Recall Press the Recall softkey to recall a saved U8903B state from a file. Refer to “Recall” on page 95 for more information on 
the Recall menu page.

Copy To Press the Copy To softkey to copy the current channel state to other channel(s).

Copy From Press the Copy From softkey to copy other channel state to the current channel.

File Explorer Press the File Explorer softkey to access the file explorer menu. Refer to “File Explorer” on page 81.
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For the graph analysis mode, the Utility menu page is displayed as shown in Figure 2-23.

Figure 2-23 Utility menu page (graph analysis mode)

Table 2-14 Utility menu description (graph analysis mode) 

Menu Description

Save Graph Press the Save Graph softkey to save the current graph state to a file. Refer to “Save” on page 94 for more information on 
the Save menu page.

Save Channels Settings Press the Save Channels Settings softkey to save the current channel graph state or all channels graph state to a file. 
Refer to “Save” on page 94 for more information on the Save menu page.

Save Traces Press the Save Traces softkey to save the current trace state, all traces state, axis settings state, all traces and axis settings 
states, or the current trace data to a file. Refer to “Save” on page 94 for more information on the Save menu page.

Recall Press the Recall softkey to load a trace from a CSV file into the active trace. Refer to “Recall” on page 95 for more 
information on the Recall menu page.

Copy To Press the Copy To softkey to copy the current channel graph state to other channel(s).

Copy Graph From Press the Copy Graph From softkey to copy other channel graph state to the current channel.

File Explorer Press the File Explorer softkey to access the file explorer menu. Refer to “File Explorer” on page 81.
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File Explorer

File explorer allows you to rename, delete, copy, or move files from the U8903B’s internal 
storage or an external flash drive.

Figure 2-24 File Explorer menu page 

Table 2-15 File Explorer menu description 

Menu Description

Select Press the Select softkey to select the folder to browse in the file explorer mode.

Type Press the Type softkey to select the file type to be displayed on the current directory and to be saved into.

Rename Press the Rename softkey to rename the selected file in the current directory.

Copy or Move Press the Copy or Move softkey to copy or move the marked files to the selected folder.

Delete Press the Delete softkey to delete the selected file in the current directory.

New Folder Press the New Folder softkey to create a new folder in the current directory.
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System

The System menu page allows you to view error messages, configure I/O settings, update 
the U8903B, perform self-tests, configure the U8903B settings, configure the HP8903B 
mode settings, and others.

Figure 2-25 System menu page 1

NOTE
– The System menu page is only available in the Standard View mode. Refer to “Menu 

Key” on page 60 for more information.

– Pressing  in the System menu page will bring up the File Explorer menu.
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Error Info

Press the Error Info softkey to display the Error Info menu page. The error messages will be 
listed in the error log viewing panel. The error messages are displayed in decending order 
where the latest error message is displayed at the top most of the list.

Figure 2-26 System > Error Info menu page (Error) 

Table 2-16 Error Info menu description

Menu Description

Load File
Press the Load File softkey to select the log file to be loaded in the error log viewing panel. The latest log file name is 
EventLog_CE.xml. The older log files are named as EventLog_CE.<yyyyMMdd>_n.xml, where yyyy = 
year, MM = month, dd = day, and n = version. The U8903B will keep the log files up to seven days.
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I/O

Press the I/O softkey to display the I/O menu page.

Figure 2-27 System > I/O menu page 

Table 2-17 I/O menu description 

Menu Description

Lan Settings Press the Lan Settings softkey to configure the LAN settings. Refer to Table 2-18 for more information.

GPIB Press the GPIB softkey to set the desired GPIB address.

FTP Press the FTP softkey to enable or disable the FTP control.
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In the Lan Settings menu page, you can reset the LAN, change the hostname, and switch 
between automatic or manual configuration mode as shown in Figure 2-28.

Figure 2-28 System > I/O > Lan Settings menu page 1

Update

Refer to “Update the U8903B” on page 46.

Table 2-18 System > I/O > Lan Settings menu description 

Menu Description

Reset Press the Reset softkey to reset the LAN settings.

Hostname Press the Hostname softkey to set the LAN hostname.

Config Mode
Press the Config Mode softkey to select the LAN configuration mode.
– Auto
– Manual

IP Address
Press the IP Address softkey to set the LAN IP address. 
This setting  is only available when the LAN configuration mode is set to Manual.

Subnet mask
Press the Subnet mask softkey to set the LAN subnet mask address. 
This setting  is only available when the LAN configuration mode is set to Manual.

Gateway
Press the Gateway softkey to set the LAN gateway address. 
This setting  is only available when the LAN configuration mode is set to Manual.

DNS 1
Press the DNS 1 softkey to set the LAN DNS 1 address. 
This setting  is only available when the LAN configuration mode is set to Manual.

DNS 2
Press the DNS 2 softkey to set the LAN DNS 2 address. 
This setting  is only available when the LAN configuration mode is set to Manual.
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Service

Press the Service softkey to display the Service menu page.

Figure 2-29 System > Service menu page

Table 2-19 System > Service menu description

Menu Description

Self-Test Press the Self-Test softkey to perform self-test. Refer to “Perform self-test” on page 48 for more information.

Diagnostic Press the Diagnostic softkey to perform the front panel or display diagnostics test.

Secure Erase Press the Secure Erase softkey to securely erase all the files saved in the internal flash memory (for example, state file, 
arbitrary waveform, test sequence project files, and so on). It does not affect the U8903B settings and license information.

Options Press the Options softkey to display the installed U8903B options. You may also add or remove the U8903B options from 
the Options menu page. Refer to “Add or remove U8903B options” on page 49 for more information.

Residual Noise Press the Residual Noise softkey to measure the residual noise and get the result.
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Settings

Press the Settings softkey to display the Settings menu page.

Figure 2-30 System > Settings menu page 1

Table 2-20 System > Settings menu description 

Menu Description

Date Press the Date softkey to edit the date in dd/mm/yyyy format.

Time Press the Time softkey to edit the current time in 24-hour format.

Brightness Press the Brightness softkey to adjust the LCD display brightness value.

Key Sound Press the Key Sound softkey to enable or disable the front panel key sound.

Power Up State

Press the Power Up State softkey to select the power up state.
– Last 

The U8903B will start up with the last saved settings.
– Default 

The U8903B will start up with the factory default settings.
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Shortcut 1

Press the Shortcut 1 softkey to select a specific function to map the shortcut 1 key.
– Error List 

Display the last 30 errors, warnings, or messages logged.
– Auto-Scale 

Automatically scale the graph display.
– File Explorer 

Launch the file explorer.
– Audio Monitor 

Enable of disable the aux audio monitor.
– Audio Volume 

Adjust the aux audio volume by using the up and down arrow keys or the knob.  
This is only available if the Audio Monitor is enabled.

Shortcut 2

Press the Shortcut 2 softkey to select a specific function to map the shortcut 2 key.
– Error List 

Display the last 30 errors, warnings, or messages logged.
– Auto-Scale 

Automatically scale the graph display.
– File Explorer 

Launch the file explorer.
– Audio Monitor 

Enable of disable the aux audio monitor.
– Audio Volume 

Adjust the aux audio volume by using the up and down arrow keys or the knob.  
This is only available if the Audio Monitor is enabled.

Table 2-20 System > Settings menu description (continued)

Menu Description
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HP8903B Config

Press the HP8903B Config softkey to display the HP8903B Config menu page.

Figure 2-31 System > HP8903B Config menu page

NOTE
– The HP8903B configuration settings will not be affected by any reset operation.

– Refer to Chapter 8, “HP8903B” for more information on the HP8903B mode.

Table 2-21 System > HP8903B Config menu description 

Menu Description

Active Channel
Press the Active Channel softkey to select the HP8903B active channel.
– 1
– 2

Left Filter

Press the Left Filter softkey to select the left filter type. The left filter represents the filter on the left side of the HP8903B 
front panel. The HP8903B filter may be different according to the model and the purchased HP8903B option. The default 
left filter is None.
– None
– A-Weighing
– CCIR 1k wtd
– CCIR 2k wtd
– C-Message
– CCITT
– 400 Hz
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Fan & Temperature

Press the Fan & Temperature softkey to display the temperatures of the available cards and 
the speed of the three 80 mm fans in the U8903B. This menu page is for service usage only. 
Refer to the U8903B Service Guide for more information.

Figure 2-32 System > Fan & Temperature menu page

Right Filter

Press the Right Filter softkey to select the right filter type. The right filter represents the filter on the right side of the 
HP8903B front panel. The HP8903B filter may be different according to the model and the purchased HP8903B option. 
The default right filter is None.
– None
– A-Weighing
– CCIR 1k wtd
– CCIR 2k wtd
– C-Message
– CCITT
– 400 Hz

Default LPF

Press the Default LPF softkey to select the default filter for the HP8903B mode. The default filter is 80 kHz.
– None
– 30 kHz
– 80 kHz

Table 2-21 System > HP8903B Config menu description (continued)

Menu Description
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Aux Output

Press the Aux Output softkey to display the Aux Output menu page.

Figure 2-33 System > Aux Output menu page

Table 2-22 System > Aux Output menu description 

Menu Description

Audio Monitor Press the Audio Monitor softkey to enable or disable the auxiliary audio monitor.

Audio Output
Press the Audio Output softkey to select the aux audio output type.
– Speaker
– Phone

Audio Mode

This is only available when Phone is selected as the audio output.
Press the Audio Mode softkey to select the aux audio mode type. 
– Stereo
– Mono

Volume Press the Volume softkey to select the aux audio volume.

DC Output Press the DC Output softkey to set the aux DC output value.
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Board Info

Press the Board Info softkey to display the U8903B available cards information.

Figure 2-34 System > Board Info menu page

Legacy Sweep

Press the Legacy Status softkey to enable or disable the legacy sweep.

When the legacy sweep is enabled, sweep is limited to analog and the sweep channel for 
the analyzer and generator is paired. For example, analog generator channel 1 is measured 
by analog analyzer channel 1.

When legacy sweep is disabled, you can select multiple channels to be swept and the 
channels for generator and analyzer are not required to be paired.
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RUN CONTROL Panel

The RUN CONTROL panel is used to start or stop signal generation, measurements, and 
test sequence operations.

Figure 2-35 RUN CONTROL panel

1 2

Table 2-23 Navigation and CHANNEL/DATA panels description

Key Description

1 On/Off

Press  to start or stop the signal generation or measurements for the selected generator or 

analyzer channel respectively.

Press  to start or stop the graph generation in the graph analysis mode.

Press  to start or stop the sweep in the sweep mode.

Press  to start or stop the test sequence in the test sequence application mode.

2 Stop All
Press  to stop all generator, sweep, and test sequence operations.
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Save and Recall

Save

The Save menu page allows you to save the U8903B state, graph analysis trace settings, 
sweep function points, or screen capture of the current display into a file.

Figure 2-36 Save menu page

Select the ‘...’ item at the list and press  to move up a level from the current folder 

or to another directory. Use the arrow keys to navigate through the files or select the 
desired folder or file.

Table 2-24 Save menu description

Menu Description

Save Press the Save softkey to save the specific function to a file.

Type Press the Type softkey to select the file type to be displayed on the current directory and to be saved into.

Rename Press the Rename softkey to rename the selected file in the current directory.

Copy or Move Press the Copy or Move softkey to copy or move the marked files to the selected folder.

Delete Press the Delete softkey to delete the selected file in the current directory.

New Folder Press the New Folder softkey to create a new folder in the current directory.

NOTE
For the detailed procedure on renaming, copying, moving, and deleting files, please refer to 
“Appendix 27: Procedure to Rename, Copy, Move, and Delete Files” on page 603.
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Recall

The Recall menu page allows you to recall the U8903B state, graph analysis trace settings, 
or sweep function points from a file.

Figure 2-37 Recall menu page

Select the ‘...’ item at the list and press  to move up a level from the current folder 

or to another directory. Use the arrow keys to navigate through the files or select the 
desired folder or file.

Table 2-25 Recall menu description 

Menu Description

Recall Press the Recall softkey to recall the selected file.

Type Press the Type softkey to select the file type to be displayed on the current directory.

Rename Press the Rename softkey to rename the selected file in the current directory.

Copy or Move Press the Copy or Move softkey to copy or move the marked files to the selected folder.

Delete Press the Delete softkey to delete the selected file in the current directory.

New Folder Press the New Folder softkey to create a new folder in the current directory.

NOTE
For the detailed procedure on renaming, copying, moving, and deleting files, please refer to 
“Appendix 27: Procedure to Rename, Copy, Move, and Delete Files” on page 603.
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This chapter describes the U8903B audio generator functions and configurations.
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Audio Generator

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode. The Analog Generator menu page, Digital Generator menu page, and Bluetooth 
Generator menu page are displayed as shown in Figure 3-1, Figure 3-2, and Figure 3-3 
respectively.  

Press  on the FUNCTION panel to switch between the analog, digital, and Bluetooth 

interface.

Press  or  on the CHANNEL/DATA panel to switch to channel 1 or channel 2 

respectively and start configuring the active channel.

Press  on the RUN CONTROL panel to start or stop the signal generation for 

the selected generator channel.

Figure 3-1 Analog Generator menu page

Table 3-1 Analog Generator menu description 

Menu Description

Waveform Press the Waveform softkey to display the list of available analog generator waveform types. Select the desired waveform 
from the drop-down list.

Waveform Config Press the Waveform Config softkey to set the current active waveform configuration such as frequency, amplitude, and 
others. Refer to “Waveform Configuration” on page 102 for more information.

Output Config Press the Output Config softkey to set the output configurations such as the connector type, impedance, and others. Refer 
to “Output Configuration (Analog Generator)” on page 141 for more information.

References Press the References softkey to configure the output references settings that are used in the unit conversion. Refer to 
“References (Analog Generator)” on page 172 for more information.
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Figure 3-2 Digital Generator menu page

Table 3-2 Digital Generator menu description 

Menu Description

Waveform Press the Waveform softkey to display the list of available digital generator waveform types. Select the desired waveform 
from the drop-down list.

Waveform Config Press the Waveform Config softkey to set the current active waveform configuration such as frequency, amplitude, and 
others. Refer to “Waveform Configuration” on page 102 for more information.

Output Config Press the Output Config softkey to set the output configurations such as the connector type, impedance, and others. Refer 
to “Output Configuration (Digital Generator)” on page 143 for more information.

DSI Config Press the DSI Config softkey to set the DSI output configurations such as the format, resolution, and others. Refer to “DSI 
Output Configuration (Digital Generator)” on page 158 for more information.

AES3/SPDIF Press the AES3/SPDIF softkey to set the AES3/SPDIF output configurations such as the level, resolution, and others. Refer 
to “AES3/SPDIF Output Configuration (Digital Generator)” on page 160 for more information.

References Press the References softkey to configure the output references settings that are used in the unit conversion. Refer to 
“References (Digital and Bluetooth Generator)” on page 173 for more information.

Clock Config Press the Clock Config softkey to configure the clock settings.
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Figure 3-3 Bluetooth Generator menu page

Table 3-3 Bluetooth Generator menu description 

Menu Description

Waveform Press the Waveform softkey to display the list of available Bluetooth generator waveform types. Select the desired 
waveform from the drop-down list.

Waveform Config Press the Waveform Config softkey to set the current active waveform configuration such as frequency, amplitude, and 
others. Refer to “Waveform Configuration” on page 102 for more information.

Link Config Press the Link Config softkey to set the link configurations such as device scan, A2DP settings, and others. Refer to “Link 
Configuration (Bluetooth Generator)” on page 147 for more information.

References Press the References softkey to configure the output references settings that are used in the unit conversion. Refer to 
“References (Digital and Bluetooth Generator)” on page 173 for more information.
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Waveform Configuration

Sine waveform

Sine waveform is the most basic and commonly used waveform in audio analysis.

Sine waveform mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for sine waveform is displayed as shown in Figure 3-4, Figure 3-5, 
and Figure 3-6 for the analog, digital, and Bluetooth generator respectively.

Figure 3-4 Analog Generator > Waveform Config menu page (sine waveform)

Figure 3-5 Digital Generator > Waveform Config menu page (sine waveform)
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Figure 3-6 Bluetooth Generator > Waveform Config menu page (sine waveform)

Table 3-4 Analog/Digital/Bluetooth Generator > Waveform Config menu description (sine waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Frequency Frequency refers to the reciprocal of the period of the signal.

DC Offset DC offset refers to the DC component of the waveform.
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Variable phase waveform

Variable phase waveform outputs a sine waveform on all channels. The waveforms on all 
channels share the same frequency; however their phase and amplitude can differ. Variable 
phase waveforms are useful for measuring the phase difference or timing skew between the 
channels of a multiple channel audio system. Variable phase waveform outputs a sine 
waveform at the selected frequency at both channel outputs with the channel 2 output 
phase varies from –180° to +179.99°, relative to the channel 1 output. 

Variable phase waveform mode is applicable for the analog, digital, and Bluetooth 
generator. The waveform configuration for variable phase waveform is displayed as shown 
in Figure 3-7, Figure 3-8, and Figure 3-8 for the analog, digital, and Bluetooth generator 
respectively.

Figure 3-7 Analog Generator > Waveform Config menu page (variable phase waveform)

Figure 3-8 Digital Generator > Waveform Config menu page (variable phase waveform)
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Figure 3-9 Bluetooth Generator > Waveform Config menu page (variable phase waveform)

Table 3-5 Analog/Digital/Bluetooth Generator > Waveform Config menu description (variable phase waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for analog generator. 
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Frequency Frequency refers to the reciprocal of the period of the signal.

Phase -> 1

This is only available when the analog, digital, and Bluetooth generator is in channel 2.
Phase -> 1 refers to the phase of the channel 2 sine waveform with reference to channel 1. A positive value will cause the 
channel 1 output to lead the channel 2 output. A negative value will cause the channel 2 output to lag the channel 1 
output. 
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Dual waveform

Dual waveform allows you to generate a composite waveform that is the summation of two 
independent sine waveforms. Dual sine waveforms are useful in testing the intermodulation 
distortion characteristics of an audio system.

Dual waveform mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for dual waveform is displayed as shown in Figure 3-10, 
Figure 3-11, and Figure 3-12 for the analog, digital, and Bluetooth generator respectively.

Figure 3-10 Analog Generator > Waveform Config menu page (dual waveform)

Figure 3-11 Digital Generator > Waveform Config menu page (dual waveform)
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Figure 3-12 Bluetooth Generator > Waveform Config menu page (dual waveform)

Table 3-6 Analog/Digital/Bluetooth Generator > Waveform Config menu description (dual waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Frequency 1 Frequency 1 refers to the frequency for the first sine component.

Frequency 2 Frequency 2 refers to the frequency for the second sine component.

DC Offset DC Offset refers to the DC component of the waveform.

Ratio Ratio refers to the amplitude ratio of the second sine component over the first sine component.

Summation

Summation refers to the method to sum up two levels.
– RSS 

The amplitude displayed is the Root Sum Square (RSS) summation result of the two levels. The analyzer will read the 
same amplitude set at the generator regardless of tone ratio.

– Linear 
The amplitude displayed is the linear summation result of the two levels. The level of each tone can be easily calculated 
back from the tone ratio.
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SMPTE IMD waveforms (1:1/4:1/10:1)

SMPTE IMD is a signal which is the linear combination of two sine waveforms. The SMPTE 
IMD waveforms conform to the SMPTE standard RP120-1983 for testing intermodulation 
distortion. For SMPTE IMD 1:1, the lower frequency sine wave is linearly combined in 1:1 
amplitude ratio with the upper frequency sine wave. For SMPTE IMD 4:1, the lower 
frequency sine wave is linearly combined in 4:1 amplitude ratio with the upper frequency 
sine wave. For SMPTE IMD 10:1, the lower frequency sine wave is linearly combined in 10:1 
amplitude ratio with the upper frequency sine wave. 

SMPTE IMD waveform mode is applicable for the analog, digital, and Bluetooth generator. 
The waveform configuration for SMPTE 1:1 waveform is displayed as shown in Figure 3-13, 
Figure 3-14, and Figure 3-15 for both the analog, digital, and Bluetooth generator 
respectively.

Figure 3-13 Analog Generator > Waveform Config menu page (SMPTE 1:1 waveform)

Figure 3-14 Digital Generator > Waveform Config menu page (SMPTE 1:1 waveform)
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Figure 3-15 Bluetooth Generator > Waveform Config menu page (SMPTE 1:1 waveform)

Table 3-7 Analog/Digital/Bluetooth Generator > Waveform Config menu description (SMPTE IMD waveforms) 

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Lower Freq Lower Freq refers to the lower frequency of the waveform. The lower and upper frequencies are differentiated by the 
amplitude ratio between the frequencies.

Upper Freq Upper Freq refers to the upper frequency of the waveform. The lower and upper frequencies are differentiated by the 
amplitude ratio between the frequencies.

DC Offset DC Offset refers to the DC component of the waveform.

Summation

Summation refers to the method to sum up two levels.
– RSS 

The amplitude displayed is the Root Sum Square (RSS) summation result of the two levels. The analyzer will read the 
same amplitude set at the generator regardless of tone ratio.

– Linear 
The amplitude showed is the linear summation result of the two levels. The level of each tone can be easily calculated 
back from the tone ratio.
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DFD IEC waveforms (IEC 60118/IEC 60268)

There are two predefined DFD dual tones waveforms comprising DFD IEC 60118 and DFD 
IEC 60268. The DFD IEC waveforms are similar to SMPTE IMD, except that the two tones 
have equal amplitude and are spaced closer together.

DFD waveform mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for IEC 60118 waveform is displayed as shown in Figure 3-16, 
Figure 3-17, and Figure 3-18 for the analog, digital, and Bluetooth generator respectively.

Figure 3-16 Analog Generator > Waveform Config menu page (IEC 60118 waveform)

Figure 3-17 Digital Generator > Waveform Config menu page (IEC 60118 waveform)
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Figure 3-18 Bluetooth Generator > Waveform Config menu page (IEC 60118 waveform)

Table 3-8 Analog/Digital/Bluetooth Generator > Waveform Config menu description (IEC 60118 waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Upper Freq Upper Freq refers to the upper frequency of the waveform.

Diff Freq Diff Freq refers to the difference frequency of the waveform.

DC Offset DC Offset refers to the DC component of the waveform.

Summation

Summation refers to the method to sum up two levels.
– RSS 

The amplitude displayed is the Root Sum Square (RSS) summation result of the two levels. The analyzer will read the 
same amplitude set at the generator regardless of the tone ratio.

– Linear 
The amplitude showed is the linear summation result of the two levels. The level of each tone can be easily calculated 
back from the tone ratio.
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The waveform configuration for IEC 60268 waveform is displayed as shown in Figure 3-19, 
Figure 3-20, and Figure 3-21 for the analog, digital, and Bluetooth generator respectively.

Figure 3-19 Analog Generator > Waveform Config menu page (IEC 60268 waveform)

Figure 3-20 Digital Generator > Waveform Config menu page (IEC 60268 waveform)
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Figure 3-21 Bluetooth Generator > Waveform Config menu page (IEC 60268 waveform)

Table 3-9 Analog/Digital/Bluetooth Generator > Waveform Config menu description (IEC 60268 waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Center Freq Center Freq refers to the center frequency of the waveform.

Diff Freq Diff Freq refers to the difference frequency of the waveform.

DC Offset DC Offset refers to the DC component of the waveform.

Summation

Summation refers to the method to sum up two levels.
– RSS 

The amplitude displayed is the Root Sum Square (RSS) summation result of the two levels. The analyzer will read the 
same amplitude set at the generator regardless of the tone ratio.

– Linear 
The amplitude showed is the linear summation result of the two levels. The level of each tone can be easily calculated 
back from the tone ratio.
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Gaussian noise

Gaussian noise is a random noise signal where the frequency components have a Gaussian 
distribution centered on a predetermined frequency value.

Gaussian noise mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for Gaussian noise is displayed as shown in Figure 3-22, 
Figure 3-23, and Figure 3-24 for the analog, digital, and Bluetooth generator respectively.

Figure 3-22 Analog Generator > Waveform Config menu page (Gaussian noise)

Figure 3-23 Digital Generator > Waveform Config menu page (Gaussian noise)
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Figure 3-24 Bluetooth Generator > Waveform Config menu page (Gaussian noise)

Table 3-10 Analog/Digital/Bluetooth Generator > Waveform Config menu description (Gaussian noise)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

DC Offset DC Offset refers to the DC component of the waveform.
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Rectangular noise

Rectangular noise is a noise signal based on Rectangular distribution.

Rectangular noise mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for Rectangular noise is displayed as shown in Figure 3-25, 
Figure 3-26, and Figure 3-27 for the analog, digital, and Bluetooth generator respectively.

Figure 3-25 Analog Generator > Waveform Config menu page (Rectangular noise)

Figure 3-26 Digital Generator > Waveform Config menu page (Rectangular noise)
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Figure 3-27 Bluetooth Generator > Waveform Config menu page (Rectangular noise)

Table 3-11 Analog/Digital/Bluetooth Generator > Waveform Config menu description (Rectangular noise)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

DC Offset DC Offset refers to the DC component of the waveform.
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Triangular noise

Triangular noise mode is only applicable for the digital generator. The waveform 
configuration for triangular noise is displayed as shown in Figure 3-28.

Figure 3-28 Digital Generator > Waveform Config menu page (Triangular noise)

Table 3-12 Digital Generator > Waveform Config menu description (Triangular noise)

Menu Description

Amplitude
Amplitude can be expressed as FFS, dBFS, or %FS for the digital generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

DC Offset DC Offset refers to the DC component of the waveform.
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Pink noise

Pink noise is a noise signal that contains an equal sound pressure level in each octave band 
where the energy decreases as frequency increases. 

Pink noise mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for Pink noise is displayed as shown in Figure 3-29, Figure 3-30, 
and Figure 3-31 for the analog, digital, and Bluetooth generator respectively.

Figure 3-29 Analog Generator > Waveform Config menu page (Pink noise)

Figure 3-30 Digital Generator > Waveform Config menu page (Pink noise)
Keysight U8903B User’s Guide 119



3 Audio Generator Functions
Figure 3-31 Bluetooth Generator > Waveform Config menu page (Pink noise)

Table 3-13 Analog/Digital/Bluetooth Generator > Waveform Config menu description (Pink noise)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak, while Vrms is equivalent to Vpeak/√2.

DC Offset DC Offset refers to the DC component of the waveform.
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Square waveform

Square waveform is a waveform that ideally alternates regularly and instantaneously 
between two levels.

Square waveform mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for square waveform is displayed as shown in Figure 3-32, 
Figure 3-33, and Figure 3-34 for the analog, digital, and Bluetooth generator respectively.

Figure 3-32 Analog Generator > Waveform Config menu page (square waveform)

Figure 3-33 Digital Generator > Waveform Config menu page (square waveform)
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Figure 3-34 Bluetooth Generator > Waveform Config menu page (square waveform)

Table 3-14 Analog/Digital/Bluetooth Generator > Waveform Config menu description (square waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Frequency Frequency refers to the frequency of the square waveform.

DC Offset
This is only available for the digital generator.
DC Offset refers to the DC component of the waveform. 
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DC signal

DC signal output is used when a low current DC supply is required. Examples include, 
biasing amplifiers or other similar circuitry.

DC signal mode is applicable for the analog generator only. The waveform configuration for 
DC signal is displayed as shown in Figure 3-35.

Figure 3-35 Analog Generator > Waveform Config menu page (DC signal)

Table 3-15 Analog Generator > Waveform Config menu description (DC signal)

Menu Description

Voltage Voltage refers to the amplitude of the composite signal.
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Sine burst waveform

Sine burst waveform is usually a sine wave that is switched between two levels. Sine burst 
waveform mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for sine burst waveform is displayed as shown in Figure 3-37, 
Figure 3-38, and Figure 3-38 for the analog, digital, and Bluetooth generator respectively.

Figure 3-36 Analog Generator > Waveform Config menu page (sine burst)

Figure 3-37 Digital Generator > Waveform Config menu page (sine burst)
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Figure 3-38 Bluetooth Generator > Waveform Config menu page (sine burst)

Table 3-16 Analog/Digital/Bluetooth Generator > Waveform Config menu description (sine burst)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak, and Vrms is equivalent to Vpeak/√2.

Frequency Frequency refers to the frequency for the first sine component.

DC Offset
This is only available for the analog and Bluetooth generator.
DC Offset refers to the DC component of the waveform.

Burst On Burst On refers to the number of cycles at which the signal amplitude will be at the higher level. The Burst On value must 
be less than the period value by one cycle.

Period Period refers to the number of cycles from the beginning of one burst to the beginning of the next burst. The period value 
must be at least one cycle greater than the burst on.

Low Level Low Level refers to the amplitude ratio of Burst On over Burst Off.
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Stereo waveform

Stereo waveform generates two independent sine waveforms for channel 1 and channel 2. 
Stereo waveform mode is applicable for the digital generator only. For digital generator, 
stereo waveform can be generated with a sinewave at two different channels. The 
waveform configuration for stereo waveform is displayed as shown in Figure 3-39.

Figure 3-39 Digital Generator > Waveform Config menu page (stereo)

Table 3-17 Digital Generator > Waveform Config menu description (stereo)

Menu Description

Amplitude
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Frequency Frequency refers to the frequency for the first sine component.

DC Offset DC Offset refers to the DC component of the waveform.
126 Keysight U8903B User’s Guide



Audio Generator Functions 3
Monotonicity

Monotonicity waveform consists of a repeating square-wave staircase signal. The duration 
for each half cycle of the square wave is determined by the Samples/Step parameter.

Monotonicity waveform mode is applicable for the digital generator only. The waveform 
configuration for monotonicity waveform is displayed as shown in Figure 3-40.

Figure 3-40 Digital Generator > Waveform Config menu page (monotonicity)

Table 3-18 Digital Generator > Waveform Config menu description (monotonicity)

Menu Description

Samples/Step Samples/Step refers to the duration for each half cycle of the square wave.
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Constant value waveform

Constant value mode outputs a continuous stream of data samples at the same fixed value. 
This mode helps in the investigation of data-dependent errors in digital systems. In order to 
repeat a specific error, a fixed value must be used.

Constant value waveform mode is applicable for the digital and Bluetooth generator. The 
waveform configuration for constant value waveform is displayed as shown in Figure 3-41 
and Figure 3-42 for the digital and Bluetooth generator respectively.

Figure 3-41 Digital Generator > Waveform Config menu page (constant)

Figure 3-42 Bluetooth Generator > Waveform Config menu page (constant)
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Table 3-19 Digital/Bluetooth Generator > Waveform Config menu description (constant)

Menu Description

Voltage Press the Voltage softkey to select the output voltage or set your desired output voltage.
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Walking zero

In walking zero waveform mode, one bit is set to 0 and the rest of the bits are set to 1. The 
bit 0 is continuously incremented from the least significant bit (LSB) to the most significant 
bit (MSB) and loops back to the LSB.

Walking zero waveform mode is applicable for the digital generator only. The waveform 
configuration for walking zero waveform is displayed as shown in Figure 3-43.

Figure 3-43 Digital Generator > Waveform Config menu page (walking zero)

Table 3-20 Digital Generator > Waveform Config menu description (walking zero)

Menu Description

Samples/Step Samples/Step refers to the speed the single bit 0 is incremented.
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Walking one

In walking one waveform mode, one bit is set to 1 and the rest of the bits are set to 0. The 
bit 1 is continuously incremented from the least significant bit (LSB) to the most significant 
bit (MSB) and loops back to the LSB.

Walking one waveform mode is applicable for the digital generator only. The waveform 
configuration for walking one waveform is displayed as shown in Figure 3-44.

Figure 3-44 Digital Generator > Waveform Config menu page (walking one)

Table 3-21 Digital Generator > Waveform Config menu description (walking one)

Menu Description

Samples/Step Samples/Step refers to the speed the single bit 1 is incremented.
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Arbitrary waveform

You can load a properly formatted waveform file into the U8903B as a sequence of 
waveform samples. The samples are outputted at the sample rate of the generator. The 
waveform files must be in the .arb or .wav file type. For .wav file type, mono or stereo 
audio with 8, 16, or 24 bits per sample are supported. 

Arbitrary waveform mode is applicable for the analog, digital, and Bluetooth generator. The 
waveform configuration for arbitrary waveform is displayed as shown in Figure 3-45, 
Figure 3-46, and Figure 3-47 for the analog, digital, and Bluetooth generator respectively. 
Refer to “Appendix 17: Arbitrary File Format” on page 561 for more information on the 
arbitrary waveform file format.

Figure 3-45 Analog Generator > Waveform Config menu page (arbitrary waveform)

Figure 3-46 Digital Generator > Waveform Config menu page (arbitrary waveform)
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Figure 3-47 Bluetooth Generator > Waveform Config menu page (arbitrary waveform)

Table 3-22 Analog/Digital/Bluetooth Generator > Waveform Config menu description (arbitrary waveform)

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

DC Offset DC Offset refers to the DC component of the waveform.

Load File Press the Load File softkey to load a waveform from a file. Refer to “Recall” on page 95 for more information on the Recall 
menu page.

Info Press the Info softkey to display the loaded waveform information.
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Multitone waveform

Multitone waveform is a composite waveform that is a summation of multiple independent 
sine waveforms. This feature is useful in measuring different characteristics of audio 
devices from a single acquisition of audio data.

Multitone waveform mode is applicable for the analog, digital, and Bluetooth audio 
generator. The waveform configuration for multitone waveform is displayed as shown in 
Figure 3-48, Figure 3-49 and Figure 3-50 for the analog, digital, and Bluetooth generator 
respectively.

Figure 3-48 Analog Generator > Waveform Config menu page 1 (multitone waveform)

Figure 3-49 Digital Generator > Waveform Config menu page 1 (multitone waveform)
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Figure 3-50 Bluetooth Generator > Waveform Config menu page 1 (multitone waveform)

Table 3-23 Analog/Digital/Bluetooth Generator > Waveform Config menu description (multitone waveform) 

Menu Description

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
Amplitude can be expressed as FFS, dBFS, or %FS for the digital and Bluetooth generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

DC Offset
This is only available for the analog and Bluetooth generator.
DC Offset refers to the DC component of the waveform.

Start Freq Start Freq refers to the lowest frequency in the multitone waveform which is usually the frequency for the first tone.

Stop Freq Stop Freq refers to the highest frequency in the multitone waveform which is usually the frequency for the last tone.

Freq Spacing

Freq Spacing refers to the frequency spacing between the tones.
– Linear
– Log
– Custom

Tone Count
Tone Count refers to the number of signal frequency components. For analog generator, the maximum number of tones 
that can be generated is 60. For digital and Bluetooth generator, the maximum number of tones that can be generated is 
64.

Length

Length refers to the waveform length that determines the number of samples used to create one iteration of the multitone 
waveform. Longer waveform length provides higher frequency resolution but will take more time to generate and process.
– 1024
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536

Custom
Press the Custom softkey to access the custom multitone menu page. You can set the frequency, amplitude, phase, and 
optimize the crest factor for each tone. Refer to “Custom multitone” on page 136 for more information on the custom 
multitone menu page.
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Custom multitone

The custom multitone waveform configuration is displayed as shown in Figure 3-51, 
Figure 3-52, and Figure 3-53 for both the analog, digital, and Bluetooth generator 
respectively.

Figure 3-51 Analog Generator > Waveform Config > Custom menu page 1 (multitone waveform)

Figure 3-52 Digital Generator > Waveform Config > Custom menu page 1 (multitone waveform)
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Figure 3-53 Bluetooth Generator > Waveform Config > Custom menu page 1 (multitone waveform)

Table 3-24 Analog/Digital/Bluetooth Generator > Waveform Config > Custom menu description (multitone waveform)

Menu Description

Apply Press the Apply softkey to apply the current setting on the selected tone for the custom multitone waveform.

Optimize Press the Optimize softkey to optimize the crest factor for the custom multitone waveform.

Frequency Press the Frequency softkey to set the frequency value for the custom multitone waveform.

Amplitude Press the Amplitude softkey to set the amplitude value for the custom multitone waveform.

Phase Press the Phase softkey to set the phase value for the custom multitone waveform.

Add Above Press the Add Above softkey to add the tone above the selected tone for the custom multitone waveform.

Add Below Press the Add Below softkey to add the tone below the selected tone for the custom multitone waveform.

Remove Press the Remove softkey to remove the selected tone for the custom multitone waveform.

Clear Press the Clear softkey to clear all the tones in the custom multitone waveform list.
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Dual-Tone Multi-Frequency (DTMF)

Dual-Tone Multi-Frequency (DTMF), also known as touch-tone, is a system of signal tones 
used in telecommunications. Applications include voice mail, help desks, telephone 
banking, and others. DTMF is only applicable for the analog generator only.

There are 12 DTMF signals where each of the signal is made up of two tones from the 
following selection: 

– 697 Hz

– 770 Hz

– 852 Hz

– 941 Hz

– 1209 Hz

– 1336 Hz

– 1477 Hz

The tones are divided into two groups (low and high), and each DTMF signal uses one from 
each group. This prevents any harmonics from being misinterpreted as part of the signal. 
The waveform configuration for DTMF is displayed as shown in Figure 3-54.

Figure 3-54 Analog Generator > Waveform Config menu page 1 (DTMF)
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Dial

The dial mode allows you to generate a single DTMF tone or to modify the DTMF sequence. 
Press the Mode softkey to switch between Single or Sequence as the dial mode. Press the 
numeric keys on the CHANNEL/DATA panel to generate the respective DTMF tone as listed 
in Table 3-27. The Dial menu page is displayed as shown in Figure 3-55.

Figure 3-55 Dial menu page

Table 3-25 Analog Generator > Waveform Config menu description (DTMF)

Menu Description

Dial Press Dial softkey to generate a single DTMF tone or modify the DTMF sequence. Refer to “Dial” on page 139 for more 
information.

Amplitude
Amplitude can be expressed as Vrms, Vpeak, Vpp, dBV, dBu, and dBm for the analog generator.
For a perfect sine waveform without any DC offset, Vpp is twice Vpeak and Vrms is equivalent to Vpeak/√2.

Ratio Ratio refers to the level difference between the high-frequency tone and low-frequency tone.

Tone Duration Tone Duration refers to the DTMF signal duration.

Tone Delay Tone Delay refers to the delay between two DTMF tones.

Pause Time Pause Time refers to the interval time for the DTMF sequence.

Repeat Press the Repeat softkey to enable or disable repeating the DTMF sequence.

Summation

Summation refers to the method to sum up two levels.
– RSS 

The amplitude displayed is the Root Sum Square (RSS) summation result of the two levels. The analyzer will read the 
same amplitude set at generator regardless of tone ratio.

– Linear 
The amplitude showed is the linear summation result of the two levels. The level of each tone can be easily calculated 
back from the tone ratio.
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Table 3-26 Dial menu page description 

Menu Description

Mode
Mode refers to the mode of operation for the dial mode.
Single – You can dial a single DTMF tone using the numeric keys and A to D softkeys.
Sequence – You can dial and modify the DTMF sequence.

A
B
C
D

Single dial mode
Press and hold the A, B, C, or D softkey to dial the A, B, C, or D tone respectively.
Sequence dial mode
Press the A, B, C, or D softkey to add the A tone to the DTMF sequence.

Pause
Pause refers to the pause to be added to the DTMF sequence.
Press the Pause softkey to add a pause to the sequence in the form of a comma.

Table 3-27 DTMF tone mapping

DTMF tone Description

0 to 9 Press the numeric keys on the CHANNEL/DATA panel to generate the DTMF 0 to 9 tones 
respectively.

* Press  on the CHANNEL/DATA panel to generate the ‘*’ DTMF tone.

# Press  on the CHANNEL/DATA panel to generate the ‘#’ DTMF tone.

A to D Press the A to D softkeys to generate the DTMF A to D tones respectively.
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Output Configuration (Analog Generator)

The output configuration for the analog generator is displayed as shown in Figure 3-56.

Figure 3-56 Analog Generator > Output Config menu page

Table 3-28 Analog Generator > Output Config menu description 

Menu Description

Connector

Press the Connector softkey to select the output connector type.
– Bal 

Balanced mode outputs a pair of differential signals which are equal in amplitude but 180 degrees out of phase on the 
XLR positive and negative pins.

– UnBal 
Unbalanced mode outputs a signal referenced to ground on the BNC output connector.

– Com 
Common mode outputs a pair of equal amplitude and in-phase signals on the XLR positive and negative pins. The 
common mode test signal is applied to both pins 2 and 3 or the XLR connector, while pin 1 is connected to the  
return signal.

– IEC60268 
The common mode test signal is applied to both pins 2 and 3 or the XLR connector, while pin 1 is connected to the 
return signal. An additional 10 Ω output series resistance is added to pin 2 or 3.

Impedance

Press the Impedance softkey to select the output impedance value.
For Bal, Com, and IEC60268
– 600 Ω
– 100 Ω
– 40 Ω
For UnBal
– 600 Ω
– 50 Ω
– 20 Ω
Keysight U8903B User’s Guide 141



3 Audio Generator Functions
IEC60268 10 Ω 

Press the IEC60268 10 Ω softkey to select the additional 10 Ω output series resistance for pin 2 or 3 of the XLR connector 
in the common IEC60268 configuration. This setting is only available when the output connector type is set to IEC60268.
– Pin2 

Additional 10 Ω is added to pin 2.
– Pin3 

Additional 10 Ω is added to pin 3.

Ground

Press the Ground softkey to select the grounding type.
– Float 

In the floating grounding type, the signal return line (XLR pin 1 for balanced output or BNC return for unbalanced 
output) is not grounded to the chassis earth and is “floating”.

– Ground 
In the ground grounding type, the signal return line (XLR pin 1 for balanced output or BNC return for unbalanced output) 
is connected to the chassis earth.

Max Voltage
Press the Max Voltage softkey to set the maximum voltage. The maximum voltage value set will limit the maximum 
amplitude output from the generator and prevent any excessive high voltage values from damaging the device under  
test (DUT).

Table 3-28 Analog Generator > Output Config menu description (continued)

Menu Description
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Output Configuration (Digital Generator)

The output configuration for the digital generator is displayed as shown in Figure 3-57.

Figure 3-57 Digital Generator > Output Config menu page 

Table 3-29 Digital Generator > Output Config menu description 

Menu Description

Connector

Press the Connector softkey to select the output connector type.
– Bal 

Balanced mode outputs a digital signal on the XLR output connector at the U8903B rear panel.
– UnBal 

Unbalanced mode outputs a digital signal on the BNC output connector at the U8903B rear panel.

AES Output Press the AES Output softkey to enable or disable the AES output.

Optical Output Press the Optical Output softkey to enable or disable the optical output.

Sample Rate Press the Sample Rate softkey to set the sample rate value.

Audio Format

Press the Audio Format softkey to select the encoding audio format.
– Linear PCM
– A-Law
– μ-Law

Dither

Press the Dither softkey to select the dither type. Dither is a noise component that can be superimposed on a signal.
– Off
– Rectangular
– Triangular
– Shaped
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Reference clock

Figure 3-58 Digital Generator > Clock Config > Ref Clock menu page

Table 3-30 Digital Generator > Clock Config > Ref Clock menu description 

Menu Description

Source

Press the Source softkey to select the reference clock source. Refer to “Appendix 20: Digital System Clock 
Distribution Block Diagram” on page 567 for more information on the system clock.
– Internal
– AES RCLK
– External
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Sync clock

Figure 3-59 Digital Generator > Clock Config > Sync Clock menu page

Table 3-31 Digital Generator > Clock Config > Sync Clock menu description 

Menu Description

Output Press the Output softkey to enable or disable the synchronous clock output.

Divider

Press the Divider softkey to select the synchronous clock divider value. When the synchronous clock divider is set to 1, the 
synchronous clock is locked to 128 × sampling rate (bi-phase clock). When the synchronous clock divider is set to 128, the 
synchronous clock is divided by 128 which is equal to the sampling rate set at the U8903B.
– 1
– 128

Source

Press the Source softkey to select the synchronous clock source. Refer to “Appendix 20: Digital System Clock 
Distribution Block Diagram” on page 567 for more information on the system clock.
– Internal
– AES RCLK
– External
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Figure 3-60 Digital Generator > Clock Config > External Clock menu page

Table 3-32 Digital Generator > Clock Config > External Clock menu description

Menu Description

Type

Press the Type softkey to select the external reference clock type. Refer to “Appendix 20: Digital System Clock 
Distribution Block Diagram” on page 567 for more information on the system clock.

– MClk Sync In
– Frame Clk In
– DSI Gen FS
– DSI Gen Clk

Word Length
– Press the Word Length softkey to set the external reference clock word length value.

– 8 to 32

Multiplier – Press the Multiplier softkey to set the external reference clock multiplier value. The selection available in the external 
reference clock multiplier depends on the external reference clock word length.

Frequency – Press the Frequency softkey to set the external reference clock frequency value.
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Link Configuration (Bluetooth Generator)

The link configuration for the Bluetooth generator is displayed as shown in Figure 3-61.

Figure 3-61 Bluetooth Generator > Link Config menu page

NOTE
When connecting the U8903B to a PC's Bluetooth using A2DP profile where the U8903B 
acts as source, initiate the connection from the PC (as sink) instead of U8903B. The 
U8903B does not support the initialization of A2DP source profile connection from the 
U8903B when connecting to a PC.

Table 3-33 Bluetooth Generator > Link Config menu description 

Menu Description

Device Scan Press the Device Scan softkey to configure the device scan settings when searching for discoverable Bluetooth devices 
within range. Refer to “Device scan” on page 148 for more information.

Device Action Press the Device Action softkey to configure the Bluetooth device action settings such as unpair device, profile connection, 
and others. Refer to “Device action” on page 149 for more information.

Common Settings Press the Common Settings softkey to configure the Bluetooth common settings such as profile, discoverable, and others. 
Refer to “Common settings” on page 151 for more information.

A2DP Settings Press the A2DP Settings softkey to configure the Bluetooth advanced audio distribution profile settings. Refer to “A2DP 
settings” on page 154 for more information.

HFP Settings Press the HFP Settings softkey to configure the Bluetooth handsfree/headset profile settings. Refer to “HFP settings” on 
page 155 for more information.

AVRCP Log View Press the AVRCP Log View softkey to configure the Bluetooth audio/video remote control profile operation log. Refer to 
“AVRCP log view” on page 157 for more information.
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Device scan

Figure 3-62 Bluetooth Analyzer > Link Config > Device Scan menu page

Table 3-34 Bluetooth Analyzer > Link Config > Device Scan menu description 

Menu Description

Device Search Press the Device Search softkey to begin identifying all the discoverable Bluetooth devices within range.

Max Scan

Press the Max Scan softkey to set the maximum number of discoverable Bluetooth devices to be identified during the 
Device Search procedure. The Device Search procedure will stop when the identified Bluetooth devices reached the set 
number or if more than 30 s elapsed.
– 1 to 16

Filter Class

Press the Filter Class softkey to select the Bluetooth device class to be used during the Device Search procedure. The 
Device Search procedure identifies all the discoverable Bluetooth device based on the selected class.
– All 

Search for all available Bluetooth device class.
– Custom 

Manually sets the Bluetooth device class using the 6-digit hexadecimal numeric number of the Bluetooth device 
address such as 60020C for smartphones and 240408 for handsfree/headset devices.

Custom
Only available if Filter Class is set to Custom.
Press the Custom softkey to manually sets the Bluetooth device class.

Refresh Device Press the Refresh Device softkey to refresh the friendly name of the selected Bluetooth device.
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Device action

Figure 3-63 Bluetooth Analyzer > Link Config > Device Action menu page

Table 3-35

Menu Description

Pair/Unpair Device Press the Pair/Unpair Device softkey to pair with the selected discovered Bluetooth device or unpair with the selected 
paired Bluetooth device respectively.

Unpair All Device Press the Unpair All Device softkey to unpair all the paired Bluetooth devices.

Profile Connection

Press the Profile Connection softkey to connect or disconnect the Bluetooth profiles for the connection.
– Connect/Disconnect All
– Connect/Disconnect A2DP
– Connect/Disconnect HFP
– Connect/Disconnect AVRCP

A2DP Operation

Press the A2DP Operation softkey to select the advanced audio distribution profile operation settings. This is only 
available if the A2DP profile is connected.
– Open Media Connection 

Establishes the audio media connection to the connected Bluetooth device via the A2DP profile.
– Close Media Connection 

Disconnects the audio media connection to the connected Bluetooth device via the A2DP profile.
– Start Streaming 

Starts or resumes the audio media connection to the connected Bluetooth device. 
– Pause Streaming 

Stops or pauses the audio media connection to the connected Bluetooth device. 
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HFP Operation 
(Handsfree/Headset)

Press the HFP Operation softkey to select the HFP (Handsfree/Headset) profile operation settings. This is only available if 
the HFP profile is connected and the Common Settings > Profile is set to HFP HF.
– Dial 

Emulates making an outgoing call from the connected handsfree/headset device.
– Answer Call 

Emulates answering an incoming call from the connected handsfree/headset device.
– End Call 

Emulates terminating a call from the connected handsfree/headset device.
– Reject Call 

Emulates rejecting an incoming call from the connected handsfree/headset device.
– Toggle Audio 

Toggles the audio between RAC and audio gateway of the connected handsfree/headset device.
– Button Press 

Emulates a button press on the connected remote headset device. Only applicable for HFP profile.
– Send AT Command 

Sends the AT command from the U8903B’s Bluetooth card to the connected remote device. 
NOTE: Only support transmitting AT commands. AT command receiving feature is not supported.

HFP Operation  
(Audio Gateway)

Press the HFP Operation softkey to select the HFP (Audio Gateway) profile operation settings. This is only available if the 
HFP profile is connected and the Common Settings > Profile is set to HFP AG.
– Connect 

Establishes an audio connection to the headset device via the connected handsfree/headset device.
– Disconnect 

Disconnects an audio connection to the headset device via the connected handsfree/headset device.
– Call 

Emulates a call alert to the headset device via the connected handsfree/headset device.
– Hang Up 

Emulates ending a call to the headset device via the connected handsfree/headset device.
– Send AT Command 

Sends the AT command from the U8903B’s Bluetooth card to the connected remote device. 
NOTE: Only support transmitting AT commands. AT command receiving feature is not supported.

AVRCP Operation

Press the AVRCP Operation softkey to configure the audio/video remote control profile operation settings. This is only 
available if the AVRCP profile is connected and the Common Settings > Profile is set to AVRCP CTRL.
– Volume Up
– Volume Down
– Mute
– Play
– Stop
– Pause
– Rewind
– Fast Forward
– Forward
– Backward

Table 3-35

Menu Description
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Common settings

Figure 3-64 Bluetooth Analyzer > Link Config > Common Settings menu page 1

Figure 3-65 Bluetooth Analyzer > Link Config > Common Settings menu page 2
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Figure 3-66 Bluetooth Analyzer > Link Config > Common Settings menu page 3

Table 3-36 Bluetooth Analyzer > Link Config > Common Settings menu description 

Menu Description

Profile

Press the Profile softkey to select the U8903B’s Bluetooth card profile. There are two sets of profiles available and the 
selected profile set will be accessible by the connected Bluetooth device.
– A2DP SRC, HFP AG, AVRCP TRGT 

A2DP source, HFP audio gateway, AVRCP target
– A2DP SNK, HFP HF, AVRCP CTRL 

A2DP sink, HFP handsfree/headset, AVRCP controller

Friendly Name Press the Friendly Name softkey to set the friendly name of the U8903B’s Bluetooth card.

Device PIN Press the Device PIN softkey to set the passkey for the U8903B’s Bluetooth card.

Device Class

Press the Device Class softkey to select the device class based on the configured profile.
– Auto 

When auto is set and the Bluetooth card is configured as a source profile, device class sets to 60020C (smartphone). 
When auto is set and the Bluetooth card is configured as a sink profile, device class sets to 240408  
(handsfree/headset device).

– Custom 
Manually set the device class.

Custom
This is only available if the Device Class is set to Custom.
Press the Custom softkey to set the device class. 

SSP Mode

Press the SSP Mode softkey to select the U8903B’s Bluetooth card simple secure pairing (SSP) mode when pairing.
– Just Works 

Just works mode is selected when only minimal security is needed. No passkey is required during pairing.
– Man-In-The-Middle 

Man-in-the-middle mode is selected when maximum security is needed. A passkey is required during pairing.

Auto Pair Press the Auto Pair softkey to enable or disable the auto-pairing function of the U8903B’s Bluetooth card with a remote 
device.
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IO Capability

Press the IO Capability softkey to select the IO capability of the U8903B’s Bluetooth card.
– Display Only
– Display Yes No
– Keyboard Only
– No IO

Discoverable Press the Discoverable softkey to enable or disable the discoverability function of the U8903B’s Bluetooth card by a 
remote device.

Connectable Press the Connectable softkey to enable or disable the connectability function of the U8903B’s Bluetooth card by a remote 
device.

Loopback Press the Loopback softkey to enable or disable the integrated interchip sound (I2S) audio loopback function. This is only 
available if the HFP profile is connected.

Link Status Press the Link Status softkey to enable or disable the link status of the U8903B’s Bluetooth card. This is only available if 
the HFP profile or A2DP profile is connected.

RF Port
Press the RF Port softkey to select the U8903B’s Bluetooth card RF port connector.
– RF1
– RF2

Table 3-36 Bluetooth Analyzer > Link Config > Common Settings menu description (continued)

Menu Description
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A2DP settings

Figure 3-67 Bluetooth Analyzer > Link Config > A2DP Settings menu page

Table 3-37 Bluetooth Analyzer > Link Config > A2DP Settings menu description 

Menu Description

Codec
Press the Codec softkey to select the prefered codec for the A2DP profile.
– SBC
– apt-X

Sampling Rate

Press the Sampling Rate softkey to select the prefered audio sampling rate for the A2DP profile.
– 16 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
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HFP settings

Figure 3-68 Bluetooth Analyzer > Link Config > HFP Settings menu page

Table 3-38 Bluetooth Analyzer > Link Config > HFP Settings menu description 

Menu Description

Wideband

Press the Wideband softkey to enable or disable the wideband speech mode in the HFP profile connection. When the 
wideband mode is enabled, 16 kHz sampling rate and mSBC codec will be used in the connection. When the wideband 
mode is disabled (narrowband), 8 kHz sampling rate and CVSD codec will be used in the connection. If the wideband 
speech mode is enabled, the use of EV3 packet type is mandatory and must be selected together with other optional EDR 
packet type(s) ( EV4, EV5, 2EV3, 3EV3, 2EV5, and 3EV5). The connection will fail if the EV3 packet type is not included.

Latency
Press the Latency softkey to set the HFP's codec channel latency in miliseconds.
– 4 to 65534

Retransmit

Press the Retransmit softkey to select the HFP's codec retransmission effort.
– No Transmission 

No retransmission effort.
– Power Saving 

One or more retransmission effort. Optimized for power consumption.
– Link Quality 

One or more retransmission effort. Optimized for link quality.
– No Preference 

No retransmission effort preference.
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Packet Types

Press the Packet Types softkey to select the packet type used in the HFP’s codec. Multiple packet types can be selected 
and the available options are dependent on the supported feature set of the connected Bluetooth device.
– HV1
– HV2
– HV3
– EV3
– EV4
– EV5
– 2EV3
– 3EV3
– 2EV5
– 3EV5

Table 3-38 Bluetooth Analyzer > Link Config > HFP Settings menu description (continued)

Menu Description
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AVRCP log view

Figure 3-69 Bluetooth Analyzer > Link Config > AVRCP log view menu page

Table 3-39 Bluetooth Analyzer > Link Config > AVRCP log view menu description 

Menu Description

Clear Log Press the Clear Log softkey to clear the AVRCP operation log history.

Refresh Log Press the Refresh Log softkey to refresh the AVRCP operation log history.
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DSI Output Configuration (Digital Generator)

The DSI output configuration for the digital generator is displayed as shown in Figure 3-70.

Figure 3-70 Digital Generator > DSI Config menu page 1

 
Table 3-40 Digital Generator > DSI Output Config menu description 

Menu Description

Format

Press the Format softkey to select the DSI output format.
– Left
– Right
– I2S
– DSP

Fsync Polarity
Press the Fsync Polarity softkey to select the sync polarity.
– Rising
– Falling

Fsync Width

Press the Fsync Width softkey to select the sync width.
– One Bit Clock
– One Subframe
– 50% Duty Cycle

Data Shift Cnt Press the Data Shift Cnt softkey to set the data shift count value.

Data Shift Dir
Press the Data Shift Dir softkey to select the data shift direction.
– Left
– Right

Word Length
Press the Word Length softkey to set the master clock word length value. The word length cannot be less than the  
audio resolution.
– 8 to 32

Resolution
Press the Resolution softkey to set the audio resolution.
– 8 to 24
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Sample Rate Press the Sample Rate softkey to set the sample rate value.

Master Clock Press the Master Clock softkey to enable or disable the master clock output.

Multiplier Press the Multiplier softkey to set the multiplier value.

W/BClk Dir Press the W/BClk Dir softkey to set the word and bit clock direction.

Bit Clk Edge
Press the Bit Clk Edge softkey to select the clock edge type.
– Rising
– Falling

Voltage

Press the Voltage softkey to select the output voltage or set your desired output voltage.
– 1.2 Vpp
– 1.5 Vpp
– 1.8 Vpp
– 2.5 Vpp
– 3 Vpp
– 3.3 Vpp
– Custom

Table 3-40 Digital Generator > DSI Output Config menu description (continued)

Menu Description
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AES3/SPDIF Output Configuration (Digital Generator)

The AES3/SPDIF output configuration for the digital generator is displayed as shown in 
Figure 3-71.

Figure 3-71 Digital Generator > AES Config menu page 1

Table 3-41 Digital Generator > AES Config menu description 

Menu Description

Level Press the Level softkey to set the output voltage level.

Resolution
Press the Resolution softkey to set the audio resolution value.
– 8 to 24

Validity Bit
Press the Validity Bit softkey to select the vailidty bit.
– Set
– Clear

Mode
Press the Mode softkey to select the AES3/SPDIF format.
– Consumer
– Professional

Status Bits
Press the Status Bits softkey to select the status bits type.
– Channel
– User

Edit Bits Press the Edit Bits softkey to configure the bits according to the format selected. Refer to “Edit Bits (Consumer 
format)” on page 161 and “Edit Bits (Professional format)” on page 166 for more information.

Clear Bits Press the Clear Bits softkey to clear all the bits.

Save File Press the Save File softkey to save the bits to a file. Refer to “Save” on page 94 for more information on the Save  
menu page.

Load File Press the Load File softkey to load the bits from a file. Refer to “Recall” on page 95 for more information on the Recall 
menu page.
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Edit Bits (Consumer format)

The AES3/SPDIF bits configuration for the Consumer format is displayed as shown in 
Figure 3-72.

Figure 3-72 Digital Generator > AES Config > Edit Bits (Consumer format) menu page 1

Table 3-42 Digital Generator > AES Config > Edit Bits (Consumer format) menu description 

Menu Description

Select Byte Press the Select Byte softkey to select the byte and edit the byte.

Audio Mode
Press the Audio Mode softkey to select the audio mode.
– Non-Linear PCM
– Linear PCM

Copyright
Press the Copyright softkey to select the copyright type.
– Copyright
– Non-copyright

Emphasis

Press the Emphasis softkey to select the emphasis type.
– No pre-emphasis
– 50/15 μs
– Reserved 1
– Reserved 2

Channel Mode
Press the Channel Mode softkey to set the channel mode value.
– 0 to 3
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Category

Press the Category softkey to select the category code type.
– General
– Laser Optical
– D/D Converter
– Magnetic
– Digital Broadcast 1
– Digital Broadcast 2
– Musical Instrument
– ADC Non Copyright
– Solid State Memory
– ADC Copyright
– Experimental
– Reserved 1
– Reserved 2

Source Num
Press the Source Num softkey to set the source number.
– 0 to 15

Channel Num
Press the Channel Num softkey to set the channel number.
– 0 to 15

Sample Freq

Press the Sample Freq softkey to select the sample frequency value.
– Not indicated
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz
– 768 kHz

Clk Accuracy

Press the Clk Accuracy softkey to select the clock accuracy type.
– Level 1
– Level 2
– Level 3
– Reserved

Max Word Len
Press the Max Word Len softkey to select the maximum word length.
– 24 bits
– 20 bits

Table 3-42 Digital Generator > AES Config > Edit Bits (Consumer format) menu description (continued)

Menu Description
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Word Length

Press the Word Length softkey to select the word length.
24 bits maximum word length
– Not indicated
– 20 bits
– 21 bits
– 22 bits
– 23 bits
– 24 bits
20 bits maximum word length
– Not indicated
– 16 bits
– 17 bits
– 18 bits
– 19 bits
– 20 bits

Orig S.Freq

Press the Orig S.Freq softkey to select the original sample frequency value.
– Not indicated
– 8 kHz
– 11.025 kHz
– 12 kHz
– 16 kHz
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz
– Reserved 1
– Reserved 2

CGMA-A

Press the CGMA-A softkey to select the CGMA-A type.
– Copying Permitted
– Condition Not Used
– One Generation Copy
– Copying Denied

Table 3-42 Digital Generator > AES Config > Edit Bits (Consumer format) menu description (continued)

Menu Description
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Table 3-43 AES3/SPDIF Consumer mode bit description 

Bits Label Description

0 Application mode
0: Consumer
1: Professional

1 Non-audio
0: Audio data is linear PCM samples
1: Other than linear PCM samples

2 Copyright
0: Asserted
1: Not asserted

3 – 5 Emphasis
000: Emphasis not indicated
100: CD-type emphasis

6 – 7 Channel status mode
00: Mode zero
Other values reserved

8 – 15 Category code Bit 8 is LSB

16 – 19 Source number Bit 16 is LSB

20 – 23 Channel number Bit 20 is LSB

24 – 27 Sampling frequency
0000: 44.1 kHz
0100: 48 kHz
1100: 32 kHz

28 – 29 Clock accuracy
10: Level I, ±50 ppm
00: Level II, ±1000 ppm
01: Level III, variable pitch shifted

30 – 31 Reserved

32 Word length (field size)
0: Maximum length 20 bits
1: Maximum length 24 bits

33 – 35 Word length

000
101
001
010
011
100

If bit 32 = 1
Not indicated
24 bits
23 bits
22 bits
21 bits
20 bits

If bit 32 = 0
Not indicated
20 bits
19 bits
18 bits
17 bits
16 bits
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36 – 39 Original sampling frequency

1111: 44.1 kHz
1110: 88.2 kHz
1101: 22.05 kHz
1100: 176.4 kHz
1011: 48 kHz
1010: 96 kHz
1001: 24 kHz
1000: 192 kHz
0111: Reserved
0110: 8 kHz
0101: 11.025 kHz
0100: 12 kHz
0011: 32 kHz
0010: Reserved 
0001: 16 kHz 
0000: Not indicated

40 – 41 CGMS-A

00: Copying permitted
01: Condition not used
10: One generation copy
11: Copying denied

42 – 192 Reserved

Table 3-43 AES3/SPDIF Consumer mode bit description (continued)

Bits Label Description
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Edit Bits (Professional format)

The AES3/SPDIF bits configuration for the Professional format is displayed as shown in 
Figure 3-72.

Figure 3-73 Digital Generator > AES Config > Edit Bits (Consumer format) menu page 1

Table 3-44 Digital Generator > AES Config > Edit Bits (Professional format) menu description 

Menu Description

Select Byte Press the Select Byte softkey to select the byte and edit the byte.

Audio Mode
Press the Audio Mode softkey to select the audio mode.
– Non-Linear PCM
– Linear PCM

Emphasis

Press the Emphasis softkey to select the emphasis type.
– Not indicated
– No pre-emphasis
– 50/15 μs
– CCITT J.17

Freq Mode
Press the Freq Mode softkey to select the frequency mode.
– Locked
– Unlocked
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Sample Freq

Press the Sample Freq softkey to select the sample frequency value.
– Not indicated
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz

Freq Scaling Press the Freq Scaling softkey to enable or disable frequency scaling.

Chan Mode

Press the Chan Mode softkey to select the channel mode.
– Not indicated
– 2-channel
– Single channel
– Primary-Secondary
– Stereo
– Reserved 1
– Reserved 2
– Mono Double Rate
– Left Double Rate
– Right Double Rate
– Multichannel

User Bits

Press the User Bits softkey to select the user bits type.
– Not indicated
– 192-bit block
– Reserved for AES18
– User defined
– Reserved for Metadata
– As in IEC60958-3

Aux Bits

Press the Aux Bits softkey to select the auxiliary bits.
– 20-bit not defined
– 24-bit main audio
– 20-bit single
– Reserved

Table 3-44 Digital Generator > AES Config > Edit Bits (Professional format) menu description (continued)

Menu Description
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Word Length

Press the Word Length softkey to select the word length.
24 bits maximum word length
– Not indicated
– 20 bits
– 21 bits
– 22 bits
– 23 bits
– 24 bits
20 bits maximum word length
– Not indicated
– 16 bits
– 17 bits
– 18 bits
– 19 bits
– 20 bits

Alignment

Press the Alignment softkey to select the alignment level.
– Not Indicated
– –18.06 dBFS
– –20 dBFS
– Reserved

Multi-Channel
Press the Multi-Channel softkey to select the multi-channel status.
– Defined
– Undefined

Multi-Ch Mode

This is only available when the multi-channel status is set to Defined.
Press the Multi-Ch Mode softkey to select the multi-channel mode. 
– Mode 0
– Mode 1
– Mode 2
– Mode 3
– User Defined

Channel Num
Press the Channel Num softkey to set the channel number.
– 1 to 16 (Defined multi-channel status)
– 1 to 128 (Undefined multi-channel status)

Ref Signal

Press the Ref Signal softkey to select the reference signal type.
– Not a ref. signal
– Grade 1
– Grade 2
– Reserved

Channel Origin Press the Channel Origin softkey to set the channel origin value (4 alphanumeric digit).

Channel Dest Press the Channel Dest softkey to set the channel destination value (4 alphanumeric digit).

Local Addr
Press the Local Addr softkey to set the local address value.

– 0 to 232–1

Table 3-44 Digital Generator > AES Config > Edit Bits (Professional format) menu description (continued)

Menu Description
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Time of Day
Press the Time of Day softkey to set the time of day.

– 0 to 232–1

Rel Flags

Press the Rel Flags softkey to select the reliability flags.
– 0-5
– 6-13
– 14-17
– 18-21

Table 3-44 Digital Generator > AES Config > Edit Bits (Professional format) menu description (continued)

Menu Description

Table 3-45 AES3/SPDIF Professional mode bit description 

Bits Label Description

0 Application mode
0: Consumer
1: Professional

1 Non-audio
0: Audio data is linear PCM samples
1: Other than linear PCM samples

2 – 4 Emphasis

000: Not indicated
100: No emphasis
110: CD-type emphasis
111: J-17 emphasis

5 Lock
0: Not indicated
1: Unlocked

6 – 7 Sampling frequency

00: Not indicated (or see byte 4)
10: 48 kHz
01: 44.1 kHz
11: 32 kHz

8 – 11

Channel mode

0000: Not indicated (default to 2 channels)
0001: 2 channels
0010: 1 channel (monophonic)
0011: Primary/secondary
0100: Stereo
0101: Reserved for user application
0110: Reserved for user application
0111: SCDSR (see byte 3 for ID)
1000: SCDSR (stereo left)
1001: SCDSR (stereo right)
1111: Multichannel (see byte 3 for ID)

Single Channel Double Sample Rate (SCDSR)
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12 – 15 User bit management

0000: Not indicated
0001: 192-bit block as in channel status
0010: As defined in AES18
0011: User-defined
0100: As in IEC60958-3 (consumer)

16 – 18 Use of AUX sample word

0000: Not defined, audio maximum 20 bits
0001: Used for main audio, maximum 24 bits
0010: Used for coordination signal, audio maximum 20 bits
0011: User-defined

19 – 21 Source word length

000:
001:
010:
011:
100:
101:

If maximum = 24 bits
Not indicated
23 bits
22 bits
21 bits
20 bits
24 bits

If maximum = 20 bits
Not indicated
19 bits
18 bits
17 bits
16 bits
20 bits

22 – 23 Alignment level
00: Not indicated
01: –20 dBFS
10: –18.06 dBFS

24 – 31 Channel identification
If bit 31 = 0, then channel number is 1 plus the numeric value of bits 24 - 30.
If bit 31 = 1, then bits 4 - 6 define a multichannel mode and bits 0 - 3 give the channel 
number within that mode.

32 – 33
Digital Audio Reference 
Signal (DARS)

00: Not a DARS
01: DARS grade 1 (±1 ppm)
10: DARS grade 2 (±10 ppm)

35 – 38 Sampling frequency

0000: Not indicated
1000: 24 kHz
0100: 96 kHz
1001: 22.05 kHz
0101: 88.2 kHz
1101: 176.4 kHz
1111: User defined

39 Sampling frequency scaling
0: No scaling
1: Apply factor of 1/1.001 to value

48 – 79
Alphanumeric channel 
origin

Four-character label using 7-bit ASCII with no parity. 
Bit 55, 63, 71, 79 = 0

80 – 111
Alphanumeric channel 
destination

Four-character label using 7-bit ASCII with no parity. 
Bit 87, 95, 103, 111 = 0

112 – 143 Local sample address code
32-bit binary number representing the sample count of the first sample of the channel 
status block

144 – 175 Time of day code 32-bit binary number representing tiem source encoding in samples since midnight

Table 3-45 AES3/SPDIF Professional mode bit description (continued)

Bits Label Description
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176 – 183 Reliability flags
0: Data in byte range is reliable
1: Data in byte range is unreliable

184 – 191 CRCC
00000000: Not implemented
nnnnnnnn: Error check code for bits 0 - 183

Table 3-45 AES3/SPDIF Professional mode bit description (continued)

Bits Label Description
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References (Analog Generator)

The output references for the analog generator is displayed as shown in Figure 3-74.

Figure 3-74 Analog Generator > References menu page

 
Table 3-46 Analog Generator > References menu description 

Menu Description

Ref. Imp Press the Ref. Imp softkey to set the reference impedance for the unit conversion of dBm measurements.
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References (Digital and Bluetooth Generator)

The output references for the digital and Bluetooth generator is displayed as shown in 
Figure 3-75 and Figure 3-76 respectively.

Figure 3-75 Digital Generator > References menu page

Figure 3-76 Bluetooth Generator > References menu page

Table 3-47 Digital/Bluetooth Generator > References menu description 

Menu Description

Volts/FS Press the Volts/FS softkey to set the volts/FS reference for the analog output voltage (in Volts) of the DAC used when 
converted to digital full scale (1 FS). This is useful in DAC tests for the conversion of digital units to analog units.
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THIS PAGE HAS BEEN INTENTIONALLY LEFT BLANK.
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This chapter describes the U8903B performance audio analyzer measurement functions 
and configurations.
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Audio Analyzer

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode. The Analog Analyzer menu page, Digital Analyzer menu page, and Bluetooth 
Analyzer menu page are displayed as shown in Figure 4-1, Figure 4-2, and Figure 4-3 
respectively.

Press  on the FUNCTION panel to switch between analog and digital interface.

Press  or  on the CHANNEL/DATA panel to switch to channel 1 or channel 2 

respectively, and start configuring the active channel.

The U8903B can also be expanded with additional analog analyzer channels. Refer to 
“U8903B Options” on page 37 for more information.

Press  on the RUN CONTROL panel to start or stop the measurements for the 

selected analyzer channel.

Figure 4-1 Analog Analyzer menu page
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Figure 4-2 Digital Analyzer menu page (standard measurement mode)

Table 4-1 Analog Analyzer menu description 

Menu Description

Functions Press the Functions softkey to configure the analog analyzer functions. Refer to “Functions” on page 184 for more 
information.

Filters Config Press the Filters Config softkey to set the filters configuration. Refer to “Filters Configuration (Analog Analyzer)” on 
page 233 for more information.

Meas Config Press the Meas Config softkey to set the measurement configuration. Refer to “Measurement Configuration (Analog 
Analyzer)” on page 240 for more information.

Input Config Press the Input Config softkey to set the input configuration. Refer to “Input Configuration (Analog Analyzer)” on 
page 248 for more information.

Wave File Press the Wave File softkey to configure the wave file settings. Refer to “Wave File (Analog, Digital, and Bluetooth 
Analyzer)” on page 257 for more information.

Statistics Press the Statistics softkey to configure the statistics settings. Refer to “Statistics” on page 259 for more information.
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Table 4-2 Digital Analyzer menu description 

Menu Description

Meas Mode

Press the Meas Mode softkey to select the measurement mode. Refer to “Measurement mode (Digital Analyzer)” on 
page 181 for more information.
– Standard
– Process Delay
– BERT

Unit

This is only available when the measurement mode is BERT.
Press the Unit softkey to select the unit for the BERT measurement mode.
– Hex
– Dec

Functions
This is only available when the measurement mode is Standard.
Press the Functions softkey to configure the analog analyzer functions. Refer to “Functions” on page 184 for more 
information.

Filters Config
This is only available when the measurement mode is Standard.
Press the Filters Config softkey to set the filters configuration. Refer to “Filters Configuration (Digital Analyzer)” on 
page 236 for more information.

Meas Config
This is only available when the measurement mode is Standard.
Press the Meas Config softkey to set the measurement configuration. Refer to “Measurement Configuration (Digital 
Analyzer)” on page 242 for more information.

Input Config Press the Input Config softkey to set the input configuration. Refer to “Input Configuration (Digital Analyzer)” on 
page 250 for more information.

DSI Config Press the DSI Config softkey to set the DSI input configurations such as the format, resolution, and others. Refer to “DSI 
Input Configuration (Digital Analyzer)” on page 253 for more information.

AES/SPDIF Press the AES/SPDIF softkey to set the AES3/SPDIF input configurations such as the decoding, resolution, and others. 
Refer to “AES/SPDIF Input Configuration (Digital Analyzer)” on page 255 for more information.

Bits Analysis Press the Bits Analysis softkey to set the bits analysis configuration. Refer to “Bits Analysis (Digital Analyzer)” on 
page 256 for more information.

Statistics Press the Statistics softkey to configure the statistics settings. Refer to “Statistics” on page 259 for more information.
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Figure 4-3 Bluetooth Analyzer menu page

Table 4-3 Bluetooth Analyzer menu description 

Menu Description

Functions Press the Functions softkey to configure the analog analyzer functions. Refer to “Functions” on page 184 for more 
information.

Filters Config Press the Filters Config softkey to set the filters configuration. Refer to “Filters Configuration (Analog Analyzer)” on 
page 233 for more information.

Meas Config Press the Meas Config softkey to set the measurement configuration. Refer to “Measurement Configuration (Analog 
Analyzer)” on page 240 for more information.

Link Config Press the Link Config softkey to set the input configuration. Refer to “Link Configuration (Bluetooth Analyzer)” on 
page 252 for more information.

Wave File Press the Wave File softkey to configure the wave file settings. Refer to “Wave File (Analog, Digital, and Bluetooth 
Analyzer)” on page 257 for more information.

Statistics Press the Statistics softkey to configure the statistics settings. Refer to “Statistics” on page 259 for more information.
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Measurement mode (Digital Analyzer)

Standard

Standard mode is the default mode for the digital analyzer.

Process delay

The process delay measurement calculates the time difference between the output and 
input frames. A digital audio signal will have delay when the signal is transmitted through a 
DUT. The process delay measurement calculates the time difference between the first 
output frame signal and the first input frame signal. Due to the nature of measurements 
involving frame-to-frame delay, this measurement is only meant for the AES3 signal which 
has a unique frame pattern. Process delay mode allows you to view the process delay in 
seconds.

Figure 4-4 Digital Analyzer menu page (process delay measurement mode)

NOTE
When the digital analyzer analysis mode is set to Process Delay, you are not allowed to 
perform any other types of measurements.
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BERT (Bit Error Rate Test)

The BERT mode measurement will provide the total errors, total bits run, and bit error rate. 
This test will only be meaningful if the selected output and input connectors are the same 
type.

The U8903B is able to analyze all waveform types generated by the digital generator In 
BERT mode except for the following: 

– Monotonicity 

– Square wave with the frequency setting less than half the sampling rate 

– Walking one or walking zero with the Sample per Step setting more than 1

Figure 4-5 Digital Analyzer menu page (BERT measurement mode)

NOTE
If square wave for BERT analysis is needed, set the frequency of the square wave to be 
equal to half the sampling rate.

If walking one or walking zero for BERT analysis is needed, set the sample per step to be 
equal to 1.

NOTE
When the digital analyzer measurement mode is set to BERT, you are not allowed to 
perform any other types of measurements.
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Table 4-4 Digital Analyzer > Meas Mode > BERT menu description

Menu Description

Unit
Press the Unit softkey to select the BERT result in either hex or decimal.
– Hex
– Dec

Reset BERT Press the Reset BERT softkey to reset the BERT result.
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Functions

The U8903B supports up to four functions to be measured in one single query. The function 
configuration for analog, digital, and Bluetooth analyzer are displayed as shown in 
Figure 4-6, Figure 4-7, and Figure 4-8.

Figure 4-6 Analog Analyzer > Functions menu page 1

Figure 4-7 Digital Analyzer > Functions menu page 1
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Figure 4-8 Bluetooth Analyzer > Functions menu page 1

Table 4-5 Analog/Digital/Bluetooth Analyzer > Functions menu description

Menu Description

Multi-Chn

Press the Multi-Chn softkey to select the multichannel measurement mode.
– Off 

The measurement functions are set independently across all channels.
– Phase 

Refer to “Phase Measurement” on page 227 for the configuration.
– X-Talk 

Refer to “Crosstalk Measurement” on page 230 for the configuration.

Function No. Press the Function No. softkey to select the active function number to configure the settings.

Meas. Func

Press the Meas. Func softkey to display the list of available analyzer measurement function types. Select the desired 
measurement function from the drop-down list. Refer to “Measurement Functions” on page 186 for the respective 
measurement functions settings.
This setting is only available when the multichannel mode is set to Off.
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Measurement Functions

Frequency measurement

Frequency is a common and basic measurement function which is expressed in hertz (Hz). 
The U8903B uses software algorithm to detect the period of a repetitive waveform, and the 
frequency is computed from the reciprocal of the period.

To obtain better accuracy and resolution, auto ranging should be enabled. For  
low-frequency signals, set a larger sample size to obtain better and more stable readings. 
Input filters can also be activated to remove unwanted high-frequency noise from the 
measured signal, allowing more stable readings.

Frequency measurement function mode is applicable for the analog, digital, and Bluetooth 
analyzer. The settings for frequency measurement are displayed as shown in Figure 4-9, 
Figure 4-10, and Figure 4-11 for the analog, digital, and Bluetooth analyzer respectively.

Figure 4-9 Analog Analyzer > Functions > Frequency menu page 1

NOTE
A limitation in the firmware supplied by the Bluetooth chipset vendor causes the Bluetooth 
analyzer frequency measurement for the A2DP profile under SBC codec at 44.1 kHz 
sampling rate to exhibit a ±0.05% measurement error. Do expect approximately 30 s of 
settling time for the first frequency measurement in the A2DP profile after the Open Media 
Connection have been initiated.
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Figure 4-10 Digital Analyzer > Functions > Frequency menu page 1

Figure 4-11 Bluetooth Analyzer > Functions > Frequency menu page 1

Table 4-6 Analog/Digital/Bluetooth Analyzer > Functions > Frequency menu description 

Menu Description

Unit
Press the Unit softkey to select the measurement unit.
– Hz
– ΔHz

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value). 
– Delta 

Selecting Delta will return the measurement result by deducting the reference frequency from the measured frequency.
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Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference 
frequency.

Ref. Freq Press the Ref. Freq softkey to set the reference frequency.

Table 4-6 Analog/Digital/Bluetooth Analyzer > Functions > Frequency menu description (continued)

Menu Description
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AC voltage level measurement

AC voltage level measurement is the most common measurement function of an AC signal. 
The U8903B provides two types of AC level detection consisting of rms and peak-to-peak. 
When the rms detection method is selected, the AC voltage measurement is expressed as 
an rms value. Likewise, if the peak-to-peak detector is selected, the result is a 
peak-to-peak value.

As an example, for a 1 Vrms sine input signal, the display will show 1 V if the rms detector 
is selected. On the other hand, if the peak-to-peak detector is selected, the display will 
show 2.828 V (1.414 × 2).

AC voltage level measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for AC voltage level measurement are displayed as shown 
in Figure 4-12, Figure 4-13 and Figure 4-14 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-12 Analog Analyzer > Functions > AC Voltage menu page 1

NOTE
Ensure that the input coupling is set to AC before measuring AC voltage level. Refer to 
“Input Configuration (Analog Analyzer)” on page 248 and “Measurement Configuration 
(Digital Analyzer)” on page 242 for more information.
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Figure 4-13 Digital Analyzer > Functions > AC Voltage menu page 1

Figure 4-14 Bluetooth Analyzer > Functions > AC Voltage menu page 1
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Table 4-7 Analog/Digital/Bluetooth Analyzer > Functions > AC Voltage menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
Analog Analyzer
– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x
Digital and Bluetooth Analyzer
– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Logarithmic 

Selecting Logarithmic will return the measurement result by using the following formula: 

 
The result is returned in unit dBr. 

– Linear 
Selecting Linear will return the measurement result by dividing the measured level by the reference level. The result is 
returned in unit x. 

– Delta 
Selecting Delta will return the meausrement result by deducting the reference level from the measured level. The result 
is returned in unit ΔV. This is only available for the analog analyzer.

Set to 0dB
This is only available for analog analyzer.
Press the Set to 0dB softkey to store the measured level as the reference level, and set the measurement reading format to 
Logarithmic.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference level.

Ref. Level Press the Ref. Level softkey to set the reference level value. There is only one reference level for each channel.

20 10 Measured rms voltage
Reference level

------------------------------------------- 
 log
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Ref. Imp
This is only available for the analog analyzer.
Press the Ref. Imp softkey to set the reference impedance value. This setting is only available if the unit is set to W.

Volt/FS
This is only available for the digital analyzer.
Press the Volt/FS softkey to set the volts/FS reference value.

Cal SPL Press the Cal SPL softkey to set the calibrator level value. This setting is only available when the unit is set to dBSPL.

Detector
Press the Detector softkey to select the AC level detection type.
– RMS
– Pk-Pk

Table 4-7 Analog/Digital/Bluetooth Analyzer > Functions > AC Voltage menu description (continued)

Menu Description
192 Keysight U8903B User’s Guide



Audio Analyzer Measurement Functions 4
DC voltage level measurement

DC voltage levels are often encountered in audio equipment although they are not part of 
the audio signal, for example, bias voltages and outputs from AC-to-DC converters. DC 
voltage is expressed in volts (V). The input coupling must be set to DC for DC voltage level 
measurement. 

DC voltage level measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for DC voltage level measurement are displayed as shown 
in Figure 4-15, Figure 4-16, and Figure 4-17 for the analog, digital, and Bluetooth 
analyzer respectively.

Figure 4-15 Analog Analyzer > Functions > DC Voltage menu page 1

NOTE
Ensure that the input coupling is set to DC before measuring DC voltage level. Refer to 
“Input Configuration (Analog Analyzer)” on page 248 and “Measurement Configuration 
(Digital Analyzer)” on page 242 for more information.
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Figure 4-16 Digital Analyzer > Functions > DC Voltage menu page 1

Figure 4-17 Bluetooth Analyzer > Functions > DC Voltage menu page 1
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Table 4-8 Analog/Digital/Bluetooth Analyzer > Functions > DC Voltage menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
Analog Analyzer
– V
– ΔV
– x
Digital and Bluetooth Analayzer
– FFS
– V
– LSB
– Hex
– Dec
– x

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Linear 

Selecting Linear will return the measurement result by dividing the measured level by the reference level. The result is 
returned in unit x. 

– Delta 
Selecting Delta will return the meausrement result by deducting the reference level from the measured level. The result 
is returned in unit ΔV. This is only available for the analog analyzer.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference level.

Ref. Level Press the Ref. Level softkey to set the reference level value. There is only one reference level for each channel.
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THD+N ratio and THD+N level measurements

Harmonic distortion on a spectrally pure signal is created by nonlinearities in the circuit 
through which it passes. The nonlinearities can arise in the transfer characteristics of an 
active device or by running the active device into saturation or cutoff. In most cases, 
distortion can be reduced by decreasing the signal level, applying filtering, or adding 
negative feedback.

According to Fourier mathematics, the nonlinear terms in the circuit transfer function give 
rise to harmonics of the signal. Therefore, the THD+N function provides a quantitative 
measurement of the quality of an audio signal or in other words, the purity of a signal.

The THD+N ratio is defined as the ratio of the square root of the sum of the squares of all 
the signal harmonics components and noise amplitude, relative to the total signal 
amplitude. The THD+N ratio can be computed as follows.

THD+N ratio measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for THD+N ratio measurement are displayed as shown in 
Figure 4-18, Figure 4-19, and Figure 4-20 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-18 Analog Analyzer > Functions > THD+N Ratio menu page 1

THD+N ratio 20 Log10
rms value of noise and distortion

rms value of signal, noise, and distortion
------------------------------------------------------------------------------- 
 =
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Figure 4-19 Digital Analyzer > Functions > THD+N Ratio menu page 1

Figure 4-20 Bluetooth Analyzer > Functions > THD+N Ratio menu page 1
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THD+N level is defined as the square root of the sum of the squares of all the signal 
harmonics components and noise amplitude, and it is expressed in Vrms. The THD+N level 
can be computed as follows.

Table 4-9 Analog/Digital/Bluetooth Analyzer > Functions > THD+N Ratio menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x

Format

Press the Format softkey to select the format of the returned measurement reading.
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Linear 

Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

– Delta 
Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

Set to 0dB
This is only available for analog analyzer.
Press the Set to 0dB softkey to store the measured ratio as the reference ratio, and set the measurement reading format to 
Delta.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio value.

Precision
This is only available for digital analyzer.
Press the Precision softkey to enable or disable the precision mode.

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Analog Notch
This is only available for analog analyzer. 
Press the Analog Notch softkey to enable or disable the analog notch filter. This filter is used to emulate the analog notch 
filter used in HP8903B.

THD+N Level rms value of noise and distortion=
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THD+N level measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for THD+N level measurement are displayed as shown in 
Figure 4-21, Figure 4-22, and Figure 4-23 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-21 Analog Analyzer > Functions > THD+N Level menu page 1

Figure 4-22 Digital Analyzer > Functions > THD+N Level menu page 1
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Figure 4-23 Bluetooth Analyzer > Functions > THD+N Level menu page 1

Table 4-10 Analog/Digital/Bluetooth Analyzer > Functions > THD+N Level menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
Analog Analyzer
– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x
Digital and Bluetooth Analyzer
– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL
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Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Logarithmic 

Selecting Logarithmic will return the measurement result by using the following formula: 

 
The result is returned in unit dBr. 

– Linear 
Selecting Linear will return the measurement result by dividing the measured level by the reference level. The result is 
returned in unit x. 

– Delta 
Selecting Delta will return the meausrement result by deducting the reference level from the measured level. The result 
is returned in unit ΔV. This is only available for the analog analyzer.

Set to 0dB
This is only available for analog analyzer.
Press the Set to 0dB softkey to store the measured level as the reference level, and set the measurement reading format to 
Logarithmic.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference level.

Ref. Level Press the Ref. Level softkey to set the reference level value. There is only one reference level for each channel.

Ref. Imp
This is only available for the analog analyzer.
Press the Ref. Imp softkey to set the reference impedance value. This setting is only available if the unit is set to W and 
dBm.

Volt/FS
This is only available for the digital and Bluetooth analyzer.
Press the Volt/FS softkey to set the volts/FS reference value.

Precision
This is only available for the digital analyzer.
Press the Precision softkey to enable or disable the precision mode.

Cal SPL Press the Cal SPL softkey to set the calibrator level value. This setting is only available when the unit is set to dBSPL.

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Analog Notch
This is only available for analog analyzer. 
Press the Analog Notch softkey to enable or disable the analog notch filter. This filter is used to emulate the analog notch 
filter used in HP8903B.

Table 4-10 Analog/Digital/Bluetooth Analyzer > Functions > THD+N Level menu description (continued)

Menu Description

20 10 Measured rms voltage
Reference level

------------------------------------------- 
 log
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SINAD measurement

SINAD (Signal, Noise, and Distortion Ratio) is equal to the reciprocal of the distortion 
measurement. It is mostly used to determine the sensitivity of a communications receiver. 
The ratio computed in the SINAD measurement is shown as follows.

SINAD measurement function mode is applicable for the analog, digital, and Bluetooth 
audio analyzer. The settings for SINAD measurement are displayed as shown in 
Figure 4-24, Figure 4-25, and Figure 4-26 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-24 Analog Analyzer > Functions > SINAD menu page 1

Figure 4-25 Digital Analyzer > Functions > SINAD menu page 1

SINAD 20 Log rms value of signal, noise, and distortion
rms value of noise and distortion

------------------------------------------------------------------------------- 
 =
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Figure 4-26 Bluetooth Analyzer > Functions > SINAD menu page 1

Table 4-11 Analog/Digital/Bluetooth Analyzer > Functions > SINAD menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x

Format

Press the Format softkey to select the format of the returned measurement reading.
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Linear 

Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

– Delta 
Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

Set to 0dB
This is only available for the analog analyzer.
Press the Set to 0dB softkey to store the measured ratio as the reference ratio, and set the measurement reading format to 
Delta.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio value.

Precision
This is only available for the digital analyzer.
Press the Precision softkey to enable or disable the precision mode.
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Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Table 4-11 Analog/Digital/Bluetooth Analyzer > Functions > SINAD menu description (continued)

Menu Description
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THD ratio and THD level measurements

THD (Total Harmonic Distortion) measures the selected harmonics amplitude that are 
generated due to the nonlinearity of the DUT and adding up the harmonics amplitude. The 
THD measurement will exclude any noise components that may be present in the DUT.

THD Ratio is defined as the ratio of the THD Level relative to the fundamental signal 
amplitude, and it is expressed in dB (default) or as a percentage. The THD Ratio can be 
computed as follows.

THD+N Ratio measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for THD ratio measurement are displayed as shown in 
Figure 4-27, Figure 4-28, and Figure 4-29 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-27 Analog Analyzer > Functions > THD Ratio menu page 1

THD ratio 20 Log10
rms value of distortion

rms value of signal and distortion
----------------------------------------------------------------- 
 =
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Figure 4-28 Digital Analyzer > Functions > THD Ratio menu page 1

Figure 4-29 Bluetooth Analyzer > Functions > THD Ratio menu page 1

Table 4-12 Analog/Digital/Bluetooth Analyzer > Functions > THD Ratio menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x
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Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Delta 

Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

– Linear 
Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

Set to 0dB
This is only available for analog analyzer.
Press the Set to 0dB softkey to store the measured ratio as the reference ratio, and set the measurement reading format to 
Delta.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio value.

Even Harmonic

Press the Even Harmonic softkey to display the even harmonics order selection. Press the Enter key on the navigation 
panel to select the desired even harmonics order, and press the Even Harmonic softkey again to confirm the selection.
– ALL
– 2
– 4
– 6
– 8

Odd Harmonic

Press the Odd Harmonic softkey to display the odd harmonics order selection. Press the Enter key on the navigation panel 
to select the desired odd harmonics order, and press the Odd Harmonic softkey again to confirm the selection.
– ALL
– 3
– 5
– 7
– 9

Freq Lock

This is only available for analog and Bluetooth analyzer.
Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Table 4-12 Analog/Digital/Bluetooth Analyzer > Functions > THD Ratio menu description (continued)

Menu Description
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THD Level is defined as the square root of the sum of the squares of all the signal 
harmonics components, and it is expressed in Vrms. The THD Level can be computed  
as follows.

THD+N Level measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for THD level measurement are displayed as shown in 
Figure 4-30, Figure 4-31, and Figure 4-32 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-30 Analog Analyzer > Functions > THD level menu page 1

Figure 4-31 Digital Analyzer > Functions > THD level menu page 1

THD Level rms value of distortion=
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Figure 4-32 Bluetooth Analyzer > Functions > THD level menu page 1

Table 4-13 Analog/Digital/Bluetooth Analyzer > Functions > THD Level menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
Analog Analyzer
– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x
Digital and Bluetooth Analyzer
– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL
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Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Logarithmic 

Selecting Logarithmic will return the measurement result by using the following formula: 

 
The result is returned in unit dBr. 

– Linear 
Selecting Linear will return the measurement result by dividing the measured level by the reference level. The result is 
returned in unit x. 

– Delta 
Selecting Delta will return the meausrement result by deducting the reference level from the measured level. The result 
is returned in unit ΔV. This is only available for the analog analyzer.

Set to 0dB
This is only available for the analog analyzer.
Press the Set to 0dB softkey to store the measured level as the reference level, and set the measurement reading format to 
Logarithmic.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference level.

Ref. Level Press the Ref. Level softkey to set the reference level value. There is only one reference level for each channel.

Ref. Imp
This is only available for the analog analyzer.
Press the Ref. Imp softkey to set the reference impedance value. This setting is only available if the unit is set to W and 
dBm.

Volt/FS
This is only available for the digital analyzer.
Press the Volt/FS softkey to set the volts/FS reference value.

Cal SPL Press the Cal SPL softkey to set the calibrator level value. This setting is only available when the unit is set to dBSPL.

Even Harmonic

Press the Even Harmonic softkey to select the even harmonics.
– ALL
– 2
– 4
– 6
– 8

Odd Harmonic

Press the Odd Harmonic softkey to select the odd harmonics.
– ALL
– 3
– 5
– 7
– 9

Table 4-13 Analog/Digital/Bluetooth Analyzer > Functions > THD Level menu description (continued)

Menu Description

20 10 Measured rms voltage
Reference level

------------------------------------------- 
 log
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Freq Lock

This is only available for the analog and Bluetooth analyzer.
Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Table 4-13 Analog/Digital/Bluetooth Analyzer > Functions > THD Level menu description (continued)

Menu Description
Keysight U8903B User’s Guide 211



4 Audio Analyzer Measurement Functions
SMPTE IMD measurements

The SMPTE IMD function provides a measure of the second and third order intermodulation 
distortion introduced by the DUT by injecting two pure tones (tone 1 and tone 2, where 
tone 1 is at a much lower frequency than tone 2, for example, 60 Hz and 7 kHz respectively) 
into the DUT. SMPTE IMD is expressed in dB (default) or as a percentage.

If tone 1 = f1 and tone 2 = f2, the following harmonics are considered.

– f2 – f1

– f2 + f1

– f2 – 2f1

– f2 + 2f1

The SMPTE IMD value is computed as the ratio of the sum of the intermodulation 
harmonics amplitude to the upper frequency tone amplitude. Refer to “Dual waveform” on 
page 106 for more information on generating dual tones for this measurement.

SMPTE IMD measurement function mode is applicable for the analog, digital, and 
Bluetooth analyzer. The settings for SMPTE IMD measurement are displayed as shown in 
Figure 4-33, Figure 4-34, and Figure 4-35 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-33 Analog Analyzer > Functions > SMPTE IMD menu page 1
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Figure 4-34 Digital Analyzer > Functions > SMPTE IMD menu page 1

Figure 4-35 Bluetooth Analyzer > Functions > SMPTE IMD menu page 1
Keysight U8903B User’s Guide 213



4 Audio Analyzer Measurement Functions
Table 4-14 Analog/Digital/Bluetooth Analyzer > Functions > SMPTE IMD menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Delta 

Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

– Linear 
Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

Set to 0dB
This is only available for the analog analyzer.
Press the Set to 0dB softkey to store the measured ratio as the reference ratio, and set the measurement reading format to 
Delta.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio.

Freq Lock

This is only available for the analog and Bluetooth analyzer.
Press the Freq Lock softkey to select the searching method for the upper and lower frequencies.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the upper and lower frequencies of the input signal based on the 
upper and lower frequencies of the respective generator channel. You can select the generator channel by setting the 
Src Channel in the Meas. Config. menu page. This Gen Lock method is only useful if you use the internal audio 
generator.

– Custom 
If you have a known input signal, you can define the upper and lower frequency values by setting the searching method 
to Custom and setting the frequency value in Upper Freq and Lower Freq.

Upper Freq Press the Upper Freq softkey to set the upper frequency value. This setting is only available when Freq Lock is set to 
Custom.

Lower Freq Press the Lower Freq softkey to set the lower frequency value. This setting is only available when Freq Lock is set to 
Custom.
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DFD measurements

The DFD measurement is similar to SMPTE IMD, except that the two tones in the stimulus 
signal are of equal amplitude and are spaced closer to each other (typically 19 kHz and 
20 kHz). This measurement also allows you to select either the second or third order 
intermodulation distortion. The available DFD measurements are DFD 60268 2nd, DFD 
60268 3rd, DFD 60118 2nd, or DFD 60118 3rd.

DFD measurement function mode is applicable for the analog, digital, and Bluetooth audio 
analyzer. The settings for DFD measurements are displayed as shown in Figure 4-36, 
Figure 4-37, and Figure 4-38 for the analog, digital, and Bluetooth analyzer respectively.

Figure 4-36 Analog Analyzer > Functions > DFD 60268 2nd menu page 1

Figure 4-37 Digital Analyzer > Functions > DFD 60268 2nd menu page 1
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Figure 4-38 Bluetooth Analyzer > Functions > DFD 60268 2nd menu page 1

Table 4-15 Analog/Digital/Bluetooth Analyzer > Functions > DFD measurements menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Delta 

Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

– Linear 
Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

Set to 0dB
This is only available for the analog analyzer.
Press the Set to 0dB softkey to store the measured ratio as the reference ratio, and set the measurement reading format to 
Delta.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio.
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SNR measurement

SNR is defined as the ratio of the signal amplitude to noise amplitude. The U8903B 
implementation of the SNR measurement is a closed-loop configuration in which both the 
generator and the analyzer are used in the test setup. For example, channel 1 of the analog 
generator and analog analyer must be used together for this measurement.

SNR is further defined by the measurement bandwidth. The measurement bandwidth is 
specified by the filter selected for the audio analyzer. The SNR measurement is 
accomplished by an internal routine that alternatively switches the U8903B generator 
output on and off. When the U8903B output is in the off state, the U8903B output will be 
terminated at the DUT input.

The SNR result can be expressed in dB (default) or as a percentage. The SNR can be 
computed as follows.

SNR measurement function mode is applicable for analog analyzer only. The settings for 
SNR measurement are displayed as shown in Figure 4-39.

Figure 4-39 Analog Analyzer > Functions > SNR menu page 1

SNR 20 Log10
rms value of signal
rms value of noise
------------------------------------ 
 =
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Table 4-16 Analog Analyzer > Functions > SNR menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Delta 

Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

– Linear 
Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

Set to 0dB Press the Set to 0dB softkey to store the measured ratio as the reference ratio, and set the measurement reading format to 
Delta.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio.

SNR Delay Press the SNR Delay softkey to set the SNR delay.
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SNR (fast mode) measurement

SNR (fast mode) measurement is used to measure the ratio of signal amplitude over noise 
amplitude. The SNR (fast mode) measurement is a frequency domain calculation. This 
method is significantly faster than the standard SNR measurement, but it is not suitable for 
measuring very high SNR. The noise measurement is made by notching out the 
fundamental and harmonics from the frequency spectrum.

You can set the number of harmonics that will be removed in the computation. For 
example, if the harmonics count is 1, the fundamental frequency will only be notched. If the 
harmonics count is 3, the fundamental frequency and the first and second harmonics will 
be notched for the calculation.

The SNR (fast mode) can be computed as follows.

SNR (fast mode) measurement function mode is applicable for the analog and Bluetooth 
analyzer. The settings for SNR (fast mode) measurement are displayed as shown in 
Figure 4-40 and Figure 4-41 for the analog and Bluetooth respectively.

Figure 4-40 Analog Analyzer > Functions > SNR (Fast) menu page 1

SNR 20 Log10
rms value of signal
rms value of noise
------------------------------------ 
 =
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Figure 4-41 Bluetooth Analyzer > Functions > SNR (Fast) menu page 1

Table 4-17 Analog/Bluetooth Analyzer > Functions > SNR (Fast) menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x

Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Delta 

Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

– Linear 
Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

Set to 0dB
This is only available for the analog analyzer.
Press the Set to 0dB softkey to store the measured level or ratio as the reference value, and set the reading to refer to the 
stored reference value.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio.
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Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Harmonics Press the Harmonics softkey to set the number of harmonics order to be removed.

Table 4-17 Analog/Bluetooth Analyzer > Functions > SNR (Fast) menu description (continued)

Menu Description
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J-test measurement

Jitter in a digital system is defined as the variation in time between the periodic samples. 
Jitter may occur during sampling process of the ADC and DAC and clock recovery process. 
It can also appear in the data pattern of the digital interface link.

J-test is an AES3 test signal that is developed to simulate the worst case data jitter in the 
digital signal and also to test the jitter susceptibility of the DAC. The J-test signal consists 
of a test tone with a frequency at 1/4 of the sampling rate (Fs) and a jitter signal with a 
frequency of 1/192 Fs. The J-test digital pattern to be transmitted is as follows:

C00000 C00000 400000 400000 x24 
BFFFFF BFFFFF BFFFFF BFFFFF x24

The digital pattern will cause inter-symbol interference in the digital signal and stress the 
DAC clock recovery subsystem. You can measure the DAC system jitter performance by 
observing the analog output of the DAC in the FFT spectrum.

J-test measurement function mode is applicable for the analog analyzer only. The J-test 
measurement is displayed as shown in Figure 4-42.

Figure 4-42 Analog Analyzer > Functions > J-Test menu page
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Positive peak measurement

Positive peak measurement function mode is a measurement of the greatest positive 
voltage level. Positive peak measurement function is applicable for the digital analyzer 
only. The positive peak measurement is displayed as shown in Figure 4-43.

Figure 4-43 Digital Analyzer > Functions > Positive Peak menu page

Table 4-18 Digital Analyzer > Functions > Positive Peak menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL
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Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Logarithmic 

Selecting Logarithmic will return the measurement result by using the following formula: 

 
The result is returned in unit dBr. 

– Linear 
Selecting Linear will return the measurement result by dividing the measured level by the reference level. The result is 
returned in unit x. 

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference level.

Ref. Level Press the Ref. Level softkey to set the reference level value. There is only one reference level for each channel.

Volt/FS Press the Volt/FS softkey to set the volts/FS reference value.

Cal SPL Press the Cal SPL softkey to set the calibrator level value. This setting is only available when the unit is set to dBSPL.

Table 4-18 Digital Analyzer > Functions > Positive Peak menu description (continued)

Menu Description

20 10 Measured rms voltage
Reference level

------------------------------------------- 
 log
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Negative peak measurement

Negative peak measurement function mode is a measurement of the greatest negative 
voltage level. Negative peak measurement function is applicable for the digital analyzer 
only. The negative peak measurement is displayed as shown in Figure 4-44.

Figure 4-44 Digital Analyzer > Functions > Negative Peak menu page

Table 4-19 Digital Analyzer > Functions > Negative Peak menu description 

Menu Description

Unit

Press the Unit softkey to select the measurement unit.
– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL
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Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Logarithmic 

Selecting Logarithmic will return the measurement result by using the following formula: 

 
The result is returned in unit dBr. 

– Linear 
Selecting Linear will return the measurement result by dividing the measured level by the reference level. The result is 
returned in unit x. 

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference level.

Ref. Level Press the Ref. Level softkey to set the reference level value. There is only one reference level for each channel.

Volt/FS Press the Volt/FS softkey to set the volts/FS reference value.

Cal SPL Press the Cal SPL softkey to set the calibrator level value. This setting is only available when the unit is set to dBSPL.

Table 4-19 Digital Analyzer > Functions > Negative Peak menu description (continued)

Menu Description

20 10 Measured rms voltage
Reference level

------------------------------------------- 
 log
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Phase Measurement

Phase measurements are used to describe the positive or negative time offset in a periodic 
waveform cycle (such as a sine waveform), measured from a reference waveform. The 
reference is usually the same signal at a different point in the system, or a related signal in 
a different channel of the system. Phase is expressed in degrees (°).

Phase shift varies with frequency, and therefore, it is common to make phase 
measurements at several frequencies or to plot the phase response of a frequency sweep.

There are generally two types of phase measurements as follows.

– interchannel phase delay

– device phase response

To make an interchannel phase measurement, the signal level must be specified. Phase 
measurements are generally not level-sensitive, as long as the signal is well above the 
noise and below distortion.

For example, to test the interchannel phase delay of a stereo system, we inject a 1 Vrms, 
1 kHz sine waveform using the same analog generator channel. The output of one channel 
is connected to the analog analyzer channel 1 while the other is connected to channel 2. 
Set the analog analyzer to measure phase. If channel 1 is set as the reference channel, the 
channel 2 result is the interchannel phase delay.

A phase response measurement compares the phase of the output signal of a DUT to the 
phase of the signal at its input. For example, a simple way to make this measurement is to 
use the analog analyzer channel 1 to measure the input, and use the analog analyzer 
channel 2 to measure the output.

The U8903B always uses channel 1 of the analog generator as the reference channel, while 
the selected analog analyzer channel becomes the reference channel for interchannel 
phase measurements.

Phase measurement function mode is applicable for the analog, digital, and Bluetooth 
audio analyzer. The settings for phase measurement are displayed as shown in 
Figure 4-45, Figure 4-46, and Figure 4-47 for both the analog, digital, and Bluetooth 
analyzer respectively.

NOTE
Auto range will be disabled for phase measurement. Refer to “Measurement Configuration 
(Analog Analyzer)” on page 240 to set the input voltage range.
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Figure 4-45 Analog Analyzer > Functions > Phase menu page

Figure 4-46 Digital Analyzer > Functions > Phase menu page
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Figure 4-47 Bluetooth Analyzer > Functions > Phase menu page

Table 4-20 Analog/Digital/Bluetooth Analyzer > Functions > Phase menu description

Menu Description

Ref. Channel Press the Ref. Channel softkey to set the reference channel number.

Freq Lock

This is only available for the analog and Bluetooth analyzer.
Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq. 

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.
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Crosstalk Measurement

In audio systems with more than one channel, it is common for a signal in one channel to 
appear at the output of another channel at a reduced level. Crosstalk refers to this signal 
leakage across channels, and it is expressed in dB (default) or as a percentage.

Crosstalk is a measurement of the ratio of the signal amplitude in an unused channel 
relative to that of a channel driven with a signal. The unused channels should be grounded 
or set to an appropriate bias point. Crosstalk is largely due to capacitive coupling between 
the channel conductors in the device and generally varies with frequency. Crosstalk can be 
computed as follows.

Phase measurement function mode is applicable for the analog, digital, and Bluetooth 
audio analyzer. The settings for crosstalk measurement are displayed as shown in 
Figure 4-48, Figure 4-49, and Figure 4-50 for the analog, digital, and Bluetooth analyzer 
respectively.

Figure 4-48 Analog Analyzer > Functions > X-Talk menu page 1

Crosstalk 20 Log10
rms value of signal measured

rms value of signal driven
--------------------------------------------------------- 
 =
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Figure 4-49 Digital Analyzer > Functions > X-Talk menu page 1

Figure 4-50 Bluetooth Analyzer > Functions > X-Talk menu page 1

Table 4-21 Analog/Digital/Bluetooth Analyzer > Functions > X-Talk menu description 

Menu Description

Ref. Channel Press the Ref. Channel softkey to set the driven channel.

Unit

Press the Unit softkey to select the measurement unit.
– dB
– ΔdB
– %
– x
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Format

Press the Format softkey to select the format of the returned measurement reading. 
– Off 

Selecting Off will return the measurement reading without any formatting (raw value).
– Delta 

Selecting Delta will return the measurement result by deducting the reference ratio from the measured ratio. The result 
will be returned in unit ΔdB.

– Linear 
Selecting Linear will return the measurement result by dividing the measured ratio by the reference ratio. The result is 
returned in unit x.

Set to 0dB
This is only available for the analog analyzer.
Press the Set to 0dB softkey to store the measured level or ratio as the reference value, and set the reading to refer to the 
stored reference value.

Set result as ref. from Press the Set result as ref. from softkey to store the measurement result from the selected channel as the reference ratio.

Ref. Ratio Press the Ref. Ratio softkey to set the reference ratio.

Freq Lock

This is only available for the analog and Bluetooth analyzer.
Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. You can select the generator channel by setting the Src Channel in the Meas. 
Config. menu page. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Table 4-21 Analog/Digital/Bluetooth Analyzer > Functions > X-Talk menu description (continued)

Menu Description
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Filters Configuration (Analog Analyzer)

Filters are used to bandwidth limit the input signals before applying a measurement 
function. The filter configuration for the analog analyzer is displayed as shown in 
Figure 4-51.

Figure 4-51 Analog Analyzer > Filter Config menu page

Table 4-22 Analog Analyzer > Filter Config menu description 

Menu Description

Clear Filters Press the Clear Filters softkey to clear all the filter settings.

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)
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HPF

Press the HPF softkey to select the high-pass filter. 
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)

Deemphasis

Press the Deemphasis softkey to select the de-emphasis value.
– None
– 50 μs
– 75 μs
– Custom

Notch Filter Press the Notch Filter softkey to configure the notch filter settings. Refer to “Notch Filter” on page 235 for more 
information.

Table 4-22 Analog Analyzer > Filter Config menu description (continued)

Menu Description
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Notch Filter

Notch filter is used to remove the unwanted frequency component in the input signal. This 
setting is only applicable for THD+N and SINAD measurements.

Figure 4-52 Analog Analyzer > Filter Config > Notch Filter menu page

Table 4-23 Analog Analyzer > Filter Config > Notch Filter menu description 

Menu Description

State Press the State softkey to enable or disable the notch filter.

Center Freq Press the Center Freq softkey to set the frequency of the component to be removed from the input signal.

Bandwidth Press the Bandwidth softkey to set the bandwidth of the signal component to be removed.
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Filters Configuration (Digital Analyzer)

Filters are used to bandwidth limit the input signals before applying a measurement 
function. The filter configuration for digital analyzer is displayed as shown in Figure 4-53.

Figure 4-53 Digital Analyzer > Filter Config menu page

Table 4-24 Digital Analyzer > Filter Config menu description 

Menu Description

Clear Filters Press the Clear Filters softkey to clear all the filter settings.

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)

HPF

Press the HPF softkey to select the high-pass filter. 
– None
– 20 Hz
– 100 Hz
– 400 Hz
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)
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Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)

Deemphasis

Press the Deemphasis softkey to select the de-emphasis value.
– None
– 50 μs
– 75 μs
– Custom

Sample Rate

This is only available for digital analyzer.
Press the Sample Rate softkey to select the sample rate.
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz

Table 4-24 Digital Analyzer > Filter Config menu description (continued)

Menu Description
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Filters Configuration (Bluetooth Analyzer)

Filters are used to bandwidth limit the input signals before applying a measurement 
function. The filter configuration for the Bluetooth analyzer is displayed as shown in 
Figure 4-54.

Figure 4-54 Bluetooth Analyzer > Filter Config menu page

Table 4-25 Bluetooth Analyzer > Filter Config menu description 

Menu Description

Clear Filters Press the Clear Filters softkey to clear all the filter settings.

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 15 kHz
– 20 kHz
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)

HPF

Press the HPF softkey to select the high-pass filter. 
– None
– 22 Hz
– 100 Hz
– 400 Hz
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom (Refer to “Appendix 18: User-defined Filter File Format” on page 563 for more information.)
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Notch Filter

Notch filter is used to remove the unwanted frequency component in the input signal. This 
setting is only applicable for THD+N and SINAD measurements.

Figure 4-55 Bluetooth Analyzer > Filter Config > Notch Filter menu page

Deemphasis

Press the Deemphasis softkey to select the de-emphasis value.
– None
– 50 μs
– 75 μs
– Custom

Notch Filter Press the Notch Filter softkey to configure the notch filter settings. Refer to “Notch Filter” on page 239 for more 
information.

Table 4-25 Bluetooth Analyzer > Filter Config menu description (continued)

Menu Description

Table 4-26 Bluetooth Analyzer > Filter Config > Notch Filter menu description 

Menu Description

State Press the State softkey to enable or disable the notch filter.

Center Freq Press the Center Freq softkey to set the frequency of the component to be removed from the input signal.

Bandwidth Press the Bandwidth softkey to set the bandwidth of the signal component to be removed.
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Measurement Configuration (Analog Analyzer)

The measurement configuration for analog analyzer is displayed as shown in Figure 4-56.

Figure 4-56 Analog Analyzer > Meas Config menu page 1

Table 4-27 Analog Analyzer > Meas Config menu description 

Menu Description

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Mov Average
Press the Mov Average softkey to set the number of measurement readings to be used for the moving average calculation. 
This is useful for noisy signal. Applying the average points will smooth out the  fluctuations introduced by the noise that 
caused the inconsistencies in the measurement reading.

Sync Average
Press the Sync Average softkey to set the number of points for the synchronous averaging in the analyzer meter mode. 
Synchronous averaging reduces noise levels by averaging the acquired data. 
– 1 to 64

Src Channel
Press the Src Channel to select the internal generator channel as the reference channel used in the following situations.
– For the result calculation in unit dBg.
– For the frequencies searching algorithm when the frequency lock is set to Gen Lock.

Trigger Press the Trigger softkey to configure the trigger settings. Refer to “Trigger (Analog, Digital, and Bluetooth 
Analyzer)” on page 246 for more information.
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NOTE
For details on audio measurement ranging, please refer to “Appendix 29: Audio 
Measurement Ranging” on page 605 to set the input voltage range.
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Measurement Configuration (Digital Analyzer)

The measurement configuration for digital analyzer is displayed as shown in Figure 4-57.

Figure 4-57 Digital Analyzer > Meas Config menu page

Table 4-28 Digital Analyzer > Meas Config menu description 

Menu Description

Coupling

Press the Coupling softkey to select the coupling type.
– DC 

DC coupling allows both AC and DC input signals to pass through to the digital analyzer and to be measured down to  
0 Hz. This setting should be selected when making DC voltage measurements.

– AC 
AC coupling blocks the DC component of the input signal. This setting should be selected when you need to measure 
only the AC component of a signal. For example, when you are making rms or peak-to-peak voltage measurement.

Sample Size

Press the Sample Size softkey to select the sample size. The sample size is the number of data points acquired for the 
measurement. The higher the sample size, the higher the accuracy of the measurement result.
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M
242 Keysight U8903B User’s Guide



Audio Analyzer Measurement Functions 4
Mov Average
Press the Mov Average softkey to set the average points. Higher number of average points should be used when the 
analyzed data is noisy.
– 1 to 20 points

Trigger Press the Trigger softkey to configure the trigger settings. Refer to “Trigger (Analog, Digital, and Bluetooth 
Analyzer)” on page 246 for more information.

Table 4-28 Digital Analyzer > Meas Config menu description (continued)

Menu Description
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Measurement Configuration (Bluetooth Analyzer)

The measurement configuration for Bluetooth analyzer is displayed as shown in 
Figure 4-58.

Figure 4-58 Bluetooth Analyzer > Meas Config menu page

Table 4-29 Bluetooth Analyzer > Meas Config menu description 

Menu Description

Coupling

Press the Coupling softkey to select the coupling type.
– DC 

DC coupling allows both AC and DC input signals to pass through to the Bluetooth analyzer and to be measured down to  
0 Hz. This setting should be selected when making DC voltage measurements.

– AC 
AC coupling blocks the DC component of the input signal. This setting should be selected when you need to measure 
only the AC component of a signal. For example, when you are making rms or peak-to-peak voltage measurement.

Sample Size

Press the Sample Size softkey to select the sample size. The sample size is the number of data points acquired for the 
measurement. The higher the sample size, the higher the accuracy of the measurement result.
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288

Mov Average
Press the Mov Average softkey to set the average points. Higher number of average points should be used when the 
analyzed data is noisy.
– 1 to 20 points
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Sync Average
– Press the Sync Average softkey to set the number of points for the synchronous averaging in the analyzer meter mode. 

Synchronous averaging reduces noise levels by averaging the acquired data.
– 1 to 64

Src Channel
Press the Src Channel to select the internal generator channel as the reference channel used in the following situations.
– For the result calculation in unit dBg.
– For the frequencies searching algorithm when the frequency lock is set to Gen Lock.

Trigger Press the Trigger softkey to configure the trigger settings. Refer to “Trigger (Analog, Digital, and Bluetooth 
Analyzer)” on page 246 for more information.

Table 4-29 Bluetooth Analyzer > Meas Config menu description (continued)

Menu Description
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Trigger (Analog, Digital, and Bluetooth Analyzer)

The trigger menu page for analog, digital, and Bluetooth analyzer is displayed as shown in 
Figure 4-59, Figure 4-60, and Figure 4-61.

Figure 4-59 Analog Analyzer > Meas Config > Trigger menu page

Figure 4-60 Digital Analyzer > Meas Config > Trigger menu page
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Figure 4-61 Bluetooth Analyzer > Meas Config > Trigger menu page

Table 4-30 Digital Analyzer > Meas Config > Trigger menu description 

Menu Description

Trigger Source

Press the Trigger Source softkey to select the trigger source. The default trigger in is Free Run, where the analyzer triggers 
immediately after the previous data is acquired. If External trigger in is set, the analyzer waits for a trigger pulse on the 
Trigger In connector at the rear panel before acquiring the measurement data.
– Free Run
– External
– Channel

Trigger Edge

This is only available when the trigger source is External or Channel.
Press the Trigger Edge softkey to select the trigger edge type. 
– Rising
– Falling

Interface

This is only available when the trigger source is Channel.
Press the Interface softkey to select the trigger interface.
– Analog
– Digital
– Bluetooth

Channel
This is only available when the trigger source is Channel.
Press the Channel softkey to set the channel number. 

Trigger Level

This is only available when the trigger source is Channel.
When the Trigger Interface is Analog, the Trigger Level is in Vpeak.
When the Trigger Interface is Digital or Bluetooth, the Trigger Level is in Hex.
Press the Trigger Level softkey to set the trigger level. 
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Input Configuration (Analog Analyzer)

The input configuration for analog analyzer is displayed as shown in Figure 4-62.

Figure 4-62 Analog Analyzer > Input Config menu page

Table 4-31 Analog Analyzer > Input Config menu description 

Menu Description

Connector

Press the Connector softkey to select the input connector type.
– UnBal 

Unbalanced connector type routes the signal from the BNC input connector. The signal in the inner conductor of the 
coaxial connector is referenced to the ground for measurement.

– Bal 
Balanced connector type routes the signal from the XLR input connectors in the front panel to the analog analyzer. The 
signals on the positive and negative pins of the XLR connector enter a differential amplifier where they are subtracted 
before passing on to the detector. 

– Loopback 
Loopback connector type routes the signal from the generator to the analyzer internally.  
The generator channel 1 signal will be routed to the analyzer odd channels (1, 3, 5, and 7), and the generator channel 2 
signal will be routed to the analyzer even channels (2, 4, 6, and 8).  
For example, if you select Loopback in any of the analyzer odd channels, the output connector type of the generator 
channel 1 will automatically be set to Loopback.

Impedance

Press the Impedance softkey to select the input impedance value. This setting is only available when Connector is set to 
UnBal or Bal.
– 100 kΩ (for UnBal)
– 200 kΩ (for Bal)
– 600 Ω
– 300 Ω

Auto Range Press the Auto Range softkey to enable or disable auto range.
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Range

Press the Range softkey to select the input voltage range. This setting is only available when the auto range is disabled.
– 140 V
– 100 V
– 32 V
– 10 V
– 3.2 V
– 1 V
– 320 mV

Bandwidth

Press the Bandwidth softkey to select the input bandwidth value. This setting is only available with Option N3431A. Refer 
to “U8903B Options” on page 37 for more information.
– 90 kHz  

(This is the default setting with sampling rate of 192 kHz)
– 1.5 MHz

Coupling

Press the Coupling softkey to select the input coupling type.
– DC 

DC coupling allows both the AC and DC analog input signals to pass through to the analog analyzer and to be measured 
down to 0 Hz. This setting should be selected when making DC voltage measurements.

– AC 
AC coupling blocks the DC component of the analog input signal by switching a capacitor in series to the input path. 
This setting should be selected when you need to measure only the AC component of a signal. For example, use AC 
coupling when you are making an rms or peak-to-peak voltage measurement. 

Ext. Gain

Press the Ext. Gain softkey to set the input external gain value.
The external gain can be set in the range of –60 dB to 60 dB. The default external gain is 0 dB. External gain is used to 
correct the effects of any external gain or loss that may be part of a measurement setup.
For example, if an amplifier is part of a measurement setup, the external gain value is used to remove the effects of its gain. 
However, if an external attenuator is used in a high voltage measurement, the external gain value is used to correct the 
loss. The external gain value can be set in unit dB or x.

Table 4-31 Analog Analyzer > Input Config menu description (continued)

Menu Description
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Input Configuration (Digital Analyzer)

The input configuration for digital analyzer is displayed as shown in Figure 4-63.

Figure 4-63 Digital Analyzer > Input Config menu page

Table 4-32 Digital Analyzer > Input Config menu description 

Menu Description

Connector

Press the Connector softkey to select the connector type.
– UnBal 

Unbalanced connector type routes the digital signal from the BNC input connector at the rear panel to the  
digital analyzer.

– Bal 
Balanced connector type routes the digital signal from the XLR input connectors in the rear panel to the digital analyzer.

– Optical 
Optical connector type routes the digital signal from the TOSLINK input connector at the rear panel to the  
digital analyzer.

– DSI 
DSI connector type routes the digital signal from the 25-pin female D-SUB connector at the rear panel to the  
digital analyzer.

Impedance

Press the Impedance softkey to select the input impedance.
Unbalanced connector type
– 75 Ω
– HiZ
Balanced connector type
– 110 Ω
– HiZ
250 Keysight U8903B User’s Guide



Audio Analyzer Measurement Functions 4
Freq Scaling

Press the Freq Scaling softkey to select the frequency scaling type.
– MISR 

The frequency will track the incoming Word Clock and recover the audio at its original frequency.
– Custom 

The audio signal frequency will be translated according to the reference sample rate value set in the Ref SR.

Ref SR
This is only available when frequency scaling is Custom.
Press the Ref SR softkey to set the reference sample rate value. 

Table 4-32 Digital Analyzer > Input Config menu description (continued)

Menu Description
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Link Configuration (Bluetooth Analyzer)

The link configuration for the Bluetooth analyzer is identical to the link configuration for the 
Bluetooth generator. Please refer to “Link Configuration (Bluetooth Generator)” on 
page 147 for more information.
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DSI Input Configuration (Digital Analyzer)

The DSI input configuration for digital analyzer is displayed as shown in Figure 4-64.

Figure 4-64 Digital Analyzer > DSI Config menu page 1

Table 4-33 Digital Analyzer > DSI Config menu description 

Menu Description

Format

Press the Format softkey to select the data format.
– Left
– Right
– I2S
– DSP

Fsync Polarity

This is only available when the format is Left or Right.
Press the Fsync Polarity softkey to select the frame clock edge synchronization.
– Rising (indicates the frame clock is high on the left channel of data)
– Falling (indicates the frame clock is low on the left channel of data)

Fsync Width

This is only available when the format is Left or Right.
Press the Fsync Width softkey to select the frame clock synchronization width. 
– One Bit Clock
– One Subframe
– 50% Duty Cycle

Data Shift Cnt
This is only available when the format is Left or Right.
Press the Data Shift Cnt softkey to set the number for the data bits  to be shifted in relative to the frame clock. 

Data Shift Dir

This is only available when the format is Left or Right.
Press the Data Shift Dir softkey to select the data shift direction. 
– Left
– Right
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Word Length
Press the Word Length softkey to set the word length value. The word length value must be greater than or equal to the 
audio resolution.
– 8 to 32

Resolution
Press the Resolution softkey to set the audio resolution value.
– 8 to 24

Decoding

Press the Decoding softkey to select the decoding format.
– Linear PCM
– A-Law
– μ-Law

W/Bclk Dir
Press the W/Bclk Dir softkey to select the word/bit clock direction.
– In
– Out

Bit Clk Edge
Press the Bit Clk Edge softkey to select the bit clock edge.
– Rising
– Falling

Voltage

Press the Voltage softkey to select the input voltage value.
– 1.2 Vpp
– 1.5 Vpp
– 1.8 Vpp
– 2.5 Vpp
– 3 Vpp
– 3.3 Vpp
– Custom

Table 4-33 Digital Analyzer > DSI Config menu description (continued)

Menu Description
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AES/SPDIF Input Configuration (Digital Analyzer)

The AES/SPDIF input configuration for digital analyzer is displayed as shown in 
Figure 4-65.

Figure 4-65 Digital Analyzer > AES Config menu page 1

Table 4-34 Digital Analyzer > AES Config menu description 

Menu Description

Decoding

Press the Decoding softkey to select the decoding format.
– Linear PCM
– A- Law
– μ- Law

Resolution
Press the Resolution softkey to set the audio resolution value.
– 8 to 24

Status Bits
Press the Status Bits softkey to select the status bits type.
– Channel
– User

Save in Hex Press the Save in Hex softkey to save the status bits to a HEX file. Refer to “Save” on page 94 for more information on the 
Save menu page.

Save in Xml Press the Save in Xml softkey to save the status bits to an XML file. Refer to “Save” on page 94 for more information on 
the Save menu page.
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4 Audio Analyzer Measurement Functions
Bits Analysis (Digital Analyzer)

The bits analysis menu page allows you to view the data of every single bit in each word of 
the embedded audio data in the digital signal. The bits analysis configuration for digital 
analyzer is displayed as shown in Figure 4-66.

Figure 4-66 Digital Analyzer > Bits Analysis menu page 1

Table 4-35 Digital Analyzer > Bits Analysis menu description 

Menu Description

Refresh Rate Press the Refresh Rate softkey to set the refresh rate. This is only applicable when the Bit Types is set to Active Bit.

Bit Types

Press the Bit Types softkey to select the bit type.
– Data 

Data bits represent the data in a word of the embedded audio data of the digital signal at the time of the measurement. 
"1" indicates that the data is 1 at the particular bit, and "0" indicates that the data is 0 at the particular bit.

– Active 
Active bits indicate bits that have changed state during the measurement period. "1" indicates a bit has changed state, 
and "0" indicates no change.
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Wave File (Analog, Digital, and Bluetooth Analyzer)

The U8903B allows you to record and save the input measurement signal into a wave file. 
The recorded wave file can be used as a test signal. The wave file settings for analog, 
digital, and Bluetooth analyzer is displayed as shown in Figure 4-67, Figure 4-68, and 
Figure 4-69 respectively.

Figure 4-67 Analog Analyzer > Wave File menu page

Figure 4-68 Digital Analyzer > Wave File menu page

NOTE
It is recommended to use fixed input range for analog wave file saving to ensure that the 
recorded signal’s amplitude is closer to the measured signal. The selected range should be 
close to the measured signal's amplitude.
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4 Audio Analyzer Measurement Functions
Figure 4-69 Bluetooth Analyzer > Wave File menu page

Table 4-36 Analog/Digital/Bluetooth Analyzer > Wave File menu description 

Menu Description

Channel

Press the Channel softkey to select the wave file channel type.
– Left 

Selecting Left will record the present analyzer channel 1 signal into a mono wave file.
– Right 

Selecting Right will record the present analyzer channel 2 signal into a mono wave file.
– Stereo 

Selecting Stereo will record both the present analyzer channel 1 and channel 2 signals into a stereo wave file.

Bits/Sample

Press the Bits/Sample softkey to select the wave file bits per sample.
– 8
– 16
– 24 

Duration Press the Duration softkey to set the recording duration of the wave file.

Record Press the Record softkey to start recording and save the measurement into a wave file. Refer to “Save” on page 94 for 
more information on the Save menu page.
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Statistics

The statistics settings for analog, digital, and Bluetooth analyzer is displayed as shown in 
Figure 4-70, Figure 4-71, and Figure 4-72 respectively.

Figure 4-70 Analog Analyzer > Statistics menu page

Figure 4-71 Digital Analyzer > Statistics menu page
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4 Audio Analyzer Measurement Functions
Figure 4-72 Bluetooth Analyzer > Statistics menu page

Table 4-37 Analog/Digital/Bluetooth Analyzer > Statistics menu description 

Menu Description

Show Stats Press the Show Stats softkey to enable or disable the statistics calculation.

No. of Reading Press the No. of Reading softkey to set the number of readings used for the statistics calculation.

Stat 1 
Stat 2 
Stat 3

Press the respective softkeys to select the statistics calculation type. The U8903B allows you to display three types of 
statistics data.
– Min 

The minimum value obtained in the measurement.
– Max 

The maximum value obtained in the measurement.
– Average 

The calculated average value on the number of measurement readings captured.
– Std Dev 

The calculated standard deviation value on the number of measurement readings captured.
– ΔMinMax 

The difference between the maximum value and minimum value.
The number of measurement readings is the value set in No. Of Readings.

Clear Press the Clear softkey to reset the statistics results of the current analog and Bluetooth analyzer.
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5 Graph Analysis
Graph Analysis

The U8903B graph analysis mode displays a 2-dimensional graph of the signal. Press 

 on the FUNCTION panel to access the graph analysis mode. The Graph Analysis 

menu page is displayed as shown in Figure 5-1.

Press  on the RUN CONTROL panel to start or stop the graph analysis.

Refer to “GRAPH Panel” on page 67 for quick access to the commonly used graph 
functions.

Figure 5-1 Graph Analysis menu page

NOTE
– The U8903B graph analysis mode is only available in the Standard View mode. Refer to 

“Menu Key” on page 60 for more information.

– When the graph analysis mode is activated, all filters will be turned off.
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Table 5-1 Graph Analysis menu description 

Menu Description

Analysis Type

Press the Analysis Type softkey to select graph analysis mode to be plotted on the current  
graph panel.
– Frequency 

Frequency domain
– Phase 

Phase magnitude
– Time 

Time domain
– PSD 

The total power contained in each of the frequency bins in the band, and then dividing the result by the “effective 
bandwidth”.

Graph Settings Press the Graph Settings softkey to configure the graph settings. Refer to “Graph Settings” on page 264 for more 
information.

Axis Settings Press the Axis Settings softkey to configure the axis settings. Refer to “Axis Settings” on page 266 for more information.

Trace Settings Press the Trace Settings softkey to configure the trace settings. Refer to “Trace Settings” on page 268 for more 
information.

Display Option

Press the Display Option softkey to select the graph analysis display option. Refer to “Display Options” on page 273 for 
more information.
– Graph
– Data Table
– Marker Table
– Statistics
– Harmonics
– Signal Analysis

Running Mode
Press the Running Mode softkey to select the graph analysis running mode.
– Continuous
– Single

Measurement Press the Measurement softkey to configure the graph analysis measurement settings. Refer to “Measurement 
Settings” on page 278 for more information.
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5 Graph Analysis
Graph Settings

The graph settings for graph analysis is displayed as shown in Figure 5-2.

Figure 5-2 Graph Analysis > Graph Settings menu page

Table 5-2 Graph Analysis > Graph Settings menu description 

Menu Description

Active Channel Press the Active Channel softkey to select the available active channel. The active channel determines the channel for the 
graph settings.

Sample Size

Press the Sample Size softkey to select the graph sample size value. The sample size affects the performance and quality 
of the analysis performed. For frequency domain measurements, the data returned is half of the current selected sample 
size.
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M
If the sample size of an analyzer card channel is set to 2M, the rest of the analyzer card channels sample size will be set to 
2048.
If the sample size of an analyzer card channel is set to 1M, the rest of the analyzer card channels sample size will be set to 
262144 (if the initial sample size is more than 262144).
If the sample size of an analyzer card channel is set to 52428, the rest of the analyzer card channels sample size will be set 
to 262144 (if the initial sample size is more than 262144).
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Window

Press the Window softkey to select the window function to be applied to the data before the FFT process. The selected 
window function is dependent on the type of results needed from your measurements. Typically, the window function 
reduces the effect of spectral leakage that may occur when performing FFT analysis.
– Rectangular
– Hanning
– Blackman
– Rife-Vincent
– Rife-Vincent 3
– Hamming
– Flat Top
– Kaiser

Sync Avg Press the Sync Avg softkey to set the number of samples to be acquired and averaged before the FFT process is performed. 

Hold

Press the Hold softkey to select the type of hold to be performed after the FFT process.
– None 

If None is selected, the latest data will always be displayed.
– Average 

The Average hold will average both the current and previous data.
– Min 

The Min hold will compare the current data with the previous data and retains whichever value that is lower.
– Max 

The Max hold will compare the current data with the previous data and retain whichever value that is higher.

Table 5-2 Graph Analysis > Graph Settings menu description (continued)

Menu Description
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5 Graph Analysis
Axis Settings

The axis settings for graph analysis is displayed as shown in Figure 5-3.

Figure 5-3 Graph Analysis > Axis Settings menu page 1

Table 5-3 Graph Analysis > Axis Settings menu description 

Menu Description

Axis
Press the Axis softkey to select the active axis to be configured. 
– Primary
– Secondary

Enabled Press the Enabled softkey to enable or disable the axis settings. This setting is only available when the axis type is 
secondary. If the axis type is primary, this setting is always set to On. 

Left Press the Left softkey to set the left axis limit value. If the value entered is more than the right value, the right value will 
automatically be set to a value of (Left + 10).

Right Press the Right softkey to set the right axis limit value. If the value entered is more than the left value, the left value will 
automatically be set to a value of (Right – 10).

Span Press the Span softkey to set the total X-axis span or total range to be monitored in the graph.

Center Press the Center softkey to set the X-axis center point in the graph. 

Top Press the Top softkey to set the top axis limit value. If the value entered is less than the bottom value, the bottom value will 
automatically be set to a value of (Top – 10).

Bottom Press the Bottom softkey to set the bottom axis limit value. If the value entered is more than the top value, the top value 
will automatically be set to a value of (Bottom + 10).
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X-Scale

Press the X-Scale softkey to select the X-axis scale type. The left and right values must be more than 0 in order to use the 
log scale.
– Linear
– Log

Y-Scale

Press the Y-Scale softkey to select the Y-axis scale type. The bottom and top values must be more than 0 in order to use 
the log scale.
– Linear
– Log

Table 5-3 Graph Analysis > Axis Settings menu description (continued)

Menu Description
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5 Graph Analysis
Trace Settings

The trace settings for graph analysis is displayed as shown in Figure 5-4.

Figure 5-4 Graph Analysis > Trace Settings menu page 1

Table 5-4 Graph Analysis > Trace Settings menu description 

Menu Description

Active Trace Press the Active Trace softkey to select the active trace number.

Source Press the Source softkey to select data source of the active trace from the available channels, traces, files, and memory.

Enabled Press the Enabled softkey to enable or disable the active trace data. You can also access this function by pressing the Shift 
key and the trace number key on the CHANNEL/DATA panel.

Memory Press the Memory softkey to save or load a trace. Refer to “Memory” on page 270 for more information.

Math Press the Math softkey to apply a math function. Refer to “Math” on page 271 for more information.

Unit

Press the Unit softkey to select the trace unit type.
– V
– dBV
– dBu
– W
– dBm
– dBSPL

Persistence Press the Persistence softkey to configure the persistence settings. Refer to “Persistence” on page 272 for more 
information.
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Axis

Press the Axis softkey to attach the active trace to the primary or secondary axis. The display of the active trace will reflect 
on the selected axis.
– Primary
– Secondary

Color

Press the Color softkey to select the color of the active trace.
– Yellow
– Cyan
– White
– Pink
– Green
– Orange
– Red
– Purple

Table 5-4 Graph Analysis > Trace Settings menu description (continued)

Menu Description
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5 Graph Analysis
Memory

Figure 5-5 Graph Analysis > Trace Settings > Memory menu page

Table 5-5 Graph Analysis > Trace Settings > Memory menu description 

Menu Description

Save To Memory
Press the Save To Memory softkey to save the active trace to the memory buffer[a]. The trace in the memory buffer can be 
loaded into any other traces. The memory buffer icon will be displayed at the top of the display when there is a trace saved 
in the memory buffer as shown in Table 1-5.

Load From Memory Press the Load From Memory softkey to load a trace from the memory buffer into the active trace. An error will be 
displayed if this softkey is pressed when there is no trace in the memory buffer.

Clear Memory Press the Clear Memory softkey to clear the trace from the memory buffer.

[a] Files saved in the internal volatile memory will be erased after power cycle or reset (refer to “Preset” on page 78).
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Math

Figure 5-6 Graph Analysis > Trace Settings > Math menu page

Table 5-6 Graph Analysis > Trace Settings > Math menu description 

Menu Description

Apply Math Press the Apply Math softkey to apply the corresponding math function to the trace data or turn off the math function.

Function

Press the Function softkey to select the math function to be applied on the active trace.
– None
– f(Source) + x
– f(Source) - x
– f(Source) * x
– f(Source) / x

X Press the X softkey to set the x value in the selected math function.
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5 Graph Analysis
Persistence

Figure 5-7 Graph Analysis > Trace Settings > Persistence menu page

Table 5-7 Graph Analysis > Trace Settings > Persistence menu description 

Menu Description

Persist
Press the Persist softkey to enable or disable persistence on the active trace. Persistence allows you to view the previous 
sets of trace data in the graph before they are removed. The previous trace data will be displayed in a lighter shade color of 
the active trace to distinguish between the previous and updated trace data.

Persist Count

Press the Persist Count softkey to set the number of previous sets of trace data to be displayed in the graph before they are 
removed. For example, a value of 5 indicates that up to a total of 5 previous sets of trace data will be displayed in the graph 
before they are removed.
This setting is only available when persistence is enabled.
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Graph Analysis 5
Display Options

Graph

Graph view is the default display option. In the graph view, the frequency, phase, and time 
domain analysis are performed. The graph view is displayed as shown in Figure 5-8.

Figure 5-8 Graph Analysis > Display Option > Graph menu page
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5 Graph Analysis
Data table

In the data table view, you can observe the individual data points in a table format with up 
to a maximum of four different traces without scrolling. The data table view is displayed as 
shown in Figure 5-9. Press the up or down arrow keys to scroll up or down the data points 
in the table.

Figure 5-9 Graph Analysis > Display Option > DataTable menu page

Marker table

In the marker table view, you can observe the marker and cross-marker calculation 
information in a table format. The delta marker readings are also listed in the table. The 
marker table view is displayed as shown in Figure 5-10.

Figure 5-10 Graph Analysis > Display Option > Marker Table menu page
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Statistics

In the statistics view, the typical statistics calculations are listed down. The available 
statistics functions are minimum, maximum, standard deviation, and average. The statistics 
view is displayed as shown in Figure 5-11.

Figure 5-11 Graph Analysis > Display Option > Statistics menu page

Harmonics

In the harmonics view, you can view and perform harmonic analysis. Information such as 
the fundamental frequency amplitude and the respective harmonics can be observed in a 
bar chart. You can also observe the THD information for the individual channels. The 
harmonics display is displayed as shown in Figure 5-12.

Figure 5-12 Graph Analysis > Display Option > Harmonics menu page
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5 Graph Analysis
Press the Harm Settings softkey to configure the harmonics settings. This setting is only 
available when the graph analysis display option is Harmonics.

Figure 5-13 Graph Analysis > Harm Settings menu page (Harmonics display)

Table 5-8 Graph Analysis > Harm Settings menu description (Harmonics display)

Menu Description

Active Press the Active softkey to select the active channel. 

Odd 

Press the Odd softkey to select the odd harmonics.
– ALL
– 3
– 5
– 7
– 9

Even 

Press the Even to select the even harmonics.
– ALL
– 2
– 4
– 6
– 8

Display
Press the Display softkey to select the type of harmonic analysis data to be displayed.
– Harmonics
– THD

THD unit
Press the THD unit softkey to select the unit for THD measurements.
– dB
– %
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Graph Analysis 5
Signal analysis

In the signal analysis view, you can view the analyzer and generator channel information. 
The signal analysis display is displayed as shown in Figure 5-14.

Figure 5-14 Graph Analysis > Display Option > Signal Analysis menu page
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5 Graph Analysis
Measurement Settings

The U8903B allows you to observe up to two measurements running simultaneously in the 
graph analysis mode. The measurements will be displayed at the bottom of the graph. The 
measurement settings for graph analysis is displayed as shown in Figure 5-15.

Figure 5-15 Graph Analysis > Measurement menu page

Table 5-9 Graph Analysis > Measurement menu description 

Menu Description

Enabled Press the Enabled softkey to enable or disable the measurements in the graph. If measurement is not required, disable the 
measurements for better performance.

Measurement 1 Press the Measurement 1 softkey to configure the measurement 1 parameters. Refer to “Measurement 1/
Measurement 2” on page 279 for more information.

Measurement 2 Press the Measurement 2 softkey to configure the measurement 2 parameters. Refer to “Measurement 1/
Measurement 2” on page 279 for more information.
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Measurement 1/Measurement 2

Figure 5-16 Graph Analysis > Measurement > Measurement 1 menu page

Table 5-10 Graph Analysis > Measurement > Measurement 1/Measurement 2 menu description 

Menu Description

Interface

Press the Interface softkey to select the measurement interface type.
– Analog Analyzer
– Digital
– Bluetooth

Channel Press the Channel softkey to select the desired channel to perform the measurement.

Function No

Press the Function No softkey to select the function to be displayed based on the function number (1 to 4). The function 
number corresponds to the respective measurement functions in the analyzer. The allowable measurement functions are 
as follows.
– Frequency
– DC voltage
– THD ratio
– THD level
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6 Sweep Function
Sweep Parameter

The U8903B sweep mode allows you to perform sweeps and to display the results in a plot 

view. Press  on the FUNCTION panel to access the sweep mode. The Sweep 

Parameter menu page is the default page and is displayed as shown in Figure 6-1. 

There are three main panels on the Sweep Parameter menu page. The top panel displays 
the current sweep settings and the bottom panels display the audio generator and audio 

analyzer settings respectively. Press  on the FUNCTION panel to switch between 

analog and digital interface. Use the arrow keys to navigate among the panels.

Press  on the RUN CONTROL panel to start or stop the sweep in the sweep 

mode.

Figure 6-1 Sweep Parameter menu page

NOTE
The U8903B sweep mode is only available in the Standard View mode. Refer to “Menu Key” 
on page 60 for more information.
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Sweep Function 6
Table 6-1 Sweep Parameter menu description 

Menu Description

App. Type

Press the App. Type softkey to select the sweep application type.
– Sweep
– Group Delay 

This is only applicable for digital interface. Refer to “Group Delay” on page 284 for more information.

Parameter
This is only available when the sweep application type is Sweep.
Press the Parameter softkey to select the sweep parameter type. The parameter selection depends on the waveform type 
set at the analog generator.

Points Settings
Press the Points Settings softkey to configure the sweep point parameters such as start, stop, step size, point count, and 
spacing. 
Refer to “Points settings” on page 285 for more information.

Dwell Time Press the Dwell Time softkey to set the delay in ms for the generator to output the signal.

Sweep Mode

Press the Sweep Mode softkey to select the sweep mode.
– Continuous 

Sweep all points.
– Single 

Sweep point by point.

Channels
Press the Channels softkey to set the sweep channels.  
Refer to “Sweep channels” on page 286 for more information. This setting is only available when the legacy sweep is 
disabled.

Plot View Press the Plot View softkey to display the Plot View menu page.  
Refer to “Plot View” on page 287 for more information.
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6 Sweep Function
Group Delay

Group delay is the difference of phase over the difference of the frequency. All signals are 
delayed when transiting through a device such as a filter, an amplifier, or a processor. This 
small delay is usually not a problem, but if the delay is different for different frequencies, 
and the signal is built up by more than one frequency, then the shape of the signal is 
distorted. The difference in delay for different frequencies is group delay.

Group delay is a useful measure of phase distortion. The variations in a group delay cause 
signal distortion, just as deviations from linear phase cause distortion. Group delay is 
calculated by differentiating the insertion phase response of the DUT versus frequency. 
Group delay is only meaningful when performing sweep.

The input signal is compared with the output signal to calculate the phase between the 
input and output signals. The phase for frequency 1 is then recorded. The output frequency 
is then shifted to frequency 2, and the phase is measured again. The result is a group delay 
value of (phase 1 – phase 2) / (frequency 1 – frequency 2). This measurement can be done 
for a series of frequency points to plot the group delay measurement graph which will show 
the linearity of the phase versus frequency plot.

Group Delay measurement function mode is only applicable for digital interface. 

Figure 6-2 Sweep Parameter > App. Type > Group Delay menu page
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Sweep Function 6
Points settings

Figure 6-3 Sweep Parameter > Points Settings menu page 1

Table 6-2 Sweep Parameter > Points Settings menu description 

Menu Description

Spacing

Press the Spacing softkey to select the spacing type.
– Log – Geometric series 

 

– Linear – Arithmetic series 

 

– Custom – Arbitrary spacing

Unit

Press the Unit softkey to select the sweep unit. This setting is only available when the sweep parameter is amplitude.
– Vrms
– dBV
– Vp
– Vpp
– dBm
– dBu
– dBSPL

Start Press the Start softkey to set the sweep start value. This setting is only available when the sweep spacing is Log or Linear.

Stop Press the Stop softkey to set the sweep stop value. This setting is only available when the sweep spacing is Log or Linear.

Step Press the Step softkey to set the sweep step value. Adjusting the sweep step value will change the sweep points value. 
This setting is only available when the sweep spacing is Log or Linear.

Step size 10

10 Stop
Start
--------- 
 log

Points 1–( )
-------------------------

=

Step size Start Stop–( )
Points 1–( )

---------------------------=
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6 Sweep Function
Sweep channels

Figure 6-4 Sweep Parameter > Channels menu page

Points Press the Points softkey to set the sweep points value. Adjusting the sweep points value will change the sweep step value. 
This setting is only available when the sweep spacing is Log or Linear.

Edit Points
Press the Edit Points softkey to configure the sweep points.  
Refer to “Edit Points” on page 291 for more information. If the sweep points are changed, the sweep spacing mode will 
be set to Custom.

Table 6-2 Sweep Parameter > Points Settings menu description (continued)

Menu Description

NOTE
This setting is only available when the legacy sweep is disabled.

Table 6-3 Sweep Parameter > Channels menu description 

Menu Description

Source Press the Source softkey to select the source channel(s).

Measure Press the Measure softkey to select the measure channel(s). The available selection depends on the number of installed 
analog analyzer cards.
286 Keysight U8903B User’s Guide



Sweep Function 6
Plot View

The sweep plot view menu page is displayed as shown in Figure 6-5.

Press  on the RUN CONTROL panel to start or stop the sweep in the sweep 

mode.

Figure 6-5 Sweep > Plot View menu page

Table 6-4 Sweep > Plot View menu description 

Menu Description

Axis Settings
Press the Axis Settings softkey to configure the sweep axis settings. 
Refer to “Axis settings” on page 288 for more information.

Plot Settings
Press the Plot Settings softkey to configure the sweep trace settings.  
Refer to “Plot settings” on page 289 for more information.

Edit Points
Press the Edit Points softkey to configure the sweep points.  
Refer to “Edit Points” on page 291 for more information.

Save Pts
Press the Save Pts softkey to save the sweep points to a file.  
Refer to “Save” on page 94 for the Save menu page.
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6 Sweep Function
Axis settings

Figure 6-6 Sweep > Plot View > Axis Settings menu page

Table 6-5 Sweep > Plot View > Axis Settings menu description 

Menu Description

Active Axis
Press the Active Axis softkey to select the active axis.
– Primary
– Secondary

Left Press the Left softkey to set the left axis value.

Right Press the Right softkey to set the right axis value.

Top Press the Top softkey to set the top axis value.

Bottom Press the Bottom softkey to set the bottom axis value.

X-Scale
Press the X-Scale softkey to set the X-axis scale type.
– Linear
– Log

Y-Scale
Press the Y-Scale softkey to set the Y-axis scale type.
– Linear
– Log
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Sweep Function 6
Plot settings

Figure 6-7 Sweep > Plot View > Plot Settings menu page

Table 6-6 Sweep > Plot View > Plot Settings menu description 

Menu Description

Data Channel Press the Data Channel softkey to select the trace data channel number to be plotted. This setting is only available when 
the measured channels are more than one channel.

Y Data

Press the Y Data softkey to select the Y-axis trace data source.
– S: <sweep parameter>
– F1: <measurement function 1>
– F2: <measurement function 2>
– F3: <measurement function 3>
– F4: <measurement function 4>

Y2 Data

Press the Y2 Data softkey to select the second Y-axis trace data source.
– S: <sweep parameter>
– F1: <measurement function 1>
– F2: <measurement function 2>
– F3: <measurement function 3>
– F4: <measurement function 4>

X Data

Press the X Data softkey to select the X-axis trace data source.
– S: <sweep parameter>
– F1: <measurement function 1>
– F2: <measurement function 2>
– F3: <measurement function 3>
– F4: <measurement function 4>
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6 Sweep Function
Wrap Phase

Press the Wrap Phase softkey to enable or disable the wrap phase. This is only applicable if Y Data or Y2 Data is set to 
phase.
– On 

The phase result is wrapped so that it falls within the range of -180° ~ 180°.
– Off 

The result displayed is the exact value after substracted from the reference channel.

Hold Type

Press the Hold Type softkey to select the data type to be plotted in the graph.
– None 

Initial sweep data.
– Average 

Each point is averaged with the corresponding point from the previous result.
– Max 

Always keep the maximum value of each point.
– Min 

Always plot the minimum value of each point.

Table 6-6 Sweep > Plot View > Plot Settings menu description (continued)

Menu Description
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Sweep Function 6
Edit Points

Figure 6-8 Sweep > Edit Points menu page 1

Table 6-7 Sweep > Edit Points menu description 

Menu Description

Data Channel Press the Data Channel softkey to select the trace data channel number to be plotted.  
This setting is only available when the measured channels are more than one channel.

Wrap Phase

Press the Wrap Phase softkey to enable or disable the wrap phase. This is only applicable if Y Data or Y2 Data is set to 
phase.
– On 

The phase result is wrapped so that it falls within the range of -180° ~ 180°.
– Off 

The result displayed is the exact value after substracted from the reference channel.

Goto Point Press the Goto Point softkey to set the sweep point number to go to. The sweep point number will be highlighted. You can 
also use the arrow keys to select the desired sweep point.

Point Value Press the Point Value softkey to set the currently selected sweep point value.

Add Point Press the Add Point softkey to add a sweep point.

Remove Point Press the Remove Point softkey to remove the selected sweep point.

Load Points Press the Load Points softkey to load the sweep points from a file.  
Refer to “Recall” on page 95 for the Recall menu page.

Save Points Press the Save Points softkey to save the sweep points to a file.  
Refer to “Save” on page 94 for the Save menu page.

NOTE
If the sweep points are changed, the sweep spacing mode will be set to Custom. Refer to 
Table 6-2 for more information.
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Test Sequence Application

The U8903B test sequence application (Test Seq App) mode allows you to create a series of 
automated measurements on a DUT. You can customize the order in which the 
measurements are performed, edit the pass or fail limits, add sub steps, and create a 
detailed report of the measurements.

There are two main tabs in the test sequence application mode: Project tab and Report tab.

The Project tab allows you to add up to 20 test sequence and configure the measurements 
in each test sequence. The Report tab allows you to display all the measurements results 
and generate a report.

Use the left and right arrow keys to switch between the Project tab or Report tab. Refer to 
“Project” on page 297 and “Report” on page 405 for more information.

An example of the Project tab menu page is displayed as shown in Figure 7-1.

Figure 7-1 TSA > Project menu page
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7 Test Sequence Application
Press  to start or stop the test sequence. The Test Application menu page will 

be displayed as shown in Figure 7-2.

Figure 7-2 Test Application menu page

Table 7-1 Test Application menu description 

Menu Description

Start Test App Press the Start Test App softkey to start the test application project. 

Start Test App From Here
Press the Start Test App From Here softkey to start the test application from the selected test or measurement tab.
This setting  is only available when the On/Off key is pressed with the test or measurement tab selected. 

Start Selected 
Measurement

Press the Start Selected Measurement softkey to start the test for the selected measurement.
This setting  is only available when the On/Off key is pressed with the measurement tab selected.
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Project

The TSA > Project menu page is displayed as shown in Figure 7-3.

Figure 7-3 TSA > Project menu page

Press the up or down arrow key to select the test sequence, IO configuration, or 
measurements tabs. The respective menu page will be displayed. Refer to “Test Sequence” 
on page 299, “IO Configuration” on page 300, and “Measurements” on page 312 for more 
information.

Table 7-2 TSA > Project menu description 

Menu Description

New Project Press the New Project softkey to create a new project.

Open Project Press the Open Project softkey to load a project from a file. Refer to “Recall” on page 95 for more information on the 
Recall menu page.

Save Project Press the Save Project softkey to save the project to a file. Refer to “Save” on page 94 for more information on the Save 
menu page.

Properties Press the Properties softkey to configure the project properties. Refer to “Properties” on page 298 for more information 
on the Properties menu page.
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Properties

The TSA > Project > Properties menu page is displayed as shown in Figure 7-4.

Figure 7-4 TSA > Project > Properties menu page

Table 7-3 TSA > Project > Properties menu description 

Menu Description

Prompt DUT ID Press the Prompt DUT ID softkey to enable or disable the prompt for device ID (device serial number) at the start of a test 
sequence.

Prompt Msg Press the Prompt Msg softkey to set the prompt message. This setting  is only available when Prompt DUT ID is enabled.

Pass/Fail Msg Press the Pass/Fail Msg softkey to enable or disable the on-screen message dialog box that can be displayed at the end of 
a test sequence. Press Enter to close the dialog box.

Pass Message Press the Pass Message softkey to edit the pass message. If all the measurements in the test sequence pass, the pass 
message is displayed. The default message is “Passed”. This setting  is only available when Pass/Fail Msg is enabled.

Fail Message Press the Fail Message softkey to edit the fail message. If one or more measurements in the test sequence fails, the fail 
message is displayed. The default message is “Failed” This setting  is only available when Pass/Fail Msg is enabled.
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Test Sequence

The TSA > Project > Test menu page is displayed as shown in Figure 7-5.

Figure 7-5 TSA > Project > Test menu page

Table 7-4 TSA > Project > Test menu description 

Menu Description

Enable Press the Enable softkey to enable or disable the selected test sequence. The check boxes for the test and all the 
measurements in the test will be selected when enabled.

Add Test Sequence

Press the Add Test Sequence softkey to add a test sequence. 
– New 

Add a new test sequence.
– Saved 

Load a saved test sequence file. Refer to “Recall” on page 95 for more information on the Recall menu page.

Delete Test Sequence Press the Delete Test Sequence softkey to delete the selected test sequence.

Save Press the Save softkey to save the test sequence to a file. Refer to “Save” on page 94 for more information on the Save 
menu page.

Edit Press the Edit softkey to move or copy the selected test sequence, or paste a copied test sequence after the selected test 
sequence.

Properties Press the Properties softkey to set the test sequence name.
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IO Configuration

The IO Configuration tab allows you to configure the output and input settings. There will 
be one IO Configuration tab in each test sequence. The settings configured in the IO 
configuration will be applied to all the measurements in the test sequence. The TSA > 
Project > Test > IO Configuration menu page is displayed as shown in Figure 7-6.

Figure 7-6 TSA > Project > Test > IO Configuration menu page

Table 7-5 TSA > Project > Test > IO Configuration menu description 

Menu Description

Add Measurement Press the Add Measurement softkey to add measurements to the selected test sequence. Refer to “Measurements” on 
page 312 for more information.

Edit Press the Edit softkey to paste a copied measurement after the IO configuration. The IO Configuration cannot be moved or 
copied.

Settings Press the Settings softkey to configure the IO settings. Refer to “Settings” on page 301 for more information.

Properties Press the Properties softkey to configure the IO configuration properties. Refer to “Properties” on page 308 for more 
information.
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Settings

Press  on the FUNCTION panel to switch between the analog and Bluetooth 

interface. Press the up or down arrow key to select between output configuration or input 
configuration.

Output configuration (Analog)

The TSA > Project > Test > IO Configuration > Output Configuration menu page is displayed 
as shown in Figure 7-7.

Figure 7-7 TSA > Project > Test > IO Configuration > Output Configuration menu page (Analog)
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Table 7-6 TSA > Project > Test > IO Configuration > Output Configuration menu description  (Analog)

Menu Description

Channels

Press the Channels softkey to select the number of output channels in use.
– None (External) 

Disable the generator outputs and configure the analyzer for external source (open-loop) measurements.
– 1
– 2

Connector

Press the Connector softkey to select the output connector type.
– Bal 

Balanced mode outputs a pair of differential signals which are equal in amplitude but 180 degrees out of phase on the 
XLR positive and negative pins.

– UnBal 
Unbalanced mode outputs a signal referenced to ground on the BNC output connector.

– Com 
Common mode outputs a pair of equal amplitude and in-phase signals on the XLR positive and negative pins. The 
common mode test signal is applied to both pins 2 and 3 or the XLR connector, while pin 1 is connected to the return 
signal.

– IEC60268 
The common mode test signal is applied to both pins 2 and 3 or the XLR connector, while pin 1 is connected to the 
return signal. An additional 10 Ω output series resistance is added to pin 2 or 3.

Impedance

Press the Impedance softkey to select the output impedance value.
For Bal, Com, and IEC60268
– 600 Ω
– 100 Ω
– 40 Ω
For UnBal
– 600 Ω
– 50 Ω
– 20 Ω

IEC60268 10 Ω 

Press the IEC60268 10 Ω softkey to select the additional 10 Ω output series resistance for pin 2 or 3 of the XLR connector 
in the common IEC60268 configuration. This setting is only available when the output connector type is set to IEC60268.
– Pin2 

Additional 10 Ω is added to pin 2.
– Pin3 

Additional 10 Ω is added to pin 3.

Ground

Press the Ground softkey to select the grounding type.
– Float 

In the floating grounding type, the signal return line (XLR pin 1 for balanced output or BNC return for unbalanced 
output) is not grounded to the chassis earth and is “floating”.

– Ground 
In the ground grounding type, the signal return line (XLR pin 1 for balanced output or BNC return for unbalanced output) 
is connected to the chassis earth.

Max Voltage Press the Max Voltage softkey to set the maximum voltage. The maximum voltage value set will limit the maximum 
amplitude output from the generator and prevent any excessive high voltage values from damaging the DUT.

Reference
Press the Reference softkey to set the output references for generator.
– Impedance 

Set the reference impedance for the unit conversion of dBm measurements.
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Output configuration (Bluetooth)

The TSA > Project > Test > IO Configuration > Output Configuration menu page is displayed 
as shown in Figure 7-8.

Figure 7-8 TSA > Project > Test > IO Configuration > Output Configuration menu page (Bluetooth)

Table 7-7 TSA > Project > Test > IO Configuration > Output Configuration menu description (Bluetooth)

Menu Description

Channels

Press the Channels softkey to select the number of output channels in use.
– None (External) 

Disable the generator outputs and configure the analyzer for external source (open-loop) measurements.
– 1  

This is only applicable if the Profiles consist of only HFP, or HFP and AVRCP.
– 2  

This is only applicable if the Profiles consist of A2DP.

Device Press the Device softkey to select the paired or connected Bluetooth device.

Profiles

Press the Profiles softkey to select the profile that will be used in the test. If the connected Bluetooth device is selected in 
Device, the profile used will be fixed to the connected profile(s).
– A2DP
– HFP
– AVRCP

Link Config Press the Link Config softkey to configure the Bluetooth link settings. Refer to “Link Configuration (Bluetooth 
Generator)” on page 147.

References
Press the Reference softkey to set the output references for generator.
– Volt/FS 

Set the volts/FS reference value.
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Input configuration (Analog)

The TSA > Project > Test > IO Configuration > Input Configuration menu page is displayed 
as shown in Figure 7-9.

Figure 7-9 TSA > Project > Test > IO Configuration > Input Configuration menu page (Analog)

Table 7-8 TSA > Project > Test > IO Configuration > Input Configuration menu description (Analog)

Menu Description

Channels Press the Channels softkey to select the number of input channels in use.

Connector

Press the Connector softkey to select the input connector type.
– UnBal 

Unbalanced connector type routes the signal from the BNC input connector. The signal in the inner conductor of the 
coaxial connector is referenced to the ground for measurement.

– Bal 
Balanced connector type routes the signal from the XLR input connectors in the front panel to the analog analyzer. The 
signals on the positive and negative pins of the XLR connector enter a differential amplifier where they are subtracted 
before passing on to the detector. 

– Loopback 
Loopback connector type routes the signal from the generator to the analyzer internally.  
The generator channel 1 signal will be routed to the analyzer odd channels (1, 3, 5, and 7), and the generator channel 2 
signal will be routed to the analyzer even channels (2, 4, 6, and 8).  
For example, if you select Loopback in any of the analyzer odd channels, the output connector type of the generator 
channel 1 will automatically be set to Loopback.

Impedance

Press the Impedance softkey to select the input impedance value. This setting is only available when Connector is set to 
UnBal or Bal.
– 100 kΩ (for Unbalanced)
– 200 kΩ (for Balanced)
– 600 Ω
– 300 Ω
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Coupling

Press the Coupling softkey to select the input coupling type.
– DC 

DC coupling allows both the AC and DC analog input signals to pass through to the analog analyzer and to be measured 
down to 0 Hz. This setting should be selected when making DC voltage measurements.

– AC 
AC coupling blocks the DC component of the analog input signal by switching a capacitor in series to the input path. 
This setting should be selected when you need to measure only the AC component of a signal. For example, use AC 
coupling when you are making an rms or peak-to-peak voltage measurement. 

Bandwidth

Press the Bandwidth softkey to select the input bandwidth value.
– 90 kHz  

(This is the default setting with sampling rate of 192 kHz)
– 1.5 MHz 
– This setting is only available with Option N3431A. Refer to “U8903B Options” on page 37 for more information.

Reference

Press the Reference softkey to set the input references for analyzer.
– Voltage
– Ratio
– Frequency
– Impedance
– Sound level
– Calibrator level

Table 7-8 TSA > Project > Test > IO Configuration > Input Configuration menu description (continued)(Analog)

Menu Description
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Input configuration (Bluetooth)

The TSA > Project > Test > IO Configuration > Input Configuration menu page is displayed 
as shown in Figure 7-9.

Figure 7-10 TSA > Project > Test > IO Configuration > Input Configuration menu page (Bluetooth)

Table 7-9 TSA > Project > Test > IO Configuration > Input Configuration menu description (Bluetooth)

Menu Description

Channels Displays the number of input channels in use. If the Profiles consist of A2DP, the input channels in use will be fixed to 2 
channels. If the Profiles consist of only HFP or HFP and AVRCP, the input channels in use will be fixed to 1 channel.

Device Press the Device softkey to select the paired or connected Bluetooth device.

Profiles

Press the Profiles softkey to select the profile that will be used in the test. If the connected Bluetooth device is selected in 
Device, the profile used will be fixed to the connected profile(s).
– A2DP
– HFP
– AVRCP

Link Config Press the Link Config softkey to configure the Bluetooth link settings. Refer to “Link Configuration (Bluetooth 
Generator)” on page 147.
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Coupling

Press the Coupling softkey to select the coupling type.
– DC 

DC coupling allows both AC and DC input signals to pass through to the Bluetooth analyzer and to be measured down to 
0 Hz. This setting should be selected when making DC voltage measurements.

– AC 
AC coupling blocks the DC component of the input signal. This setting should be selected when you need to measure 
only the AC component of a signal. For example, select this setting when you are making rms or peak-to-peak voltage 
measurement.

References

Press the Reference softkey to set the input references for generator.
– Voltage 

Set the reference voltage value.
– Ratio 

Set the reference ratio value.
– Frequency 

Set the reference frequency value.
– Sound Lvl 

Set the sound level value.
– Calibrator Lvl 

Set the calibration level value value.
– Volt/FS 

Set the volts/FS reference value.

Table 7-9 TSA > Project > Test > IO Configuration > Input Configuration menu description (continued)(Bluetooth)

Menu Description
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Properties

The TSA > Project > Test > IO Configuration > Properties menu page is displayed as shown 
in Figure 7-11.

Figure 7-11 Test > IO Configuration > Properties menu page

Table 7-10 TSA > Project > Test > IO Configuration > Properties menu description 

Menu Description

Name Press the Name softkey to rename the IO configuration.

Sub-Steps Press the Sub-Steps softkey to configure the sub-steps settings. Refer to “Sub-steps” on page 309 for more information 
on the sub-steps settings.

Failure Press the Failure softkey to edit the failure message. If one or more measurements in the test sequence fails, the failure 
message is displayed. The default message is “Failed”. This setting is only available when Pass/Fail Msg is enabled.
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Sub-steps

You can add any number of sub-steps to the measurement. The sub-steps can be enabled, 
disabled, or deleted and moved into any order. You can add delay, prompts, and send SCPI 
commands to the sub-steps. Press the Add Sub-Step softkey to add sub-step and press the 
up and down arrow keys to select the desired sub-step.

The delay sub-step menu page is displayed as shown in Figure 7-12.

Figure 7-12 Delay sub-step menu page

Table 7-11 Sub-step menu description 

Menu Description

Enable Press the Enable softkey to enable or disable the selected sub-step. The check box of the sub-step will be selected when 
enabled.

Add Sub-Step

Press the Add Sub-Step softkey to add sub-step to the list.
– Delay
– Prompt
– Send SCPI

Delete Sub-Step Press the Delete Sub-Step softkey to delete the selected sub-step.

Edit Press the Edit softkey to move or copy the selected sub-step, or paste a copied sub-step after the selected sub-step.

Settings

Press the Settings softkey to configure the sub-step settings.
– Delay 

Set the delay time in seconds. 
Minimum: 0 s 
Maximum: 3600 s (1 hour)

– Prompt 
Refer to “Prompt sub-step settings” on page 310 for more information.

– Send SCPI 
Refer to “Send SCPI sub-step settings” on page 311 for more information.

Properties Press the Properties softkey to rename the sub-step.
Keysight U8903B User’s Guide 309



7 Test Sequence Application
Prompt sub-step settings

The prompt sub-step inserts a prompt message with reply option to the measurement. This 
provides you the information and opportunity to interact with the sequence. Press OK to 
close the prompt window and continue the test sequence. The prompt sub-step settings 
menu page is displayed as shown in Figure 7-13.

Figure 7-13 Prompt sub-step settings menu page

Table 7-12 Prompt sub-step settings menu description 

Menu Description

Message Press the Message softkey to set the prompt message at the lower half of the main display.

Prompt Icon

Press the Prompt Icon softkey to select the prompt icon to be displayed.
– None
– Hand
– Question
– Exclamation
– Asterisk

Dialog Settings

Press the Dialog Settings softkey to add additional settings to the prompt window.
– Timeout 

When selected, the timeout value sets the maximum prompt window display time, in seconds. If the timeout is reached, 
the current measurement fails. When unselected, the prompt window will remain open until user closes it.

– Cancel 
When selected, a Cancel button will be added to the prompt window. Press the Cancel button to close the prompt 
window and stop the test sequence.

Timeout

Press the Timeout softkey to set the prompt timeout value in seconds. This setting is only available if Timeout is selected in 
the dialog settings.
Minimum: 1 s 
Maximum: 3600 s (1 hour)
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Send SCPI sub-step settings

The send SCPI sub-step can be inserted into any measurement in the test sequence to 
issue SCPI command(s) to a connected external instrument and to pause for a specified 
delay time after the command(s) is issued. This sub-step is useful for setting up an external 
instrument connected through a USB/GPIB interface before a measurement is performed. 
The send SCPI sub-step settings menu page is displayed as shown in Figure 7-14.

Figure 7-14 Send SCPI sub-step settings menu page

Table 7-13 Send SCPI sub-step settings menu description 

Menu Description

GPIB Address Press the GPIB Address softkey to select the desired GPIB address.

SCPI Commands

Press the SCPI Commands softkey to configure the SCPI commands.
– Edit 

Set the SCPI commands at the lower half of the main display.
– Import 

Load the SCPI commands from a file. Refer to “Recall” on page 95 for more information on the Recall menu page.

Progress Msg Press the Progress Msg softkey to set the optional text message that will be displayed on a dialog box for the time length 
set in Delay.

Delay
Press the Delay softkey to set the delay time length after the SCPI command(s) is issued. The SCPI command(s) may start 
an external event that takes some time to complete. An optional delay time can be set to wait for completion. The next 
sub-step in the test sequence will not be executed until the delay time has passed.
Keysight U8903B User’s Guide 311



7 Test Sequence Application
Measurements

The U8903B allows up to 20 results in a single measurement. You can move a selected 
measurement within the same test sequence. An example of the measurement menu page 
is displayed as shown in Figure 7-15.

Figure 7-15 TSA > Project > Test > AC Level menu page

Table 7-14 TSA > Project > Test > Measurement menu description 

Menu Description

Enable Press the Enable softkey to enable or disable the selected measurement. The check box for the measurement will be 
selected when enabled.

Add Measurement Press the Add Measurement softkey to add measurements.

Delete Measurement Press the Delete Measurement softkey to delete the selected measurement.

Edit Press the Edit softkey to move or copy the selected measurement, or paste a copied measurement after the selected 
measurement.
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Settings

Press the Settings softkey to configure the selected measurement. Refer to the respective measurement settings for more 
information.
– AC level
– Frequency
– Phase
– SNR
– THD+N
– DC level
– Crosstalk
– SMPTE IMD
– DFD IMD
– Multitone analyzer
– Stepped frequency sweep
– SMPTE frequency sweep
– DFD frequency sweep
– Stepped level sweep
– SMPTE level sweep
– DFD level sweep
– DC level sweep
– Receiver sensitivity
– Measurement recorder
– Voice quality

Properties Press the Properties softkey to configure the measurement properties. Refer to “Properties” on page 314 for more 
information.

Table 7-14 TSA > Project > Test > Measurement menu description (continued)

Menu Description
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Properties

An example of the measurement properties menu page is displayed as shown in 
Figure 7-16.

Figure 7-16 TSA > Project > Test > AC Level > Properties menu page

Table 7-15 TSA > Project > Test > Measurement > Properties menu description 

Menu Description

Name Press the Name softkey to rename the selected measurement.

Sub-Steps Press the Sub-Steps softkey to configure the sub-steps settings. Refer to “Sub-steps” on page 309 for more information 
on the sub-steps settings.

Failure Handling

Press the Failure Handling softkey to select the failure handling type for the selected measurement. When a measurement 
exceeded its preset limit or faced failure due to improper configuration (for example, calling for a file that does not exist or 
sending a SCPI sub-step to an unconnected devices), you can direct the application to the following:
– Cancel Seq. 

Stop the test sequence.
– Allow Retry 

Display a prompt window with Abort, Retry, and Ignore commands. Abort will immediately stop the test sequence. Retry 
will rerun the selected measurements. Ignore will flag the measurement as failed and continue with the test sequence.

– Continue Seq. 
Flag the measurement as failed and continue with the test sequence.
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AC level

AC level measurement provides a single value measurement of the output level from each 
DUT channel, as measured at each of the analyzer input. The AC level measurement 
settings allows you to configure the signal generation and signal analysis settings. The 
result for the AC level measurement for all the selected channels are displayed in a bar 
chart (AC Level and Gain). The gain result is not available if None is selected for the output 
configuration channels. Refer to “Measurement Results” on page 401 for more information 
on the respective result menu page.

Use the arrow keys to navigate through the respective tabs and to display the menu page.

Signal generation

The AC level signal generation settings menu page is displayed as shown in Figure 7-17.

Figure 7-17 TSA > Project > Test > AC Level > Settings > Signal Generation menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Signal analysis

The AC level signal analysis settings menu page is displayed as shown in Figure 7-18.

Figure 7-18 TSA > Project > Test > AC Level > Settings > Signal Analysis menu page

Table 7-16 TSA > Project > Test > AC Level > Settings > Signal Generation menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– Sine
– Variable Phase
– Square
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.

– Phase->1st Ch 
Set the phase value. This setting is only available when channel 2 is selected.
316 Keysight U8903B User’s Guide



Test Sequence Application 7
Table 7-17 TSA > Project > Test > AC Level > Settings > Signal Analysis menu description 

Menu Description

Detector

Press the Detector softkey to select the AC level detector type.
– RMS 

AC level measurement is expressed in an rms value. 
– Pk-Pk 

AC level measurement is expressed in a Vpp value. 

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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Frequency

Frequency measurement provides a single value frequency measurement of the strongest 
component in the output signal of each DUT channel. The frequency measurement settings 
allows you to configure the signal generation settings and signal analysis settings. 

The result for the frequency measurement for all the selected channels are displayed in a 
bar chart (Frequency). Refer to “Measurement Results” on page 401 for more information 
on the respective result menu page. Use the arrow keys to navigate through the respective 
tabs and to display the menu page.

Signal generation

The frequency signal generation settings menu page is displayed as shown in Figure 7-19.

Figure 7-19 Frequency > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-18 Frequency > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– Sine
– Variable Phase
– Square
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.

– Phase->1st Ch 
Set the phase value. This setting is only available when channel 2 is selected.
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Signal analysis

The frequency signal analysis settings menu page is displayed as shown in Figure 7-20.

Figure 7-20 Frequency > Signal Analysis settings menu page

Table 7-19 Frequency > Signal Analysis settings menu description 

Menu Description

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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Test Sequence Application 7
Phase

Phase measurement provides a single value measurement of the relative phase of the DUT 
channels. One channel is chosen as the phase reference channel and the remaining 
channels are measured against it. The phase measurement settings allows you to configure 
the signal generation settings and signal analysis settings. 

The result for the phase measurement for all the selected channels are displayed in a bar 
chart (Phase). Refer to “Measurement Results” on page 401 for more information on the 
respective result menu page. Use the arrow keys to navigate through the respective tabs 
and to display the menu page.

Signal generation

The phase signal generation settings menu page is displayed as shown in Figure 7-21.

Figure 7-21 Phase > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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7 Test Sequence Application
Table 7-20 Phase > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– Sine
– Variable Phase
– Square
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.

– Phase->1st Ch 
Set the phase value. This setting is only available when channel 2 is selected.
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Test Sequence Application 7
Signal analysis

The phase signal analysis settings menu page is displayed as shown in Figure 7-22.

Figure 7-22 Phase > Signal Analysis settings menu page

Table 7-21 Phase > Signal Analysis settings menu description 

Menu Description

Ref Channel Press the Ref Channel softkey to set the reference channel number. The phase of each channel is measured against the 
reference channel. The phase result for the reference channel should always be displayed zero.

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Track 1st Ch 

If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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7 Test Sequence Application
SNR

SNR measurement provides a single value measurement of the signal to noise ratio of the 
output signal from each DUT channel. SNR is used to evaluate the intelligibility of a signal 
by expressing the difference between the nominal signal level and the noise. SNR is formed 
by two measurements where the first measurement is the signal level and the second 
measurement is the noise level with the signal turned off. These two measurements are 
expressed as ratio and displayed in decibels. The SNR measurement settings allows you to 
configure the signal generation settings and signal analysis settings.

The result for the SNR measurement for all the selected channels are displayed in a bar 
chart (SNR). Refer to “Measurement Results” on page 401 for more information on the 
respective result menu page. Use the arrow keys to navigate through the respective tabs 
and to display the menu page.

Signal generation

The SNR signal generation settings menu page is displayed as shown in Figure 7-23.

Figure 7-23 SNR > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Test Sequence Application 7
Table 7-22 SNR > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– Sine
– Variable phase
– Square
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.

– Phase->1st Ch 
Set the phase value. This setting is only available when channel 2 is selected.
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Signal analysis

The SNR signal analysis settings menu page is displayed as shown in Figure 7-24.

Figure 7-24 SNR > Signal Analysis settings menu page

Table 7-23 SNR > Signal Analysis settings menu description 

Menu Description

SNR Mode

Press the SNR Mode softkey to select the SNR measurement mode.
– Fast 

The SNR measurement is based on the frequency domain computation method.
– Standard 

The SNR measurement is measured by an internal routine that alternatively switches the U8903B generator output on 
and off. This mode is a closed-loop configuration which requires both the generator and analyzer in the test setup.

SNR Delay Press the SNR Delay softkey to set the SNR delay. This setting is only available when SNR Mode is set to Standard.

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency. This setting is only available 
when SNR Mode is set to Fast.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when SNR Mode is set to 
Fast and Freq Lock is set to Custom.

Harmonic Cnt Press the Harmonic Cnt softkey to set the number of harmonic order to be removed. This setting is ony available when SNR 
Mode is set to Fast.
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Test Sequence Application 7
LPF

Press the Filtering softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Table 7-23 SNR > Signal Analysis settings menu description (continued)

Menu Description
Keysight U8903B User’s Guide 327



7 Test Sequence Application
Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-23 SNR > Signal Analysis settings menu description (continued)

Menu Description
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Test Sequence Application 7
THD+N

THD+N measurement provides a single value measurement of the THD+N (Total Harmonic 
Distortion with Noise) in the output signal from each DUT channel, as measured at each of 
the analyzer input. The THD+N measurement settings allows you to configure the signal 
generation settings and signal analysis settings. 

The result for the THD+N measurement for all the selected channels are displayed in a bar 
chart (SINAD, THD Level, THD Ratio, THD+N Level, and THD+N Ratio). Refer to 
“Measurement Results” on page 401 for more information on the respective result menu 
page. Use the arrow keys to navigate through the respective tabs and to display the menu 
page.

Signal generation

The THD+N signal generation settings menu page is displayed as shown in Figure 7-25.

Figure 7-25 THD+N > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Signal analysis

The THD+N signal analysis settings menu page is displayed as shown in Figure 7-26.

Figure 7-26 THD+N > Signal Analysis settings menu page

Table 7-24 THD+N > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– Sine
– Variable phase
– Square
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.

– Phase->1st Ch 
Set the phase value. This setting is only available when channel 2 is selected.
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Test Sequence Application 7
Table 7-25 THD+N > Signal Analysis settings menu description 

Menu Description

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Harmonics
Press the Harmonics softkey to select the harmonics count to be used in the THD ratio and THD level results.
– All
– 2 to 9

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom
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Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-25 THD+N > Signal Analysis settings menu description (continued)

Menu Description
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Test Sequence Application 7
DC level

DC level measurement provides a single value measurement of the DC voltage present at 
the output of each DUT channel. If AC coupling is selected in the input configuration 
settings, it will change to DC coupling when the DC level measurement is being performed. 
The DC level measurement settings allows you to configure the signal generation settings 
and signal analysis settings. 

The result for the DC level measurement for all the selected channels are displayed in a bar 
chart (DC Level). Refer to “Measurement Results” on page 401 for more information on the 
respective result menu page. Use the arrow keys to navigate through the respective tabs 
and to display the menu page.

Signal generation

The DC level signal generation settings menu page is displayed as shown in Figure 7-27.

Figure 7-27 DC Level > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-26 DC Level > Signal Generation settings menu description 

Menu Description

Waveform
Press the Waveform softkey to select the waveform type.
– Sine
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Test Sequence Application 7
Signal analysis

The DC level signal analysis settings menu page is displayed as shown in Figure 7-28.

Figure 7-28 DC Level > Signal Analysis settings menu page

Table 7-27 DC Level > Signal Analysis settings menu description 

Menu Description

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
Keysight U8903B User’s Guide 335
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Crosstalk

Crosstalk is the unwanted leakage or bleed of a signal from one or more channels to other 
channels in a DUT. Crosstalk measurement provides the measurement of the crosstalk into 
the unstimulated DUT channel(s) when one channel is stimulated. 

The generator will output the test signal to the DUT on the selected driven channel. The 
crosstalk in each of the remaining channels is then measured. The crosstalk measurement 
settings allows you to configure the signal generation settings and signal analysis settings. 

The crosstalk measured in each channels are displayed in a bar chart (Crosstalk). Refer to 
“Measurement Results” on page 401 for more information on the respective result menu 
page. Use the arrow keys to navigate through the respective tabs and to display the menu 
page.

Signal generation

The crosstalk signal generation settings menu page is displayed as shown in Figure 7-29.

Figure 7-29 Crosstalk > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Test Sequence Application 7
Signal analysis

The crosstalk signal analysis settings menu page is displayed as shown in Figure 7-30.

Figure 7-30 Crosstalk > Signal Analysis settings menu page

Table 7-28 Crosstalk > Signal Generation settings menu description 

Menu Description

Waveform
Press the Waveform softkey to select the waveform type.
– Sine
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Table 7-29 Crosstalk > Signal Analysis settings menu description 

Menu Description

Driven Ch Press the Driven Ch softkey to select the driven channel number from the generator.

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to use the driven channel frequency value. You can select the generator 
channel by setting the Driven Ch. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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SMPTE IMD

SMPTE IMD measurement provides a single value measurement of the IMD ratio in the 
output signal from each DUT channel using the SMPTE method. The SMPTE IMD 
measurement settings allows you to configure the signal generation settings and signal 
analysis settings. 

The result for the SMPTE ratio measurement for all the selected channels are displayed in a 
bar chart (SMPTE Ratio). Refer to “Measurement Results” on page 401 for more 
information on the respective result menu page. Use the arrow keys to navigate through 
the respective tabs and to display the menu page.

Signal generation

The SMPTE IMD signal generation settings menu page is displayed as shown in 
Figure 7-31.

Figure 7-31 SMPTE IMD > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Signal analysis

The SMPTE IMD signal analysis settings menu page is displayed as shown in Figure 7-32.

Figure 7-32 SMPTE IMD > Signal Analysis settings menu page

Table 7-30 SMPTE IMD > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Upper Freq 
Set the upper frequency value.

– Lower Freq 
Set the lower frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Test Sequence Application 7
Table 7-31 SMPTE IMD > Signal Analysis settings menu description 

Menu Description

Freq Lock

Press the Freq Lock softkey to select the searching method for the upper and lower frequencies. 
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the upper and lower frequencies of the input signal based on the 
upper and lower frequencies of the respective generator channel. This Gen Lock method is only useful if you use the 
internal audio generator.

– Custom 
If you have a known input signal, you can define the upper and lower frequency values by setting the searching method 
to Custom and setting the frequency value in Upper Freq and Lower Freq.

Upper Freq Press the Upper Freq softkey to set the upper fundamental frequency value. This setting is only available when Freq Lock is 
set to Custom.

Lower Freq Press the Lower Freq softkey to set the lower fundamental frequency value. This setting is only available when Freq Lock is 
set to Custom.

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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DFD IMD

DFD IMD measurement provides a single value measurement of the IMD ratio in the output 
signal from each DUT channel using the DFD method. The DFD measurement settings 
allows you to configure the signal generation settings and signal analysis settings. 

The result for the DFD ratio measurement for all the selected channels are displayed in a 
bar chart (DFD Ratio). Refer to “Measurement Results” on page 401 for more information 
on the respective result menu page. Use the arrow keys to navigate through the respective 
tabs and to display the menu page.

Signal generation

The DFD IMD signal generation settings menu page is displayed as shown in Figure 7-33.

Figure 7-33 DFD IMD > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Test Sequence Application 7
Signal analysis

The DFD IMD signal analysis settings menu page is displayed as shown in Figure 7-34.

Figure 7-34 DFD IMD > Signal Analysis settings menu page

Table 7-32 DFD IMD > Signal Generation settings menu description 

Menu Description

Waveform
Press the Waveform softkey to select the waveform type.
– IEC60118
– IEC60268

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration. The available settings depend on the waveform 
type.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Upper Freq 
Set the upper frequency value.

– Center Freq 
Set the center frequency value.

– Diff Freq 
Set the difference frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Table 7-33 DFD IMD > Signal Analysis settings menu description 

Menu Description

DFD order
Press the DFD order softkey to select the distortion order to be measured.
– 2nd
– 3rd

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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Multitone analyzer

Multitone analyzer measurement uses the FFT analysis with a multitone stimulus 
waveform. The multitone stimulus signal is the combination of two or more sine waveforms. 
The multitone signal is applied to the DUT, and the DUT output is acquired for 
measurement. You can create a multitone from the Tones Config menu page in the signal 
generation settings.

The result for the multitone analyzer measurement for all the selected channels are 
displayed in a graph (Spectrum, Waveform, Level, and Gain) and in a bar chart (Max Tone 
Level, Min Tone Level, TD+N Level, TD+N Ratio, and Tone Level). Refer to “Measurement 
Results” on page 401 for more information on the respective result menu page. Use the 
arrow keys to navigate through the respective tabs and to display the menu page.

Signal generation

The multitone analyzer signal generation settings menu page is displayed as shown in 
Figure 7-35.

Figure 7-35 Multitone Analyzer > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable. This measurement is also unavailable if a 
different interface is selected for the output and input configuration channel.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-34 Multitone Analyzer > Signal Generation settings menu description 

Menu Description

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Amplitude 
Set the amplitude value.

Tones Config

Press the Tones Config softkey to set the tones.
– Start freq 

The lowest frequency in the multitone waveform.
– Stop freq 

The highest frequency in the multitone waveform.
– Freq Spacing 

The frequency spacing between the tones.
– Tone Count 

The number of signal frequency components. The maximum number of tones that can be generated is 60 for analog and 
64  for digital/Bluetooth.

– Length 
The waveform length that determines the number of samples used to create one iteration of the multitone waveform. 
Longer waveform length provides higher frequency resolution but will take more time to generate and process.

– Apply 
Apply the multitone after it has been customized.

– Optimize 
Optimize the multitone.

– Amplitude Dist: Zero 
Set the amplitude of all tones to 0 dB.

– Phase Dist: Zero 
Set thephase of all tones to 0 degrees.

– Phase Dist: Random 
Set thephase of all tones to random phase in degrees.

– Edit Tones 
Edit the individual tones frequency, amplitude, and phase.

– Active Channel 
The active channel for the absolute amplitude for each tone to be displayed in a table.
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Signal analysis

The multitone analyzer signal analysis settings menu page is displayed as shown in 
Figure 7-36.

Figure 7-36 Multitone Analyzer > Signal Analysis settings menu page

Table 7-35 Multitone Analyzer > Signal Analysis settings menu description 

Menu Description

Input Range

Press the Input Range softkey to configure the input range settings.
– Track 1st Ch 

If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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Stepped frequency sweep

Stepped sweep is an audio testing method where one parameter is swept across a range of 
values while one or more other parameters are measured. The stepped frequency sweep 
measurement provides a sine wave stimulus signal that is moved across a range of 
frequencies in a specified number of points. The DUT output is acquired by the analyzer and 
the results are displayed on an X-Y graph, with the generator frequency on the X-axis and 
the measured results from the DUT on the Y-axis (AC Level, Gain, Phase, THD Ratio, THD 
Level, THD+N Ratio, THD+N Level, and SINAD).

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Auto ranging is not supported for the phase result. Use the arrow keys to 
navigate through the respective tabs and to display the menu page.

Signal generation

The stepped frequency sweep signal generation settings menu page is displayed as shown 
in Figure 7-37.

Figure 7-37 Stepped Frequency Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-36 Stepped Frequency Sweep > Signal Generation settings menu description 

Menu Description

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The stepped frequency sweep signal analysis settings menu page is displayed as shown in 
Figure 7-38.

Figure 7-38 Stepped Frequency Sweep > Signal Analysis settings menu page

Table 7-37 Stepped Frequency Sweep > Signal Analysis settings menu description 

Menu Description

Ref Channel Press the Ref Channel softkey to set the reference channel number. The phase of each channel is measured against the 
reference channel. The phase result for the reference channel should always be displayed zero.

Wrap Phase

Press the Wrap Phase softkey to enable or disable the wrap phase. 
– On 

The phase result is wrapped so that it falls within the range of -180° ~ 180°.
– Off 

The result displayed is the exact value after substracted from the reference channel.

Harmonics
Press the Harmonics softkey to select the harmonics count to be used in the THD ratio and THD level results.
– All
– 2 to 9
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LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Table 7-37 Stepped Frequency Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-37 Stepped Frequency Sweep > Signal Analysis settings menu description (continued)

Menu Description
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SMPTE frequency sweep

SMPTE frequency sweep measurement will hold one of the two tones at a fixed frequency 
while the other is swept through a range of frequencies. The results are displayed on an X-Y 
graph, with the swept frequency on the X-axis and the measured SMPTE ratio on the 
Y-axis. 

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The SMPTE frequency sweep signal generation settings menu page is displayed as shown 
in Figure 7-39.

Figure 7-39 SMPTE Frequency Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-38 SMPTE Frequency Sweep > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Swept 

Select Upper Freq or Lower Freq as the sweep parameter.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Upper Freq 
Set the upper frequency value. This setting is only available if Swept is set to Lower Freq.

– Lower Freq 
Set the lower frequency value. This setting is only available if Swept is set to Upper Freq.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The SMPTE frequency sweep signal analysis settings menu page is displayed as shown in 
Figure 7-40.

Figure 7-40 SMPTE Frequency Sweep > Signal Analysis settings menu page

Table 7-39 SMPTE Frequency Sweep > Signal Analysis settings menu description 

Menu Description

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.
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DFD frequency sweep

DFD frequency sweep measurement will hold one of the two frequencies (IEC60118 upper 
or difference frequency and IEC60268 center or difference frequency) at a fixed frequency 
while the other is swept through a range of frequencies. The results are displayed on an X-Y 
graph, with the swept frequency on the X-axis and the measured DFD ratio on the Y-axis. 

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The DFD frequency sweep signal generation settings menu page is displayed as shown in 
Figure 7-41.

Figure 7-41 DFD Frequency Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-40 DFD Frequency Sweep > Signal Generation settings menu description 

Menu Description

Waveform
Press the Waveform softkey to select the waveform type.
– IEC60118
– IEC60268

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Swept 

Select Upper Freq or Diff Freq as the sweep parameter.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Upper Freq 
Set the upper frequency value. This setting is only available if Swept is set to Diff Freq.

– Diff Freq 
Set the difference frequency value. This setting is only available if Swept is set to Upper Freq.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The DFD frequency sweep signal analysis settings menu page is displayed as shown in 
Figure 7-42.

Figure 7-42 DFD Frequency Sweep > Signal Analysis settings menu page

Table 7-41 DFD Frequency Sweep > Signal Analysis settings menu description 

Menu Description

DFD order
Press the DFD order softkey to select the distortion product order to be measured.
– 2nd
– 3rd

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M
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Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-41 DFD Frequency Sweep > Signal Analysis settings menu description (continued)

Menu Description
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External frequency sweep

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The external frequency sweep signal generation settings menu page is displayed as shown 
in Figure 7-43.

Figure 7-43 External Frequency Sweep > Signal Generation settings menu page

Table 7-42 External Frequency Sweep > Signal Generation settings menu description 

Menu Description

Instrument

Press the Instrument softkey to select the instrument model.
– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A
– Other

GPIB Address
Press the GPIB Address softkey to select the GPIB address.
– 0 to 30

Init Instrument
Press the Init Instrument softkey to enable or disable the U8903B to send SCPI commands to initialize the connected
signal generator.

Init SCPI

Press the Init SCPI softkey to set the SCPI commands that initialize the connected instrument. You can set the SCPI 
command directly or load from a file.
– Edit
– Import (Refer to “Recall” on page 95 for more information on the Recall menu page.)
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Sweep SCPI

Press the Sweep SCPI softkey to set the sweep SCPI commands that initialize the connected instrument. You can set the 
SCPI command directly or load from a file.
– Edit
– Import (Refer to “Recall” on page 95 for more information on the Recall menu page.)

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Table 7-42 External Frequency Sweep > Signal Generation settings menu description (continued)

Menu Description
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Signal analysis

The external frequency sweep signal analysis settings menu page is displayed as shown in 
Figure 7-44.

Figure 7-44 External Frequency Sweep > Signal Analysis settings menu page

Table 7-43 External Frequency Sweep > Signal Analysis settings menu description 

Menu Description

Ref Channel Press the Ref Channel softkey to select the reference channel number. The phase of each channel is measured against the 
reference channel. The phase result for the reference channel should always be displayed zero.

Harmonics
Press the Harmonics softkey to select the harmonics count to be used in the THD ratio and THD level results.
– All
– 2 to 9

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom
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HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Notch Filter

Press the Notch Filter softkey to configure the notch filter settings.
– HP8903B 

Enable or disable the HP8903B mode.
– Custom Notch 

Enable or disable the custom notch.
– Center Freq 

Set the center frequency value. This is only applicable when custom notch is enabled.
– Bandwidth 

Set the bandwidth value. This is only applicable when custom notch is enabled.

Table 7-43 External Frequency Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-43 External Frequency Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Stepped level sweep

Stepped sweep is an audio testing method where one parameter is swept across a range of 
values while one or more other parameters are measured. The stepped level sweep 
measurement provides a sine wave stimulus signal that is moved across a range of levels in 
a specified number of points. The DUT output is acquired by the analyzer and the results 
are displayed on an X-Y graph, with the generator level on the X-axis and the measured 
results from the DUT on the Y-axis (AC Level, Gain, THD Ratio, THD Level, THD Ratio Vs 
Measured Amplitude, THD Level Vs Measured Amplitude, THD+N ratio, THD+N Level, 
THD+N Ratio Vs Measured Amplitude, THD+N Level Vs Measured Amplitude, and SINAD).

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The stepped level sweep signal generation settings menu page is displayed as shown in 
Figure 7-45.

Figure 7-45 Stepped Level Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-44 Stepped Level Sweep > Signal Generation settings menu description 

Menu Description

Waveform
Press the Waveform softkey to select the waveform type.
– Sine
– Arbitrary

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The stepped level sweep signal analysis settings menu page is displayed as shown in 
Figure 7-46.

Figure 7-46 Stepped Level Sweep > Signal Analysis settings menu page

Table 7-45 Stepped Level Sweep > Signal Analysis settings menu description 

Menu Description

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.
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LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Table 7-45 Stepped Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-45 Stepped Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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SMPTE level sweep

SMPTE level sweep measurement will add two tones of different frequencies into a stimulus 
signal to sweep through a range of levels. The results are displayed on an X-Y graph, with 
the swept generator level or measured DUT level on the X-axis and the measured SMPTE 
ratio on the Y-axis. 

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The SMPTE level sweep signal generation settings menu page is displayed as shown in 
Figure 7-47.

Figure 7-47 SMPTE Level Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-46 SMPTE Level Sweep > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Upper Freq 
Set the upper frequency value.

– Lower Freq 
Set the lower frequency value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The SMPTE level sweep signal analysis settings menu page is displayed as shown in 
Figure 7-48.

Figure 7-48 SMPTE Level Sweep > Signal Analysis settings menu page

Table 7-47 SMPTE Level Sweep > Signal Analysis settings menu description 

Menu Description

Freq Lock

Press the Freq Lock softkey to select the searching method for the upper and lower frequencies. 
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the upper and lower frequencies of the input signal based on the 
upper and lower frequencies of the respective generator channel. This Gen Lock method is only useful if you use the 
internal audio generator.

– Custom 
If you have a known input signal, you can define the upper and lower frequency values by setting the searching method 
to Custom and setting the frequency value in Upper Freq and Lower Freq.

Upper Freq Press the Upper Freq softkey to set the upper fundamental frequency value. This setting is only available when Freq Lock is 
set to Custom.

Lower Freq Press the Lower Freq softkey to set the lower fundamental frequency value. This setting is only available when Freq Lock is 
set to Custom.
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Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-47 SMPTE Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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DFD level sweep

DFD level sweep measurement will add up two tones of different frequencies into a 
stimulus signal to sweep through a range of levels. The results are displayed on an X-Y 
graph, with the swept generator level or measured DUT level on the X-axis and the 
measured DFD ratio on the Y-axis. 

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The DFD level sweep signal generation settings menu page is displayed as shown in 
Figure 7-49.

Figure 7-49 DFD Level Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Table 7-48 DFD Level Sweep > Signal Generation settings menu description 

Menu Description

Waveform
Press the Waveform softkey to select the waveform type.
– IEC60118
– IEC60268

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Upper Freq 
Set the upper frequency value.

– Diff Freq 
Set the difference frequency value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The DFD level sweep signal analysis settings menu page is displayed as shown in 
Figure 7-50.

Figure 7-50 DFD Level Sweep > Signal Analysis settings menu page

Table 7-49 DFD Level Sweep > Signal Analysis settings menu description 

Menu Description

DFD order
Press the DFD order softkey to select the distortion product order to be measured.
– 2nd
– 3rd

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M
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Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-49 DFD Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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DC level sweep

DC level sweep measurement sweeps a DC signal across a range of values in a series of 
points and the DUT output is acquired by the analyzer. The results are displayed on an X-Y 
graph, with the generator DC level on the X-axis and the measured result on the Y-axis. If 
AC coupling is selected in the input configuration settings, it will temporary be set to DC 
coupling while the DC level sweep measurement is performed.

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The DC level sweep signal generation settings menu page is displayed as shown in 
Figure 7-51.

Figure 7-51 DC Level Sweep > Signal Generation settings menu page

NOTE
This measurement requires a closed-loop configuration in which both the generator and 
the analyzer are used in the test setup. If None is selected for the output configuration 
channel, this measurement is unavailable.

NOTE
The signal generation is disabled if None is selected for the output configuration channel.
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Signal analysis

The DC level sweep signal analysis settings menu page is displayed as shown in 
Figure 7-52.

Figure 7-52 DC Level Sweep > Signal Analysis settings menu page

Table 7-50 DC Level Sweep > Signal Generation settings menu description 

Menu Description

Output Press the Output softkey to select the output channel.

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.
Keysight U8903B User’s Guide 379



7 Test Sequence Application
Table 7-51 DC Level Sweep > Signal Analysis settings menu description 

Menu Description

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom
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Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-51 DC Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Receiver sensitivity

Receiver sensitivity measurement uses an external RF (radio frequency) signal generator to 
create a RF stimulus signal that is moved across a range of powers in a specified number of 
points. The DUT output which is in analog audio is acquired by the analyzer and processed 
for display.

The receiver sensitivity measurement is typically used for characterizing radio sensitivity by 
measuring SINAD. SINAD is an audio quality value that is used to specify the RF sensitivity 
of radio receivers. A higher SINAD value indicates higher quality audio.

Figure 7-53 shows a general setup for the receiver sensitivity measurement. A signal 
generator provides its own modulation and the U8903B controls the signal generator 
through Keysight 82357B USB/GPIB interface. A receiver such as a two-way radio is 
connected to the U8903B either by a direct connection or through an acoustic coupler.

Figure 7-53 General setup for the receiver sensitivity measurement

Set the audio output level of the receiver as required and the signal generator settings to 
the desired value. The U8903B will automatically adjust the RF power output from the 
signal generator so that the targeted SINAD is produced at the receiver output. The 
targeted SINAD value is generally 12 dB for a communications receiver and 23 dB (mono) 
or 26 dB (stereo) for a broadcast receiver such as a car radio or Hi-Fi tuner.

The results are displayed on an X-Y graph, with the RF power parameter on the X-axis and 
the measured SINAD results on the Y-axis. Refer to “Measurement Results” on page 401 
for more information on the respective result menu page. Use the arrow keys to navigate 
through the respective tabs and to display the menu page.

NOTE
Receiver sensitivity measurement will be unavailable if the Bluetooth interface is selected 
for the input configuration.
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Signal generation

The receiver sensitivity signal generation settings menu page is displayed as shown in 
Figure 7-54.

Figure 7-54 Receiver Sensitivity > Signal Generation settings menu page

Table 7-52 Receiver Sensitivity > Signal Generation settings menu description 

Menu Description

Instrument
Press the Instrument softkey to select the signal generator model.
– Keysight E4438C
– Other

GPIB address Press the GPIB address softkey to set the GPIB address for the connected signal generator.

Start Power Press the Start Power softkey to set the sweep start RF power.

Stop Power Press the Stop Power softkey to set the sweep stop RF power.

Step Size Press the Step Size softkey to set the step size. 

Dwell Time Press the Dwell Time softkey to set the delay between each measured SINAD in seconds.

Init Instrument Press the Init Instrument softkey to enable or disable the U8903B to send SCPI commands to initialize the connected 
signal generator.

FM Frequency Press the FM Frequency softkey to set the RF signal output frequency. This setting is only available if Instrument is set to 
Keysight E4438C and the Init Instrument is enabled.

FM Deviation Press the FM Deviation softkey to set the RF signal frequency modulation deviation. This setting is only available if 
Instrument is set to Keysight E4438C and the Init Instrument is enabled.

FM Rate Press the FM Rate softkey to set the RF signal internal frequency modulation rate. This setting is only available if 
Instrument is set to Keysight E4438C and the Init Instrument is enabled.
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Signal analysis

The receiver sensitivity signal analysis settings menu page is displayed as shown in 
Figure 7-55.

Figure 7-55 Receiver Sensitivity > Signal Analysis settings menu page

Init SCPI
Press the Init SCPI softkey to set the SCPI commands that initialize the connected signal generator. You can set the SCPI 
command directly or load from a file. This setting is only available if Instrument is set to Other and the Init Instrument is 
enabled.

Output Power SCPI

Press the Output Power SCPI softkey to edit the SCPI command that adjusts the RF power of the connected signal 
generator. The command must be in the following pattern.
Cmds <val>
Cmds is the SCPI command and <val> is the value that will be filled up by the measurement to perform sweep. For 
example, :POW <val>DBM. This setting is only available if Instrument is set to Other.

Table 7-52 Receiver Sensitivity > Signal Generation settings menu description (continued)

Menu Description

Table 7-53 Receiver Sensitivity > Signal Analysis settings menu description 

Menu Description

Meas Channel Press the Meas Channel softkey to set the measured channel number.

Target SINAD Press the Target SINAD softkey to set the target SINAD value measured from the Meas Channel.

Min 1st Value Press the Min 1st Value softkey to set the minimum first value.

Stop Condition
Press the Stop Condition softkey to select the stop condition.
– Until End
– On Target
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Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Custom 

If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.

LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Table 7-53 Receiver Sensitivity > Signal Analysis settings menu description (continued)

Menu Description
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Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Notch Filter

Press the Notch Filter softkey to configure the notch filter settings.
– HP8903B 

Enable or disable the HP8903B notch filter mode.
– Custom Notch 

Enable or disable custom notch filter.
– Center Freq 

Set the center frequency value. This is only available when the Custom Notch is enabled.
– Bandwidth 

Set the bandwidth value. This is only available when the Custom Notch is enabled.

Average Points
Press the Average Points softkey to set the number of measurement readings to be used for the average calculation. This 
is useful for noisy signals. Applying the average points will smooth out the fluctuations introduced by the noise that causes 
the inconsistencies in the measurement reading. 

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-53 Receiver Sensitivity > Signal Analysis settings menu description (continued)

Menu Description
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External level sweep

Refer to “Measurement Results” on page 401 for more information on the respective result 
menu page. Use the arrow keys to navigate through the respective tabs and to display the 
menu page.

Signal generation

The external level sweep signal generation settings menu page is displayed as shown in 
Figure 7-56.

Figure 7-56 External Level Sweep > Signal Generation settings menu page

Table 7-54 External Level Sweep > Signal Generation settings menu description 

Menu Description

Instrument

Press the Instrument softkey to select the instrument model.
– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A
– Other

GPIB Address
Press the GPIB Address softkey to select the GPIB address.
– 0 to 30

Init Instrument
Press the Init Instrument softkey to enable or disable the U8903B to send SCPI commands to initialize the connected
signal generator.

Init SCPI

Press the Init SCPI softkey to set the SCPI commands that initialize the connected instrument. You can set the SCPI 
command directly or load from a file.
– Edit
– Import (Refer to “Recall” on page 95 for more information on the Recall menu page.)
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Sweep SCPI

Press the Sweep SCPI softkey to set the sweep SCPI commands that initialize the connected instrument. You can set the 
SCPI command directly or load from a file.
– Edit
– Import (Refer to “Recall” on page 95 for more information on the Recall menu page.)

Sweep Config

Press the Sweep Config softkey to set the sweep configuration.
– Start 

Set the start value for the sweep parameter.
– Stop 

Set the stop value for the sweep parameter.
– Spacing 

Select Log, Linear, or Custom for the sweep spacing.
– Points 

Set the number of sweep points.
– Step Size 

Set the step size for linear spacing. This setting is only available when spacing is set to Linear.
– Dwell Time 

Set the delay between the sweep points.
– Edit Points 

Edit the individual points value, insert or remove points, load points, and save the points.

Table 7-54 External Level Sweep > Signal Generation settings menu description (continued)

Menu Description
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Signal analysis

The external frequency sweep signal analysis settings menu page is displayed as shown in 
Figure 7-57.

Figure 7-57 External Level Sweep > Signal Analysis settings menu page

Table 7-55 Stepped Level Sweep > Signal Analysis settings menu description 

Menu Description

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.
Keysight U8903B User’s Guide 389



7 Test Sequence Application
LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Table 7-55 Stepped Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Notch Filter

Press the Notch Filter softkey to configure the notch filter settings.
– HP8903B 

Enable or disable the HP8903B mode.
– Custom Notch 

Enable or disable the custom notch.
– Center Freq 

Set the center frequency value.
– Bandwidth 

Set the bandwidth value.

Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-55 Stepped Level Sweep > Signal Analysis settings menu description (continued)

Menu Description
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Measurement recorder

Measurement recorder is a tool that provides a record of a number of measurements versus 
elapsed time. It is useful to monitor the output of a DUT over an extended period of time. 
The measurement recorder does not require a specific test signal. It can be used with any 
audio signal within the input range of the analyzer or with no signal.

The reading rate of the measurement recorder is dependent on the channel count, sample 
size, and result type. A reading is obtained at the beginning of the measurement and 
throughout the duration set until the elapsed time.

The results are displayed on an X-Y graph, with the time parameter on the X-axis and the 
measured results on the Y-axis (AC Level, Gain, Phase, THD+N Ratio, THD+N Level, DC 
Level, Frequency, and SINAD). Refer to “Measurement Results” on page 401 for more 
information on the respective result menu page. Use the arrow keys to navigate through 
the respective tabs and to display the menu page.

NOTE
– Auto ranging is not supported for the phase result.

– DC level result is not available if AC coupling is selected in the output configuration 
settings.
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Signal generation

The measurement recorder signal generation settings menu page is displayed as shown in 
Figure 7-58.

Figure 7-58 Measurement Recorder > Signal Generation settings menu page

NOTE
The signal generation is disabled if None is selected for the output configuration channel.

Table 7-56 Measurement Recorder > Signal Generation settings menu description 

Menu Description

Waveform

Press the Waveform softkey to select the waveform type.
– Sine
– Variable Phase
– Square
– Arbitrary

Output Press the Output softkey to select the output channel.

Waveform Config

Press the Waveform Config softkey to set the waveform configuration.
– Track 1st Ch 

If Track 1st Ch is enabled, the generator channel 1 waveform configuration settings will be copied to the other channels 
and the waveform configuration settings for the other channels cannot be edited. Any changes made to channel 1 
waveform configuration settings will be reproduced in the other channels waveform configuration settings. Disable the 
Track 1st Ch to set the individual channels.

– Frequency 
Set the frequency value.

– Amplitude 
Set the amplitude value.

– DC Offset 
Set the DC offset value.
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Signal analysis

The measurement recorder signal analysis settings menu page is displayed as shown in 
Figure 7-59.

Figure 7-59 Measurement Recorder > Signal Analysis settings menu page

Table 7-57 Measurement Recorder > Signal Analysis settings menu description 

Menu Description

Duration

Press the Duration softkey to set the length of the measurement record. The duration is in the following pattern.
hh:mm:ss
hh is the hours, mm is the minutes, and ss is the seconds. 
The minimum duration is 0 s, and the maximum duration is 3 days (71:59:59). When the duration is set to 0 s, a single 
measurement will be made.

Ref Channel Press the Ref Channel softkey to set the reference channel number. The phase of each channel is measured against the 
reference channel. The phase result for the reference channel should always be displayed zero.

Wrap Phase

Press the Wrap Phase softkey to enable or disable the wrap phase. 
– On 

The phase result is wrapped so that it falls within the range of -180° ~ 180°.
– Off 

The result displayed is the exact value after substracted from the reference channel.

Freq Lock

Press the Freq Lock softkey to select the searching method for the fundamental frequency.
– Auto 

Selecting Auto will allow the U8903B to search for the fundamental frequency automatically.
– Gen Lock 

Selecting Gen Lock will allow the U8903B to search for the fundamental frequency based on the generator frequency 
value of the respective generator channel. This Gen Lock method is only useful if you use the internal audio generator.

– Custom 
If you have a known input signal, you can define the fundamental frequency value by setting the searching method to 
Custom and setting the frequency value in Fund Freq.

Fund Freq Press the Fund Freq softkey to set the fundamental frequency value. This setting is only available when Freq Lock is set to 
Custom.
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LPF

Press the LPF softkey to select the low-pass filter.
– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

HPF

Press the HPF softkey to select the high-pass filter.
– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Weighting

Press the Weighting softkey to select the weighting filter.
– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Deemphasis

Press the Deemphasis softkey to select the de-emphasis filter.
– None
– 50 μs
– 75 μs
– Custom

Table 7-57 Measurement Recorder > Signal Analysis settings menu description (continued)

Menu Description
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Sample Size

Press the Sample Size softkey to select the number of samples to be acquired for the measurement. 
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Input Range

Press the Input Range softkey to configure the input range settings.
– Auto Range 

Enable or disable the auto input range. 
If auto range is enabled, each analog channel input range is determined automatically, based on the level of the input 
signal. If the input signal level changes beyond the ranging threshold, auto range will cause the input ranging circuits to 
move up or down for a proper ranging. 
If auto range is disabled, you can set a fixed input voltage range for each analog input channel.

– Track 1st Ch 
If Track 1st Ch is enabled, all the other channels will be set to follow the channel 1 range setting. Any changes made to 
channel 1 range setting will be reproduced in the other channels. Disable the Track 1st Ch to set the individual 
channels.

– Voltage Range 
Set the input voltage range.

Table 7-57 Measurement Recorder > Signal Analysis settings menu description (continued)

Menu Description
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Voice quality

Perceptual Objective Listening Quality Assessment (POLQA) is the next-generation voice 
quality testing technology for fixed, mobile, and IP-based networks. POLQA was 
standardized by the ITU-T (International Telecommunication Union) as the new 
Recommendation P.863 and can be applied for voice quality analysis of high definition 
voice, 3G, and 4G/LTE networks. POLQA is licensed by OPTICOM GmbH.

POLQA provides significantly improved benchmark accuracy for 3G and strong support for 
testing of most recent technologies such as Unified Communications, Next Gen Networks, 
and 4G/LTE compared to PESQ/P8.862 that was originally released in the year 2001.

POLQA measurement working model is to predict speech quality by analysing digital 
speech signal. The objective measures should be as close as possible to the subjective 
quality scores as if it would be obtained from subjective listening tests. Typically, POLQA 
measurement uses real speech as a test stimulus to assess the quality and performance of 
telephony networks. POLQA measurement is the successor to PESQ/P8.862 measurement.

The result for the voice quality measurement for all the selected channels are displayed in a 
bar chart (MOS-LQO and Levels). Refer to “Measurement Results” on page 401 for more 
information on the respective result menu page. Use the arrow keys to navigate through 
the respective tabs and to display the menu page.

NOTE
POLQA measurement is only available with N3432A. Refer to “U8903B Options” on 
page 37 for more information.

This measurement is unavailable if a different interface is selected for the output and input 
configuration channel.

NOTE
Perceptual Objective Listening Quality Analysis (POLQA) according to ITU-T 
Recommendation P. 863 included in this product is protected by copyright and by 
European, US and other International patents and patent applications and is provided 
under license from OPTICOM Dipl.-Ing. M. Keyhl GmbH, Erlangen, Germany, 2011 - 
www.opticom.de.

POLQA® is a registered trademark of OPTICOM GmbH. Used by permission. 

© 2011 by the POLQA Coalition of OPTICOM GmbH, Germany - SwissQual AG, Switzerland 
- KPN, The Netherlands - TNO, The Netherlands. 

Copying, modifying, translating, reverse engineering or decompiling the POLQA Software is 
prohibited. Acknowledgement of the rights in the POLQA software shall not be removed 
from the POLQA software or any installation of it.

For further information please refer to www.polqa.info.
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Signal generation and analysis

The voice quality signal generation and analysis settings menu page is displayed as shown 
in Figure 7-60.

Figure 7-60 Voice Quality > Signal Generation and Analysis settings menu page

NOTE
POLQA voice quality analysis may have a reduced wave file recording duration compared to 
the PESQ voice quality analysis based on the different option card configuration and 
settings in the U8903B. For more information, please refer to “POLQA Recording Duration 
Analysis” on page 604.

Table 7-58 Voice Quality > Signal Generation and Analysis settings menu description 

Menu Description

Test Config

Press the Test Config softkey to set the test configurations.
– Standard 

Select POLQA as the test standard.
– Bandwidth 

Select Narrowband or Super Wideband as the bandwidth type for POLQA standard. 
– Level Align 

Enable or disable the automatic level alignment. This setting is only applicable for POLQA standard.
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Test Sequence Application 7
Reference

Press the Reference softkey to set the reference source configuration. 
– Source 

Select the reference source.
– File 

Use the Reference File as the comparison file.
– Generator 

Use the Reference File options to determine the comparison file.
– Reference File 

Use the Reference File as the comparison file if the Source is set to File.  
Use the following Reference File options as the comparison file if the Source is set to Generator: 
– Playback File 

Use the Playback File as the comparison file.
– Recorded 

Use the Recorded Playback File as the comparison file.
– Custom File 

Use the Custom File as the comparison file.
– Playback File 

This setting is only available when the Reference Source is set to Generator. Set the playback file to be used as the 
comparison file if Reference File is set to Playback File. Set the playback file to be recorded as the comparison file if 
Reference File is set to Recorded. Set the playback file to be recorded and the Custom File to be used as the comparison 
file if Reference File is set to Custom.

– Custom File 
Set the custom file to be used as the comparison file. This setting is only available when Reference Source is set to 
Generator and Reference File is set to Custom.

– Rec Channel 
Set the channel number to be recorded from. This setting is only available when Source is set to Generator and 
Reference File is set to Recorded.

– Rec Duration 
Set the recording duration to be recorded. This setting is only available when Source is set to Generator and Reference 
File is set to Recorded.

– Rec Step 
Set the start recording type. This setting is only available when Source is set to Generator and Reference File is set to 
Recorded.
– Auto 

Start the recording automatically.
– Delay 

Start the recording after a delay.
– Prompt 

Start the recording after the user presses the Enter key to proceed in the confirmation prompt.
– Rec Delay 

Set the delay time before a recording is performed. This setting is only available when Source is set to Generator, 
Reference File is set to Recorded, and Rec Step is set to Delay.

– Rec to File 
Enable or disable exporting the recording function. This setting is only available when Source is set to Generator and 
Reference File is set to Recorded.
– Yes 

Export the recording to the file path specified in Rec File.
– No 

Do not export the recording.
– Rec File 

Set the file path for the exported recording destination. This setting is only available when Source is set to Generator, 
Reference File is set to Recorded, and Rec To File is set to Yes.

Table 7-58 Voice Quality > Signal Generation and Analysis settings menu description (continued)

Menu Description
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Degraded

Press the Degraded softkey to set the degraded source configuration. 
– Source 

Select the degraded source.
– File 

Use the Degraded File as the comparison file.
– Analyzer 

Use the Analyzer recording as the comparison file.
– Degraded File 

Set the degraded file as the comparison file. This setting is only available when Source is set to File.
– Rec Channel 

Set the channel number to be recorded from. This setting is only available when Source is set to Analyzer.
– Rec Duration 

Set the recording duration to be recorded. This setting is only available when Source is set to Analyzer.
– Rec Step 

Set the start recording type. This setting is only available when Source is set to Analyzer.
– Auto 

Start the recording automatically.
– Delay 

Start the recording after a delay.
– Prompt 

Start the recording after the user presses the Enter key to proceed in the confirmation prompt.
– Rec Delay 

Set the delay time before a recording is performed. This setting is only available when Source is set to Analyzer and Rec 
Step is set to Delay.

– Rec to File 
Enable or disable exporting the recording function. This setting is only available when Source is set to Analyzer.
– Yes 

Export the recording to the file path specified in Rec File.
– No 

Do not export the recording.
– Rec File 

Set the file path for the exported recording destination. This setting is only available when Source is set to Analyzer and 
Rec To File is set to Yes.

IO Config
Press the IO Config softkey to set the IO configuration.
– Output Level 

Set the output level value.

Show/Hide POLQA 
License Press the Show/Hide POLQA License softkey to show or hide the POLQA license information.

Table 7-58 Voice Quality > Signal Generation and Analysis settings menu description (continued)

Menu Description
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Measurement Results

The test sequence application allows you to display the measurement results in a bar chart 
or graph.

Bar chart

An example of the bar chart result menu page is displayed as shown in Figure 7-61.

Figure 7-61 AC Level > Settings > Result (AC level) menu page

Table 7-59 TSA > Project > Test > Measurement > Settings > Result (bar chart) menu description 

Menu Description

Enable Press the Enable softkey to enable or disable the selected result tab.

Add Result Press the Add Result softkey to add a new result tab to the measurement.

Delete Result Press the Delete Result softkey to delete the selected result tab from the measurement.

Save Data Press the Save Data softkey to save the selected result data to a CSV file format in the internal storage or external USB 
flash storage. Refer to “Save” on page 94 for the Save menu page.
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Graph

An example of the graph result menu page is displayed as shown in Figure 7-62.

Figure 7-62 Multitone Analyzer > Settings > Result (Spectrum) menu page

Edit Limits

Press the Edit Limits softkey to configure the limits settings.
– Track 1st 

If Track 1st trace is enabled, the channel 1 limits settings will be copied to the other channels and the limits settings for 
the other channels cannot be edited. Any changes made to the channel 1 limits settings will be reproduced in the other 
channels limits settings. Disable the Track 1st trace to set the individual channels limits.

– Lower Limit 
Enable or disable the lower limit.

– Upper Limit 
Enable or disable the upper limit.

– Lower Limit 
Set the lower limit value.

– Upper Limit 
Set the upper limit value.

Graph Properties

Press the Graph Properties softkey to set the graph properties.
– Title 

Edit the bar chart title.
– X-axis
– Auto Scale 

Enable or disable the X-axis autoscale.
– Unit 

Select the X-axis unit type.
– Left 

Set the X-axis left edge value. This setting is only available when Auto Scale is disabled.
– Right 

Set the X-axis right edge value. This setting is only available when Auto Scale is disabled.

Table 7-59 TSA > Project > Test > Measurement > Settings > Result (bar chart) menu description (continued)

Menu Description
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Table 7-60 TSA > Project > Test > Measurement > Settings > Result (graph) menu description 

Menu Description

Enable Press the Enable softkey to enable or disable the selected result tab.

Add Result Press the Add Result softkey to add a new result tab to the measurement.

Delete Result Press the Delete Result softkey to delete the selected result tab from the measurement.

Save Data Press the Save Data softkey to save the selected result data to a CSV file format in the internal storage or external USB 
flash storage. Refer to “Save” on page 94 for the Save menu page.

Edit Limits

Press the Edit Limits softkey to configure the limits settings.
– Trace 

Select the trace channel number or the trace type (POLQA measurement)
– Limit Type 

Select Upper or Lower as the limit type.
– Track 1st 

If Track 1st trace is enabled, the channel 1 limits settings will be copied to the other channels and the limits settings for 
the other channels cannot be edited. Any changes made to the channel 1 limits settings will be reproduced in the other 
channels limits settings. Disable the Track 1st trace to set the individual channels limits.

– Limit 
Enable or disable the limit.

– Points
– Point No 

Set the point number.
– X 

Set the X-axis value for the selected point number.
– Y 

Set the Y-axis value for the selected point number.
– Add Point 

Add a limit point.
– Remove Point 

Remove the selected limit point.
– Clear Points 

Clear all the limit points.
– Load Points 

Load limit points from a file. Refer to “Recall” on page 95 for the Recall menu page.
– Save Points 

Save the selected limit points to a file. Refer to “Save” on page 94 for the Save menu page.
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Graph Properties

Press the Graph Properties softkey to set the graph properties.
– Title 

Edit the graph title.
– X-axis
– Auto Scale 

Enable or disable the X-axis autoscale.
– Spacing 

Select Linear or Log for the spacing.
– Unit 

Select the X-axis unit type.
– Left 

Set the X-axis left edge value. This setting is only available when Auto Scale is disabled.
– Right 

Set the X-axis right edge value. This setting is only available when Auto Scale is disabled.
– Center 

Set the X-axis center value. This setting is only available when Auto Scale is disabled.
– Span 

Set the X-axis span value. This setting is only available when Auto Scale is disabled.
– Y-axis
– Auto Scale 

Enable or disable the Y-axis autoscale.
– Spacing 

Select Linear or Log for the spacing.
– Unit 

Select the Y-axis unit type.
– Top 

Set the Y-axis top value. This setting is only available when Auto Scale is disabled.
– Bottom 

Set the Y-axis bottom value. This setting is only available when Auto Scale is disabled.
– Traces
– Trace 

Select the analyzer trace channel.
– State 

Enable or disable the trace.
– Color 

Set the trace color.

Graph Properties
(This is only applicable for 
POLQA measurement 
MOS-LQO and Delay 
results)

Press the Graph Properties softkey to set the graph properties.
– Title 

Set the bar chart title.
– Auto Scale 

Enable or disable autoscale.
– Left 

Set the X-axis left edge value. This setting is only available when Auto Scale is disabled.
– Right 

Set the X-axis right edge value. This setting is only available when Auto Scale is disabled.
– Top 

Set the Y-axis top edge value. This setting is only available when Auto Scale is disabled.
– Bottom 

Set the Y-axis bottom edge value. This setting is only available when Auto Scale is disabled.

Table 7-60 TSA > Project > Test > Measurement > Settings > Result (graph) menu description (continued)

Menu Description
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Report

The U8903B allows you to generate a report of the test sequence results. The TSA > Report 
menu page is displayed as shown in Figure 7-63.

Figure 7-63 TSA > Report menu page

Table 7-61 TSA > Report menu description 

Menu Description

Clear Press the Clear softkey to clear all the report data.

Save Press the Save softkey to save the report to a DOCX file format. Refer to “Save” on page 94 for more information on the 
Save menu page.

Properties Press the Properties softkey to configure the auto save settings. Refer to “Properties” on page 406 for more information.
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Properties

Figure 7-64 TSA > Report > Properties menu page

Table 7-62 TSA > Report > Properties menu description 

Menu Description

Auto Save Press the Auto Save softkey to enable or disable saving the report automatically at the end of a test sequence.

Format
Press the Format softkey to select the report file format to be saved.
– Docx
– Html

Name Option

Press the Name Option softkey to select the naming convention of the file name for the automatically saved report.
– Timestamp 

Save the report in a time stamp suffix file name.
– Numeric 

Save the report in a numerical suffix file name that increments with each save.
– Prompt 

Prompts for the file name at the end of a test sequence.

Prefix Press the Prefix softkey to set the prefix for the file name.

Location Press the Location softkey to select the folder for the automatically saved report. Refer to “Location” on page 407 for 
more information.
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Location

Select the ‘...’ item at the list and press  to move up a level from the current folder 

or to another directory. Use the arrow keys to navigate through the files or select the 
desired folder or file.

Press the Select softkey to select the current folder as the location to be saved to. Press the 
New Folder softkey to create a new folder at the current directory or folder.

Figure 7-65 Select Path menu page
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This chapter describes the various configurations for the HP8903B mode..

NOTE
The HP8903B mode is only available when GPIB is initialized successfully. Entering or 
exiting the HP8903B mode will cause the system to reset. Some of the SCPI commands for 
the active channel of the analog analyzer and analog generator that work in the standard 
view mode will not work in the HP8903B mode.



8 HP8903B
HP8903B

Press  and select HP8903B to access the HP8903B menu page. The U8903B allows 

you to emulate the HP8903B audio analyzer behavior in the HP8903B mode.

Figure 8-1 HP8903B menu page

1

2

3

4 5
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HP8903B 8
Table 8-1 U8903B LCD display description 

Item Description

1 SINAD meter Display the SINAD measurement mode readings.

2 Analyzer panel
Display the measurement results. The left panel reading shows the frequency result while the 
right panel reading shows the result of the selected measurement modes. Refer to 
“Measurement” on page 412 for the available measurement modes.

3 Generator panel

Display the frequency and amplitude values of the sine waveform. The highlighted generator 
parameter label in red indicates the current increment parameter. You can use the up or down 
arrow keys to increment/decrement the current parameter value according to the parameter 
step value. Refer to “Generator” on page 414 for more information.

4 Measurement setting panel Display the current measurement settings in red.

5 HP8903B settings panel
Display the current setting for input range, detector, impedance, and sweep points. If the auto 
range is selected, the input range parameter will be highlighted in red.
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Measurement

Select Measurement in the HP8903B menu page to configure the HP8903B measurement 
settings.

Figure 8-2 HP8903B > Measurement menu page

Table 8-2 HP8903B > Measurement menu description 

Menu Description

Function

Press the Function softkey to select the HP8903B measurement mode.
– AC LEVEL
– SINAD
– DISTN
– DC LEVEL
– SIG / NOISE
– DISTN LEVEL

LP Filter

Press the LP Filter softkey to select the HP8903B measurement low-pass filter value. The default low-pass filter can be 
set at “HP8903B Config” on page 89.
– None
– 30 kHz
– 80 kHz

HP/W Filter Press the HP/W Filter softkey to select the HP8903B high-pass or weighting filter value. The filter selection depends on 
the left and right filters set at “HP8903B Config” on page 89.

Reference Press the Reference softkey to set the reference value to be compared with the measured value in ratio mode. Changing 
the reference value will enable the measurement ratio mode.

Ratio Press the Ratio softkey to enable or disable the HP8903B measurement ratio mode.

Format
Press the Format softkey to select the HP8903B measurement format type.
– Log
– Lin
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Table 8-3 shows the measurement units that are applicable for the individual HP8903B 
measurement modes.

Table 8-3 HP8903B unit charts

Measurement Ratio On Ratio Off

LOG LIN LOG LIN

AC LEVEL dB % dBm into 600 Ω V

DC LEVEL dB % dBm into 600 Ω V

SINAD dB % dB %

SIG/NOISE dB % dB %

DSTN dB % dB %

DSTN LEVEL dB % dBm into 600 Ω V
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Generator

Select Generator in the HP8903B menu page to configure the HP8903B generator settings.

Figure 8-3 HP8903B > Generator menu page

NOTE
The generator in the HP8903B generates sine waveform.

Table 8-4 HP8903B > Generator menu description 

Menu Description

Frequency Press the Frequency softkey to set the HP8903B generator frequency value. Changing the frequency value will also set the 
step parameter to frequency.

Amplitude Press the Amplitude softkey to set the HP8903B generator amplitude value. Changing the amplitude value will also set 
the step parameter to amplitude.

Step Param
Press the Step Param softkey to select the HP8903B generator step parameter type.
– Frequency
– Amplitude

Freq. Step Press the Freq. Step softkey to set the HP8903B generator frequency step value. This setting is only available when the 
step parameter is set to frequency.

Amp. Step Press the Amp. Step softkey to set the HP8903B generator amplitude step value. This setting is only available when the 
step parameter is set to amplitude.

x 10 Press the x 10 softkey to multiply the current parameter step value by 10.

÷ 10 Press the ÷ 10 softkey to divide the current parameter step value by 10.
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Sweep

In HP8903B mode, the source frequency is logarithmically swept. The number of frequency 
points in a sweep is determined by the sweep width (ratio of the stop and start frequencies) 
and the selected sweep resolution. The maximum number of points allowable in a sweep is 
255. The frequency points in a sweep can be computed by using the following formulas:

Where n is the frequency point number (0 is the start frequency) and k is the number of 
points per decade. Refer to the HP8903B special function codes, 17.0 to 17.9 as listed in 
Table 8-6. The frequency point formula for reverse sweep is as follows:

Select Sweep in the HP8903B menu page to configure the HP8903B sweep settings.

Figure 8-4 HP8903B > Sweep menu page

Frequency Start frequency 10

n
k
-- 
 

×=

Frequency Start frequency 10

n–
k

---- 
 

×=

Table 8-5 HP8903B > Sweep menu description

Menu Description

Freq. Start Press the Freq. Start softkey to set the HP8903B sweep frequency start value.

Freq. Stop Press the Freq. Stop softkey to set the HP8903B sweep frequency stop value.

Sweep Status Press the Sweep Status softkey to start or abort sweeping in the HP8903B mode.
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Special function code list

Select Code List in the HP8903B menu page to display the list of supported HP8903B 
special function codes. The special function codes will be displayed in the lower main 
display as shown in Figure 8-5. Press the up or down arrow keys to scroll up or down the 
selected special function code list respectively. The HP8903B special function code are as 
listed in Table 8-6.

Figure 8-5 HP8903B > Code List menu page (Input Level Range (except DC Level))

Table 8-6 HP8903B special function code list description 

Special function Code Description

Input Level Range (except DC Level)

1.0
1.3
1.4 ~ 1.5
1.6 ~ 1.8
1.9 ~ 1.10
1.11 ~ 1.13
1.14 ~ 1.15
1.16 ~ 1.19

Auto range
140 V range
100 V range
32 V range
10 V range
3.2 V range
1 V range
0.32 V range

Input Level Range (DC Level only)

2.0
2.2
2.3
2,4

Auto Range
100 V range
32 V range
10 V range

Post Notch Detector Response (except in SINAD) 5.0 ~ 5.1 RMS Detector

Display Source Settings 10.0 Activate the generator menu.

Re-enter Ratio Mode

11.0 

11.1 

Restore last RATIO reference and enter RATIO 
mode if allowed
Display RATIO reference (measurement menu will 
be activated)
416 Keysight U8903B User’s Guide



HP8903B 8
Signal-to-Noise Measurement Delay

12.0
12.1
12.2
12.3
12.4
12.5
12.6
12.7
12.8
12.9

No delay
200 ms delay
400 ms delay
600 ms delay
800 ms delay
1.0 s delay
1.2 s delay
1.4 s delay
1.6 s delay
1.8 s delay

SINAD and Signal-to-Noise Display Resolution
16.0 

16.1

0.01 dB above 25 dB 
0.5 dB below 25 dB
0.01 dB all ranges

Sweep Resolution (maximum 255 points/sweep)

17.0
17.1
17.2
17.3
17.4
17.5
17.6
17.7
17.8
17.9

10 points/decade
1 point/decade
2 points/decade
5 points/decade
10 points/decade
20 points/decade
50 points/decade
100 points/decade
200 points/decade
500 points/decade

Display Level in Watts
19.0
19.NNN

Display level as watts into 8 Ω
Display level as watts into NNN Ω

Read Display to SCPI
20.0
20.1

Read right display
Read left display (Frequency)

GPIB Address (SCPI Only) 21.1 Displays GPIB address in decimal

GPIB Service Request Condition (SCPI Only) 22.N

Enable a Condition to cause a service request. N 
is the sum of any combination of the weighted 
conditions below: 
1 - Data Ready 
2 - GPIB error 
4 - Instrument Error 
The instrument powers up in the 22.2 state.

Source Output Impedance (Instrument powers up at 600 Ω)
47.0
47.1

600 Ω
50 Ω

Table 8-6 HP8903B special function code list description (continued)

Special function Code Description
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SPCL

Press the SPCL softkey to set the HP8903B special function code except those indicated as 
SCPI only, and execute the special function. The HP8903B special function code are as 
listed in Table 8-6.

Floating input

Table 8-7 Floating input settings

Floating input Analog analyzer settings

Off (default) Analyzer connector is unbalanced and the analyzer impedance is 100 kΩ (default).

On Analyzer connector is balanced and the analyzer impedance is 200 kΩ .

Table 8-8 Floating output settings

Floating output Analog analyzer settings

Off (default) Generator connector is unbalanced with unbalanced impedance of 600 Ω (default) or 50 Ω.

On Generator connector is balanced with balanced impedance of 600 Ω or 40 Ω.

Table 8-9 Floating output settings and special functions to change the generator impedance

Floating output Special function Generator impedance

Off 47.0SP Change the generator impedance to 600 Ω.

Off 47.1SP Change the generator impedance to 50 Ω.

On 47.0SP Change the generator impedance to 600 Ω.

On 47.1SP Change the generator impedance to 40 Ω.
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For the characteristics and specifications of the U8903B Performance Audio Analyzer, refer 
to the data sheet at http://literature.cdn.keysight.com/litweb/pdf/5991-4551EN.pdf.
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Appendixes A
Appendix 1: FUNCTION panel

Table A-1 FUNCTION panel description

Key Description

Interface Switch between the analog, digital, or Bluetooth interface.

Generator|Analyzer

Switch between the generator or analyzer mode.
Refer to “Appendix 4: Analog Generator Menu Tree” on page 430 and “Appendix 7: 
Analog Analyzer Menu Tree” on page 452 for the analog generator and analog analyzer menu 
trees.

Graph
Access the graph analysis mode.
Refer to “Appendix 10: Graph Analysis Menu Tree” on page 488 for the graph analysis menu 
tree.

Sweep
Access the sweep function mode.
Refer to “Appendix 11: Sweep Function Menu Tree” on page 492 for the sweep function 
menu tree.

Full Screen
Maximize the graph view to the full display size.
This function is only applicable in the graph analysis mode.

Display
Switch among the 2-panel view, 4-panel view, or 10-panel view in the analyzer and generator mode.
Switch between single panel view and 2-panel view in the graph analysis mode.

Shortcut 1 Customizable shortcut key. Refer to “Appendix 3: System Panel Menu Tree” on page 426 for 
more information.

Shortcut 2 Customizable shortcut key. Refer to “Appendix 3: System Panel Menu Tree” on page 426 for 
more information.
Keysight U8903B User’s Guide 423



A Appendixes
Appendix 2: Graph Panel Menu Tree

Table A-2 GRAPH panel menu tree description 

Key Level 1 Level 2 Description

Peak Search

Max Peak
Search and move the active marker to the highest peak which is higher than 
the peak threshold value.

Next Peak
Search and move the active marker to the next peak which is higher than 
the peak threshold value.

Prev Peak
Search and move the active marker to the previous peak which is higher 
than the peak threshold value.

Next Min
Search and move the active marker to the previous peak which is lower 
than the minimum threshold value.

Prev Min
Search and move the active marker to the next peak which is lower than the 
minimum threshold value.

Threshold

Line Visible
Enable or disable the threshold line in the graph.
– On
– Off

Peak Thres Set the peak threshold value.

Min Thres Set the minimum threshold value.

Marker

Active Marker M1 to M8 Select the active marker number.

State
– On
– Off

Enable or disable the active marker.

Trace 1 to 8 Select the trace number for the active marker.

Ref Mkr
– OFF
– M1 to M8

Select the reference marker number.

Movement

– Single
– Pair
– Bin
– Peak
– Harmonic

Select the marker movement type.

Function
– None
– Slope
– PSD

Select the marker function type.

Marker ->

-> Start Set the left value of the graph to the current marker location.

-> Stop Set the right value of the graph to the current marker location.

-> Center Set the center value of the graph to the current marker location.

-> Delta
Set the left and right values of the graph to the current marker and the
reference marker location.

Move to 3 dB Place the marker on the nearest –3 dB value data point.

Move to 6 dB Place the marker on the nearest –6 dB value data point.
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Marker

Harmonics

Trace Set the trace number to place the marker.

Enabled
Show or hide the markers.
– On
– Off

Rdg at Mkr
– On
– Off

Enable or disable the readings at the marker.

Print  
(Shift + Marker) Print the current display to a file.

Scale

AutoScale Perform autoscaling on the X-axis and Y-axis.

AutoScale X
Perform autoscaling on the X-axis by searching for the most optimum scale 
(left and right values) for the X-axis based on the data being displayed in 
the graph.

AutoScale Y
Perform autoscaling on the Y-axis by searching for the most optimum scale 
(top and bottom values) for the Y-axis based on the data being displayed in 
the graph.

Zoom Magnify a section of the graph.

Table A-2 GRAPH panel menu tree description (continued)

Key Level 1 Level 2 Description
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Appendix 3: System Panel Menu Tree

Table A-3 SYSTEM panel menu tree description 

Key Level 1 Level 2 Level 3 Description

Preset

(Current mode) Reset the current mode to its default settings.

Save User State Save the current user state.

Mode
Reset all modes to the default settings without 
deleting the user-defined files.

To Factory Settings

Reset the U8903B to the factory default settings, 
delete all the files saved in the internal flash 
memory (for example, state file, arbitrary 
waveform, test sequence project files, and so on), 
and reset the GUI state to the Standard View 
mode. If the HP8903B mode is turned on, the GUI 
state will remain at the HP8903B mode.

User State
Reset the U8903B to the previously saved  
user state.

Utility
(if the mode is in the 
Analyzer or Generator 
mode)

Save Channel (x)
(x) = current channel 
number

Save the current channel state to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Save (x)
(x) = current mode

Save the current mode state to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Recall
Recall a saved U8903B state from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Copy To
Copy the current channel state to other 
channel(s).

Copy From
Select a channel number to copy the state to the 
current channel.

File Explorer  Rename, delete, copy, or move files.

Utility
(if the mode is in 
Graph Analysis mode)

Save Graph
Save the current graph state to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Save Channels 
Settings

Channel (x)
(x) = current channel

Save the current channel graph state to  
a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

All Channels Settings
Save all channels graph state to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.
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(if the mode is in 
Graph Analysis mode)

Save Traces

Trace (x)
(x) = current trace 
number

Save the active trace to a CSV file format.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

All Traces
Save all traces state to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Axis Settings
Save the axis settings state to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Traces + Axis
Save all traces and axis settings states.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Save Trace (x) Data
(x) = current channel

Save the active trace data to a CSV file format.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Recall
Load a trace from a CSV file into the active trace.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Copy To
Copy the current channel graph state to other 
channel(s).

Copy Graph From
Select a channel number to copy the graph state 
to the current channel.

File Explorer  Rename, delete, copy, or move files.

Help 
(Shift + Utility)

Display the help mode.
Press Shift + Utility to close the help mode.

System

Error Info Load File

Select the log file to be loaded in the error log 
viewing panel.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

I/O
LAN Settings

Reset Reset the LAN settings.

Hostname Set the LAN hostname.

Config Mode
Select the LAN configuration mode.
– Auto
– Manual

IP Address Set the LAN IP address.

Subnet mask Set the LAN subnet mask address.

Gateway Set the LAN gateway address.

DNS 1 Set the LAN DNS 1 address.

DNS 2 Set the LAN DNS 2 address.

GPIB 0 to 30 Set the desired GPIB address.

Table A-3 SYSTEM panel menu tree description (continued)

Key Level 1 Level 2 Level 3 Description
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I/O FTP
– Enabled
– Disabled

Enable or disable the FTP control.

System

Firmware
Update

Load the update files.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

EULA Display the Keysight EULA page.

Service

Self-Test

Customize Test
Select all or deselect the desired tests.
LAN Test
Card Self Test

Run Test Run the selected tests.

Clear Result Clear the previous self-test results.

Diagnostic
Front Panel Perform the front panel diagnostics.

Display Perform the display diagnostics.

Secure Erase

Securely erase all the files saved in the internal 
flash memory (for example, state file, arbitrary 
waveform, test sequence project files, and so on), 
It does not affect the U8903B settings and license 
information.

Options
Add Option

Add a new U8903B option.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Remove Option Remove the selected U8903B option.

Settings

Date Edit the date in dd/mm/yyyy format.

Time Edit the current time in 24-hour format.

Brightness 0 to 6 Adjust the LCD display brightness value.

Key Sound
– On
– Off

Enable or disable the front panel key sound.

Power Up State
– Last
– Default

Select the power up state.

Shortcut 1

– Error List
– Auto-Scale
– File Explorer
– Audio Monitor
– Audio Volume

Select a specific function to map the shortcut 1 
key.

Shortcut 2

– Error List
– Auto-Scale
– File Explorer
– Audio Monitor
– Audio Volume

Select a specific function to map the shortcut 2 
key.

Table A-3 SYSTEM panel menu tree description (continued)

Key Level 1 Level 2 Level 3 Description
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System

HP8903B Config

Active Channel
– 1
– 2

Select the HP8903B active channel.

Left Filter

– None
– A-Weighing
– CCIR 1k wtd
– CCIR 2k wtd
– C-Message
– CCITT
– 400 Hz

Select the left filter type.

Right Filter

– None
– A-Weighing
– CCIR 1k wtd
– CCIR 2k wtd
– C-Message
– CCITT
– 400 Hz

Select the right filter value.

Default LPF
– None
– 30 kHz
– 80 kHz

Select the default filter for the HP8903B mode.

Fan & Temperature
Display the temperatures of the available cards 
and the speed of the three 80 mm fans in the 
U8903B.

Aux Output

Audio Monitor
– On
– Off

Enable or disable the aux audio monitor.

Audio Output
– Speaker
– Phone

Select the aux audio output type.

Audio Mode
– Stereo
– Mono

This is only available when audio output is Phone.
Select the aux audio mode type. 

Volume 0 to 100 Select the aux audio volume.

DC Output Set the aux DC output value.

Board Info Display the U8903B available cards information.

Legacy Sweep
– On
– Off

Enable or disable the legacy sweep.

Macro
(Shift + System)

Reserved for future expansion.

Local
Switch from remote control mode to local mode. 
The front panel keys are locked in the remote 
mode.

Lock/Unlock
Lock or unlock the front panel keys in the local 
mode.
A dialog box will pop-up for confirmation.

Table A-3 SYSTEM panel menu tree description (continued)

Key Level 1 Level 2 Level 3 Description
Keysight U8903B User’s Guide 429



A Appendixes
Appendix 4: Analog Generator Menu Tree

Table A-4 Analog generator menu tree description 

Level 1 Level 2 Level 3 Description

Waveform

– Sine
– V. Phase
– Dual
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1
– IEC 60118
– IEC 60268
– Gaus. Noise
– Rect. Noise
– Pink Noise
– Square
– DC
– Sine Burst
– Arbitrary
– Multitone
– DTMF

Select the waveform type.

Waveform Config 
(Sine)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Waveform Config  
(V. Phase)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Phase -> 1
This is only available when the analog generator is in channel 2.
Set the phase of the channel 2 sine waveform with reference to channel 1.

Waveform Config 
(Dual)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Frequency 2
Set the second sine wave signal frequency value.
This setting is only applicable for the dual waveform.

DC Offset Set the signal DC offset value.

Ratio
Set the ratio of the amplitude of the second sine wave over the first sine 
wave.

Summation
– RSS
– Linear

Summation refers to the method to sum up two levels.
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Waveform Config 
(SMPTE 1:1/4:1/10:1)

Amplitude Set the signal amplitude value.

Lower Freq Set the lower frequency value.

Upper Freq Set the higher frequency value.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

Summation refers to the method to sum up two levels.

Waveform Config  
(IEC 60118)

Amplitude Set the signal amplitude value.

Upper Freq Set the higher frequency value.

Diff Freq Set the difference frequency of the waveform.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

Summation refers to the method to sum up two levels.

Waveform Config  
(IEC 60268)

Amplitude Set the signal amplitude value.

Center Freq Set the center frequency of the waveform.

Diff Freq Set the difference frequency of the waveform.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

Summation refers to the method to sum up two levels.

Waveform Config 
(Gaus. Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config 
(Rect. Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config  
(Pink Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config 
(Square)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Waveform Config  
(DC)

Voltage Set the signal voltage value.

Waveform Config  
(Sine Burst)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Burst On Set the number of cycles at which the amplitude is at the highest level.

Period
Set the number of cycles from the beginning of one burst to the beginning 
of the next burst.

Low Level Set the amplitude ratio of Burst On over Burst Off.

Table A-4 Analog generator menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Waveform Config 
(Abitrary)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Load File
Load a waveform from a file.
Refer to “Appendix 13: Recall Menu Tree” on page 496 for the recall 
menu tree.

Info Display the loaded waveform information.

Waveform Config 
(Multitone)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Start Freq
Set the lowest frequency in the multitone waveform which is usually the 
frequency for the first tone.

Stop Freq
Set the highest frequency in the multitone waveform which is usually the 
frequency for the last tone.

Freq Spacing
– Linear
– Log
– Custom

Select frequency spacing between the tones.
Custom is selected when the custom multitone waveform is set.

Tones Set the number of signal frequency components.

Length

– 1024
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536

Select the waveform length that determines the number of samples used to 
create one iteration of the multitone waveform.

Custom

Apply
Apply the current setting on the selected tone for the custom multitone 
waveform.

Optimize Optimize the crest factor for the custom multitone waveform.

Frequency Set the frequency value for the custom multitone waveform.

Amplitude Set the amplitude value for the custom multitone waveform.

Phase Set the phase value for the custom multitone waveform.

Add Above Add the tone above the selected tone for the custom multitone waveform.

Add Below Add the tone below the selected tone for the custom multitone waveform.

Remove Remove the selected tone for the custom multitone waveform.

Clear Clear all the tones in the custom multitone waveform list.

Table A-4 Analog generator menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Waveform Config 
(DTMF)

Dial

Mode
Select the mode of operation for the dial mode.
Single
Sequence

A 
B 
C 
D

Single dial mode
– Press and hold the A, B, C, or D softkey to dial the A, B, C, or D tone 

respectively.
Sequence dial mode
– Press the A, B, C, or D softkey to add the A tone to the DTMF sequence.

Pause Add a pause to the DTMF sequence in the form of a comma.

Amplitude Set the amplitude level of the DTMF signal.

Ratio
Set the level difference between the high-frequency tone and 
low-frequency tone.

Waveform Config 
(DTMF)

Tone Duration Set the DTMF signal duration.

Tone Delay Set the delay between two DTMF tones.

Pause Time Set the interval time for the DTMF sequence.

Repeat Enable or disable repeating the DTMF sequence.

Summation
– RSS
– Linear

Summation refers to the method to sum up two levels.

Output Config

Connector

– Bal
– UnBal
– Com
– IEC60268

Select the output connector type.

Impedance

For Bal, Com, and 
IEC60268
– 600 Ω
– 100 Ω
– 40 Ω
For UnBal
– 600 Ω
– 50 Ω
– 20 Ω

Select the output impedance value.

IEC60268 10 Ω
– Pin 2
– Pin 3

Select the additional 10 Ω output series resistance for pin 2 or 3 of the XLR 
connector in the common IECIEC 6026860268 configuration.
This setting is only available when the output connector type is set to IEC 
60268.

Ground
– Float
– Ground

Select the grounding type.

Max Voltage Set the maximum voltage value.

References Ref Impedance
Set the reference impedance for the unit conversion of dBm 
measurements.

Table A-4 Analog generator menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Table A-5 Digital generator menu tree description 

Level 1 Level 2 Level 3 Level 4 Description

Waveform

– Sine
– V. Phase
– Dual
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1
– IEC 60118
– IEC 60268
– Gaus. Noise
– Rect. Noise
– Tri. Noise
– Pink Noise
– Square
– Sine Burst
– Stereo
– Monotonicity
– Constant
– Walking Zero
– Walking One
– Multitone
– Arbitrary

Select the waveform type.

Waveform Config 
(Sine)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Waveform Config  
(V. Phase)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Phase -> 1

This is only available when the digital generator is 
in channel 2.
Set the phase of the channel 2 sine waveform with 
reference to channel 1.
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Waveform Config 
(Dual)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Frequency 2
Set the second sine wave signal frequency value.
This setting is only applicable for the dual 
waveform.

DC Offset Set the signal DC offset value.

Ratio
Set the ratio of the amplitude of the second sine 
wave over the first sine wave.

Summation
– RSS
– Linear

.
Summation refers to the method to sum up two 
levels.

Waveform Config 
(SMPTE 1:1/4:1/10:1)

Amplitude Set the signal amplitude value.

Lower Freq Set the lower frequency value.

Upper Freq Set the higher frequency value.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

Summation refers to the method to sum up two 
levels.

Waveform Config  
(IEC 60118)

Amplitude Set the signal amplitude value.

Upper Freq Set the higher frequency value.

Diff Freq Set the difference frequency of the waveform.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

Summation refers to the method to sum up two 
levels.

Waveform Config  
(IEC 60268)

Amplitude Set the signal amplitude value.

Center Freq Set the center frequency of the waveform.

Diff Freq Set the difference frequency of the waveform.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

Summation refers to the method to sum up two 
levels.

Waveform Config 
(Gaus. Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config 
(Rect. Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config  
(Triangular Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config  
(Pink Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Waveform Config 
(Square)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Waveform Config  
(Sine Burst)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Burst On
Set the number of cycles at which the signal 
amplitude will be at the higher level.

Period
Set the number of cycles from the beginning of 
one burst to the beginning of the next burst.

Low Level Set the amplitude ratio of Burst On over Burst Off.

Waveform Config  
(Stereo)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Waveform Config  
(Monotonicity)

Samples/Step
Set the duration for each half cycle of the square 
wave.

Waveform Config  
(Constant)

Voltage Set the signal voltage value.

Waveform Config  
(Walking Zero)

Samples/Step Set the speed the single bit 0 is incremented.

Waveform Config  
(Walking One)

Samples/Step Set the speed the single bit 1 is incremented.

Waveform Config 
(Multitone)

Amplitude Set the signal amplitude value.

Start Freq
Set the lowest frequency in the multitone 
waveform which is usually the frequency for the 
first tone.

Stop Freq
Set the highest frequency in the multitone 
waveform which is usually the frequency for the 
last tone.

Freq Spacing
– Linear
– Log
– Custom

Select frequency spacing between the tones.
Custom is selected when the custom multitone 
waveform is set.

Tones Set the number of signal frequency components.

Length

– 1024
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536

Select the waveform length that determines the 
number of samples used to create one iteration of 
the multitone waveform.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Waveform Config 
(Multitone)

Custom

Apply
Apply the current setting on the selected tone for 
the custom multitone waveform.

Optimize
Optimize the crest factor for the custom multitone 
waveform.

Frequency
Set the frequency value for the custom multitone 
waveform.

Amplitude
Set the amplitude value for the custom multitone 
waveform.

Phase
Set the phase value for the custom multitone 
waveform.

Add Above
Add the tone above the selected tone for the 
custom multitone waveform.

Add Below
Add the tone below the selected tone for the 
custom multitone waveform.

Remove
Remove the selected tone for the custom 
multitone waveform.

Clear
Clear all the tones in the custom multitone 
waveform list.

Waveform Config 
(Abitrary)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Load File
Load a waveform from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Info Display the loaded waveform information.

Output Config

Connector
– Bal
– UnBal

Select the output connector type.

AES Output
– On
– Off

Enable or disable the AES output.

Optical Output
– On
– Off

Enable or disable the optical output.

Sample Rate Set the sample rate value.

Audio Format
– Linear PCM
– A-Law
– μ-Law

Select the encoding audio format.

Dither

– Off
– Rectangular
– Triangular
– Shaped

Select the dither type.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Voltage

– 1.2 Vpp
– 1.5 Vpp
– 1.8 Vpp
– 2.5 Vpp
– 3 Vpp
– 3.3 Vpp

Select the output voltage or set your desired 
output voltage.

Channels

– 2
– 4
– 6
– 8
– 10
– 12
– 14
– 16

Select the number of channels.

Format

– Left
– Right
– I2S
– DSP

Select the DSI output format.

Resolution 8 to 24 Set the audio resolution.

BClk Edge
– Rising
– Falling

Select the clock edge type.

Fsync Polarity
– Rising
– Falling

Select the sync polarity.

DSI Config

Fsync Width
– One Bit Clock
– One Subframe
– 50% Duty Cycle

Select the sync width.

Data Shift Cnt Set the data shift count value.

Data Shift Dir
– Left
– Right

Select the data shift direction.

Master Output
– On
– Off

Enable or disable the master clock output.

Word Length
Set the master clock word length value. The word 
length cannot be less than the audio resolution.
– 8 to 32

Multiplier Set the multiplier value.

Sample Rate Set the sample rate value.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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AES3/SPDIF

Level Set the output voltage level.

Resolution 8 to 24 Set the audio resolution value.

Validity Bit
– Set
– Clear

Select the vailidity bit.

Mode
– Consumer
– Professional

Select the AES3/SPDIF format.

Status Bits
– Channel
– User

Select the status bits type.

Edit Bits 
(Consumer)

Select Byte Select the byte and edit the byte.

Audio Mode
– Non-Linear PCM
– Linear PCM

Select the audio mode.

Copyright
– Copyright
– Non-copyright

Select the copyright type.

Emphasis

– No pre-emphasis
– 50/15 ìs
– Reserved 1
– Reserved 2

Select the emphasis type.

Channel Mode 0 to 3 Set the channel mode value.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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AES3/SPDIF
Edit Bits 
(Consumer)

Category

– General
– Laser Optical
– D/D Converter
– Magnetic
– Digital Broadcast 1
– Digital Broadcast 2
– Musical Instrument
– ADC Non Copyright
– Solid State Memory
– ADC Copyright
– Experimental
– Reserved 1
– Reserved 2

Select the category code type.

Source Num 0 to 15 Set the source number.

Channel Num 0 to 15 Set the channel number.

Sample Freq

– Not indicated
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz
– 768 kHz

Select the sample frequency value.

Clk Accuracy

– Level 1
– Level 2
– Level 3
– Reserved

Select the clock accuracy type.

Max Word Len
– 24 bits
– 20 bits

Select the maximum word length.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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AES3/SPDIF

Edit Bits 
(Consumer)

Word Length

24 bits maximum word 
length
– Not indicated
– 20 bits
– 21 bits
– 22 bits
– 23 bits
– 24 bits
20 bits maximum word 
length
– Not indicated
– 16 bits
– 17 bits
– 18 bits
– 19 bits
– 20 bits

Select the word length.

Orig S.Freq

– Not indicated
– 8 kHz
– 11.025 kHz
– 12 kHz
– 16 kHz
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz
– Reserved 1
– Reserved 2

Select the original sample frequency value.

CGMA-A

– Copying Permitted
– Condition Not Used
– One Generation 

Copy
– Copying Denied

Select the CGMA-A type.

Edit Bits 
(Professional)

Select Byte Select the byte and edit the byte.

Audio Mode
– Non-Linear PCM
– Linear PCM

Select the audio mode.

Emphasis

– Not indicated
– No pre-emphasis
– 50/15 μs
– CCITT J.17

Select the emphasis type.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Edit Bits 
(Professional)

Freq Mode
– Locked
– Unlocked

Select the frequency mode.

Sample Freq

– Not indicated
– 22.05 kHz
– 24 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz

Select the sample frequency value.

Freq Scaling
– On
– Off

Enable or disable frequency scaling.

Chan Mode

– Not indicated
– 2-channel
– Single channel
– Primary-Secondary
– Stereo
– Reserved 1
– Reserved 2
– Mono Double Rate
– Left Double Rate
– Right Double Rate
– Multichannel

Select the channel mode.

User Bits

– Not indicated
– 192-bit block
– Reserved for AES18
– User defined
– Reserved for 

Metadata
– As in IEC60958-3

Select the user bits type.

Aux Bits

– 20-bit not defined
– 24-bit main audio
– 20-bit single
– Reserved

Select the auxiliary bits.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Edit Bits 
(Professional)

Word Length

24 bits maximum word 
length
– Not indicated
– 20 bits
– 21 bits
– 22 bits
– 23 bits
– 24 bits
20 bits maximum word 
length
– Not indicated
– 16 bits
– 17 bits
– 18 bits
– 19 bits
– 20 bits

Select the word length.

Alignment

– Not Indicated
– –18.06 dBFS
– –20 dBFS
– Reserved

Select the alignment level.

Multi-Channel
– Defined
– Undefined

Select the multi-channel status.

Multi-Ch Mode

– Mode 0
– Mode 1
– Mode 2
– Mode 3
– User Defined

This is only available when the multi-channel 
status is set to Defined.
Select the multi-channel mode. 

Channel Num

– 1 to 16 (Defined 
multi-channel 
status)

– 1 to 128 (Undefined 
multi-channel 
status)

Set the channel number.

Ref Signal

– Not a ref. signal
– Grade 1
– Grade 2
– Reserved

Select the reference signal type.

Channel Origin
Set the channel origin value (4 alphanumeric 
digit).

Channel Dest
Set the channel destination value (4 alphanumeric 
digit).

Local Addr 0 to 232–1 Set the local address value.

Time of Day 0 to 232–1 Set the time of day.

Table A-5 Digital generator menu tree description (continued)
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AES3/SPDIF

Edit Bits 
(Professional)

Rel Flags

– 0-5
– 6-13
– 14-17
– 18-21

Select the reliability flags.

Clear Bits Clear all the bits.

Save File
Save the bits to a file. Refer to “Appendix 12: 
Save Menu Tree” on page 495 for the save 
menu tree.

Load File
Load the bits from a file. Refer to “Appendix 13: 
Recall Menu Tree” on page 496 for the recall 
menu tree.

References Volts/FS
Set the volts/FS reference for the analog output 
voltage (in Volts) of the DAC used when converted 
to digital full scale (1 FS).

Clock Config

Ref Clock Source
– Internal
– AES RClk
– External

Select the reference clock source.

Sync Clock

Output
– On
– Off

Enable or disable the synchronous clock output.

Divider
– 1
– 128

Select the synchronous clock divider value.

Source
– Internal
– AES RClk
– External

Select the synchronous clock source.

Ext Clock

Type

– MClk Sync In
– Frame Clk In
– DSI Gen FS
– DSI Gen Clk

Select the external reference clock type.

Word Length
Set the external reference clock word length 
value.

Multiplier

Set the external reference clock multiplier value. 
The selection available in the external reference 
clock multiplier depends on the external 
reference clock word length

Frequency Set the external reference clock frequency value.

Table A-5 Digital generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
444 Keysight U8903B User’s Guide



Appendixes A
Appendix 6: Bluetooth Generator Menu Tree

Table A-6 Bluetooth generator menu tree description 

Level 1 Level 2 Level 3 Level 4 Description

Waveform

– Sine
– V. Phase
– Dual
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1
– IEC 60118
– IEC 60268
– Gaus. Noise
– Rect. Noise
– Pink Noise
– Square
– Sine Burst
– Constant
– Arbitrary
– Multitone

Select the waveform type.

Waveform Config 
(Sine)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Waveform Config  
(V. Phase)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Phase -> 1

This is only available when the analog generator is in 
channel 2.
Set the phase of the channel 2 sine waveform with 
reference to channel 1.

Waveform Config 
(Dual)

Amplitude Set the signal amplitude value.

Frequency 1 Set the signal frequency value.

Frequency 2
Set the second sine wave signal frequency value.
This setting is only applicable for the dual waveform.

DC Offset Set the signal DC offset value.

Ratio
Set the ratio of the amplitude of the second sine wave 
over the first sine wave.

Summation
– RSS
– Linear

– Summation refers to the method to sum up two levels.
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Waveform Config 
(SMPTE 1:1/4:1/
10:1)

Amplitude Set the signal amplitude value.

Lower Freq Set the lower frequency value.

Upper Freq Set the higher frequency value.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

– Summation refers to the method to sum up two levels.

Waveform Config  
(IEC 60118)

Amplitude Set the signal amplitude value.

Upper Freq Set the higher frequency value.

Diff Freq Set the difference frequency of the waveform.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

– Summation refers to the method to sum up two levels.

Waveform Config  
(IEC 60268)

Amplitude Set the signal amplitude value.

Center Freq Set the center frequency of the waveform.

Diff Freq Set the difference frequency of the waveform.

DC Offset Set the signal DC offset value.

Summation
– RSS
– Linear

– Summation refers to the method to sum up two levels.

Waveform Config 
(Gaus. Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config 
(Rect. Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config  
(Pink Noise)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Waveform Config 
(Square)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

Waveform Config  
(Sine Burst)

Amplitude Set the signal amplitude value.

Frequency Set the signal frequency value.

DC Offset Set the signal DC offset value.

Burst On
Set the number of cycles at which the amplitude is at 
the highest level.

Period
Set the number of cycles from the beginning of one 
burst to the beginning of the next burst.

Low Level Set the amplitude ratio of Burst On over Burst Off.

Table A-6 Bluetooth generator menu tree description (continued)
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Waveform Config  
(Constant)

Voltage Set the signal voltage value.

Waveform Config 
(Abitrary)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Load File
Load a waveform from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Info Display the loaded waveform information.

Waveform Config 
(Multitone)

Amplitude Set the signal amplitude value.

DC Offset Set the signal DC offset value.

Start Freq
Set the lowest frequency in the multitone waveform 
which is usually the frequency for the first tone.

Stop Freq
Set the highest frequency in the multitone waveform 
which is usually the frequency for the last tone.

Freq Spacing
– Linear
– Log
– Custom

Select frequency spacing between the tones.
Custom is selected when the custom multitone 
waveform is set.

Tones Count Set the number of signal frequency components.

Length

– 1024
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536

Select the waveform length that determines the number 
of samples used to create one iteration of the multitone 
waveform.

Table A-6 Bluetooth generator menu tree description (continued)
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Waveform Config 
(Multitone)

Custom

Apply
Apply the current setting on the selected tone for the 
custom multitone waveform.

Optimize
Optimize the crest factor for the custom multitone 
waveform.

Frequency
Set the frequency value for the custom multitone 
waveform.

Amplitude
Set the amplitude value for the custom multitone 
waveform.

Phase Set the phase value for the custom multitone waveform.

Add Above
Add the tone above the selected tone for the custom 
multitone waveform.

Add Below
Add the tone below the selected tone for the custom 
multitone waveform.

Remove
Remove the selected tone for the custom multitone 
waveform.

Clear
Clear all the tones in the custom multitone waveform 
list.

Link Config Device Scan

Device Search
Search for the discoverable Bluetooth devices within 
range.

Max Scan 1 to 16
Set the maximum number of Bluetooth devices to be 
identified.

Filter Class
– All
– Custom

Select the filter class type.

Custom Set the Bluetooth device class.

Refresh Device
Refresh the friendly name of the selected Bluetooth 
device.

Table A-6 Bluetooth generator menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
448 Keysight U8903B User’s Guide



Appendixes A
Link Config Device Action

Pair/Unpair Device Pair/Unpair with the selected Bluetooth device.

Unpair All Device Unpair all the paired Bluetooth devices.

Profile Connection 

– Connect/
Disconnect All

– Connect/
Disconnect A2DP

– Connect/
Disconnect HFP

– Connect/
Disconnect AVRCP

Connect or disconnect the Bluetooth profiles for the 
connection.

A2DP Operation

– Open Media 
Connection

– Close Media 
Connection

– Start Streaming
– Pause Streaming

Select the advanced audio distribution profile operation 
settings.

HFP Operation 
(Handsfree/
Headset)

– Dial
– Answer Call
– End Call
– Reject Call
– Toggle Audio
– Button Press
– Send AT Command

Select the HFP (Handsfree/Headset) profile operation 
settings.

HFP Operation 
(Audio Gateway)

– Connect
– Disconnect
– Call
– Hang Up
– Send AT Command

Select the HFP (Audio Gateway) profile operation 
settings.

AVRCP Operation

– Volume Up
– Volume Down
– Mute
– Play
– Stop
– Pause
– Rewind
– Fast Forward
– Forward
– Backward

Select the audio/video remote control profile operation 
settings.

Table A-6 Bluetooth generator menu tree description (continued)
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Link Config

Common Settings

Profile

– A2DP SRC, HFP AG, 
AVRCP TRGT

– A2DP SNK, HFP HF, 
AVRCP CTRL

Select the U8903B’s Bluetooth card profile.

Friendly Name Set the friendly name of the U8903B’s Bluetooth card.

Device PIN Set the passkey of the U8903B’s Bluetooth card.

Device Class
– Auto
– Custom

Select the device class based on the configured profile.

Custom  Set the device class. 

SSP Mode
– Just Works
– Man-In-The-Middle

Select the U8903B’s Bluetooth card simple secure 
pairing mode.

Auto Pair Enable or disable the auto-pairing function.

IO Capability Select the IO capability of the U8903B’s Bluetooth card.

Discoverable
Enable or disable the discoverability function of the 
U8903B’s Bluetooth card.

Connectable
Enable or disable the connectability function of the 
U8903B’s Bluetooth card.

Loopback
Enable or disable the integrated interchip sound audio 
loopback function.

Link Status
Enable or disable the link status of the U8903B’s 
Bluetooth card.

RF Port
– RF1
– RF2

Select the U8903B’s Bluetooth card RF port connector.

A2DP Settings

Codec
– SBC
– apt-X

Select the codec for the A2DP profile.

Sampling Rate

– 16 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz

Select the audio sampling rate for the A2DP profile.

Table A-6 Bluetooth generator menu tree description (continued)
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Link Config

HFP Settings

Wideband
Enable or disable the wideband speech mode in the HFP 
profile connection.

Latency 4 to 65534 Set the HFP's codec channel latency in miliseconds.

Retransmit

– No Transmission
– Power Saving
– Link Quality
– No Preference

Select the HFP's codec retransmission effort.

Packet Types

– HV1
– HV2
– HV3
– EV3
– EV4
– EV5
– 2EV3
– 3EV3
– 2EV5
– 3EV5

Select the packet type used in the HFP’s codec.

AVRCP Log View
Clear Log Clear the AVRCP operation log history.

Refresh Log Refresh the AVRCP operation log history.

References Ref Impedance
Set the reference impedance for the unit conversion of 
dBm measurements.

Table A-6 Bluetooth generator menu tree description (continued)
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Table A-7 Analog analyzer menu tree description 

Level 1 Level 2 Level 3 Description

Functions

Multi-Chn
– Off
– Phase
– X-Talk

Select the multichannel mode.

Function No.

– 1
– 2
– 3
– 4

Select the active function number to configure the settings.

Meas. Func.

– None
– Frequency
– AC Voltage
– DC Voltage
– THD+N Ratio
– THD+N Level
– SINAD
– THD Ratio
– THD Level
– SMPTE IMD
– DFD60268 2nd
– DFD 60268 3rd
– DFD 60118 2nd
– DFD 60118 3rd
– SNR
– SNR (Fast)
– J-Test

Select the measurement function.
This setting is only available when the multichannel mode is set to Off.

Functions 
(Frequency)

Unit
– Hz
– ΔHz

Select the unit type.

Format
– Off
– Delta

Select the reading format of the returned measurement reading.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
frequency.

Ref. Freq Set the reference frequency value.
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Functions 
(AC Voltage)

Unit

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

Select the unit type.

Functions 
(AC Voltage)

Format

– Off
– Logarithmic
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured level as the reference level, and set the measurement 
reading format to Logarithmic.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Ref. Imp
Set the reference impedance value.
This setting is only available when the unit is set to W.

Cal SPL
Set the calibration level value.
This setting is only available when the unit is set to dBSPL.

Detector
– RMS
– Pk-Pk
– QPK

Select the AC level detection type.

Functions 
(DC Voltage)

Unit
– V
– ΔV
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Table A-7 Analog analyzer menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Functions 
(THD+N Ratio)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Analog Notch
– Enable
– Disable

Enable or disable the analog notch filter. 
This filter is used to emulate the analog notch filter used in the HP8903B.

Table A-7 Analog analyzer menu tree description (continued)
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Functions 
(THD+N Level)

Unit

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

Select the unit type.

Format

– Off
– Logarithmic
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured level as the reference level, and set the measurement 
reading format to Logarithmic.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Ref. Imp
Set the reference impedance value.
This setting is only available when the unit is set to W.

Cal SPL
Set the calibration level value.
This setting is only available when the unit is set to dBSPL.

Functions 
(THD+N Level)

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Analog Notch
– Enable
– Disable

Enable or disable the analog notch filter. 
This filter is used to emulate the analog notch filter used in the HP8903B.

Table A-7 Analog analyzer menu tree description (continued)
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Functions 
(SINAD)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Functions 
(THD Ratio)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

Display the even harmonics order selection.

Table A-7 Analog analyzer menu tree description (continued)
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Functions 
(THD Ratio)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

Display the odd harmonics order selection.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Functions 
(THD Level)

Unit

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

Select the unit type.

Format

– Off
– Logarithmic
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured level as the reference level, and set the measurement 
reading format to Logarithmic.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Ref. Imp
Set the reference impedance value.
This setting is only available when the unit is set to W.

Cal SPL
Set the calibration level value.
This setting is only available when the unit is set to dBSPL.

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

Select the even harmonics values.

Table A-7 Analog analyzer menu tree description (continued)

Level 1 Level 2 Level 3 Description
Keysight U8903B User’s Guide 457



A Appendixes
Functions 
(THD Level)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

Select the odd harmonics values.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Functions 
(SMPTE IMD)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Gen Lock
– Custom

Select the searching method for the upper and lower frequencies.

Upper Freq
Set the upper frequency value.
This setting is only available when the frequency lock is set to Custom.

Lower Freq
Set the lower frequency value.
This setting is only available when the frequency lock is set to Custom.

Table A-7 Analog analyzer menu tree description (continued)
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Functions 
(DFD60268 2nd/ 
DFD 60268 3rd/ 
DFD 60118 2nd/ 
DFD 60118 3rd)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Functions 
(SNR)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

SNR Delay Set the SNR delay value.

Functions 
(SNR (Fast))

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
frequency.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Table A-7 Analog analyzer menu tree description (continued)

Level 1 Level 2 Level 3 Description
Keysight U8903B User’s Guide 459



A Appendixes
Functions 
(SNR (Fast))

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Harmonics Set the number of harmonics order to be removed.

Functions 
(Phase)

Ref. Channel Set the reference channel number.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Functions 
(X-Talk)

Ref. Channel Set the driven channel.

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement reading.

Set to 0dB
Store the measured ratio as the reference ratio, and set the measurement 
reading format to Delta.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected channel as the reference 
ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is set to Custom.

Table A-7 Analog analyzer menu tree description (continued)
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Filters Config

Clear Filters Clear all the filter settings.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– C-Message
– CCITT
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the filter de-emphasis value.

Notch Filter

State
Enable or disable the notch filter.
– Enable
– Disable

Center Freq Set the frequency of the component to be removed from the input signal.

Bandwidth Set the bandwidth of the signal component to be removed.

Table A-7 Analog analyzer menu tree description (continued)
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Meas Config

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the sample size.

Mov Average 1 to 50
Set the number of measurement readings to be used for the moving 
average calculation.

Sync Average 1 to 64
Set the number of points for the synchronous averaging in the analyzer 
meter mode. 

Src Channel

Select the internal generator channel as the reference channel used in the 
following situations.
For the result calculation in unit dBg.
For the frequencies searching algorithm when the frequency lock is set to 
Gen Lock.

Trigger Source
– Free Run
– External

Select the trigger source

Trigger Edge
– Rising
– Falling

Select the trigger edge type.

Input Config

Connector
– UnBal
– Bal
– Loopback

Select the input connector type.

Impedance

– 100 kΩ  
(for UnBal)

– 200 kΩ  
(for Bal)

– 600 Ω
– 300 Ω

Select the input impedance value.
This setting is only available when the input connector is set to UnBal or 
Bal.

Auto Range
– On
– Off

Enable or disable the auto range.

Range

– 140 V
– 100 V
– 32 V
– 10 V
– 3.2 V
– 1 V
– 320 mV

Select the input voltage range value.
This setting is only available when the auto range is disabled.

Table A-7 Analog analyzer menu tree description (continued)
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Input Config

Bandwidth
– 90 kHz
– 1.5 MHz

Select the input bandwidth value.
This setting is only available with Option N3431A. Refer to “U8903B 
Options” on page 37 for more information.

Coupling
– DC
– AC

Select the input coupling type.

Ext. Gain Set the input external gain value.

Wave File

Channel
– Left
– Right
– Stereo

Select the wave file channel type.

Bits/Sample
– 8
– 16
– 24

Select the wave file number of bits per sample.

Duration 1 s to 600 s Set the recording duration of the wave file.

Record Start recording and save the measurement into a wave file.

Statistics

Show Stats
– On
– Off

Enable or disable the statistics calculation.

No. of Reading 2 to 20 Set the number of readings used for the statistics calculation.

Stat 1 
Stat2 
Stat3

– Min
– Max
– Average
– Std Dev
– ΔMinMax

Select the statistics calculation type.

Clear Reset the statistics results of the current analog analyzer.

Table A-7 Analog analyzer menu tree description (continued)
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Table A-8 Digital analyzer menu tree description 

Level 1 Level 2 Level 3 Level 4 Description

Meas Mode
– Standard
– Process Delay
– BERT

Select the analysis mode.

Unit
– Hex
– Dec

This is only available when the analysis mode is 
BERT.
Select the unit for the BERT analysis mode.

Functions

Multi-Chn
– Off
– Phase
– X-Talk

Select the multichannel mode.

Function No.

– 1
– 2
– 3
– 4

Select the active function number to configure the 
settings.

Meas Func

– None
– Frequency
– AC Voltage
– DC Voltage
– THD+N Ratio
– THD+N Level
– SINAD
– THD Ratio
– THD Level
– SMPTE IMD
– DFD60268 2nd
– DFD 60268 3rd
– DFD 60118 2nd
– DFD 60118 3rd
– Positive Peak
– Negative Peak

Select the measurement function.
This setting is only available when the 
multichannel mode is set to Off.

Functions 
(Frequency)

Unit
– Hz
– ΔHz

Select the unit type.

Format
– Off
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 8
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Freq Set the reference frequency value.
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Functions 
(AC Voltage)

Unit

– FFS
– dBFS
– %FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Volt/FS Set the volts/FS reference value.

Detector
– RMS
– Pk-Pk

Select the AC level detection type.

Functions 
(DC Voltage)

Unit

– FFS
– V
– Hex
– x

Select the unit type.

Format
– Off
– Linear

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Voltage
Set the reference voltage value.
There is only one reference level for each channel.
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Functions 
(THD+N Ratio)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Precision
– On
– Off

Enable or disable the precision mode.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency 
lock is set to Custom.

Functions 
(THD+N Level)

Unit

– FFS
– dBFS
– %FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Volt/FS Set the volts/FS reference value.

Precision
– On
– Off

Enable or disable the precision mode.

Table A-8 Digital analyzer menu tree description (continued)
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Functions 
(THD+N Level)

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency 
lock is set to Custom.

Functions 
(SINAD)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Precision
– On
– Off

Enable or disable the precision mode.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency 
lock is set to Custom.

Functions 
(THD Ratio)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

Display the even harmonics order selection.
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Functions 
(THD Ratio)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

Display the odd harmonics order selection.

Functions 
(THD Level)

Unit

– FFS
– dBFS
– %FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Volt/FS Set the volts/FS reference value.

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

Select the even harmonics values.

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

Select the odd harmonics values.

Table A-8 Digital analyzer menu tree description (continued)
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Functions 
(SMPTE IMD)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio Set the reference ratio value.

Functions 
(DFD60268 2nd/ 
DFD 60268 3rd/ 
DFD 60118 2nd/ 
DFD 60118 3rd)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Functions 
(Positive peak)

Unit

– FFS
– dBFS
– %FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the measurement unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned 
measurement reading.

Functions 
(Positive peak)

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Volt/FS Set the volts/FS reference value.

Table A-8 Digital analyzer menu tree description (continued)
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Functions 
(Negative peak)

Unit

– FFS
– dBFS
– %FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the measurement unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Volt/FS Set the volts/FS reference value.

Functions 
(Phase)

Ref. Channel Set the reference channel number.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency 
lock is set to Custom.

Functions 
(X-Talk)

Ref. Channel Set the driven channel.

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned 
measurement reading.

Set result as ref. from Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Table A-8 Digital analyzer menu tree description (continued)
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Functions 
(X-Talk)

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency 
lock is set to Custom.

Filters Config

Clear Filters Clear all the filter settings.

LPF

– None
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 20 Hz
– 100 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– C-Message
– CCITT
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the filter de-emphasis value.

Sample Rate

– 32 kHz
– 44.1 kHz
– 48 kHz
– 88.2 kHz
– 96 kHz
– 176.4 kHz
– 192 kHz

Select the sample rate.

Table A-8 Digital analyzer menu tree description (continued)
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Meas Config

Coupling
– DC
– AC

Select the coupling type.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the sample size.

Mov Average 1 to 20
Set the number of measurement readings to be 
used for the moving average calculation.

Trigger

Trigger Source
– Free Run
– External
– Channel

Select the trigger source.

Trigger Edge
– Rising
– Falling

This is only available when the trigger source is 
External or Channel.
Select the trigger edge type.

Interface
– Analog
– Digital

This is only available when the trigger source is 
Channel.
Select the trigger interface.

Channel
This is only available when the trigger source is 
Channel.
Set the channel number. 

Trigger Level
This is only available when the trigger source is 
Channel.
Set the trigger level. 

Table A-8 Digital analyzer menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
472 Keysight U8903B User’s Guide



Appendixes A
Input Config

Connector

– UnBal
– Bal
– Optical
– DSI

Select the input connector type.

Impedance

Unbalanced connector 
type
– 75 Ω
– HiZ
Balanced connector 
type
– 110 Ω
– HiZ

Select the input impedance value.

Freq Scaling
– MISR
– Custom

Select the frequency scaling type.

Ref SR
This is only available when frequency scaling is 
Custom.
Set the reference sample rate value. 
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DSI Config

Format

– Left
– Right
– I2S
– DSP

Select the data format

Fsync Polarity
– Rising
– Falling

This is only available when the format is Left or 
Right.
Select the frame clock edge synchronization.

Fsync Width
– One Bit Clock
– One Subframe
– 50% Duty Cycle

This is only available when the format is Left or 
Right.
Select the frame clock synchronization width. 

Data Shift Cnt
This is only available when the format is Left or 
Right.
Set the data shift count value.

Data Shift Dir
– Left
– Right

This is only available when the format is Left or 
Right.
Select the data shift direction.

Word Length 8 to 32
Set the word length value. The word length value 
must be greater than or equal to the audio 
resolution.

Resolution 8 to 24 Set the audio resolution value.

Decoding
– Linear PCM
– A-Law
– μ-Law

Select the decoding format.

W/Bclk Dir
– In
– Out

Select the word/bit clock direction.

Bit Clk Edge
– Rising
– Falling

Select the bit clock edge.

Voltage

– 1.2 Vpp
– 1.5 Vpp
– 1.8 Vpp
– 2.5 Vpp
– 3 Vpp
– 3.3 Vpp
– Custom

Select the input voltage value.

Table A-8 Digital analyzer menu tree description (continued)
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AES Config

Decoding
– Linear PCM
– A- Law
– μ- Law

Select the decoding format.

Resolution 8 to 24 Set the audio resolution value.

Status Bits
– Channel
– User

Select the status bits type.

Save in Hex
Save the status bits to a HEX file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Save in Xml
Save the status bits to an XML file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Bits Analysis

Refresh Rate Set the refresh rate.

Bit Types
– Data
– Active

Select the bit type.

Statistics

Show Stats
– On
– Off

Enable or disable the statistics calculation.

No. of Reading 2 to 20
Set the number of readings used for the statistics 
calculation.

Stat 1 
Stat2 
Stat3

– Min
– Max
– Average
– Std Dev
– ΔMinMax

Select the statistics calculation type.

Clear
Reset the statistics results of the current analog 
analyzer.

Table A-8 Digital analyzer menu tree description (continued)
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Appendix 9: Bluetooth Analyzer Menu Tree

Table A-9 Bluetooth analyzer menu tree description 

Level 1 Level 2 Level 3 Level 4 Description

Functions

Multi-Chn
– Off
– Phase
– X-Talk

Select the multichannel mode.

Function No.

– 1
– 2
– 3
– 4

Select the active function number to configure the 
settings.

Meas. Func.

– None
– Frequency
– AC Voltage
– DC Voltage
– THD+N Ratio
– THD+N Level
– SINAD
– THD Ratio
– THD Level
– SMPTE IMD
– DFD60268 2nd
– DFD 60268 3rd
– DFD 60118 2nd
– DFD 60118 3rd
– SNR (Fast)

Select the measurement function.
This setting is only available when the multichannel 
mode is set to Off.

Functions 
(Frequency)

Unit
– Hz
– ΔHz

Select the unit type.

Format
– Off
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Freq Set the reference frequency value.
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Functions 
(AC Voltage)

Unit

– FFS
– dBFS
– %FS
– V
– dB
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Cal SPL
Set the calibration level value.
This setting is only available when the unit is set to 
dBSPL.

Detector
– RMS
– Pk-Pk

Select the AC level detection type.

Functions 
(DC Voltage)

Unit

– FFS
– V
– LSB
– Hex
– Dec

Select the unit type.

Format
– Off
– Linear

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Table A-9 Bluetooth analyzer menu tree description (continued)
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Functions 
(THD+N Ratio)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(THD+N Level)

Unit

– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Cal SPL
Set the calibration level value.
This setting is only available when the unit is set to 
dBSPL.

Table A-9 Bluetooth analyzer menu tree description (continued)
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Functions 
(THD+N Level)

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(SINAD)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(THD Ratio)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

Display the even harmonics order selection.

Table A-9 Bluetooth analyzer menu tree description (continued)
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Functions 
(THD Ratio)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

Display the odd harmonics order selection.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(THD Level)

Unit

– FFS
– dBFS
– %FS
– V
– dBu
– dBV
– dBr
– x
– LSB
– Hex
– Dec
– dBSPL

Select the unit type.

Format
– Off
– Logarithmic
– Linear

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Level
Set the reference level value.
There is only one reference level for each channel.

Cal SPL
Set the calibration level value.
This setting is only available when the unit is set to 
dBSPL.

Even Harmonic

– ALL
– 2
– 4
– 6
– 8

Select the even harmonics values.
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Functions 
(THD Level)

Odd Harmonic

– ALL
– 3
– 5
– 7
– 9

Select the odd harmonics values.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(SMPTE IMD)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Gen Lock
– Custom

Select the searching method for the upper and lower 
frequencies.

Upper Freq
Set the upper frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Lower Freq
Set the lower frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(DFD60268 2nd/ 
DFD 60268 3rd/ 
DFD 60118 2nd/ 
DFD 60118 3rd)

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.
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Functions 
(SNR (Fast))

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference frequency.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Harmonics Set the number of harmonics order to be removed.

Functions 
(Phase)

Ref. Channel Set the reference channel number.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.

Functions 
(X-Talk)

Ref. Channel Set the driven channel.

Unit

– dB
– ΔdB
– %
– x

Select the unit type.

Format
– Off
– Linear
– Delta

Select the reading format of the returned measurement 
reading.

Set result as ref. 
from

Channels 1 to 2
Store the measurement result from the selected 
channel as the reference ratio.

Ref. Ratio
Set the reference ratio value.
There is only one reference ratio for each channel.

Fund Freq
Set the fundamental frequency value.
This setting is only available when the frequency lock is 
set to Custom.
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Filters Config

Clear Filters Clear all the filter settings.

LPF

– None
– 15 kHz
– 20 kHz
– Custom

– Select the low-pass filter.

HPF

– None
– 22 Hz
– 100 Hz
– 400 Hz
– Custom

– Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– C-Message
– CCITT
– Custom

– Select the weighting filter.

Filters Config

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

– Select the filter de-emphasis value.

Notch Filter

State
Enable or disable the notch filter.
– Enable
– Disable

Center Freq
Set the frequency of the component to be removed from 
the input signal.

Bandwidth
Set the bandwidth of the signal component to be 
removed.
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Coupling
– DC
– AC

Select the coupling type.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288

Select the sample size.

Mov Average 1 to 20
Set the number of measurement readings to be used for 
the moving average calculation.

Sync Average 1 to 64
Set the number of points for the synchronous averaging 
in the analyzer meter mode. 

Src Channel

Select the internal generator channel as the reference 
channel used in the following situations.
For the result calculation in unit dBg.
For the frequencies searching algorithm when the 
frequency lock is set to Gen Lock.

Trigger Trigger Source
– Free Run
– External
– Channel

Select the trigger source

Link Config Device Scan

Device Search
Search for the discoverable Bluetooth devices within 
range.

Max Scan 1 to 16
Set the maximum number of Bluetooth devices to be 
identified.

Filter Class
– All
– Custom

Select the filter class type.

Custom Set the Bluetooth device class.

Refresh Device
Refresh the friendly name of the selected Bluetooth 
device.

Table A-9 Bluetooth analyzer menu tree description (continued)
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Link Config Device Action

Pair/Unpair Device Pair/Unpair with the selected Bluetooth device.

Unpair All Device Unpair all the paired Bluetooth devices.

Profile Connection 

– Connect/
Disconnect All

– Connect/
Disconnect A2DP

– Connect/
Disconnect HFP

– Connect/
Disconnect AVRCP

Connect or disconnect the Bluetooth profiles for the 
connection.

A2DP Operation

– Open Media 
Connection

– Close Media 
Connection

– Start Streaming
– Pause Streaming

Select the advanced audio distribution profile operation 
settings.

HFP Operation 
(Handsfree/
Headset)

– Dial
– Answer Call
– End Call
– Reject Call
– Toggle Audio
– Button Press
– Send AT Command

Select the HFP (Handsfree/Headset) profile operation 
settings.

HFP Operation 
(Audio Gateway)

– Connect
– Disconnect
– Call
– Hang Up
– Send AT Command

Select the HFP (Audio Gateway) profile operation 
settings.

AVRCP Operation

– Volume Up
– Volume Down
– Mute
– Play
– Stop
– Pause
– Rewind
– Fast Forward
– Forward
– Backward

Select the audio/video remote control profile operation 
settings.
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Common Settings

Profile

– A2DP SRC, HFP AG, 
AVRCP TRGT

– A2DP SNK, HFP HF, 
AVRCP CTRL

Select the U8903B’s Bluetooth card profile.

Friendly Name Set the friendly name of the U8903B’s Bluetooth card.

Device PIN Set the passkey of the U8903B’s Bluetooth card.

Device Class
– Auto
– Custom

Select the device class based on the configured profile.

Custom  Set the device class. 

SSP Mode
– Just Works
– Man-In-The-Middle

Select the U8903B’s Bluetooth card simple secure 
pairing mode.

Auto Pair Enable or disable the auto-pairing function.

IO Capability Select the IO capability of the U8903B’s Bluetooth card.

Discoverable
Enable or disable the discoverability function of the 
U8903B’s Bluetooth card.

Connectable
Enable or disable the connectability function of the 
U8903B’s Bluetooth card.

Loopback
Enable or disable the integrated interchip sound audio 
loopback function.

Link Status
Enable or disable the link status of the U8903B’s 
Bluetooth card.

RF Port
– RF1
– RF2

Select the U8903B’s Bluetooth card RF port connector.

A2DP Settings

Codec
– SBC
– apt-X

Select the codec for the A2DP profile.

Sampling Rate

– 16 kHz
– 32 kHz
– 44.1 kHz
– 48 kHz

Select the audio sampling rate for the A2DP profile.

Table A-9 Bluetooth analyzer menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Link Config

HFP Settings

Wideband
Enable or disable the wideband speech mode in the HFP 
profile connection.

Latency 4 to 65534 Set the HFP's codec channel latency in miliseconds.

Retransmit

– No Transmission
– Power Saving
– Link Quality
– No Preference

Select the HFP's codec retransmission effort.

Packet Types

– HV1
– HV2
– HV3
– EV3
– EV4
– EV5
– 2EV3
– 3EV3
– 2EV5
– 3EV5

Select the packet type used in the HFP’s codec.

AVRCP Log View
Clear Log Clear the AVRCP operation log history.

Refresh Log Refresh the AVRCP operation log history.

Wave File

Channel
– Left
– Right
– Stereo

– Select the wave file channel type.

Bits/Sample
– 8
– 16

– Select the wave file number of bits per sample.

Duration 1 s to 600 s Set the recording duration of the wave file.

Record
Start recording and save the measurement into a wave 
file.

Statistics

Show Stats
– On
– Off

– Enable or disable the statistics calculation.

No. of Reading 2 to 20
Set the number of readings used for the statistics 
calculation.

Stat 1 
Stat2 
Stat3

– Min
– Max
– Average
– Std Dev
– ΔMinMax

– Select the statistics calculation type.

Clear
Reset the statistics results of the current analog 
analyzer.

Table A-9 Bluetooth analyzer menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Table A-10 Graph analysis menu tree description 

Level 1 Level 2 Level 3 Description

Analysis Mode

– Frequency
– Phase
– Time
– PSD

Select the graph analysis mode to be plotted on the current graph panel.
This setting is not available when the graph analysis display option is 
Harmonics.

Harm Settings

Active AA1 to AA8

Select the active channel. 
This setting is only available when the graph analysis display option is 
Harmonics.
AA2: Analog Analyzer channel 2

Odd 

– ALL
– 3
– 5
– 7
– 9

Select the odd harmonics values. 
This setting is only available when the graph analysis display option is 
Harmonics.

Even 

– ALL
– 2
– 4
– 6
– 8

Select the even harmonics values. 
This setting is only available when the graph analysis display option is 
Harmonics.

Display
– Harmonics
– THD

Select the harmonics display option.
This setting is only available when the graph analysis display option is 
Harmonics.

THD Unit
– dB
– %

Select the unit for THD measurements.
This setting is only available when the graph analysis display option is 
Harmonics.

Graph Settings

Active Channel AA1 to AA8
Select the available active channel.
AA2: Analog Analyzer channel 2

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the graph sample size value.
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Graph Settings

Window

– Rectangular
– Hanning
– Blackman
– Rife-Vincent
– Rife-Vincent 3
– Hamming
– Flat Top
– Kaiser

Select the window function to be applied to the data before the FFT 
process.

Sync Avg 1 to 64
Set the number of samples to be acquired and averaged before the FFT 
process is performed.

Hold

– None
– Average
– Min
– Max

Select the type of hold to be performed after the FFT process.

Axis Settings

Axis
– Primary
– Secondary

Select the active axis to be configured.

Enabled
– On
– Off

Enable or disable the axis settings.
This setting is only available when the axis type is secondary. If the axis 
type is primary, this setting is always set to On.

Left Set the left axis limit value.

Right Set the right axis limit value.

Span Set the total X-axis span or total range to be monitored in the graph.

Center Set the X-axis center point in the graph.

Top Set the top axis limit value.

Bottom Set the bottom axis limit value.

X-Scale
– Linear
– Log

Select the X-axis scale type.

Y-Scale
– Linear
– Log

Select the Y-axis scale type.

Trace Settings

Active Trace 1 to 8 Select the active trace channel.

Source
Select data source of the active trace from the available channels, traces, 
files, and memory.

Enabled
– On
– Off

Enable or disable the active trace data.

Memory

Save To Memory Save the active trace to the memory buffer.

Load From Memory Load a trace from the memory buffer into the active trace.

Clear Memory Clear the trace from the memory buffer.

Table A-10 Graph analysis menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Math

Apply Math

Apply the corresponding math function to the trace data or turn off the 
math function.
– On
– Off

Function

Select the math function to be applied on the active trace.
– f(Source)
– f(Source) + x
– f(Source) - x
– f(Source) * x
– f(Source) / x

X Set the x value in the selected math function.

Unit

– V
– dBV
– dBu
– W
– dBm
– dBSPL

Select the trace unit type.

Persistence

Persist Enable or disable the persistence on the active trace.

Persist Count
Set the number of previous sets of trace data to be displayed in the graph 
before they are removed.
This setting is only available when persistence is enabled.

Axis
– Primary
– Secondary

Attach the active trace to the primary or secondary axis.

Color

– Yellow
– Cyan
– White
– Pink
– Green
– Orange
– Red
– Purple

Select the color of the active trace.

Display Option

– Graph
– Data Table
– Marker Table
– Statistics
– Harmonics
– Signal Analysis

Select the graph analysis display option.

Running mode
Continuous
Single

Select the graph analysis running mode.

Table A-10 Graph analysis menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Enabled
– On
– Off

Enable or disable the measurements in the graph.

Measurement 1

Interface Select the measurement interface type.

Channel Select the desired channel to perform the measurement.

Function No Select the function to be displayed based on the function number (1 to 4).

Measurement 2

Interface Select the measurement interface type.

Channel Select the desired channel to perform the measurement.

Function No Select the function to be displayed based on the function number (1 to 4).

Table A-10 Graph analysis menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Table A-11 Sweep function menu tree description 

Level 1 Level 2 Level 3 Level 4 Description

App.Type
– Sweep
– Group Delay

Select the sweep application type.

Parameter

This is only available when the sweep application 
type is Sweep.
Select the sweep parameter type.
The parameter selection depends on the 
waveform type set at the analog generator.

Points Settings

Spacing
– Log
– Linear
– Custom

Select the spacing type.

Unit

– Vrms
– dBV
– Vp
– Vpp
– dBm
– dBu
– dBSPL

Select the sweep unit.
This setting is only available when the sweep 
parameter is amplitude.

Start
Set the sweep start value. This setting is only 
available when the sweep spacing is Log or 
Linear.

Stop
Set the sweep stop value. This setting is only 
available when the sweep spacing is Log or 
Linear.

Step
Set the sweep step value. This setting is only 
available when the sweep spacing is Log or 
Linear.

Points
Set the sweep points value. This setting is only 
available when the sweep spacing is Log or 
Linear.

Edit Points
Refer to “Edit points” on page 494 for the edit 
points menu tree.

Dwell Time
Set the delay in ms for the generator to output the 
signal.

Sweep Mode
Continuous
Single

Select the sweep mode.

Channels

Source 1 to 2 Select the source channel(s).

Measure 1 to 8
Select the measure channel(s). 
The available selection depends on the number of 
installed analog analyzer cards.
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Plot View

Axis Settings

Active Axis
– Primary
– Secondary

Select the active axis.

Left Set the left axis value.

Right Set the right axis value.

Top Set the top axis value.

Bottom Set the bottom axis value.

X-Scale
– Linear
– Log

Select the X-axis scale type.

Y-Scale
– Linear
– Log

Select the Y-axis scale type.

Plot Settings

Data Channel
Select the trace data channel number to be 
plotted.

Y Data

– S: <sweep 
parameter>

– F1: <measurement 
function 1>

– F2: <measurement 
function 2>

– F3: <measurement 
function 3>

– F4: <measurement 
function 4>

Select the Y-axis trace data source.

Y2 Data

– S: <sweep 
parameter>

– F1: <measurement 
function 1>

– F2: <measurement 
function 2>

– F3: <measurement 
function 3>

– F4: <measurement 
function 4>

Select the second Y-axis trace data source.

X Data

– S: <sweep 
parameter>

– F1: <measurement 
function 1>

– F2: <measurement 
function 2>

– F3: <measurement 
function 3>

– F4: <measurement 
function 4>

Select the X-axis trace data source.

Wrap Phase
– On
– Off

Enable of disable the wrap phase.

Table A-11 Sweep function menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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– None
– Average
– Max
– Min

Select the data type to be plotted in the graph.

Edit points

Data Channel
Select the trace data channel number to be 
plotted.

Wrap Phase
– On
– Off

Enable of disable the wrap phase.

Goto Point Set the sweep point number to go to.

Point Value Set the currently selected sweep point value.

Add Point Add a sweep point.

Remove Point Remove the selected sweep point.

Load Points
Load the sweep points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Plot View

Save Points
Save the sweep points to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Save Pts
Save the sweep points to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Table A-11 Sweep function menu tree description (continued)

Level 1 Level 2 Level 3 Level 4 Description
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Table A-12 Save menu tree description 

Level 1 Level 2 Description

Save Save to a file.

Type Select the file type to be displayed on the current directory.

Rename OK Set the file name and select OK to rename the file name.

Copy or Move

Mark Mark the selected file.

Copy Marked To Folder Copy the marked file to the selected folder.

Move Marked To Folder Move the marked file to the selected folder.

Delete Delete the selected file.

New Folder OK Set the new folder name and select OK to create a new folder.
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Table A-13 Recall menu tree description 

Level 1 Level 2 Description

Recall Recall a saved file.

Type Select the file type to be displayed on the current directory.

Rename OK Set the file name and select OK to rename the file name.

Copy or Move

Mark Mark the selected file.

Copy Marked To Folder Copy the marked file to the selected folder.

Move Marked To Folder Move the marked file to the selected folder.

Delete Delete the selected file.

New Folder OK Set the new folder name and select OK to create a new folder.
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Appendix 14: Test Sequence Menu Tree

Table A-14 Test sequence menu tree description 

Tab Level 1 Level 2 Level 3 Description

Project

New Project Create a new project.

Open Project
Load a project from a file. 
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Project
Save the project to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Properties

Prompt DUT ID
– On
– Off

Enable or disable the prompt for device ID (device 
serial number) at the start of a test sequence.

Prompt Msg
Set the prompt message.
This setting is only available when Prompt DUT ID 
is enabled.

Pass/Fail Msg
– On
– Off

Enable or disable the on-screen message dialog 
box that can be displayed at the end of a test 
sequence. Press Enter to close the dialog box.

Pass Message
Edit the pass message.
This setting is only available when Pass/Fail Msg 
is enabled.

Fail Message
Edit the fail message.
This setting is only available when Pass/Fail Msg 
is enabled.

Report

Clear Clear all the report data.

Save
Save the report to a DOCX file format.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Properties

Auto Save
– Enable
– Disable

Enable or disable saving the report automatically 
at the end of a test sequence.

Format
– Docx
– Html

Select the report file format to be saved.

Name Option
– Timestamp
– Numeric
– Prompt

Select the naming convention of the file name for 
the automatically saved report.

Prefix Set the prefix for the file name.

Location

Select
Select the folder for the automatically saved 
report.

New Folder
Create a new folder at the current directory or 
folder.
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Test

Enable
– On
– Off

Enable or disable the selected test sequence.

Add Test Sequence
New
Saved

Add a new test sequence.

Delete Test Sequence Delete the selected test sequence.

Save
Save the test sequence to a file.
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Edit

Move Move the selected test sequence.

Copy Copy the selected test sequence.

Paste
Paste a copied test sequence after the selected 
test sequence.

Properties Name Set the test sequence name.

IO Configuration

Add Measurement
Add measurements to the selected test sequence. 
Refer to “Add Measurement” on page 502 for 
the list of test measurements.

Edit Paste
Paste a copied measurement after the IO 
configuration. The IO Configuration cannot be 
moved or copied.

Settings: Output 
Configuration (Analog)

Channels
– None (External)
– 1
– 2

Select the number of output channels in use.

Connector

– Bal
– UnBal
– Com
– IEC60268

Select the output connector type.

Impedance

– For Bal, Com, and 
IEC60268

– 600 Ω
– 100 Ω
– 40 Ω
– For UnBal
– 600 Ω
– 50 Ω
– 20 Ω

Select the output impedance value.

IEC60268
– Pin 2
– Pin 3

Select the additional 10 Ω output series 
resistance for pin 2 or 3 of the XLR connector in 
the common IEC 60268 configuration.
This setting is only available when the output 
connector type is set to IEC 60268.

Ground
– Float
– Ground

Select the grounding type.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Settings: Output 
Configuration (Analog)

Max Voltage Set the maximum voltage.

Reference Impedance
Set the reference impedance for the unit 
conversion of dBm measurements.

Settings: Output 
Configuration 
(Bluetooth)

Channels
– None (External)
– 2

Select the number of output channels in use.

Device Select the paired Bluetooth device.

Profiles
– A2DP
– HFP
– AVRCP

Select the U8903B’s Bluetooth card profile.

Link Config Configure the Bluetooth link settings.

References Volt/FS Set the output references for generator.

Settings: Input 
Configuration (Analog)

Channels Display the number of input channels in use. 

Connector
– UnBal
– Bal
– Loopback

Select the input connector type.

Impedance

– 100 kΩ (for 
Unbalanced)

– 200 kΩ (for 
Balanced)

– 600 Ω
– 300 Ω

Select the input impedance value.
This setting is only available when Connector is 
set to UnBal or Bal.

Coupling
– DC
– AC

Select the input coupling type.

Bandwidth
– 90 kHz
– 1.5 MHz

Select the input bandwidth value.
This setting is only available with Option N3431A.

Reference

Voltage Set the input voltage value.

Ratio Set the input ratio value.

Frequency Set the input frequency value.

Impedance Set the input impedance value.

Sound level Set the input sound level value.

Calibrator level Set the input calibrator level value.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Settings: Input 
Configuration 
(Bluetooth)

Channels Select the number of input channels in use.

Device Select the paired Bluetooth device.

Profiles
– A2DP
– HFP
– AVRCP

Select the U8903B’s Bluetooth card profile.

Link Config Configure the Bluetooth link settings.

Coupling
– DC
– AC

Select the input coupling type.

Reference

Voltage Set the input voltage value.

Ratio Set the reference ratio value.

Frequency Set the reference frequency value.

Sound Lvl Set the sound level value.

Calibrator Lvl Set the calibration level value value.

Volt/FS Set the volts/FS reference value.

Properties

Name Rename the IO configuration.

Sub-Steps: RunIO 
Configuration

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Edit Move the RunIO Configuration sub-step in the list.

Sub-Steps:  
Delay

Enable
Enable or disable the delay sub-step.
– On
– Off

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step Delete the selected sub-step.

Edit
Move or copy the selected sub-step, or paste a 
copied sub-step after the selected sub-step.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Sub-Steps: 
Delay

Settings
Configure the delay sub-step settings.
– Delay 

Set the delay time in seconds.

Properties Rename the delay sub-step name.

Sub-Steps:  
Prompt

Enable Enable or disable the prompt sub-step.

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step Delete the selected sub-step.

Edit
Move or copy the selected sub-step, or paste a 
copied sub-step after the selected sub-step.

Settings

– Message 
Set the prompt message at the lower half of 
the main display.

– Prompt Icon 
Select the prompt icon to be displayed.
– None
– Hand
– Question
– Exclamation
– Asterisk

– Dialog Settings 
Add additional settings to the prompt window.
– Timeout
– Cancel Button

– Timeout 
Set the prompt timeout value in seconds.

Properties Set the prompt sub-step name.

Sub-Steps:  
Send SCPI

Enable Enable or disable the send SCPI sub-step.

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step Delete the selected sub-step.

Edit
Move or copy the selected sub-step, or paste a 
copied sub-step after the selected sub-step.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Sub-Steps:  
Send SCPI

Settings

– GPIB Address 
Select the desired GPIB address.

– SCPI Commands
– Edit 

Set the SCPI commands at the lower half of 
the main display.

– Import 
Load the SCPI commands from a file. Refer 
to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

– Progress Msg 
Set the optional text message that will be 
displayed on a dialog box for the time length 
set in Delay.

– Delay 
Set the delay time length after the SCPI 
command(s) is issued.

Properties Set the prompt sub-step name.

Measurement

Enable Enable or disable the selected measurement.

Add Measurement

– AC level
– Frequency
– Phase
– SNR
– THD+N
– DC level
– Crosstalk
– SMPTE IMD
– DFD IMD
– Multitone analyzer
– POLQA
– Stepped frequency sweep
– SMPTE frequency sweep
– DFD frequency sweep
– Stepped level sweep
– SMPTE level sweep
– DFD level sweep
– DC level sweep
– Receiver Sensitivity
– Measurement recorder

Add measurements.

Delete Measurement Delete the selected test measurement.

Edit
Move or copy the selected measurement, or paste 
a copied measurement after the selected 
measurement.

Settings
Configure the selected test measurement.
Refer to “Measurement settings” on page 505 
for the respective test measurement settings.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Name Rename the selected measurement.

Sub-Steps: RunIO 
Configuration

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Edit Move the RunIO Configuration sub-step in the list.

Sub-Steps:  
Delay

Enable Enable or disable the delay sub-step.

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step Delete the selected sub-step.

Edit
Move or copy the selected sub-step, or paste a 
copied sub-step after the selected sub-step.

Settings
Configure the delay sub-step settings.
– Delay 

Set the delay time in seconds.

Properties Rename the delay sub-step name.

Sub-Steps:  
Prompt

Enable Enable or disable the prompt sub-step.

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step Delete the selected sub-step.

Edit
Move or copy the selected sub-step, or paste a 
copied sub-step after the selected sub-step.

Settings

– Message 
Set the prompt message at the lower half of 
the main display.

– Prompt Icon 
Select the prompt icon to be displayed.
– None
– Hand
– Question
– Exclamation
– Asterisk

– Dialog Settings 
Add additional settings to the prompt window.
– Timeout
– Cancel Button

– Timeout 
Set the prompt timeout value in seconds.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Sub-Steps:  
Prompt

Properties Set the prompt sub-step name.

Sub-Steps:  
Send SCPI

Enable Enable or disable the send SCPI sub-step.

Add Sub-Step

Add sub-step to the list.
– Delay
– Prompt
– Sent SCPI

Delete Sub-Step Delete the selected sub-step.

Edit
Move or copy the selected sub-step, or paste a 
copied sub-step after the selected sub-step.

Settings

– GPIB Address 
Select the desired GPIB address.

– SCPI Commands
– Edit 

Set the SCPI commands at the lower half of 
the main display.

– Import 
Load the SCPI commands from a file. Refer 
to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

– Progress Msg 
Set the optional text message that will be 
displayed on a dialog box for the time length 
set in Delay.

– Delay 
Set the delay time length after the SCPI 
command(s) is executed.

Properties Set the prompt sub-step name.

Failure Handling
– Cancel Seq.
– Allow Retry
– Continue Seq.

Select the failure handling type for the selected 
measurement.

Table A-14 Test sequence menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Measurement settings

AC level

Table A-15 Measurement settings > AC Level menu tree description 

Tab Level 1 Level 2 Level 3 Description

AC Level 
(Signal Generation)

Waveform

Sine
Variable Phase
Square
Arbitrary

 Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

Phase->1st Ch
Set the phase value. This setting is only available 
when channel 2 is selected.

AC Level 
(Signal Analysis)

Detector
– RMS
– Pk-Pk

Select the AC level detector type. 

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.
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(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

AC Level
Gain

Refer to “Bar chart” on page 550 for the bar 
chart menu tree.

Table A-15 Measurement settings > AC Level menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Frequency

Table A-16 Measurement settings > Frequency menu tree description 

Tab Level 1 Level 2 Level 3 Description

Frequency  
(Signal Generation)

Waveform

– Sine
– Variable Phase
– Square
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
Enable
Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

Waveform Config

DC Offset Set the DC offset value.

Phase->1st Ch
Set the phase value. This setting is only available 
when channel 2 is selected.

Frequency  
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

Frequency
Refer to “Bar chart” on page 550 for the bar 
chart menu tree.
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Table A-17 Measurement settings > Phase menu tree description 

Tab Level 1 Level 2 Level 3 Description

Phase 
(Signal Generation)

Waveform

– Sine
– Variable Phase
– Square
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Waveform Config

Frequency Set the frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

Phase->1st Ch
Set the phase value. This setting is only available 
when channel 2 is selected.

Phase 
(Signal Analysis)

Ref Channel Set the reference channel number. 

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range
Track 1st Ch

– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

Phase
Refer to “Bar chart” on page 550 for the bar 
chart menu tree.
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SNR

Table A-18 Measurement settings > SNR menu tree description 

Tab Level 1 Level 2 Level 3 Description

SNR 
(Signal Generation)

Waveform

– Sine
– Variable phase
– Square
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

Phase->1st Ch
Set the phase value. This setting is only available 
when channel 2 is selected.

SNR 
(Signal Analysis)

SNR Mode
– Fast
– Standard

Select the SNR measurement mode.

SNR Delay
Set the SNR delay.
This setting is only available when SNR Mode is 
set to Standard.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.
This setting is only available when SNR Mode is 
set to Fast.

Fund Freq
Set the fundamental frequency value.
This setting is only available when SNR Mode is 
set to Fast and Freq Lock is set to Custom.

Harmonic Cnt
Set the number of harmonics order to be removed.
This setting is ony available when SNR Mode is 
set to Fast.
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SNR 
(Signal Analysis)

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Table A-18 Measurement settings > SNR menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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SNR 
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

SNR
Refer to “Bar chart” on page 550 for the bar 
chart menu tree.

Table A-18 Measurement settings > SNR menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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THD+N

Table A-19 Measurement settings > THD+N menu tree description 

Tab Level 1 Level 2 Level 3 Description

THD+N 
(Signal Generation)

Waveform

– Sine
– Variable phase
– Square
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

Waveform Config

DC Offset Set the DC offset value.

Phase->1st Ch
Set the phase value. This setting is only available 
when channel 2 is selected.

THD+N 
(Signal Analysis)

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when Freq Lock is set 
to Custom.

Harmonics
– All
– 2 to 9

Select the harmonics count to be used in the THD 
ratio and THD level results.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.
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THD+N 
(Signal Analysis)

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

SINAD 
THD Level 
THD Ratio 
THD+N Level 
THD+N Ratio

Refer to “Bar chart” on page 550 for the bar 
chart menu tree.

Table A-19 Measurement settings > THD+N menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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DC level

Table A-20 Measurement settings > DC Level menu tree description 

Tab Level 1 Level 2 Level 3 Description

DC Level 
(Signal Generation)

Waveform
– Sine
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

DC Level 
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

DC Level
Refer to “Bar chart” on page 550 for the bar 
chart menu tree.
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Crosstalk

Table A-21 Measurement settings > Crosstalk menu tree description 

Tab Level 1 Level 2 Level 3 Description

Crosstalk 
(Signal Generation)

Waveform
– Sine
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

Crosstalk 
(Signal Analysis)

Driven Ch
Select the driven channel number from the 
generator.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when Freq Lock is set 
to Custom.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range
Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

Crosstalk
Refer to “Bar chart” on page 550 for the bar 
chart menu tree.
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SMPTE IMD

Table A-22 Measurement settings > SMPTE IMD menu tree description 

Tab Level 1 Level 2 Level 3 Description

SMPTE IMD 
(Signal Generation)

Waveform
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Upper Freq Set the upper frequency value.

Lower Freq Set the lower frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

SMPTE IMD 
(Signal Analysis)

Freq Lock
Gen Lock
Custom

Select the searching method for the upper and 
lower frequencies. 

Upper Freq
Set the upper fundamental frequency value.
This setting is only available when Freq Lock is set 
to Custom.

Lower Freq
Set the lower fundamental frequency value.
This setting is only available when Freq Lock is set 
to Custom.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

SMPTE Ratio
Refer to “Bar chart” on page 550 for the bar 
chart menu tree.
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DFD IMD

Table A-23 Measurement settings > DFD IMD menu tree description 

Tab Level 1 Level 2 Level 3 Description

DFD IMD 
(Signal Generation)

Waveform
– IEC60118
– IEC60268

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Upper Freq Set the upper frequency value.

Center Freq Set the center frequency value.

Diff Freq Set the difference frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

DFD IMD 
(Signal Analysis)

DFD order
– 2nd
– 3rd

Select the distortion order to be measured.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

DFD Ratio
Refer to “Bar chart” on page 550 for the bar chart 
menu tree.
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Multitone analyzer

Table A-24 Measurement settings > Multitone Analyzer menu tree description 

Tab Level 1 Level 2 Level 3 Description

Multitone 
(Signal Generation)

Output Select the output channel.

Waveform Config
Track 1st Ch

– Enable
– Disable

Enable or disable the tracking of the first channel.

Amplitude Set the total amplitude value.

Tones Config

Start Freq
Set the lowest frequency in the multitone 
waveform.

Stop Freq
Set the highest frequency in the multitone 
waveform.

Freq Spacing
– Linear
– Log
– Custom

Select the frequency spacing between the tones.

Tone Count Set the number of signal frequency components.

Length

– 1024
– 2048
– 4096
– 8192
– 16384
– 32768
– 65536

Select the waveform length value.

Apply Apply the multitone after it has been customized.

Optimize Optimize the multitone.

Amplitude Dist – Zero Set the phase of all tones to 0 degrees.

Phase Dist
– Zero
– Random

Select the phase distribution of all tones in 
degrees.

Edit Tones

Frequency Set the frequency value.

Amplitude Set the amplitude value.

Phase Set the phase value.

Add Above Add a tone above the selected tone.

Add Below Add a tone below the selected tone.

Remove Remove the selected tone.

Clear All Remove all the tones in the list.

Active Channel
Set the active channel for the absolute amplitude 
for each tone to be displayed in a table.

Multitone 
(Signal Analysis)

Input Range
Track 1st Ch

– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.
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– Spectrum
– Waveform
– Level
– Gain

Refer to “Graph” on page 551 for the graph menu 
tree.

– Max Tone Level
– Min Tone Level
– TD+N Level
– TD+N Ratio
– Tone Level

Refer to “Bar chart” on page 550 for the bar 
chart menu tree.

Table A-24 Measurement settings > Multitone Analyzer menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Stepped frequency sweep

Table A-25 Measurement settings > Stepped Frequency Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

Stepped Frequency 
Sweep  
(Signal Generation)

Output Select the output channel.

Sweep Config

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

Ref Channel Set the reference channel number. 

Harmonics
– All
– 2 to 9

Select the harmonics count to be used in the THD 
ratio and THD level results.
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Stepped Frequency 
Sweep  
(Signal Analysis)

Ref Channel

– CH1
– CH2
– CH3
– CH4

Select the reference channel.

Wrap Phase
– On
– Off

Enable or disable the wrap phase.

Harmonics

– ALL
– 2
– 3
– 4
– 5
– 6
– 7
– 8
– 9

Select the harmonics counts to be used.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Table A-25 Measurement settings > Stepped Frequency Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Stepped Frequency 
Sweep  
(Signal Analysis)

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Notch Filter

– HP8903B
– Custom Notch
– Center Freq
– Bandwidth

Select the notch filter.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

– AC Level
– Gain
– Phase
– THD Ratio
– THD Level
– THD+N Ratio
– THD+N Level
– SINAD

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-25 Measurement settings > Stepped Frequency Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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SMPTE frequency sweep

Table A-26 Measurement settings > SMPTE Frequency Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

SMPTE Frequency 
Sweep  
(Signal Generation)

Waveform
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

 Select the waveform type.

Output Select the output channel.

Sweep Config

Swept
– Upper Freq
– Lowe Freq

Select the sweep parameter.

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Edit Points

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Upper Freq Set the upper frequency value.

Lower Freq Set the lower frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.
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SMPTE Frequency 
Sweep  
(Signal Analysis)

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

SMPTE Ratio
Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-26 Measurement settings > SMPTE Frequency Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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DFD frequency sweep

Table A-27 Measurement settings > DFD Frequency Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

DFD Frequency Sweep  
(Signal Generation)

Waveform
– IEC60118
– IEC60268

Select the waveform type.

Output  Select the output channel.

Sweep Config

Swept
– Upper Freq
– Lower Freq

Select the sweep parameter.

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Sweep Config Edit Points Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Upper Freq Set the upper frequency value.

Diff Freq Set the difference frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.
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DFD Frequency Sweep  
(Signal Analysis)

DFD order
– 2nd
– 3rd

Select the distortion product order to be 
measured.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

DFD Ratio
Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-27 Measurement settings > DFD Frequency Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-28 Measurement settings > External Frequency Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

External Frequency 
Sweep  
(Signal Generation)

Instrument

– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A
– Other

Select the instrument model.

GPIB Address – 0 to 30 Select the GPIB address.

Init Instrument
– On
– Off

Enable or disable the U8903B to send SCPI 
commands to initialize the connected  
signal generator.

Init SCPI
– Edit
– Import

Set the SCPI commands that initialize the 
connected instrument. You can set the SCPI 
command directly or load from a file.

Sweep SCPI
– Edit
– Import

Set the sweep SCPI commands that initialize the 
connected instrument. You can set the SCPI 
command directly or load from a file.

Sweep Config

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.
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External Frequency 
Sweep  
(Signal Analysis)

Ref Channel – CH1 to CH8

Select the reference channel number. The phase 
of each channel is measured against the reference 
channel. The phase result for the reference 
channel should always be displayed zero.

Harmonics
– All
– 2 to 9

Select the harmonics count to be used in the THD 
ratio and THD level results.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Table A-28 Measurement settings > External Frequency Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Stepped Frequency 
Sweep  
(Signal Analysis)

Notch Filter

HP8903B
– On
– Off

Enable or disable the HP8903B mode.

Custom Notch
– On
– Off

Enable or disable the custom notch.

Center Freq
Set the center frequency value. This is only 
applicable when custom notch is enabled.

Bandwidth
Set the bandwidth value. This is only applicable 
when custom notch is enabled.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

– AC Level
– Gain
– Phase
– THD Ratio
– THD Level
– THD+N Ratio
– THD+N Level
– SINAD

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-28 Measurement settings > External Frequency Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Stepped level sweep

Table A-29 Measurement settings > Stepped Level Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

Stepped Level Sweep  
(Signal Generation)

Waveform
– Sine
– Arbitrary

Select the waveform type.

Output  Select the output channel.

Sweep Config

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Sweep Config Edit Points Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

DC Offset Set the DC offset value.
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Stepped Level Sweep  
(Signal Analysis)

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value. This setting 
is only available when Freq Lock is set to Custom.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Table A-29 Measurement settings > Stepped Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

– AC Level
– Gain
– THD Ratio
– THD Level
– THD Ratio Vs Measured Amplitude
– THD Level Vs Measured Amplitude
– THD+N ratio
– THD+N Level
– THD+N Ratio Vs Measured Amplitude
– THD+N Level Vs Measured Amplitude
– SINAD

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-29 Measurement settings > Stepped Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-30 Measurement settings > SMPTE Level Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

SMPTE Level Sweep  
(Signal Generation)

Waveform
– SMPTE 1:1
– SMPTE 4:1
– SMPTE 10:1

Select the waveform type.

Output Select the output channel.

Sweep Config

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Sweep Config

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Upper Freq Set the upper frequency value.

Lower Freq Set the lower frequency value.

DC Offset Set the DC offset value.
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Freq Lock
– Gen Lock
– Custom

Select the searching method for the upper and 
lower frequencies. 

Upper Freq
Set the upper fundamental frequency value. This 
setting is only available when Freq Lock is set to 
Custom.

Lower Freq
Set the lower fundamental frequency value. This 
setting is only available when Freq Lock is set to 
Custom.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

– SMPTE Ratio
– SMPTE Ratio Vs Measured Amplitude

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-30 Measurement settings > SMPTE Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-31 Measurement settings > DFD Level Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

DFD Level Sweep  
(Signal Generation)

Waveform
– IEC60118
– IEC60268

Select the waveform type.

Output  Select the output channel.

Sweep Config Start Set the start value for the sweep parameter.

Sweep Config

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Upper Freq Set the upper frequency value.

Diff Freq Set the difference frequency value.

DC Offset Set the DC offset value.
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DFD order
– 2nd
– 3rd

Select the distortion product order to be 
measured.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

– DFD Ratio
– DFD Ratio Vs Measured Amplitude

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-31 Measurement settings > DFD Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-32 Measurement settings > DC Level Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

DC Level Sweep  
(Signal Generation)

Output Select the output channel.

Sweep Config

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Sweep Config

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.

DC Level Sweep  
(Signal Analysis)

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.
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HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

DC Level
Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-32 Measurement settings > DC Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-33 Measurement settings > Receiver Sensitivity menu tree description 

Tab Level 1 Level 2 Level 3 Description

Receiver Sensitivity  
(Signal Generation)

Instrument
– Keysight E4438C
– Other

Select the signal generator model.

GPIB address
Set the GPIB address for the connected signal 
generator.

Start Power Set the sweep start RF power.

Stop Power Set the sweep stop RF power.

Step Size Set the step size. 

Dwell Time
Set the delay between each measured SINAD in 
seconds.

Init Instrument
– On
– Off

Enable or disable the U8903B to send SCPI 
commands to initialize the connected signal 
generator.

FM Frequency

Set the RF signal output frequency. 
This setting is only available if Instrument is set to 
Keysight E4438C and the Init Instrument is 
enabled.

FM Deviation

Set the RF signal frequency modulation deviation. 
This setting is only available if Instrument is set to 
Keysight E4438C and the Init Instrument is 
enabled.

FM Rate

Set the RF signal internal frequency modulation 
rate. 
This setting is only available if Instrument is set to 
Keysight E4438C and the Init Instrument is 
enabled

Init SCPI
– Edit
– Import

Set the SCPI commands that initialize the 
connected signal generator. You can set the SCPI 
command directly or load from a file.
This setting is only available if Instrument is set to 
Other and the Init Instrument is enabled.

Output Power SCPI
Set the SCPI command that adjusts the RF power 
of the connected signal generator.

Receiver Sensitivity  
(Signal Analysis)

Meas Channel Set the measured channel number.

Target SINAD
Set the target SINAD value measured from the 
Meas Channel.

Min 1st Value Set the minimum first value.

Stop Condition
– Until End
– On Target

Select the stop condition.

Freq Lock
– Auto
– Custom

Select the searching method for the fundamental 
frequency.
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(Signal Analysis)

Fund Freq
Set the fundamental frequency value.
This setting is only available when Freq Lock is set 
to Custom.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Table A-33 Measurement settings > Receiver Sensitivity menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Notch Filter

HP8903B
– On
– Off

Enable or disable the HP8903B notch filter mode.

Custom Notch
– On
– Off

Enable or disable custom notch filter.

Center Freq
Set the center frequency value. This is only 
available when the Custom Notch is enabled.

Bandwidth
Set the bandwidth value. This is only available 
when the Custom Notch is enabled.

Mov Average
Set the number of measurement readings to be 
used for the average calculation. 

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

SINAD Vs RF Power
Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-33 Measurement settings > Receiver Sensitivity menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-34 Measurement settings > External Level Sweep menu tree description 

Tab Level 1 Level 2 Level 3 Description

Stepped Level Sweep  
(Signal Generation)

Instrument

– Keysight 33220A
– Keysight 33250A
– Keysight 33500A
– Keysight 33600A
– Other

Select the instrument model.

GPIB Address – 0 to 30 Select the GPIB address.

Init Instrument
– On
– Off

Enable or disable the U8903B to send SCPI 
commands to initialize the connected  
signal generator.

Init SCPI
– Edit
– Import

Set the SCPI commands that initialize the 
connected instrument. You can set the SCPI 
command directly or load from a file.

Sweep SCPI
– Edit
– Import

Set the sweep SCPI commands that initialize the 
connected instrument. You can set the SCPI 
command directly or load from a file.

Sweep Config

Start Set the start value for the sweep parameter.

Stop Set the stop value for the sweep parameter.

Spacing
Select Log, Linear, or Custom for the sweep 
spacing.

Points Set the number of sweep points.

Step Size
Set the step size for linear spacing. This setting is 
only available when spacing is set to Linear.

Dwell Time Set the delay between the sweep points.

Edit Points

Point No Set the point number.

Point Value Set the point value.

Insert Point Above Insert a point above the selected point.

Insert Point Below Insert a point below the selected point.

Remove Point Remove the selected point.

Clear Clear all points.

Reverse Order Reverse the order of the points.

Sort Sort the points in ascending order.

Load Points
Load points from a file.
Refer to “Appendix 13: Recall Menu Tree” on 
page 496 for the recall menu tree.

Edit Points Save Points
Save the points to a file. 
Refer to “Appendix 12: Save Menu Tree” on 
page 495 for the save menu tree.
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Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value. This setting 
is only available when Freq Lock is set to Custom.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Table A-34 Measurement settings > External Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Notch Filter

HP8903B
– On
– Off

Enable or disable the HP8903B mode.

Custom Notch
– On
– Off

Enable or disable the custom notch.

Center Freq
Set the center frequency value. This is only 
applicable when custom notch is enabled.

Bandwidth
Set the bandwidth value. This is only applicable 
when custom notch is enabled.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement. 

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

– AC Level
– Gain
– THD Ratio
– THD Level
– THD Ratio Vs Measured Amplitude
– THD Level Vs Measured Amplitude
– THD+N ratio
– THD+N Level
– THD+N Ratio Vs Measured Amplitude
– THD+N Level Vs Measured Amplitude
– SINAD

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-34 Measurement settings > External Level Sweep menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-35 Measurement settings > Measurement Recorder menu tree description 

Tab Level 1 Level 2 Level 3 Description

Measurement 
Recorder 
(Signal Generation)

Waveform

– Sine
– Variable Phase
– Square
– Arbitrary

Select the waveform type.

Output Select the output channel.

Waveform Config

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Frequency Set the frequency value.

Amplitude Set the amplitude value.

DC Offset Set the DC offset value.

Measurement 
Recorder 
(Signal Analysis)

Duration Set the length of the measurement record, 

Ref Channel Set the reference channel number. 

Wrap Phase
– On
– Off

Enable or disable the wrap phase.

Freq Lock
– Auto
– Gen Lock
– Custom

Select the searching method for the fundamental 
frequency.

Fund Freq
Set the fundamental frequency value.
This setting is only available when Freq Lock is set 
to Custom.

LPF

– None
– 2 kHz
– 3 kHz
– 5 kHz
– 8 kHz
– 10 kHz
– 15 kHz
– 20 kHz
– 22 kHz
– 30 kHz
– 40 kHz
– 50 kHz
– 80 kHz
– Custom

Select the low-pass filter.
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Recorder 
(Signal Analysis)

HPF

– None
– 15 Hz
– 20 Hz
– 22 Hz
– 30 Hz
– 50 Hz
– 70 Hz
– 100 Hz
– 200 Hz
– 300 Hz
– 400 Hz
– Custom

Select the high-pass filter.

Weighting

– None
– A
– CCIR 1k
– CCIR 2k
– CCITT
– C-Message
– Custom

Select the weighting filter.

Deemphasis

– None
– 50 μs
– 75 μs
– Custom

Select the de-emphasis filter.

Sample Size

– 2048
– 4096
– 8192
– 16384
– 32768
– 65536
– 131072
– 262144
– 524288
– 1M
– 2M

Select the number of samples to be acquired for 
the measurement.

Input Range

Auto Range
– On
– Off

Enable or disable the auto input range.

Track 1st Ch
– Enable
– Disable

Enable or disable the tracking of the first channel.

Voltage Range Set the input voltage range.

Table A-35 Measurement settings > Measurement Recorder menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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– AC Level
– Gain, Phase
– THD+N Ratio
– THD+N Level
– DC Level
– Frequency
– SINAD

Refer to “Graph” on page 551 for the graph 
menu tree.

Table A-35 Measurement settings > Measurement Recorder menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Table A-36 Measurement settings > Voice Quality menu tree description 

Tab Level 1 Level 2 Level 3 Description

Voice Quality

Test Config

Standard POLQA Select POLQA as the test standard.

Bandwidth

– Narrowband
– Wideband
– Super Wideband 

(POLQA standard)

Select Narrowband or Super Wideband as the 
bandwidth type for POLQA standard.

Level Align
Enable or disable the automatic level alignment. 
This setting is only applicable for POLQA 
standard.

Reference

Source
– File
– Generator

Select the reference source to be used.

Reference File
– Playback File
– Recorded
– Custom File

Use the Reference File as the comparison file if 
the Source is set to File. Use the Reference File 
option as the comparison file if the Source is set 
to Generator. 

Playback File

This setting is only available when the Reference 
Source is set to Generator. Set the playback file to 
be used as the comparison file if Reference File is 
set to Playback File. Set the playback file to be 
recorded as the comparison file if Reference File is 
set to Recorded. Set the playback file to be 
recorded and the Custom File to be used as the 
comparison file if Reference File is set to Custom.

Custom File

Set the custom file to be used as the comparison 
file. This setting is only available when Reference 
Source is set to Generator and Reference File is 
set to Custom.

Rec Channel
Set the channel number to be recorded from. This 
setting is only available when Source is set to 
Generator and Reference File is set to Recorded.

Rec Duration
Set the recording duration to be recorded. This 
setting is only available when Source is set to 
Generator and Reference File is set to Recorded.

Rec Step
– Auto
– Delay
– Prompt

Set the start recording type. This setting is only 
available when Source is set to Generator and 
Reference File is set to Recorded.

Rec Delay

Set the delay time before a recording is 
performed. This setting is only available when 
Source is set to Generator, Reference File is set to 
Recorded, and Rec Step is set to Delay.

Rec to File
– Yes
– No

Enable or disable exporting the recording 
function. This setting is only available when 
Source is set to Generator and Reference File is 
set to Recorded.
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Reference Rec File

Set the file path for the exported recording 
destination. This setting is only available when 
Source is set to Generator, Reference File is set to 
Recorded, and Rec To File is set to Yes.

Degraded Source
– File
– Analyzer

Select file or analyzer as the reference source.

Degraded File
Set the degraded file as the comparison file. This 
setting is only available when Source is set to File.

Rec Channel
Set the channel number to be recorded from. This 
setting is only available when Source is set to 
Analyzer.

Rec Duration
Set the recording duration to be recorded. This 
setting is only available when Source is set to 
Analyzer.

Rec Step
– Auto
– Delay
– Prompt

Set the start recording type. This setting is only 
available when Source is set to Analyzer.

Rec Delay

Set the delay time before a recording is 
performed. This setting is only available when 
Source is set to Analyzer and Rec Step is set to 
Delay.

Rec to File
– Yes
– No

Enable or disable exporting the recording 
function. This setting is only available when 
Source is set to Analyzer.

Rec File

Set the file path for the exported recording 
destination. Set the file path for the exported 
recording destination. This setting is only 
available when Source is set to Analyzer and Rec 
To File is set to Yes.

IO Config Output Level Set the output level value.

Show/Hide POLQA 
License

Show or hide the POLQA license information.

– MOS- LQO
– Levels

Refer to “Bar chart” on page 550 for the bar 
chart menu tree.

Table A-36 Measurement settings > Voice Quality menu tree description (continued)

Tab Level 1 Level 2 Level 3 Description
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Bar chart

Table A-37 Measurement Results > Bar chart menu tree description 

Level 1 Level 2 Level 3 Description

Enable Enable or disable the selected result tab.

Add Result Add a new result tab to the measurement.

Delete Result Delete the selected result tab from the measurement.

Save Data

Save the selected result data to a CSV file format in the internal storage or 
external USB flash storage.
Refer to “Appendix 12: Save Menu Tree” on page 495 for the save 
menu tree.

Edit Limits

Track 1st
– Enable
– Disable

Enable or disable the tracking of the first trace.

Lower limit
– Enable
– Disable

Enable or disable the lower limit.

Upper limit
– Enable
– Disable

Enable or disable the upper limit.

Lower limit Set the lower limit value.

Upper limit Set the upper limit value.

Graph Properties

Title Edit the bar chart title.

X-axis

Auto Scale
Enable or disable the X-axis autoscale.
On
Off

Unit Select the X-axis unit type.

Left
Set the X-axis left value.
This setting is only available when the Autoscale is disabled.

Right
Set the X-axis right value.
This setting is only available when the Autoscale is disabled.
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Table A-38 Measurement results > Graph menu tree description 

Level 1 Level 2 Level 3 Description

Enable Enable or disable the selected result tab.

Add Result Add a new result tab to the measurement.

Delete Result  Delete the selected result tab from the measurement.

Save Data

Save the selected result data to a CSV file format in the internal storage or 
external USB flash storage.
Refer to “Appendix 12: Save Menu Tree” on page 495 for the save  
menu tree.

Edit Limits

Trace

– CH1 to CH8
– POLQA
– Reference
– Degraded
– Error

Select the trace channel number or the trace type (POLQA)

Limit Type
– Upper
– Lower

Select the limit type.

Track 1st
– Enable
– Disable

Enable or disable the tracking of the first trace.

Limit
– Enable
– Disable

Enable or disable the limit.

Points

Point No Set the point number.

X Set the X-axis value for the selected point number.

Y Set the Y-axis value for the selected point number.

Add Point Add a limit point.

Remove Point Remove the selected limit point.

Clear Points Clear all the limit points.

Load Points
Load limit points from a file.
Refer to “Appendix 13: Recall Menu Tree” on page 496 for the recall  
menu tree.

Edit Limits Points Save Points
Save the selected limit points to a file.
Refer to “Appendix 12: Save Menu Tree” on page 495 for the save  
menu tree.
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Title Edit the graph title.

X-axis

Auto Scale
Enable or disable the X-axis autoscale.
– On
– Off

Spacing
Select the X-axis spacing type.
– Log
– Linear

Unit Select the X-axis unit type.

Left
Set the X-axis left value.
This setting is only available when the X-axis autoscale is disabled.

Right
Set the X-axis right value.
This setting is only available when the X-axis autoscale is disabled.

Center
Set the X-axis center value.
This setting is only available when the X-axis autoscale is disabled.

Span
Set the X-axis span value.
This setting is only available when the X-axis autoscale is disabled.

Y-axis

Auto Scale
Enable or disable the Y-axis autoscale.
– On
– Off

Spacing
Select the Y-axis spacing type.
– Log
– Linear

Unit Select the Y-axis unit type.

Y-axis

Top
Set the Y-axis bottom value.
This setting is only available when the Y-axis autoscale is disabled.

Bottom
Set the Y-axis top value.
This setting is only available when the Y-axis autoscale is disabled.

Trace

Trace
Select the analyzer trace channel.
– CH1 to CH8

State
Enable or disable the trace.
– On
– Off

Color

Select the trace color.
– Yellow
– Cyan
– White
– Pink
– Green
– Orange
– Red
– Purple

Table A-38 Measurement results > Graph menu tree description (continued)

Level 1 Level 2 Level 3 Description
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(This is only applicable 
for POLQA 
measurement 
MOS-LQO and Delay 
results)

Title Edit the graph title.

Auto Scale
– On
– Off

Enable or disable the X-axis autoscale.

Left
Set the X-axis left edge value.
This setting is only available when the Autoscale is disabled.

Right
Set the X-axis right edge value.
This setting is only available when the Autoscale is disabled.

Top
Set the X-axis top edge value.
This setting is only available when the Autoscale is disabled.

Bottom
Set the Y-axis bottom edge value.
This setting is only available when the Autoscale is disabled.

Table A-38 Measurement results > Graph menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Appendix 15: HP8903B Menu Tree

Table A-39 HP8903B menu tree description 

Level 1 Level 2 Level 3 Description

Measurement

Function

– AC LEVEL
– SINAD
– DISTN
– DC LEVEL
– SIG / NOISE
– DISTN LEVEL

Select the HP8903B measurement mode.

LP Filter
– None
– 30 kHz
– 80 kHz

Select the HP8903B measurement low-pass filter value.

HP/W Filter
Select the HP8903B high-pass or weighting filter value.
The filter selection depends on the left and right filters set at HP8903B 
Config.

Reference
Set the reference value to be compared with the  
measured value in ratio mode. 
Changing the reference value will enable the measurement ratio mode.

Ratio
– On
– Off

Enable or disable the HP8903B measurement ratio mode.

Format
– Log
– Lin

Select the HP8903B measurement format type.

Generator

Frequency
Set the HP8903B generator frequency value. 
Changing the frequency value will also set the step parameter to frequency.

Amplitude
Set the HP8903B generator amplitude value.
Changing the amplitude value will also set the step parameter to 
amplitude.

Step Param
– Frequency
– Amplitude

Select the HP8903B generator step parameter type.

Generator

Freq. Step
Set the HP8903B generator frequency step value. 
This setting is only available when the step parameter is set to frequency.

Amp. Step
Set the HP8903B generator amplitude step value. 
This setting is only available when the step parameter is set to amplitude.

x 10 Multiply the current parameter step value by 10.

÷ 10 Divide the current parameter step value by 10.

Sweep

Freq. Start Set the HP8903B sweep frequency start value.

Freq. Stop Set the HP8903B sweep frequency stop value.

Sweep Status
– On
– Off

Start or abort sweeping in the HP8903B mode.
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Code List

– None
– Input Level Range (except DC Level)
– Input Level Range (DC Level only)
– Post Notch Detector Response (except in 

SINAD)
– Display Source Settings
– Re-enter Ratio Mode
– Signal-to-Noise Measurement Delay
– SINAD and Signal-to-Noise Display 

Resolution
– Sweep Resolution (maximum 255 points/

sweep)
– Display Level in Watts
– Read Display to SCPI
– GPIB Address (SCPI only)
– GPIB Service Request Condition (SCPI only)
– Source Output Impedance (Instrument 

powers up at 600 Ω)

Select the HP8903B special function codes list to be displayed.

SPCL
Set the HP8903B special function code except those indicated as SCPI only 
and execute the special function.

Table A-39 HP8903B menu tree description (continued)

Level 1 Level 2 Level 3 Description
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Appendix 16: Units of the Measurement Function Returned Values

Analog analyzer

Table A-40 Analog analyzer units of the meaurement function returned values

Measurement function Unit Default

Frequency
– Hz
– ΔHz

Hz

AC voltage 
THD+N level 
THD level

– dBg
– dBm
– dBr
– dBu
– dBV
– W
– V
– ΔV
– dBSPL
– x

V

DC voltage
– V
– ΔV
– x

V

THD+N ratio 
SINAD 
THD ratio 
SMPTE IMD 
DFD IEC 60118 (2nd order) 
DFD IEC 60118 (3rd order) 
DFD IEC 60268 (2nd order) 
DFD IEC 60268 (3rd order) 
SNR 
SNR (Fast) 
Crosstalk

– dB
– ΔdB
– %
– x

dB

Phase ° °
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Digital analyzer

Table A-41 Digital analyzer units of the meaurement function returned values

Measurement function Unit Default

Frequency
– Hz
– ΔHz

Hz

AC voltage 
Max peak value 
Min peak value

– V
– dBFS
– dBr
– dBu
– dBV
– FFS
– x
– pctFS 
– LSB
– Hex
– Dec

FFS

DC voltage

– FFS
– V
– LSB
– Hex
– Dec
– x

FFS

THD+N level 
THD level

– V
– dBFS
– dBr
– dBu
– dBV
– FFS
– x
– pctFS 
– LSB
– Hex
– Dec

dBFS

THD+N ratio 
SINAD 
SMPTE IMD 
DFD IEC 60118 (2nd order) 
DFD IEC 60118 (3rd order) 
DFD IEC 60268 (2nd order) 
DFD IEC 60268 (3rd order) 
Crosstalk (channel driven)

– dB
– ΔdB
– %
– x

dB

Phase ° °
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Bluetooth analyzer

Table A-42 Bluetooth analyzer units of the meaurement function returned values

Measurement function Unit Default

Frequency
– Hz
– ΔHz

Hz

AC voltage

– V
– dBFS
– dBr
– dBu
– dBV
– FFS
– x
– pctFS 
– LSB
– Hex
– Dec

FFS

DC voltage

– FFS
– V
– LSB
– Hex
– Dec
– x

FFS

THD+N level 
THD level

– V
– dBFS
– dBr
– dBu
– dBV
– FFS
– x
– pctFS 
– LSB
– Hex
– Dec

dBFS

THD+N ratio 
SINAD 
SMPTE IMD 
DFD IEC 60118 (2nd order) 
DFD IEC 60118 (3rd order) 
DFD IEC 60268 (2nd order) 
DFD IEC 60268 (3rd order) 
Crosstalk (channel driven)
SNR (Fast)

– dB
– ΔdB
– %
– x

dB

Phase ° °
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The units can be computed using the following formulas.

Table A-43 Unit conversion formula

Unit Formula Description

ΔHz f – fref fref = Reference frequency

dB 20 × log10 (ratio) -

ΔdB (ratio) – Rref Rref = Reference ratio

dBg Vgen = Amplitude of the generator signal for a corresponding channel

dBm Zref = Reference impedance

dBr Vref = Reference level

dBu -

dBv 20 × log10(Vrms) -

W Zref = Reference impedance[a]

ΔV V – Vref Vref = Reference level[b]

x

Vref = Reference level[b]

Rref = Reference ratio

% 100 × (ratio) -

[a] When the Vrms measurement unit is changed to Watt or dBm, the reference impedance setting will be used for the power level calculation. The 
reference impedance refers to the circuitry impedance or load impedance connected to the analyzer when calculating power level. Note that in a 
loopback test with no load impedance, the measured voltage value will be twice the expected value as there is no voltage divider present. This will 
return a power measurement greater than 6.02 dB if a load is present.

[b] Reference level is defined as a user-entered or a captured value from the current reading as a relative level for the subsequent measurement 
reading. It can be set to delta, linear, or log scale.

20 log10

Vrms
2

Vgen
--------------
 
 
 
 

×

10 log10

1000Vrms
2

Zref
---------------------------
 
 
 
 

×

20 log10

Vrms
2

Vref
--------------
 
 
 
 

×

20 log10

Vrms
0.6

-----------
 
 
 

×

V
Zref
--------

V
Vref
--------

or
Ratio (in %)
Rref (in %)
-----------------------
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Units for digital audio measurements

Table A-44 Units for digital audio measurements

Unit Description

FFS Fractional of Full Scale

%FS Percent of Full Scale

dBFS Decibels relative to Full Scale

LSB Least Significant Bit

FS/Vrms Ratio between cross-domain input and output levels measurements (analog input and digital output)

Vrms/FS Ratio between cross-domain input and output levels measurements (digital input and analog output)
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Appendix 17: Arbitrary File Format

The U8903B arbitrary waveform mode allows you to load an arbitrary file or a wave file. To 
load waveform file for the analog arbitrary waveform, press the Waveform Config > Recall 
softkeys. The Recall menu page will be displayed to allow you to select the file to be 
loaded. Once you load the waveform file, press the Info softkey in the Waveform Config 
menu page to display the arbitrary waveform information as shown in Figure A-1.

Figure A-1 Analog Generator > Waveform Config > Info menu page (arbitrary waveform)

You may configure the arbitrary file format (*.arb) with the parameters as shown below.

#Vpeak: 2 
#DC Offset: 0 
#Points: 
0 
-0.2 
-0.4 
…
The allowable range of values for each arbitrary file parameters are as shown in 
Table A-45.

Table A-45 Allowable range for arbitrary file parameters

Parameter Range

Vpeak
– 0 to 22.6 Vp (Balanced output connection)
– 0 to 11.3 Vp (Unbalanced or common output connection)

DC Offset –11.3 V to 11.3 V

Points 32 to 8000000 points
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The sampling rate for the arbitrary waveform is fixed at 192 kHz. Thus, the interval between 
samples is 1/192000 s.

For the following arbitrary file example, the highest numerical number of the sample points, 
which is 6, is output with the Vpeak. The other samples are level-controlled according to 
their ratio to the maximum.

#Vpeak: 2 
#DC offset: –3 
#Points: 
0 
–1 
–1.5 
–1 
0 
2 
4 
6 
4 
2 
…
Any of the following conditions may cause an error or warning message to appear.

– Unable to load the sample points, as the points may not be a valid float.

– Summation of the Vpeak and DC offset exceeds the maximum voltage for the current 
output connection type.

– Invalid Vpeak and DC offset values.

– Total of sample points less than 32.

– The arbitrary file does not exist.

NOTE
When the DC offset and amplitude are added together, it must not exceed the maximum 
voltage for the current output connection type:

– For the balanced output connection, (Vpeak + |DC offset|) must be within 0 V  
and 22.6 V.

– For the unbalanced and common mode output connections, (Vpeak + |DC offset|) must 
be within 0 V and 11.3 V.
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Appendix 18: User-defined Filter File Format

Selecting Custom in either the low-pass, high-pass, or weighting filters menu enables you 
to load a user-defined filter file.

The available user-defined filter types are IIR (Infinite Impulse Response) and FIR (Finite 
Impulse Response). You need to specify the coefficients or sections as well as group delay 
for the respective filter type. Use the following examples to configure the filter file format. 
The file is saved in the *.juf format.

Example of an FIR filter file format is as follows.

#Type: FIR 
#Delay: 250 
#Coefficients: 
0.00023394 
-1.69E-05 
-1.61E-05 
-1.57E-05 
…
The coefficients of the FIR filter are described as follows.

0.00023394 //A[0] 
-1.69E-05 //A[1] 
-1.61E-05 //A[2] 
-1.57E-05 //A[3]

NOTE
The FIR filter transfer function, H(z), is defined as:

H(z) = A[0] + A[1]z–1 + A[2]z–2 + A[3]z–3 + ...

where z = complex variable
Keysight U8903B User’s Guide 563



A Appendixes
Example of an IIR filter file format is as follows.

#Type: IIR 
#Delay: 250 
#Sections: 
0.02188812 
1 
-1.852219 
0.9397715 
1 
2 
1 
0.02067037 
1 
-1.749171 
0.8318526 
1 
2 
1 
…
The coefficients of the IIR filter are described as follows.

0.02188812 //Section 1: Gain1 
1 //Section 1: A1[0] 
–1.852219 //Section 1: A1[1] 
0.9397715 //Section 1: A1[2] 
1 //Section 1: B1[0] 
2 //Section 1: B1[1] 
1 //Section 1: B1[2] 

[0.02067037 //Section 2: Gain2 
1 //Section 2: A2[0] 
–1.749171 //Section 2: A2[1] 
0.8318526 //Section 2: A2[2] 
1 //Section 2: B2[0] 
2 //Section 2: B2[1] 
1 //Section 2: B2[2]
where Ax = Denominator and Bx = Numerator
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You may set up to 256 coefficients for the FIR filter type, and up to 36 sections for the IIR 
filter. The number of FIR coefficients must not be less than four, while the minimum 
number of sections allowed for IIR is one (seven coefficients). The delay is specified in the 
form of samples and within the range of 0 to 65535.

NOTE
The IIR filter transfer function, H(z), is defined as:

where z = complex variable, N = number of sections, x = section number

H(z) Gainx

Bx 0[ ] Bx 1[ ]z–1
Bx 2[ ]z–1

+ +

Ax 0[ ] Ax 1[ ]z–1
Ax 2[ ]z–1

+ +
----------------------------------------------------------
 
 
 
 

x = 1

N

∏=
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Appendix 19: DSI Input and Output Interface

The DSI input and output interface uses the 25-pin female D-SUB connector. The pins 
assignment for the connector are shown in Figure A-2 and Table A-46.

Figure A-2 25-pin female D-SUB connector

1 2 3 4 5 6 7 8 9 10 11 12 13

14 15 16 17 18 19 20 21 22 23 24 25

Table A-46 25-pin female D-SUB connector pins assignment 

Pin no. Label Direction Description

1 Master Clk Out Out Master clock out for digital audio

2 GND – Digital ground

3 DSI Gen Data-Out Out Digital generator DSI data output

4 DSI Gen FS-InOut In/Out DSI generator DSI frame sync

5 DSI Gen CLK-InOut In/Out DSI generator DSI bit clock

6 – – Unused

7 +5.0 V – +5.0 V supply with over-current protection

8 +3.3 V – +3.3 V supply with over-current protection

9 DSI Ana Data-In In Digital analyzer DSI data input

10 DSI Ana FS-InOut In/Out Digital analyzer DSI frame sync

11 DSI Ana Clk-InOut In/Out Digital analyzer DSI bit clock

12 GND – Digital ground

13 Sync Clock Out Out Sync clock output for AES3/SPDIF and DSI

14 – 25 GND – Digital ground
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Appendix 20: Digital System Clock Distribution Block Diagram

The digital system clock distribution block diagram is shown in Figure A-3.

Figure A-3 Digital system clock distribution block diagram

PLL

AES Receiver

PLL

PLL

PLL

Internal clock

Recovered Master Clock

Master Clock / Frame Sync In

DSI Generator Frame Sync

Generator Reference Clock

Bit Clock

Master Clock

Sync Clock

PLL = Phase-Locked Loop

DSI Generator Bit Clock
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Appendix 21: Typical DSI Test Configurations

The following sections describe the possible serial audio input and output configurations.

Configuration 1

In this configuration, the DUT uses the U8903B internal reference clock source as the 
reference clock. The DUT receives the clock references and data from the U8903B.

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode, and press  on the FUNCTION panel to switch to digital interface.

Figure A-4 DSI test configuration 1

1 At the digital generator, press DSI Config > Master Clock, and select On to enable the 
master clock.

2 At the digital generator, press DSI Config > Sample Rate, and set the sample rate.

3 At the digital generator, press DSI Config > Word Length, and set the word length. The bit 
clock rate is determined by the multiplication of the sample rate, word length, and 
number of channels.

4 At the digital generator, press DSI Config > Multiplier, and select the multiplier. The 
master clock rate is determined by the multiplication of the sample rate and multiplier.

5 At the digital generator, press DSI Config > Fsync Polarity, and select either Rising or 
Falling as the edge synchronization to the leading edge of the frame clock.

NOTE
Refer to “Appendix 19: DSI Input and Output Interface” on page 566 for more information 
on the pins assignment.

DUT

Bit clock

Frame Sync

Data Pin 3

Pin 4

Pin 5

Pin 1Master clock

U8903B
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Configuration 2

In this configuration, the DUT uses an external master clock as the reference clock. The 
U8903B receives the data, frame sync, and bit clock from the DUT. A typical application for 
this configuration is analog to digital converter (ADC) evaluation.

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode, and press  on the FUNCTION panel to switch to digital interface.

Figure A-5 DSI test configuration 2

1 At the digital analyzer, press Input Config > Connector, and select DSI as the digital 
analyzer input type.

2 At the digital generator, press DSI Config > Master Clock, and select Off to turn off the  
master clock.

3 At the digital analyzer, press DSI Config > W/Bclk Dir, and select In as the word and bit  
clock direction.

U8903B
DUT

External master clock

Pin 9

Pin 10

Pin 11Bit clock

Frame Sync

Data
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Configuration 3

In this configuration, an external master clock is used to synchronize the DUT and U8903B. 
A phase-locked loop (PLL) is used in the U8903B to lock the incoming master clock and 
regenerate the frame sync and bit clock. Data will be clocked in on each bit clock.

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode, and press  on the FUNCTION panel to switch to digital interface.

Figure A-6 DSI test configuration 3

1 At the digital analyzer, press Input Config > Connector, and select DSI as the digital 
analyzer input type.

2 At the digital generator, press DSI Config > Master Clock, and select Off to turn off the  
master clock.

3 At the digital analyzer, press DSI Config > W/Bclk Dir, and select Out as the word and bit 
clock direction.

4 At the digital generator, press DSI Config > Multiplier, and set the multiplier to determine 
the sampling rate.

U8903B
DU

External master 
Sync 

Pin 9

Pin 

Pin Bit 

Frame Sync

Dat
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Configuration 4

This configuration is similar to configuration 2, except that the DUT uses the U8903B 
internal reference clock source as the reference clock.

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode, and press  on the FUNCTION panel to switch to digital interface.

Figure A-7 DSI test configuration 4

1 At the digital analyzer, press Input Config > Connector, and select DSI as the digital 
analyzer input type.

2 At the digital generator, press DSI Config > Master Clock, and select On to turn on the  
master clock.

3 At the digital analyzer, press DSI Config > W/Bclk Dir, and select In as the word and bit  
clock direction.

4 At the digital generator, press DSI Config > Sample Rate, and set the sample rate.

5 At the digital generator, press DSI Config > Multiplier, and set the multiplier to determine 
the master clock rate.

U8903B
DUT

Pin 9

Pin 10

Pin 11

Pin 1

Bit clock

Frame Sync

Data

Master clock
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Configuration 5

This configuration is similar to configuration 3, except that the DUT uses the U8903B 
internal reference clock source as the reference clock.

Press  on the FUNCTION panel to switch between audio generator or audio analyzer 

mode, and press  on the FUNCTION panel to switch to digital interface.

Figure A-8 DSI test configuration 5

1 Press Input Config > Connector, and select DSI as the digital analyzer input type.

2 At the digital generator, press DSI Config > Master Clock, and select On to turn on the  
master clock.

3 Press DSI Config > W/Bclk Dir, and select Out as the word and bit clock direction.

U8903B
DUT

Pin 9

Pin 10

Pin 11

Pin 1

Bit clock

Frame Sync

Data

Master clock
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Appendix 22: U8903B Configuration Examples

Example 1: Generating a sine waveform with the digital generator and 
measuring its voltage with the digital analyzer

In this example, you will learn how to generate a simple sine waveform from the U8903B 
digital generator and measure its voltage using the U8903B digital analyzer.

To generate a sine waveform from the digital unbalanced output with a frequency of 1 kHz 
and amplitude of 1 FFS, perform the following steps.

1 Connect the digital generator unbalanced output to the digital analyzer unbalanced 
input channel in the rear panel using a BNC cable.

2 Press  on the FUNCTION panel to switch to audio generator mode, and press 

 on the FUNCTION panel to switch to digital interface.

3 Press Waveform, and select Sine as the waveform type.

4 Press Output Config > Connector, and select Unbalanced as the digital generator output 
type.

5 Press Output Config > AES Output, and enable the AES output.

6 Press Waveform Config > Frequency, and set the frequency to 1 kHz.

7 Press Waveform Config > Amplitude, and set the amplitude to 1 FFS.

8 Press  to start the signal generation on the digital generator channel 1.

9 After you have completed the steps above, the U8903B display should look as follows.

Figure A-9 Digital generator sine waveform generation
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To measure the voltage of the sine waveform, perform the following steps.

1 Press  on the FUNCTION panel to switch to audio analyzer mode, and press 

 on the FUNCTION panel to switch to digital interface.

2 Press Analysis Mode, and select Standard as the digital analyzer analysis mode.

3 Press Input Config > Connector, and select Unbalanced as the digital analyzer input type.

4 Press Functions > Function No., and select 1.

5 Press Functions > Function 1, and select Frequency as the first measurement function.

6 Press Functions> Function No., and select 2.

7 Press Functions > Function 2, and select AC Voltage as the second measurement function.

8 Press  to start the signal measurement on the digital analyzer channel 1.

You should now obtain an AC voltage reading of 1 FFS for the generated sine waveform, 
within the tolerance as stated in “Characteristics and Specifications” on page 419. The 
U8903B display should look as follows.

Figure A-10 Digital analyzer voltage measurement
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Example 2: Establishing a connection to a Bluetooth device and generating 
a sine waveform with the Bluetooth generator.

In this example, you will learn how to establish an A2DP profile connection to a Bluetooth 
device and generate a sine waveform with the U8903B’s Bluetooth generator.

1 Connect the Bluetooth RF1 port to the DUT RF port using an RF cable.

2 Press  on the FUNCTION panel to switch to audio generator mode, and press 

 on the FUNCTION panel to switch to Bluetooth interface.

3 Press Waveform, and select Sine as the waveform type.

4 Press Link Config > Common Settings, and select Profile as A2DP SRC, HFP AG, AVRCP 
TRGT.

5 Press Link Config > Device Scan, and select Device Search to scan for all discoverable 
Bluetooth device.

6 Press Link Config > Device Action, and select the Bluetooth device to be paired. Press Pair 
Device to begin the pairing procedure.

7 Press Link Config > Device Action, and select Profile Connection as Connect A2DP to 
connect using the A2DP profile.

8 Press Link Config > Device Action, and select A2DP Operation as Open Media Connection to 
establish the media connection and start the audio streaming from the Bluetooth card 
to the connected device.

9 Press Waveform Config > Frequency, and set the frequency to 1 Vrms.

10 Press Waveform Config > Amplitude, and set the amplitude to 2 FFS.

11 Press  to start the signal generation on the Bluetooth generator channel 1.

12 After you have completed the steps above, the U8903B display should look as follows.
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Figure A-11 Bluetooth generator sine waveform generation
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Example 3: Generating a multitone waveform with the analog generator and 
viewing the multitone spectrum in the graph

In this example, you will learn how to generate a multitone waveform from the U8903B 
analog generator and view the multitone spectrum in the U8903B graph.

1 Connect the analog generator unbalanced output to the analog analyzer unbalanced 
input channel using a BNC cable.

2 Press  on the FUNCTION panel to switch to audio generator mode, and press 

 on the FUNCTION panel to switch to analog interface.

3 Press Waveform, and select Multitone as the waveform type.

4 Press Output Config > Connector, and select Unbalanced as the analog generator output 
type.

5 Press Waveform Config > Amplitude, and set the amplitude to 1 Vrms.

6 Press Waveform Config > Start Freq, and set the start frequency to 937.5 Hz.

7 Press Waveform Config > Stop Freq, and set the stop frequency to 5.0625 kHz.

8 Press  to start the signal generation on the analog generator channel 1.

9 Press  on the FUNCTION panel to switch to audio analyzer mode, and press 

 on the FUNCTION panel to switch to analog interface.

10 Press Input Config > Connector, and select UnBal as the analog analyzer input type.

11 Press  to start the signal measurement on the analog analyzer channel 1.

12 After you have completed the steps above, the U8903B display should look as follows.
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Figure A-12 Analog analyer multitone waveform measurement

To view the multitone spectrum in the U8903B graph, perform the following steps.

1 Press  on the FUNCTION panel to access the graph analysis mode.

2 Press  to enable the graph analysis mode.

3 Use the  function to select and measure the two-tone spectrum amplitude.

4 An example of the U8903B graph display is shown as follows.

Figure A-13 Graph analysis for multitone spectrum
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Example 4: Running the Test Sequence App for the multitone analyzer 
measurement

In this example, you will learn how to use the Test Sequence App for the multitone analyzer 
measurement in the U8903B.

1 Press  to switch to Test Sequence App mode.

2 In the Project tab, press Add Measurement, and select Multitone Analyzer to be added for 
Test 1.

3 Press Settings to configure the multitone analyzer. For example, you can press Waveform 
Config to set the amplitude, and press Tones Config to set the start and stop frequency.

4 The multitone measurement results can be displayed in a graph (Spectrum, Waveform, 
Level, and Gain) and in a bar chart (Max Tone Level, Min Tone Level, TD+N Level, TD+N 
Ratio, and Tone Level). Refer to “Multitone analyzer” on page 345 for more 
information.

5 Press  and select Start Test App to begin the test sequence.

6 Depending on the settings parameter set for the multitone analyzer, the result will 
return as PASS or FAIL and is shown as follows.

Figure A-14 Test Sequence App result for multitone analyzer
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7 Select the Report tab to view the test sequence results in the U8903B display. You can 
also save the result file as a .docx file type by pressing Save.

Figure A-15 Test Sequence App report for multitone analyzer
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Example 5: Configuring the system clock reference settings

In this example, you will learn how to configure the U8903B system clock reference 
settings.

To configure the system clock reference source to external Master clock in with word length 
of 24 and multiplier of 192, perform the following steps.

1 Connect the external Master clock signal to the Sync In connector in the rear panel 
using a BNC cable.

2 Press  on the FUNCTION panel to switch to audio generator mode, and press 

 on the FUNCTION panel to switch to digital interface.

3 Press Output Config > Ref Clock > Source, and select External as the reference clock source.

4 Press Output Config > Ref Clock > Type, and select MCLK to set the external clock source 
type as Master clock.

5 Press Output Config > Ref Clock > Word Length, and set the Master clock word length to 

24.[1][2]

6 Press Output Config > Ref Clock > Multiplier, and set the Master clock multiplier to 192.[3]

[1] Sampling rate constrains the master clock in word length values. Refer to “Appendix 25: Word Length, 
Sampling Rate, and Multiplier for Master Clock In” on page 591 for the range of word length that can 
be set with different sampling rate.

[2] When setting the word length, the error message, –221,“Settings conflict...” may be generated. This error 
message can be ignored as this is to notify that the word length or multiplier is auto adjusted to the 
nearest allowable value due to the settings conflict.

[3] Sampling rate and word length constrain the multiplier values. Refer to “Appendix 25: Word Length, 
Sampling Rate, and Multiplier for Master Clock In” on page 591 for the range of multiplier that can be 
set with different master clock in word length and sampling rate.
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Example 6: Configuring the digital generator DSI output settings

In this example, you will learn how to configure the U8903B digital generator DSI output 
settings.

To configure the digital generator DSI output settings to DSP format, sampling rate of 
192 kHz, word length of 24, and multiplier of 192, perform the following steps.

1 Press  on the FUNCTION panel to switch to audio generator mode, and press 

 on the FUNCTION panel to switch to digital interface.

2 Press DSI Config > Format, and select DSP as the DSI output format.

3 Press DSI Config > Sample Rate, and set the sampling rate to 192 kHz.

4 Press DSI Config > Word Length, and set the DSI word length to 24.[1][2]

5 Press DSI Config > Multiplier, and set the DSI multiplier to 192.[3]

[1] Sampling rate constrains the DSI word length values. Refer to “Appendix 24: Word Length, Sampling 
Rate, and Multiplier for DSI” on page 585 for the range of word length that can be set with different 
sampling rate.

[2] When setting the word length, the error message, –221,“Settings conflict...” may be generated. This error 
message can be ignored as this is to notify that the word length or multiplier is auto adjusted to the 
nearest allowable value due to the settings conflict.

[3] Sampling rate and word length constrain the multiplier values. Refer to “Appendix 24: Word Length, 
Sampling Rate, and Multiplier for DSI” on page 585 for the range of multiplier that can be set with 
different DSI word length and sampling rate.
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Appendix 23: Relationship between Digital Waveform Parameters 
and Channels

Table A-47 Relationship between digital waveform parameters and channels 

Waveform Parameter Channel

Sine
Frequency
Amplitude
DC Offset

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same

Stereo
Frequency
Amplitude
DC Offset

Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same

Square
Frequency
Amplitude
DC Offset

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same

Sine burst

Frequency
Amplitude
Burst On
Period
Low Level

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same

Variable phase
Frequency
Amplitude 
Phase -> 1

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same

Dual

Frequency 1
Frequency 2
Amplitude
Ratio
DC Offset

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same

SMPTE IMD 1:1/ 4:1/ 10:1

Lower Frequency
Upper Frequency
Amplitude
DC Offset

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same

DFD IEC 60118

Difference Frequency
Upper Frequency
Amplitude
DC Offset

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same

DFD IEC 60268

Difference Frequency
Center Frequency
Amplitude
DC Offset

Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same

Gaussian/Rectangular/ 
Triangular/Pink

Amplitude
DC Offset

Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same

Constant Amplitude Channel 1 and Channel 2 are the same
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Multitone

Amplitude
Start Frequency
Stop Frequency
Frequency Spacing
Count
Crest Factor
Tone Frequency
Tone Amplitude
Tone Phase

Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same
Channel 1 and Channel 2 are the same

Arbitrary
Amplitude
DC Offset

Channel 1 and Channel 2 can be different
Channel 1 and Channel 2 are the same

Table A-47 Relationship between digital waveform parameters and channels (continued)

Waveform Parameter Channel
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Appendix 24: Word Length, Sampling Rate, and Multiplier for DSI

Table A-48 Word Length, Sampling Rate, and Multiplier for DSI 

Sampling rate (kHz)[a] Word length Multiplier

400 8 128

400 9 72, 144

400 10 80, 160

400 11 88, 176

400 12 96, 192

400 13 104, 208

400 14 112, 224

400 15 120, 240

400 16 64, 128

400 17 68, 136

400 18 72, 144

400 19 76, 152

400 20 80, 160

400 21 84, 168

400 22 88, 176

400 23 92, 184

400 24 96, 192

400 25 100, 200

400 26 104, 208

400 27 108, 216

400 28 112, 224

400 29 116, 232

400 30 120, 240

400 31 124, 248

400 32 128

200 8 128, 256

200 9 72, 144, 288

200 10 80, 160, 320

200 11 88, 176, 352

200 12 96, 192, 384

200 13 104, 208, 416
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200 14 112, 224, 448

200 15 120, 240, 480

200 16 64, 128, 256

200 17 68, 136, 272

200 18 72, 144, 288

200 19 76, 152, 304

200 20 80, 160, 320

200 21 84, 168, 336

200 22 88, 176, 352

200 23 92, 184, 368

200 24 96, 192, 384

200 25 100, 200, 400

200 26 104, 208, 416

200 27 108, 216, 432

200 28 112, 224, 448

200 29 116, 232, 464

200 30 120, 240, 480

200 31 124, 248, 496

200 32 128, 256

100 8 128, 256, 512

100 9 72, 144, 288, 576

100 10 80, 160, 320, 640

100 11 88, 176, 352, 704

100 12 96, 192, 384, 768

100 13 104, 208, 416, 832

100 14 112, 224, 448, 896

100 15 120, 240, 480, 960

100 16 64, 128, 256, 512

100 17 68, 136, 272, 544

100 18 72, 144, 288, 576

100 19 76, 152, 304, 608

100 20 80, 160, 320, 640

100 21 84, 168, 336, 672

Table A-48 Word Length, Sampling Rate, and Multiplier for DSI (continued)

Sampling rate (kHz)[a] Word length Multiplier
586 Keysight U8903B User’s Guide



Appendixes A
100 22 88, 176, 352, 704

100 23 92, 184, 368, 736

100 24 96, 192, 384, 768

100 25 100, 200, 400, 800

100 26 104, 208, 416, 832

100 27 108, 216, 432, 864

100 28 112, 224, 448, 896

100 29 116, 232, 464, 928

100 30 120, 240, 480, 960

100 31 124, 248, 496, 992

100 32 128, 256, 512

50 8 128, 256, 512, 1024

50 9 72, 144, 288, 576

50 10 80, 160, 320, 640

50 11 88, 176, 352, 704

50 12 96, 192, 384, 768

50 13 104, 208, 416, 832

50 14 112, 224, 448, 896

50 15 120, 240, 480, 960

50 16 64, 128, 256, 512

50 17 68, 136, 272, 544

50 18 72, 144, 288, 576

50 19 76, 152, 304, 608

50 20 80, 160, 320, 640

50 21 84, 168, 336, 672

50 22 88, 176, 352, 704

50 23 92, 184, 368, 736

50 24 96, 192, 384, 768

50 25 100, 200, 400, 800

50 26 104, 208, 416, 832

50 27 108, 216, 432, 864

50 28 112, 224, 448, 896

50 29 116, 232, 464, 928

Table A-48 Word Length, Sampling Rate, and Multiplier for DSI (continued)

Sampling rate (kHz)[a] Word length Multiplier
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50 30 120, 240, 480, 960

50 31 124, 248, 496, 992

50 32 128, 256, 512, 1024

25 8 128, 256, 512, 1024

25 9 72, 144, 288, 576

25 10 80, 160, 320, 640

25 11 88, 176, 352, 704

25 12 96, 192, 384, 768

25 13 104, 208, 416, 832

25 14 112, 224, 448, 896

25 15 120, 240, 480, 960

25 16 64, 128, 256, 512

25 17 68, 136, 272, 544

25 18 72, 144, 288, 576

25 19 76, 152, 304, 608

25 20 80, 160, 320, 640

25 21 84, 168, 336, 672

25 22 88, 176, 352, 704

25 23 92, 184, 368, 736

25 24 96, 192, 384, 768

25 25 100, 200, 400, 800

25 26 104, 208, 416, 832

25 27 108, 216, 432, 864

25 28 112, 224, 448, 896

25 29 116, 232, 464, 928

25 30 120, 240, 480, 960

25 31 124, 248, 496, 992

25 32 128, 256, 512, 1024

12.5 8 128, 256, 512, 1024

12.5 9 72, 144, 288, 576

12.5 10 80, 160, 320, 640

12.5 11 88, 176, 352, 704

12.5 12 96, 192, 384, 768

Table A-48 Word Length, Sampling Rate, and Multiplier for DSI (continued)

Sampling rate (kHz)[a] Word length Multiplier
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12.5 13 104, 208, 416, 832

12.5 14 112, 224, 448, 896

12.5 15 120, 240, 480, 960

12.5 16 64, 128, 256, 512

12.5 17 68, 136, 272, 544

12.5 18 72, 144, 288, 576

12.5 19 76, 152, 304, 608

12.5 20 80, 160, 320, 640

12.5 21 84, 168, 336, 672

12.5 22 88, 176, 352, 704

12.5 23 92, 184, 368, 736

12.5 24 96, 192, 384, 768

12.5 25 100, 200, 400, 800

12.5 26 104, 208, 416, 832

12.5 27 108, 216, 432, 864

12.5 28 112, 224, 448, 896

12.5 29 116, 232, 464, 928

12.5 30 120, 240, 480, 960

12.5 31 124, 248, 496, 992

12.5 32 128, 256, 512, 1024

6.75 8 128, 256, 512, 1024

6.75 9 72, 144, 288, 576

6.75 10 80, 160, 320, 640

6.75 11 88, 176, 352, 704

6.75 12 96, 192, 384, 768

6.75 13 104, 208, 416, 832

6.75 14 112, 224, 448, 896

6.75 15 120, 240, 480, 960

6.75 16 128, 256, 512

6.75 17 136, 272, 544

6.75 18 144, 288, 576

6.75 19 152, 304, 608

6.75 20 160, 320, 640

Table A-48 Word Length, Sampling Rate, and Multiplier for DSI (continued)

Sampling rate (kHz)[a] Word length Multiplier
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6.75 21 168, 336, 672

6.75 22 176, 352, 704

6.75 23 184, 368, 736

6.75 24 192, 384, 768

6.75 25 200, 400, 800

6.75 26 208, 416, 832

6.75 27 216, 432, 864

6.75 28 224, 448, 896

6.75 29 116, 232, 464, 928

6.75 30 120, 240, 480, 960

6.75 31 124, 248, 496, 992

6.75 32 128, 256, 512, 1024

[a]For sampling rate less than or equal to.

Table A-48 Word Length, Sampling Rate, and Multiplier for DSI (continued)

Sampling rate (kHz)[a] Word length Multiplier
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Appendix 25: Word Length, Sampling Rate, and Multiplier for 
Master Clock In

Table A-49 Word Length, Sampling Rate, and Multiplier for Master Clock In  

Sampling rate (kHz)[a] Word length Multiplier

400 8 64, 128

400 9 72, 144

400 10 80, 160

400 11 88

400 12 96

400 13 104

400 14 112

400 15 120

400 16 64, 128

400 17 68, 136

400 18 72, 144

400 19 76

400 20 80

400 21 84

400 22 88

400 23 92

400 24 96, 192

400 25 100

400 26 104

400 27 108

400 28 112

400 29 116

400 30 120

400 31 124

400 32 128

200 8 64, 128, 256

200 9 72, 144, 288

200 10 80, 160

200 11 88, 176

200 12 96, 192
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200 13 104, 208

200 14 112, 224

200 15 120, 240

200 16 64, 128, 256

200 17 68, 136, 272

200 18 72, 144, 288

200 19 76, 152

200 20 80, 160

200 21 84, 168

200 22 88, 176

200 23 92, 184

200 24 96, 192

200 25 100, 200

200 26 104, 208

200 27 108, 216

200 28 112, 224

200 29 116, 232

200 30 120, 240

200 31 124, 248

200 32 128, 256

100 8 64, 128, 256, 512

100 9 72, 144, 288, 576

100 10 80, 160, 320

100 11 88, 176, 352

100 12 96, 192, 384

100 13 104, 208, 416

100 14 112, 224, 448

100 15 120, 240, 480

100 16 64, 128, 256, 512

100 17 68, 136, 272, 544

100 18 72, 144, 288, 576

100 19 76, 152, 304

100 20 80, 160, 320

Table A-49 Word Length, Sampling Rate, and Multiplier for Master Clock In  (continued)

Sampling rate (kHz)[a] Word length Multiplier
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100 21 84, 168, 336

100 22 88, 176, 352

100 23 92, 184, 368

100 24 96, 192, 384

100 25 100, 200, 400

100 26 104, 208, 416

100 27 108, 216, 432

100 28 112, 224, 448

100 29 116, 232, 464

100 30 120, 240, 480

100 31 124, 248, 496

100 32 128, 256, 512

50 8 64, 128, 256, 512

50 9 72, 144, 288, 576

50 10 80, 160, 320, 640

50 11 88, 176, 352, 704

50 12 95, 192, 384, 768

50 13 104, 208, 416, 832

50 14 112, 224, 448, 896

50 15 120, 240, 480, 960

50 16 64, 128, 256, 512

50 17 68, 136, 272, 544

50 18 72, 144, 288, 576

50 19 76, 152, 304, 608

50 20 80, 160, 320, 640

50 21 84, 168, 336, 672

50 22 88, 176, 352, 704

50 23 92, 184, 368, 736

50 24 96, 192, 384, 768

50 25 100, 200, 400, 800

50 26 104, 208, 416, 832

50 27 108, 216, 432, 864

50 28 112, 224, 448, 896

Table A-49 Word Length, Sampling Rate, and Multiplier for Master Clock In  (continued)

Sampling rate (kHz)[a] Word length Multiplier
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50 29 116, 232, 464, 928

50 30 120, 240, 480, 960

50 31 124, 248, 496, 992

50 32 128, 256, 512

25 8 64, 128, 256, 512

25 9 72, 144, 288, 576

25 10 80, 160, 320, 640

25 11 88, 176, 352, 704

25 12 96, 192, 384, 768

25 13 104, 208, 416, 832

25 14 112, 224, 448, 896

25 15 120, 240, 480, 960

25 16 64, 128, 256, 512

25 17 136, 272, 544

25 18 72, 144, 288, 576

25 19 152, 304, 608

25 20 80, 160, 320, 640

25 21 168, 336, 672

25 22 88, 176, 352, 704

25 23 184, 368, 736

25 24 96, 192, 384, 768

25 25 200, 400, 800

25 26 104, 208, 416, 832

25 27 216, 432, 864

25 28 112, 224, 448, 896

25 29 232, 464, 928

25 30 120, 240, 480, 960

25 31 248, 496, 992

25 32 128, 256, 512

12.5 8 64, 128, 256, 512

12.5 9 144, 288, 576

12.5 10 80, 160, 320, 640

12.5 11 176, 352, 704

Table A-49 Word Length, Sampling Rate, and Multiplier for Master Clock In  (continued)

Sampling rate (kHz)[a] Word length Multiplier
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12.5 12 96, 192, 384, 768

12.5 13 208, 416, 832

12.5 14 112, 224, 448, 896

12.5 15 240, 480, 960

12.5 16 64, 128, 256, 512

12.5 17 272, 544

12.5 18 144, 288, 576

12.5 19 304, 608

12.5 20 160, 320, 640

12.5 21 336, 672

12.5 22 176, 352, 704

12.5 23 368, 736

12.5 24 192, 384, 768

12.5 25 400, 800

12.5 26 208, 416, 832

12.5 27 432, 864

12.5 28 224, 448, 896

12.5 29 464, 928

12.5 30 240, 480, 960

12.5 31 496, 992

12.5 32 128, 256, 512

6.75 8 64, 128, 256, 512

6.75 9 288, 576

6.75 10 160, 320, 640

6.75 11 352, 704

6.75 12 192, 384, 768

6.75 13 416, 832

6.75 14 224, 448, 896

6.75 15 480, 960

6.75 16 64, 128, 256, 512

6.75 17 544

6.75 18 288, 576

6.75 19 608

Table A-49 Word Length, Sampling Rate, and Multiplier for Master Clock In  (continued)

Sampling rate (kHz)[a] Word length Multiplier
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6.75 20 320, 640

6.75 21 672

6.75 22 352, 704

6.75 23 736

6.75 24 384, 768

6.75 25 800

6.75 26 416, 832

6.75 27 864

6.75 28 448, 896

6.75 29 928

6.75 30 480, 960

6.75 31 992

6.75 32 128, 256, 512

[a]For sampling rate less than or equal to.

Table A-49 Word Length, Sampling Rate, and Multiplier for Master Clock In  (continued)

Sampling rate (kHz)[a] Word length Multiplier
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Appendix 26: U8903B Default Settings

Analog generator

Table A-50 Analog generator default settings 

Level 1 Level 2 Level 3 Default

Waveform Sine

Waveform Config

Amplitude 0 Vrms

Frequency 1 kHz

DC Offset 0 V

Phase -> 1 0°

Frequency 2 2 kHz

Ratio 100%

Lower Feq 60 Hz

Upper Freq  
(SMPTE 1:1/4:1/10:1)

7 kHz

Upper Freq (IEC 60118) 10 kHz

Diff Freq 80 Hz

Center Freq 10 kHz

Voltage 0 V

Start Freq 1001.35803222656

Stop Freq 4997.25341796875

Freq Spacing Linear

Tones 2

Length 1024

Dial (DTMF) Mode Single

Amplitude (DTMF) –4.5 dBu

Ratio (DTMF) 2 dB

Tone Duration (DTMF) 90 ms

Tone Delay (DTMF) 90 ms

Pause Time (DTMF) 90 ms

Repeat (DTMF) Off
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Analog analyzer

Output Config

Connector UnBal

Impedance 600 Ω

IEC60268 10 Ω Pin 2

Ground Float

Max Voltage 22.6 Vrms

References Ref Impedance 600 Ω

Table A-50 Analog generator default settings (continued)

Level 1 Level 2 Level 3 Default

Table A-51 Analog analyzer default settings 

Level 1 Level 2 Level 3 Default

Functions

Multi-Chn Mode Off

Function No. 1

Meas. Func. (Function 1) AC Voltage

Meas. Func. (Function 2) Frequency

Meas. Func. (Function 3) None

Meas. Func. (Function 4) None

Functions  
(Frequency)

Unit Hz

Format Off

Functions  
(AC Voltage)

Unit V

Format Off

Detector RMS

Functions  
(DC Voltage)

Unit V

Format Off

Functions 
(THD+N Ratio/SINAD)

Unit dB

Format Off

Freq Lock Auto

Fund Freq 1000

Functions 
(THD+N Level)

Unit V

Format Off

Freq Lock Auto

Fund Freq 1000
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Functions  
(THD Ratio)

Unit dB

Format Off

Even Harmonic 2, 4, 6, 8

Odd Harmonic 3, 5, 7, 9

Freq Lock Auto

Fund Freq 1000

Functions  
(THD Level)

Unit V

Format Off

Even Harmonic 2, 4, 6, 8

Odd Harmonic 3, 5, 7, 9

Freq Lock Auto

Fund Freq 1000

Functions 
(DFD60268 2nd/ 
DFD 60268 3rd/ 
DFD 60118 2nd/ 
DFD 60118 3rd)

Unit dB

Format Off

Functions  
(SMPTE IMD)

Unit dB

Format Off

Freq Lock Gen Lock

Upper Freq 60

Lower Freq 7000

Functions  
(SNR)

Unit dB

Format Off

SNR Delay 0 ms

Functions 
(SNR (Fast))

Unit dB

Format Off

Freq Lock Auto

Fund Freq 1000

Harmonics 5

Functions 
(Phase)

Ref. Channel 1

Freq Lock Auto

Fund Freq 1000

Table A-51 Analog analyzer default settings (continued)

Level 1 Level 2 Level 3 Default
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Functions 
(X-Talk)

Ref. Channel 1

Unit dB

Format Off

Freq Lock Auto

Fund Freq 1000

Filters Config

LPF None

HPF None

Weighting None

Deemphasis None

Notch Filter

State Disabled

Center Freq 1000 Hz

Bandwidth 500 Hz

Meas Config

Auto Range On

Range 1 V

Sample Size 32768

Mov Average 1

Src Channel 1

Trigger Source Free Run

Trigger Edge Rising

Input Config

Connector UnBal

Impedance
100 kΩ (Unbal)
200 kΩ (Bal)

Coupling AC

Bandwidth 90 kHz

Ext. Gain 0 dB

Wave File

Channel Left

Bits/Sample 8

Duration 10 s

Statistics

Show Stats Off

No. of Reading 10

Stat 1 Min

Stat 2 Max

Stat 3 Average

Table A-51 Analog analyzer default settings (continued)

Level 1 Level 2 Level 3 Default
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Sweep

Table A-52 Sweep default settings 

Level 1 Level 2 Default

Legacy Status Off

Parameter Frequency

Points Settings

Spacing Log

Unit Hz

Start 20

Stop 2000

Step 1.268961003

Points 30

Points Settings 
(Parameter = Amplitude)

Spacing Linear

Unit Vrms

Start 0.1

Stop 1

Step 0.031034483

Points 30

Points Settings 
(Parameter = Phase)

Spacing Linear

Unit °

Start 0

Stop 90

Step 3.103448276

Points 30

Dwell Time 0

Sweep Mode Continuous

Channels
Source 1

Measure 1
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HP8903B

System

Table A-53 HP8903B default settings 

Level 1 Level 2 Default

Measurement

Function AC level

LP Filter 80 kHz

HP/W Filter None

Ratio Off

Format Lin

Generator

Frequency 1 kHz

Amplitude 0 V

Step Param Frequency

Freq. Step 1 kHz

Amp. Step 100 mVrms

Sweep
Freq. Start 20 Hz

Freq. Stop 20 kHz

Table A-54 System default settings 

Key Level 1 Level 2 Default

System HP8903B Config

Active Channel 1

Left Filter None

Right Filter None

Default LPF 80 kHz
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Appendix 27: Procedure to Rename, Copy, Move, and Delete Files

Renaming a file

1 In the file view, select the file to rename.

2 Press the Rename softkey.

3 Enter the new file name in the New name text box.

4 Press the OK softkey when done.

5 The selected file is renamed.

Copying a file

1 In the file view, navigate to the folder that contains the file to copy.

2 Press the Copy or Move softkey.

3 Press the Mark softkey to mark the file or multiple files to copy. 

4 Navigate to the folder where the file is to be copied.

5 Press the Copy Marked To Folder softkey.

6 The marked file will be copied to the specified folder. Press the Return softkey when done.

7 If the file name to be copied already exists in the destination folder, the copied file name 
will be renamed to Copy of [file name].

Moving a file

1 In the file view, navigate to the folder that contains the file to to move.

2 Press the Copy or Move softkey.

3 Press the Mark softkey to mark the file or multiple files to move.

4 Navigate to the folder where the file is to be moved.

5 Press the Move Marked To Folder softkey.

6 The marked file will be moved to the specified folder. Press the Return softkey when done.

Deleting a file

1 In the file view, select the file to delete.

2 Press the Delete softkey.

3 A dialog box will pop up prompting confirmation to delete the file. To delete the file, 

select Yes and press . To abort, select No and press .
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Appendix 28: POLQA Recording Duration Analysis

The following shows the maximum wave file recording duration allowed for POLQA analysis 
based on the different option card configuration and settings in the U8903B.

Table A-55 U8903B option configuration

Option Configuration

1 Analog cards only

2 Analog cards and Digital card 

3 Analog cards and Bluetooth card

4 Analog cards, Digital card, and Bluetooth card

Table A-56 Maximum wave file recording duration for the POLQA narrowband and super-wideband analysis

Option Configuration

Narrowband analysis Super-wideband analysis

Maximum wave file 
recording duration for 

8 kHz sample rate

Maximum wave file 
recording duration for 

16 kHz sample rate

Maximum wave file 
recording duration for 

48 kHz sample rate

Maximum wave file 
recording duration for 

48 kHz sample rate

Option 1 30 s 16 s 5 s 5 s

Option 2 20 s 14 s 5 s 4 s

Option 3 20 s 16 s 5 s 5 s

Option 4 16 s 10 s 4 s 4 s
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Appendix 29: Audio Measurement Ranging

In order to obtain measurements with high accuracy and resolution, selecting the 
appropriate audio measurement range is crucial. The U8903B is covered by switchable 
attenuation or gain from the input circuits of the audio analyzer. The two types of audio 
measurement ranging are manual ranging and auto ranging.

Manual ranging

Manual ranging is used to configure the level of the input signal to the optimum range for 
measurements. This allows you to set the gain of the analyzer to amplify a low input signal 
or attenuate a high input signal as required.

The U8903B provides the following input voltage ranges for both unbalanced and balanced 
inputs: 

– 140 V

– 100 V

– 32 V

– 10 V

– 3.2 V

– 1 V

– 320 mV

For optimum range, you should select the lowest range with its upper limit exceeding the 
expected maximum input signal.

Auto ranging

The auto ranging mode automatically selects an appropriate range for each measurement. 
Auto ranging determines the correct range to use according to the signal level to achieve 
the optimum measurement accuracy for the input signal.

Auto ranging is suitable for measuring stable signals with levels that do not vary greatly. It 
is however not suitable for signals with rapid-changing pulses or spikes. As auto ranging 
needs to determine which range to use for each signal level, it may not be fast enough to 
accommodate signals with rapid-changing pulses or spikes. This may result in ranging 
errors leading to incorrect measurements. 

Therefore in this case, manual ranging provides better and faster performance for your 
measurement needs. 

It is recommended to know the characteristics of the input signal and its level variation 
before applying the manual or auto ranging mode.
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A Appendixes
Using manual ranging for continuous sweep and frequency response 
measurements

For continuous sweep and frequency response measurements, manual ranging is a better 
option as it ensures signals across all frequency ranges are measured within the same 
range.
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